# KeyShot 9 Manual

1. What Is KeyShot? .................................................................................................................. 7
2. What's New .......................................................................................................................... 8
   2.1 Feature Highlights ........................................................................................................... 9
   2.2 Additional Features and Improvements .......................................................................... 17
   2.3 Product Updates ............................................................................................................ 18
   2.4 KeyShot Library Updates ............................................................................................... 19
   2.5 User Interface Updates ................................................................................................. 25
   2.6 Release Notes .............................................................................................................. 28
      2.6.1 KeyShot 9.0 Release Notes .................................................................................. 29
      2.6.2 Limitations & Known Issues .................................................................................. 30
3. Getting Started ................................................................................................................... 33
4. Installation ........................................................................................................................... 38
   4.1 Migration Assistant .......................................................................................................... 40
   4.2 Resource Folder ............................................................................................................. 41
   4.3 Pro Floating Installation ................................................................................................. 45
      4.3.1 Pro Floating Quick Start Setup ................................................................................ 46
      4.3.2 Luxion License Server Installation .......................................................................... 49
      4.3.3 License Server Installation (Linux) ......................................................................... 52
      4.3.4 KeyShot Pro Floating Installation ........................................................................... 57
      4.3.4.1 Borrowing A License ......................................................................................... 61
      4.3.4.2 Changing Server Connection ............................................................................. 62
      4.3.4.3 Enabling KeyShotWeb ......................................................................................... 63
      4.3.5 Pro Floating Troubleshooting .................................................................................. 64
         4.3.5.1 Server Error: Invalid Mac Address (HostID) ................................................... 65
         4.3.5.2 Server Error: License File Not Found ............................................................... 66
         4.3.5.3 Client Error: Looping Prompt ............................................................................ 67
         4.3.5.3.1 Edit Registry (PC) ......................................................................................... 68
         4.3.5.3.2 Environment Variable (Mac) ......................................................................... 69
         4.3.5.4 Client Error: No Licenses Available ................................................................. 70
         4.3.5.5 Client Error: Unsupported KeyShot Version ...................................................... 71
         4.3.5.6 Client Error: Unknown Error .......................................................................... 72
      4.3.6 Pro Floating Advanced Setup .................................................................................... 73
         4.3.6.1 License Server Installation (PC) - Custom ....................................................... 74
         4.3.6.2 License Server Installation (Mac) - Custom ...................................................... 76
         4.3.6.3 Replace License File ......................................................................................... 84
      4.3.7 Floating License Definitions ...................................................................................... 85
   4.4 Silent Install (PC) ............................................................................................................. 86
5. Preferences ............................................................................................................................ 87
   5.1 Interface Preferences ....................................................................................................... 88
   5.2 General Preferences ........................................................................................................ 90
   5.3 Folders Preferences ......................................................................................................... 93
   5.4 Plugins Preferences ........................................................................................................ 94
   5.5 Color Management .......................................................................................................... 95
   5.6 Hotkeys Preferences ....................................................................................................... 96
   5.7 License ............................................................................................................................ 98
6. User Interface ....................................................................................................................... 99
   6.1 Real-time View .............................................................................................................. 100
   6.2 Main Menu ..................................................................................................................... 103
   6.3 Toolbar ........................................................................................................................... 108
Environments
Labels
9. Textures
9.1 Texture Library
9.2 Texture Types
9.2.1 Texture Map
9.2.2 Tiled UV
9.2.3 Tri-Planar
9.2.4 Video Map
9.2.5 Brushed
9.2.6 Mesh
9.2.7 Weave
9.2.8 Brushed (Radial)
9.2.9 Camouflage
9.2.10 Cellular
9.2.11 Color Gradient
9.2.12 Contour
9.2.13 Curvature
9.2.14 Granite
9.2.15 Leather
9.2.16 Marble
9.2.17 Noise (Fractal)
9.2.18 Noise (Texture)
9.2.19 Occlusion
9.2.20 Scratches
9.2.21 Spots
9.2.22 Vertex Color
9.2.23 Volume Map
9.2.24 Wood
9.2.25 Wood (Advanced)
9.3 Map Types
9.4 Mapping Types
9.5 Move Texture
10. Labels
11. Environments
11.1 Adding Environments
11.2 Adjusting Environments
19.1.1 Part Animations ................................................................. 521
19.1.2 Material Animations ....................................................... 525
19.1.3 Camera Animations ......................................................... 527
19.2 Animation Wizard ............................................................. 534
19.3 Working with Animations ..................................................... 536
19.4 Deformation Animations ....................................................... 539
19.5 Animation Effects .............................................................. 540
19.5.1 Motion Blur ................................................................. 541
19.5.2 Motion Ease ................................................................. 542
20. KeyShot Web ........................................................................ 545
  20.1 KeyShotXR ........................................................................ 546
  20.1.1 KeyShotXR Wizard .......................................................... 548
  20.1.2 KeyShotXR Animation ..................................................... 554
  20.1.3 KeyShotXR Variables ....................................................... 555
20.2 Web Configurator ............................................................... 564
20.3 Embedding KeyShotWeb output ............................................ 565
  20.3.1 Embed in an iBook .......................................................... 566
  20.3.2 Embed in a Presentation .................................................. 568
  20.3.3 Embed in Wordpress ....................................................... 570
21. Configurator ........................................................................ 573
  21.1 Configurator Wizard ........................................................... 575
22. KeyShot Viewer ..................................................................... 589
23. Virtual Reality ...................................................................... 594
  23.1 VR Overview ..................................................................... 596
  23.2 Render VR Images .............................................................. 599
  23.3 Work In Real-Time VR ........................................................ 600
24. KeyShot Cloud ...................................................................... 602
  24.1 KeyShot Cloud User Interface .............................................. 604
  24.2 KeyShot Cloud Account ...................................................... 606
  24.3 KeyShot Cloud Search ....................................................... 607
  24.4 Uploading/Downloading Resources ...................................... 609
  24.5 KeyShot Cloud Release Notes ............................................. 611
25. Network Rendering .............................................................. 613
26. End-User License Agreement .................................................. 614
What Is KeyShot?

KeyShot is a stand-alone, real-time ray tracing and global illumination program used to create 3D renderings, animations and interactive visuals. With its CPU-based architecture, photorealistic real-time rendering can be achieved on both Mac and PC, even on laptops, without the need for high-end graphics cards.

KeyShot supports more 3D file formats than any other rendering software, importing over 25 different file types. It has a simple user interface with drag-n-drop material and environment presets, interactive labeling, texture mapping, physical lighting, animation and much more.

KeyShot is...

**Fast**
Everything inside KeyShot happens in real-time. KeyShot uses unique rendering technology which makes it possible to see all changes to materials, lighting, and cameras instantly.

**Easy**
You don’t have to be a rendering expert to create photorealistic images of your 3D models. Simply import your data, assign materials by dragging and dropping them onto the model, adjust the lighting, and move the camera. Done.

**Accurate**
KeyShot is the most accurate rendering solution for your 3D data. KeyShot is built on Luxion’s internally developed, physically correct render engine based on research in the areas of scientifically accurate material representation and global illumination.
What's New

KeyShot 9 brings you unbound creative capability to help you realize your ideas faster. Built as the hub for all your visualization needs, KeyShot has unmatched ease, simplicity, and accessibility to give you complete creative freedom and a level of visual agility that allows you to explore your design at the speed of thought.

Explore Feature Highlights

Creative Freedom

*Unlock your imagination*
With new materials and textures, KeyShot 9 opens up your creative freedom for a new level of detail and control over your product visuals.

Visual Agility

*Get more in. Get more out.*
KeyShot 9 streamlines import, expands compatibility, and extends output to bring you a more agile workflow from start to finish.

Speed of Thought

*The flexibility to visualize faster*
KeyShot is fast. From scene setup and real-time interaction to what you make and the reaction, KeyShot 9 delivers the capabilities you need to create with speed.
Feature Highlights
KeyShot 9 introduces the following top new features and improvements:

**Feature Categories**
- Import & Integration
- Workflow & Setup
- Materials & Textures
- Image & Output

**Top Features**
- GPU Mode
- Denoise
- RealCloth
- Web Configurator
- 3D Model Library

**Other New Features**
- Contour' Procedural Texture
- 'Generic' BRDF Material
- Browzwear VStitcher Plugin
- Substance Painter Material Import
- Fuzz Geometry Shader (PRO)
- Custom Motion Ease (PRO)
- Curve Fade Animation (PRO)
- Parallel Jobs (Network Rendering)

**Top Improvements**
- Streamlined Import
- 'Resolve Missing Resources' Dialog
- Photographic Image Style 'Response Curve'
- Improved HDRI Editor Pin Interaction (PRO)
- Configurator Sub-Component Groups (PRO)

**Import & Integration**
Streamlined Import
The Import dialog and workflow has been updated in KeyShot 9 to speed up your Import efficiency. Updates include the ability to import a KeyShot Package File (.ksp) directly into an open scene with the options to exclude components of a scene i.e. Models, Cameras, Environments, Image Styles, and Studios. In addition, users of KeyShot Pro now have the ability to import directly into a new or existing Model Set.

The interface of the Import dialog has been updated to use less vertical space and Import terminology has been updated to more clearly communicate function.

How it Works
You will be presented with the updated Import dialog upon import of any supported filetype in KeyShot 9 with the relevant options and parameters shown for each respective filetype.

Quick Import
The Enable quick import option allows you to further streamline the import process by selecting it along with default import settings for your favorite filetypes which will bypass the import dialog altogether. Learn more about model import.

How it Works
When importing a new filetype you will be presented with the KeyShot Import dialog. To the bottom-left of this dialog you will see the Enable Quick import checkbox. By selecting this, KeyShot will save the settings to the Import Settings under Edit, Preferences and use those when importing the same filetype.

To display the KeyShot Import dialog again on Import use File, Import Dialog or hold Alt when dropping a file into the Real-time View.

Resolve Missing Resources
In KeyShot 9 you can now more easily relink missing textures, backplates, etc. upon opening a scene.

How it Works
When opening a .bip or .ksp file and there are missing resources you will be presented with the Resolve Missing Resources dialog where you can browse to a path to relink them.

Browzwear VStitcher Plugin
This new plugin allows you to send your garments from VStitcher straight into KeyShot 9 with all textures included. Learn more and download the VStitcher plugin.

How it Works
Once the plugin has been installed you will see an item for KeyShot in the VStitcher plugins menu. Once your avatar has been dressed, select Render to KeyShot to launch KeyShot 9 and load your garments. Note: There is currently no Live-Linking functionality so each time you Render to KeyShot a new session will be launched.

Substance Painter Material Import
KeyShot 9 adds the capability to automatically generate materials from texture sets exported from Substance Painter.

How it Works
Install the Substance Painter Plugin to add a Generic Texture Set export configuration in Substance Painter. Export your texture set to you preferred location using this configuration. In KeyShot, select Tools, Material Importer, Substance Painter Set (*.sp) from the Ribbon. From the location you
exported the Substance Painter texture set, select the folder ending with .sp to load the textures into the material list dialogue box. From the dialogue, you can drag and drop into your scene to apply. Learn more about the Material Import Tool and Generic Material Type.

**X-Rite AxF 1.6**

This X-Rite AxF update adds support for scattering media/cloudy-plastic like materials and loading AxF data directly from memory. There has also been a fix to black spots appearing at grazing angles with bump textures. On import, the AxF material is converted into a KeyShot material that uses the Measured material type. The properties for the AxF material will be mirrored in the Measured material, Properties tab. Learn more about the Material Import Tool and Measured Material Type.

**How it Works**

In KeyShot 9, on the Ribbon, select Tools, Material Importer, and choose X-Rite AxF (*.axf). Browse to a .axf file, and select a folder in the KeyShot Library to save your new Measured material. To create from scratch, go to the material type dropdown and select Measured to load an AxF file.

**Vizoo U3M Support**

KeyShot 9 supports the import of Unified 3D Material (u3m) files through the new Material Importer tool. On import, the U3M material is converted into a KeyShot material that uses the Generic material type. The properties for the u3m material will be mirrored in the Generic material Properties tab. Learn more about the Material Import Tool and Generic Material Type.

**How it Works**

In KeyShot 9, on the Ribbon, select Tools, Material Importer, and choose Unified 3D Material (*.u3m) then browse to a .u3m file alongside its "textures" folder. You will then be prompted to select a folder in the Library to specify where the material will be saved.

**Workflow & Setup**

**GPU Mode**

KeyShot 9 introduces the ability to harness the full GPU-accelerated ray tracing power of NVIDIA RTX with OptiX. Available for both real-time rendering and local render output, KeyShot’s GPU Mode allows GPU resources to be accessed with one-click to take advantage of multi-GPU performance scaling and the dedicated ray tracing acceleration hardware in NVIDIA RTX-capable GPUs. You may toggle between GPU and CPU as needed. GPU ray tracing in KeyShot 9 supports the NVIDIA Maxwell microarchitecture found in GTX 980 and above. Read more about GPU Mode.

**How it Works**

When KeyShot detects a compatible GPU, it will enable the GPU button on the Ribbon. When enabled, the image in the Real-time View and the rendered output will be rendered on the GPU instead of CPU. When GPU is enabled the CPU Usage core selection drop-down menu on the Ribbon will change to a GPU Usage selection drop-down where you can control which GPU(s) are being used.

**3D Model Library**

Adding context and detail to your scene is easier than ever with Models now available on the Cloud Library to download straight into your KeyShot Library and add to your scene. Learn more about working with Library Models.

**How it Works**
In the KeyShot 9 Library window you will now see a new Models tab. You can add your own models/scenes by clicking the Add model to Library from scene button next to the search bar. In this dialog, you can define which components in your scene are included to suit your desired workflow.

To explore Models on KeyShot Cloud, launch the KeyShot Cloud from the Toolbar button (at the far left). You will see a Models tab that contains curated and optimized, high-quality models with materials assigned that you can download straight to your KeyShot 9 Model Library. Simply drag-and-drop a model from the Model tab to the Real-time View to add and position the model in your scene. To center and snap a model to the ground, double-click (or right-click) the model in the Library and select Add to scene.

Tools Menu

Geometry, Material, and Camera tools are now grouped in one easily accessible place. Learn more about the Tools menu.

How it Works

In KeyShot 9, click on the Tools icon located on the Ribbon to see all tools available. Tools are grouped into Geometry tools (Move Tool, Edit Normals, Re-Tessellate, Close Mesh, Split Object Surfaces, and Split Separate Objects), Material tools (Material Templates, Substance Painter Importer), and Camera tools (Set Camera Target, Match Perspective).

Improved HDRI Editor Pin Interaction (PRO)

Working with pins in the HDRI Editor has been improved with the addition of new hotkey support to streamline your workflow.

How it Works

- ‘Isolate’ has been added to the right-click context menu and also by using Alt + LMB click.
- Holding Shift while dragging a pin in the HDRI Editor canvas restricts the pin to vertical and horizontal movements.
- Holding Alt by dragging a pin in the HDRI Editor canvas creates a duplicate of the pin.
- Ability to copy/paste a selection of pins from one environment to another via hotkeys.

Configurator Sup-Components (PRO)

The Configurator now supports Sub-Component Groups to define a 3rd level of dependency between Parent and Components.

How it Works

On the Component Group page of the Configurator Wizard you will see blue links within component groups which allow you to add a sub-component group when clicked.

Configurator Thumbnails (PRO)

You can now use custom image thumbnails for model and material variations in the Configurator.

How it Works

On the Summary page you will see the respective thumbnail for the selected item in the summary list. Click the Replace Thumbnail button to browse to a custom image or render a new thumbnail.
Custom Motion Ease (PRO)

Custom Motion Ease brings users more control over part and camera animations. Custom motion easing may be applied to each animation on the Animation Timeline using custom curve control in the Time Settings of the Animation Properties. Keys may be added quickly along the curve with interpolation and tangency control for each key with all adjustments seen in real-time. Learn more about Custom Motion Ease.

How it Works
In KeyShot 9, select an animation on the Animation Timeline. You will see a new option in animation Properties, Time Settings, in the Motion Ease dropdown menu for Custom. When this option is selected you will be presented with a new curve graph for granular control over the selected animation. New keys may be added along the curve by right-clicking in the curve graph and selecting Add Key. Curves may also be copied and pasted from one animation to another.

Curve Fade Animation (PRO)

Curve Fade Animation brings users more control over material animations. Applied as a Animation node in the KeyShot Material Graph, a Curve Fade animation may be applied to a material color, bump, opacity or other property. Like Custom Motion Easing, a custom curve control graph allows keys to be quickly added along the curve and adjusted in real-time to create animated material effects. Learn more about Curve Fade.

How it Works
The Number Fade material animation is now called the Curve Fade material animation. In the KeyShot Material Graph, a Curve Fade node may be added by right-clicking in the Material Graph and selecting Animation, Curve Fade. Double-clicking on the node will display the Curve Fade Properties to the right. Under Animation, the curve control graph appears. New keys may be added along the curve by right-clicking in the curve graph and selecting Add Key. Curves may also be copied and pasted from one Curve Fade material animation to another.

Materials & Textures

Contour Procedural Texture

This new procedural texture type is very similar to the Toon material that already exists in KeyShot. With Contour as a texture, you now have more control and flexibility while creating custom materials. You can use it to add an illustration-like effect on top of real-world materials such as metal or plastic.

How it Works
In the Texture dropdown menu you will now find a new item for ‘Contour’. It can be used like any other procedural texture to drive texture channels such as color, roughness, and opacity.

Generic (BRDF) Material

This new Material Type is based on the Disney BRDF shader that provides a huge amount of flexibility with a number of parameters that can be adjusted to achieve a wide variety of material finishes. Learn more about the Generic Material Type.

How it Works
You will find this new material type in the Advanced category of the Material Type dropdown menu found in the Project Material tab.
RealCloth™ Material

RealCloth™ is a patent-pending technology from Luxion driving a powerful, new material type that allows the creation and visualization of realistic woven materials. The material type provides intricate control of the weave pattern (Pro) and the ability to easily add flyaway fibers. New RealCloth materials have been added to the Library as well. Learn more about RealCloth.

How it Works
In KeyShot 9 there is a new material type for RealCloth that you can find in the material type dropdown menu in Project > Material.

Fuzz Geometry Shader (PRO)

Fuzz is a new geometry shader accessible through the KeyShot Material Graph (Pro) that allows you to add randomized, hair-like growth from the surface of any material. You can control several parameters of Fuzz such as Length, Randomness, and Density to create a range of appearances. In addition, you can modify the appearance through the built-in material properties or input a different material type to the surface of the Fuzz node for even more control. Learn more about Fuzz.

How it Works
In the KeyShot Material Graph, a Fuzz node may be added by right-clicking in the Material Graph and selecting Geometry, Fuzz. Double-clicking on the node will display the Fuzz Properties to the right. Properties for Length and Length Variation will affect how long the fuzz is, while Randomness affects the straightness. Fuzz can also be controlled using Density, Length and Direction textures from the Textures tab. Appearance properties (Color, Specular, etc) are located below the main Fuzz properties.

Image & Output

Denoise

Denoise is a one-click Image Style option that works in both CPU and GPU mode to eliminate noise in the Real-Time View and render output. This deep learning denoiser reduces the time it takes to resolve a rendered image by interpolating and refining the image to achieve smooth results in less time. Learn more about Denoise in Image Styles.

How it Works
The Denoise function is easily enabled by clicking Denoise on the Ribbon. This will enable Denoise for the currently active Image Style and is reflected in the Image tab of the Project window. In both the Basic and Photographic Image Styles you will find a new Denoise option that contains a slider for Denoise Blend to control how much of the denoised image is shown. When this is set to 0 you will see no Denoise effect in the real-time view or render output. At a value of 1, you will see a completely denoised image. Any values in between 0 and 1 will blend the original and denoised images which can be useful if the Denoise effect starts to reduce the clarity of fine detail and textures in your image.

When the Ribbon is not shown or in Presentation Mode you will notice a Denoise button in the Real-time View for easy access.

There is an item in Preferences, General, Denoise for Refresh time to set the time increment in seconds in which the image is denoised. As the number of samples increases the denoise result will improve.

The best Denoise results occur when using Product Mode rendering. It's also important to keep in mind that multi-frame renderings such as Animation, Configurator, and KeyShotXR output will likely create a very high RAM load.
Photographic Image Style Response Curve

This new feature in the Photographic Image Style allows you to use a linear, low contrast or high contrast Response Curve.

How it Works
In KeyShot 9, go to Project > Image > Photographic > Tone Mapping to find the Response Curve selection. The Linear response curve is similar to the Basic Image Style. The Low Contrast Response Curve is suitable for scenes with a high dynamic range between light and shadow i.e. interiors with Sun & Sky. The High Contrast Response Curve is suitable for scenes with low to moderate range between light and shadow i.e. product shots with diffuse lighting.

Improved STL Color Texture Export (PRO)

Users of KeyShot Pro can now Export STL files for 3D printing with improved accuracy of vertex colors from both texture maps and procedural textures.

How it Works
In KeyShot 9, select File, Export to STL..., select Save, and in the KeyShot Export dialog that appears, select Export as vertex color from the Texture Mode dropdown menu. Note: Depending on the tessellation of the model it may require subdivision for color textures to be displayed accurately.

Web Configurator (KeyShotWeb)

KeyShot 9 now offers the ability to output fully-rendered, static product viewing and configuration in a web browser. Just like Presentation Mode in KeyShot, you can select from Model, Material, and Studio options to configure your product. Unlike Presentation Mode, the Web Configurator displays fully-rendered images to give you full control and endless capabilities. The Web Configurator is output as an HTML file with associated images and files included so that you can zip and share locally or host on your website for anyone around the world to access. Learn more about KeyShotWeb.

How it Works
Once a configuration has been set up through the Configurator Wizard, navigate to the Render dialog, select the Configurator tab in the Output section and select the Web Configurator option. The Web Configurator uses the layout settings from the Configurator Wizard and supports both vertical and horizontal layout styles.

Streamlined Wizard (Network Rendering)

The Network Rendering Setup Wizard and the Network Rendering Configuration dialog have been merged to make for a more streamlined installation and setup experience.

How it Works
When KeyShot 9 Network Rendering is installed you will now be directly presented with the Network Configuration dialog to lead you through the setup process.

Run Parallel Jobs (Network Rendering)

KeyShot 9 Network Rendering now allows you to process multiple jobs simultaneously.

How it Works
In the KeyShot 9 Network Configurator > Master Settings > Job Settings you can now set the number of parallel jobs to be distributed amongst your
workers to render simultaneously.
Additional Features and Improvements

The additional features and updates are also included in KeyShot 9:

### Screenshot

- **Expanded file formats** available in Preferences > General > Screenshot and in the system dialog that shows when "Ask where to save each screenshot" is enabled.
- New option in the Render menu for "Copy Screenshot to Clipboard" with the ability to assign a custom hotkey via Preferences.

### Hotkeys

- **Duplicate** with Ctrl/Cmd+W, select part(s) in the Real-time View or the Scene-Tree and press Ctrl/Cmd+W will create a copy of the part(s) in the same group/model as the original.

### Geometry Shaders

- **Flakes** (Pro) - A new option for *Keep Original* to embed flakes within its parent surface material means you are no longer required to duplicate geometry to achieve this result.

### KeyShot Cloud

- **Tag search** - it is now possible to search by tags in KeyShot Cloud. Use the # before the tag in the search bar. If you want to find a specific Resource ID you now have to use the $ before the ID (this was previously #).
Product Updates

With KeyShot 9, we have the following product updates:

**Feature Licensing**

- **KeyShotXR** - Now includes "Web Configurator" output and the add-on is renamed to *KeyShotWeb*
- **Match Perspective** - Now included as a KeyShot HD feature.
KeyShot Library Updates

Below is a summary of changes made to the KeyShot 9 Library.

**New Materials**

**Architectural Materials**

Two materials with displacement that can be used as presentation surfaces.

- Gravel Red Displace
- Rock Face Displace

**Fabric Materials**

RealCloth materials with and without Flyaway Fibers that accurately simulate the appearance of woven fabrics.

Twill weaves:

- RealCloth Basket Twill Blue
- RealCloth Basket Twill Blue Flyaway Fibers
- RealCloth Basket Twill Dark Grey
- RealCloth Basket Twill Dark Grey Flyaway Fibers
- RealCloth Decorative Twill 1 Red
- RealCloth Decorative Twill 1 Red Flyaway Fibers
- RealCloth Decorative Twill 2 Dark Green
- RealCloth Decorative Twill 2 Dark Green Flyaway Fibers
- RealCloth Diamond Twill Red
- RealCloth Diamond Twill Red Flyaway Fibers
- RealCloth Herringbone Twill Dark Blue
- RealCloth Herringbone Twill Dark Blue Flyaway Fibers
- RealCloth Herringbone Twill Red
- RealCloth Herringbone Twill Red Flyaway Fibers
- RealCloth Icelandic Diamond Twill Red
- RealCloth Icelandic Diamond Twill Red Flyaway Fibers
- RealCloth Plain Weave Blue Variation
- RealCloth Herringbone Twill Red Flyaway Fibers
- RealCloth Icelandic Broken Diamond Twill Black
- RealCloth Plain Weave Blue Variation Flyaway Fibers
- RealCloth Herringbone Twill Red
- RealCloth Herringbone Twill Red Flyaway Fibers
- RealCloth Icelandic Diamond Twill Black
- RealCloth Icelandic Diamond Twill Black Flyaway Fibers
- RealCloth Icelandic Broken Diamond Twill Orange
- RealCloth Icelandic Broken Diamond Twill Orange Flyaway Fibers
- RealCloth Icelandic Diamond Twill Green
- RealCloth Icelandic Diamond Twill Green Flyaway Fibers
- RealCloth Twill Blue
- RealCloth Twill Blue Flyaway Fibers
- RealCloth Twill Dark Grey
- RealCloth Twill Dark Grey Flyaway Fibers
• RealCloth Twill Light Grey
• RealCloth Twill Light Grey Flyaway Fibers

Satin weaves:
• RealCloth Satin Green
• RealCloth Satin Light Brown
• RealCloth Satin Red
• RealCloth Satin Blue

Mesh fabrics:
• RealCloth Plain Weave Mesh Black
• RealCloth Plain Weave Mesh Blue
• RealCloth Plain Weave Mesh Green
• RealCloth Plain Weave Mesh Red
• RealCloth Plain Weave Mesh White

Fuzz Materials

A collection of materials utilizing the new Fuzz geometry node to simulate strands, bristles, thin blades, fibers etc. With these materials, the appearance is determined predominantly by densely scattered fibers (Fuzz).

Brushes:
• Makeup Powder Brush Dark 50mm Fuzz
• Makeup Powder Brush Light 50mm Fuzz

Fabrics (rugs, towels and suedes):
• Plastic Rug Blue Fuzz
• Plastic Rug Dark Grey Fuzz
• Plastic Rug Light Grey Fuzz
• Plastic Towel Coarse Blue Fuzz
• Plastic Towel Coarse Green Fuzz
• Plastic Towel Coarse Grey Fuzz
• Plastic Towel Fine Blue Fuzz
• Plastic Towel Fine Green Fuzz
• Plastic Towel Fine Grey Fuzz
• Plastic Suede Rough Black Fuzz
• Plastic Suede Rough Blue Fuzz
• Plastic Suede Rough Brown Fuzz
• Plastic Suede Rough Red Fuzz

Grasses:
• Lawn Grass Healthy Fuzz
• Lawn Grass Patchy Fuzz
• Tall Dry Grass Fuzz
• Tall Dry Grass Patchy Fuzz
• Tall Grass 5m Crop Circle Fuzz

Measured Materials
Scanned fabrics as provided by Vizoo. These materials are u3m imports, which is supported by the new Material Importer tool. For each material, a variation with displacement is available.

- Vizoo 0016 FTW Sparkle Purple 1k
- Vizoo 0016 FTW Sparkle Purple 1k Displace
- Vizoo 0019 FTW Leather Earthy 2k
- Vizoo 0019 FTW Leather Earthy 2k Displace
- Vizoo 0026 FTW Mesh Blue
- Vizoo 0026 FTW Mesh Blue Displace
- Vizoo 0027 Denim Dark 2k
- Vizoo 0027 Denim Dark 2k Displace
- Vizoo 0031 T-Shirt Heather Grey 2k
- Vizoo 0031 T-Shirt Heather Grey 2k Displace
- Vizoo 0034 Elastane Function Grey 2k
- Vizoo 0034 Elastane Function Grey 2k Displace

**Metal Materials**

Stainless steels with circular brushed finishes. These materials take advantage of the precise anisotropic control provided by the new Generic material type.

- Stainless Steel Circular Brushed
- Stainless Steel Circular Brushed Pattern
- Stainless Steel Circular Brushed Pattern Simple
- Stainless Steel Circular Brushed Simple

**Multi-Layer Optics**

Additional Multi-Layer Optics materials are provided to cover a wider variety of specialty optics and filters.

- Multi-Layer Optics Anti-Reflex 500 nm
- Multi-Layer Optics Anti-Reflex 500 nm Complex
- Multi-Layer Optics Anti-Reflex 600 nm
- Multi-Layer Optics Anti-Reflex 600 nm Complex
- Multi-Layer Optics Anti-Reflex 700 nm
- Multi-Layer Optics Anti-Reflex 700 nm Complex
- Multi-Layer Optics Baumesiter and Stone Broadband Mirror
- Multi-Layer Optics Dielectric Mirror
- Multi-Layer Optics High-Pass Filter 750 nm
- Multi-Layer Optics Low-Pass Filter 500 nm
- Multi-Layer Optics Quarter-Wave Plate 546 nm
- Multi-Layer Optics Quarter-Wave Plate 650 nm
- Single-Layer Optics Anti-Reflex 500 nm
- Single-Layer Optics Anti-Reflex 500 nm Simple
- Single-Layer Optics Anti-Reflex 600 nm
- Single-Layer Optics Anti-Reflex 700 nm

**Packaging Materials**

Gift wrapping foils with metallic patterns. These materials take advantage of the metallic and clearcoat properties of the new Generic material type.
**Effects Labels**

Materials with the new Contour procedural texture as opacity map. Drag-and-drop these materials into the labels list of an existing material in your scene to create stylized effects.

- Contour Emissive Blue
- Contour Emissive Green
- Contour Emissive Red
- Contour Flat Black
- Contour Flat Blue
- Contour Flat Green
- Contour Flat Red

**Animated Materials**

Area Lights with Curve Fade material animations to simulate pulsing and fading light sources.

- Area Light 1200 Lumen Pulse Neutral
- Area Light 1200 Lumen Pulse Warm
- Area Light 1200 Lumen Pulse White
- Area Light 1200 to 0 Lumen Fade Cool
- Area Light 1200 to 0 Lumen Fade Neutral
- Area Light 1200 to 0 Lumen Fade Warm
- Area Light 1200 to 0 Lumen Fade White

**New Colors**

Originally released as a content installation pack, the PANTONE Fashion, Home + Interiors (FHI) collection and additional updates are now included in the installer.

**New Libraries**

- FHI Paper TPG
- FHI Cotton TCX
- FHI Polyester TSX
- FHI Nylons Brights TN
- FHI Metallic Shimmers TPM

**Updated Libraries**
New Environments

HDRMAPS has provided 20 high-quality interior and outdoor environments that can be downloaded straight from the Cloud Library into KeyShot.

- hdrmaps-cyclorama-studio-1
- hdrmaps-cyclorama-studio-2
- hdrmaps-empty-modern-storehouse
- hdrmaps-empty-warehouse-with-fluorescent-lights
- hdrmaps-factory-truck-parking
- hdrmaps-flume-fella
- hdrmaps-garage-studio-1
- hdrmaps-mountain-desert-surrounded-by-rocks
- hdrmaps-regional-council-hall
- hdrmaps-rims-storehouse-2
- hdrmaps-road-D42
- hdrmaps-road-D106
- hdrmaps-road-to-san-jose
- hdrmaps-sports-hall-in-the-shadow
- hdrmaps-sports-hall-sundown
- hdrmaps-tires-storehouse-2
- hdrmaps-underground-garage
- hdrmaps-view-from-egg-mountain
- hdrmaps-warehouse-without-floor
- hdrmaps-wet-shiny-road-in-the-alps

The following eight environments are included in 3K resolution in the KeyShot 9 Library:

- hdrmaps-cyclorama-studio-2
- hdrmaps-empty-modern-storehouse
- hdrmaps-flume-fella
- hdrmaps-mountain-desert-surrounded-by-rocks
- hdrmaps-rims-storehouse-2
- hdrmaps-road-D42
- hdrmaps-sports-hall-in-the-shadow
- hdrmaps-view-from-egg-mountain

New Textures

Jonathan Berube has provided a small collection from his Berube Lighting Pack of .EXR files to use as image pins in the HDRI Editor.

They can be downloaded straight from the Cloud Library into your Textures Library.
- ARRI 300 Plus
- ARRI 650 Plus
- ARRI 1000 Plus
- Construction Light
- Mag Light
User Interface Updates
The following user interface improvements have been made in KeyShot 9.

Menu

- New items in the Render menu:
  - Option to Copy screenshot to clipboard. This also has the option of having a hotkey assigned.
  - Toggle GPU mode: This item is present, if you have a GPU that meets requirements.
  - GPU Usage: Enables you to limit the GPU usage GPU mode.
- New import option in the File menu. The regular Import option will now import with the user’s saved import settings (if enabled). To facilitate exceptions to the saved settings an Import Dialog option has been added. This will always show the Import dialog
- New item in the Help menu for Open (Recovery Mode)... If you experience problems when opening a scene you can now open it in "recovery mode". This means that the scene will be opened in Performance mode and geometry nodes, including flyaway fibers on RealCloth, will not be executed.

Project panel

- Full size Model Set thumbnails are now shown when hovering Model Sets in sidebar.
- Option to Duplicate added to the Model Set context menu.
- Option to Link Materials added to the Pattern tool
- New hotkey (Ctrl+w/Cmd+w) for duplicating selected parts (also works with selection in the Real-time View)
- Triangle count in Scene > Properties sub-tab for group, part, and multi-selection.
- Animation now included in the Camera list right-click context menu.
- The Depth of Field, Set Focal Point button has been replaced with a Cross-hair icon next to the Focus Distance input field.

Studios

- Option to Render High Res thumbnails added to the Studio panel settings

Ribbon

- GPU, toggles the new GPU mode.
- Denoise, toggles the new denoise functionality, which is a part of Image styles.
- Tools, drop-down that gives access to a collection of tools. Including Move tool and Material Templates, which could previously be found in the ribbon itself.

Consistency

- Renaming has been streamlined, so it consistently can be triggered by a click on a selected item.

Tools

Selected functionality has been migrated to the Tools drop-down on the ribbon to provide easier access and an improved experience. The Tools menu is split into three categories: Geometry Tools, Material Tools, and Camera Tools. Also some of the tools have had an update of the UI.

Geometry Tools
• **Move Tool** - The widget has been moved out of the rendered part of the Real-time View, so it from now on can be placed freely inside the Real-time View.
• **Close Mesh** (PRO) - the tool have been moved from the geometry view, and now has the preview as an integrated part of the tool.
• **Edit Normals** (PRO) - the tool have been moved from the geometry view, and now has the preview as an integrated part of the tool.
• **Split Separate Objects** (PRO) - the tool have been moved from the geometry view, and now has the preview as an integrated part of the tool.
• **Split Separate Surfaces** (PRO) - the tool have been moved from the geometry view, and now has the preview as an integrated part of the tool.
• **Re-tessellate** (PRO) - the UI has been updated to match the other tools

**Material Tools**

• **Material Templates**
• **Material Importer** - New tool, which allows you to import .axf and .u3m files, as well as import and generate materials from Substance Painter Texture sets.

**Camera Tools**

• **Match Perspective**
• **Set Camera Target** - widget has been expanded. It now offers the option to select type of target - Point on surface/ Center of Part/ Center of Mode

**Environments**

• Added modifier keys for better handling of pins in the HDRI editor
• Shift+drag will restrict drag movement to horizontal/vertical axes
• Alt+click will isolate the Pin
• Alt+drag will duplicate pins

**Image styles**

• Choice of response curve has been added to the Photographic style
• Denoise has been added

**Import**

• Import dialog has been updated
• Option to set up default import settings added (for each import format), which enables the user to skip the Import dialog entirely on regular import.
• Modifier key added to trigger import dialog - Hold Alt when importing via drag and drop
• Resolve missing resources function added on import/open

**Animation (PRO)**

• New animation node Curve Fade for custom fading between values. Replaces the Number fade node.
• New icon on Color Fade node in the material graph
• New option to use custom Easing curves on animations.
• Icons for Imported Animation and Linked Imported Animation added
• Option to sort items in the timeline.
Configurator (PRO)

The Configurator has been updated so it can handle Sub-Components, which is reflected in the Component Group step of the Configurator wizard as well as in the Presentation mode layout.

- Default thumbnail for “None” options in Component Groups added.
- Materials, Material Ways etc. can now be re-ordered in the Material Variations list.
- Default thumbnails for Material Ways will now show the first 3 materials in the Material Set.
- The appearance of the Material variations list and the Summary in the Configurator has been updated for easier overview.
- The Material Variation step of the Configurator wizard now reflects Material Sets and Material Ways.
- Option to set font size added to the layout step the Configurator wizard.
- New hotkey (Q) for launching the Configurator wizard.
Release Notes
The following is a summary of new features and known issues for KeyShot 8

New Features
See Feature Highlights

Release notes
- KeyShot 9.0 Release Notes
- Limitations & Known Issues
KeyShot 9.0 Release Notes

The following pages contain updates on the major releases for KeyShot 9. For an overview of major features, please see the Feature Highlights.

Version: 9.0
Release Date:

Noteworthy KeyShot 9.0 Bug Fixes

- Bug fix

Noteworthy KeyShot Network Rendering 9.0 Bug Fixes

- Bug fix
Limitations & Known Issues

On this page you will find known issues and limitations that the development team is aware of, along with workarounds where applicable.

### Rendering

<table>
<thead>
<tr>
<th>Feature</th>
<th>Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interior mode</td>
<td>Interior Mode does not support material samples.</td>
</tr>
</tbody>
</table>

### Caustics

<table>
<thead>
<tr>
<th>Feature</th>
<th>Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caustics</td>
<td>Caustics have a different appearance in the Real-Time View and rendered output.</td>
</tr>
<tr>
<td></td>
<td>Details and possible solution</td>
</tr>
<tr>
<td></td>
<td>The Real-Time View uses a slightly different approach from the Output window when rendering, this is especially apparent when dealing with caustics with Interior Mode.</td>
</tr>
<tr>
<td></td>
<td>Possible solution: Try to increase the amount of samples.</td>
</tr>
</tbody>
</table>

Volumetric Caustics are only supported in Interior Mode.

Volumetric Caustics are not rendered when Light Sources are contained inside a Scattering Medium volume.

### Render Passes

<table>
<thead>
<tr>
<th>Feature</th>
<th>Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Render Passes</td>
<td>Passes with Interior Mode are missing Specular Reflections of Light Source materials.</td>
</tr>
</tbody>
</table>

Depth Pass has artifacts when rendering is stopped before finishing with Interior Mode.

Opacity textures are not supported by Refraction render pass in Interior Mode.

Bump textures are not supported by Render passes in Product Mode.

Caustics cast onto the ground material will not Show up in the caustics pass.

### GPU Mode

Following materials/textures/geometry types are not supported in GPU mode:

- Cutaway material: objects with this material will be ignored.
- NURBS: NURBS-only objects will be ignored in GPU mode. Objects that have both triangles and NURBS data, will be shown as triangles.
- Legacy textures, from KeyShot 6 or earlier, (except Texture maps) are not supported. They will be ignored in GPU mode.
- Curve geometry: GPU mode has limited support for Curve geometry, e.g. imported from Alembic, Max, C4D or Maya. Curve geometry that is not fully supported will either be ignored or appear wrong.
- ZSpheres: GPU Mode does not support zsphere geometry (transferred from ZBrush).

If you run into one of these, a warning icon ![Warning Icon](https://example.com/alert) will appear in the top right corner of the Real-time View. Click the icon to get info about what parts of the scene are impacted and by what.
## Materials and Textures

<table>
<thead>
<tr>
<th>Material</th>
<th>Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cutaway</td>
<td>Opacity maps on cutaway caps are not supported</td>
</tr>
<tr>
<td></td>
<td>Fade Animations are not supported with cutaway materials</td>
</tr>
<tr>
<td></td>
<td>Co-planar surfaces may produce artifacts with inherit/material caps</td>
</tr>
<tr>
<td></td>
<td>- Details</td>
</tr>
<tr>
<td></td>
<td>If you have two co-planar parts where one is excluded from the cutaway and you use inherit caps or material caps. Artefacts can occur on the surface of the excluded material.</td>
</tr>
<tr>
<td></td>
<td>Cutaway material may interfere with shadows on the environment ground</td>
</tr>
<tr>
<td></td>
<td>- Details and workaround</td>
</tr>
<tr>
<td></td>
<td>If the cutaway object touches the environment ground it will cut that just as it cuts into regular parts.</td>
</tr>
<tr>
<td></td>
<td>Workaround: Add a groundplane (Edit &gt; Add Geometry &gt; Add Ground Plane) and exclude it from the cutaway.</td>
</tr>
<tr>
<td></td>
<td>When the Camera is inside the cutaway object, Color caps and Material caps are not working as intended</td>
</tr>
<tr>
<td></td>
<td>- Details</td>
</tr>
<tr>
<td></td>
<td>When using material caps or color caps and the camera is positioned inside the the cutaway object, all objects in the scene will be displayed with the cap material/color.</td>
</tr>
<tr>
<td></td>
<td>Excluded objects in cutaway have incorrect reflections</td>
</tr>
<tr>
<td></td>
<td>- Details</td>
</tr>
<tr>
<td></td>
<td>Objects excluded by cutaway show reflections of the inside of the object being cut.</td>
</tr>
<tr>
<td></td>
<td>Bad shadows on excluded cutaway objects</td>
</tr>
<tr>
<td></td>
<td>- Details</td>
</tr>
<tr>
<td></td>
<td>The shadows on excluded objects appear as if the cut objects are still visible.</td>
</tr>
<tr>
<td></td>
<td>Fade Animation is not supported when viewing through a Cutaway object.</td>
</tr>
<tr>
<td></td>
<td>Scattering Media and Cutaway materials in the same scene will sometimes lead to undesirable results.</td>
</tr>
<tr>
<td></td>
<td>- Details</td>
</tr>
<tr>
<td></td>
<td>- If there is overlap between the cutaway and the Scattering Medium, and the Scattering Medium object is set to be excluded, the resulting image can have visual errors.</td>
</tr>
<tr>
<td></td>
<td>- Cutaway material does not allow scattering medium to be seen through the cutaway material.</td>
</tr>
<tr>
<td>Geometry nodes</td>
<td>Some geometry may not show Flakes/Bubbles.</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Some CAD formats i.e., .3dm, .c4d may be imported as several triangle groups and then merged making the body unfit for Flakes/Bubbles.</td>
</tr>
<tr>
<td></td>
<td><strong>Workaround:</strong> Import with NURBS and Re-Tessellate.</td>
</tr>
</tbody>
</table>

| Details       | Geometry nodes don't respect disabled state. |

<table>
<thead>
<tr>
<th>Displacement</th>
<th>When applying Displacement to geometry with hard edges, these edges become split.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image1.png" alt="Image" /> Hard model edges become split. Left cube is with hard edges, on the right the cube has a small fillet on the edges.</td>
</tr>
<tr>
<td></td>
<td><strong>Workaround:</strong> Applying blends in CAD usually solves the issue.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Area Light</th>
<th>ZSpheres transferred from ZBrush are not supported for Area Light</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-Layer Optics</td>
<td>Multi-Layer Optics do not support nested dielectrics/liquid interfaces.</td>
</tr>
<tr>
<td>Scattering Medium</td>
<td>Overlapping objects with Scattering Medium may have shading issues.</td>
</tr>
<tr>
<td>UV Mapped Textures</td>
<td>UV mapped textures applied to NURBS objects in Rhino are not mapped properly</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Camera</th>
<th>Feature</th>
<th>Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depth of Field</td>
<td>Panoramic Camera behavior is significantly different when &quot;Use GPU (enable effects)&quot; is disabled in Preferences</td>
<td></td>
</tr>
</tbody>
</table>
Getting Started

How Easy is KeyShot?

KeyShot’s drag and drop based workflow will have you rendering images in minutes. With a simple interface providing many advanced features and instant real-time feedback, you save time while focusing on your design.

Step 1: Import Your 3D Model

Launch KeyShot. Import your 3D model via File, Import... KeyShot supports over 20 3D file formats, including SketchUp, SolidWorks, Solid Edge, Pro/ENGINEER, PTC Creo, Rhinoceros, Maya, 3ds Max, IGES, STEP, OBJ, 3ds, Collada, and FBX. KeyShot also features many plugins with more features, including KeyShot BIP export and LiveLinking. Learn More
Step 2: Assign Your Materials

From the Library Window, select the Materials tab. Apply any of the 700+ scientifically accurate materials from the material library by simply dragging and dropping them onto your model in the Real-time View. Changes appear on your model instantly with accurate color and lighting under the current lighting conditions. Learn More

Step 3: Choose Your Environment

Now select the Environment tab. Drag and drop an Interior, Outdoor or Studio lighting environment (HDRI) into your scene. You will see the change in the scientifically accurate, real world lighting immediately and how it affects the appearance of your colors, materials and finishes.
Step 4: Adjust Your Camera

Use your mouse to adjust the camera. Additional settings are available in the Project, Camera tab. Adjust the angle and distance, control perspective with focal length and field of view settings, and easily add depth of field to your scene. Learn More
**Step 5: Enjoy the Perfect Image**

Hit *Render* on the main toolbar. Use the default setting or adjust the output options. Select the *Render* button to watch your image render right before your eyes. Learn More
Installation

System Requirements

Before installation, confirm that your system meets the necessary hardware and operating system requirements. You can view the system requirements here.

Installing KeyShot

The KeyShot installer will guide you through the installation process.

On Windows, the installation process will ask you to consider the following:

- End-User Agreement
- Install for everyone using the computer or just for the current user
- Location of the KeyShot Installation folder
- Location of the Resource folder - The resource folder contains a number of textures environments etc. which you can use with KeyShot. It will also be the default destination folder when unpacking .ksp files. Learn more about the Resource folder.
- Enabling access for KeyShot services in firewall settings

On Mac, KeyShot will be installed in the applications folder and the resources folder will be located in "Application Support".

Installing Your License

First time you launch KeyShot, you will be asked to register a license. This can be a node-locked license or a floating license. The standard node-locked license of KeyShot can only be active on one machine at a time. However, you can transfer your license repeatedly between up to three machines of mixed platforms. With a Floating license your company can have a number of licenses that can be used by multiple computers. Learn more about floating licenses here.

Node locked licenses

- Automatic Install When you receive your keyshot9.lic file, save it to your computer. Next, start KeyShot, and select Install a license file (*.lic) and browse to the keyshot9.lic file. If your license fails to install, check to ensure you have full permissions set on your KeyShot 9 resources folder.
- Manual Install When you receive your keyshot9.lic file, you can manually copy it to the Keyshot 9 resources folder on PC or Mac.

Transferring Your License

During the license transfer process, an Internet connection is required. Once the license has been successfully transferred, KeyShot can run without being connected to the Internet.

How to Transfer Your License
To transfer your license, ensure you are connected to the Internet on the active machine.

Start KeyShot and go to Help, Deactivate License on this Computer...

Next, ensure the new machine is connected to the internet and KeyShot is installed. Start the software, fill out your information on the activation screen, and press Next.

On the following screen you will be asked for your KeyShot serial code. Type in your information and press Next to finalize the activation.
Migration Assistant

If you have KeyShot 8 installed on your PC/Mac, when installing KeyShot 9 for the first time, the Migration Assistant will help you transfer your settings and resources to KeyShot 9. You can choose to migrate Settings, Resources or both.

Migrating Settings

Preferences

Any alterations you have made to the default Preferences setup will be transferred.

Workspaces

You won’t have to re-create your favorite Workspaces.

Swatches saved in Color Picker

If you have added any color swatches to the the Color Picker, these will also be transferred.

License Information

- **Node Locked license**: Information about name, company etc. will be prefilled in the Registration dialog.
- **Floating license**: KeyShot 9 will connect to the same license server as you used in KeyShot 8. If there are no licenses for KeyShot 9 on the server all your information will be prefilled in the Registration dialog.

Migrating Resources

Library resources

All non-stock resources will be copied into the respective KeyShot 9 libraries. Here they will be located in the Migrated folder.

If you have customized the folder settings all KeyShot 9 resources will be added to your custom folders.

Material Templates

Any Material Templates you have created will be copied to KeyShot 9.

Scripts

All custom scripts will be copied into your scripts list where they will be located in the Migrated folder.
Your KeyShot installation contains a folder of preset KeyShot resources (or assets). Resources such as materials, environments, and textures are stored here. When you open a .bip file, KeyShot references the KeyShot resources folder location and loads any files that apply to the scene. You can specify the location of the KeyShot resources folder under the Folder Preferences tab.

On Windows, you will find Preferences in the Main Menu under Edit, Preferences and on Mac in the Main Menu under KeyShot, Preferences.

The KeyShot resources folder contains the following sub-folders:

**Animations**

Animations will be saved to this folder by default. At render time, other locations can be specified in the Render Options window.

**Backplates**

The KeyShot Library loads backplates from the this location and saves imported backplates to this folder by default.

**Colors**

The KeyShot Library loads color library files from the this location and saves imported color library files to this folder by default.

**Downloads**

Resources downloaded from the KeyShot Cloud will be saved to this location.

**Environments**

The KeyShot Library loads environments from this location and saves imported environments to this folder by default.

**Favorites**

This folder is empty until a favorite list of resources is created. Once created, the favorite list is saved to this location as a XML file.

**Materials**

The KeyShot Library loads materials this location and saves imported materials to this location by default.

**Material Templates**

This folder is empty until a material template is created. Once created, the material template is saved to this location.

**Models**
This folder contains standard primitives that you can import into KeyShot and saves imported model library files to this folder by default.

**Renderings**

Renderings will be saved to this folder by default. At render time, other locations can be specified inside the Render Options window.

**Scenes**

This folder contains sample scenes that you can only open with KeyShot. These scenes are saved as BIP files.

**Scripts**

This folder contains sample scripts that you can use with KeyShot.

**Textures**

The KeyShot Library loads textures from this location and saves imported textures to this folder by default.

**PC Location**

After KeyShot 9 is installed, a “KeyShot 9 Resources” shortcut will be created on your desktop. By default, this shortcut points to: *Documents/KeyShot 9.*

**Setting Permissions**

You must have read and write permissions for your KeyShot 9 folder in order to save renders, animations, and more. Here’s how to set permissions:

- Right click the KeyShot 9 resources folder and select “Properties”.
- Go to the Security tab and highlight your group or user name.
- Click the “Edit” button.
- Set permissions to “Full Control.”
- Click “Apply” and “OK.”
Mac Location

On a Mac, your KeyShot 9 resources folder is saved inside the “Application Support”: /Library/Application Support/KeyShot9

Setting Permissions

You must have read and write permissions to your KeyShot 9 folder in order to save renders, animations, and more. Here’s how to set permissions:

1. Right click the KeyShot 9 resources folder and select “Get Info.”
2. Expand “Sharing & Permissions” and unlock
2. Change all privileges to “Read & Write.”
3. Click the settings button and select “Apply to enclosed items…”
4. Click “OK” and close the window.
Pro Floating Installation

Welcome to the KeyShot Pro Floating Installation Guide! This guide will walk you through the installation process starting with the license management application: Luxion License Server (Windows & Mac) or lmgrd (Linux). You will then install and configure the client application: KeyShot! We have also included a list of features and add-ons, a troubleshooting guide, and licensing terminology with definitions.

Server Setup

Luxion License Server
Luxion License Server is the license management application for Mac and Windows
Requires:
- Windows Server 2008 and later.
- Mac OS X 10.10 and later

lmgrd (Linux)
The lmgrd (Unix executable file) is the license management process for Linux.

You can also visit the Pro Floating Advanced Setup pages for help with manual setup.

All license management applications utilize the latest FlexNet licensing tools by Flexera Software LLC. KeyShot Pro Floating and Luxion License Server are both provided by Luxion Inc.

Client Setup

KeyShot Pro Floating Installation
Amazing Rendering and Animation in real-time
- Download KeyShot 9

In this section
- Pro Floating Quick Start Setup
- Luxion License Server Installation
- License Server Installation (Linux)
- KeyShot Pro Floating Installation
- Pro Floating Troubleshooting
- Pro Floating Advanced Setup
- Floating License Definitions
Pro Floating Quick Start Setup

KeyShot Pro Floating - Server Installation

All license management applications utilize the latest FlexNet licensing tools by Flexera Software LLC. KeyShot Pro Floating and KeyShot License Manager are both provided by Luxion Inc. Please follow the instructions below to install the license server and have your license file issued.

During license setup, you will install the server on a single computer in your network. This computer will host your license file and will be referred to as the license server. Note: The server must be a local central server - a dedicated machine for the FlexNet server software to be installed on and powered on and connected to the network at all times.

Before You Begin

Your KeyShot Pro Floating license will be sent via email. If you have a previous installation, please save the license file to your license server folder (e.g. C:\FlexLM on Windows) overwriting the previous file. If you changed the port number in the original file, please make sure your new license reflects that. It is important to note that the latest client software installation requires the latest KeyShot license server software. Without the latest license server software, KeyShot will display an "unknown error".

1. Download the license server software
   KeyShot License Server - Windows
   KeyShot License Server - MacOS
   KeyShot License Server - Linux

2. Install the license server
   1. Download and unpack the server software on the machine that will host the licenses.
   2. Start the server software.
   3. The server software will automatically provide the Host Name and the Host ID.
   4. Send the following information to license@luxion.com.
      • Company name
      • Serial code
      • Computer Host name
      • Computer MAC Address

How to Restart a Windows Server

1. Go to the server’s C:\FlexLM folder
2. Launch LMTools.exe
3. Go to the START/STOP/REREAD tab
4. Enable Force Server Shutdown
5. Click Stop Server and wait for the server to stop
6. After a minute, click Start Server

The service will restart. Client computers will be able to connect as usual.

How to Restart a Mac Server

1. Launch KeyShot License Manager.app
2. Make sure to select Install License File

On this page

• KeyShot Pro Floating - Server Installation
  • Before You Begin
  • 1. Download the license server software
  • 2. Install the license server
  • How to Restart a Windows Server
  • How to Restart a Mac Server
  • How to Restart a Linux Server
  • How to move the license server
• KeyShot Pro Floating - Client Installation
  • 1. Gather Server Information
  • 2. Install KeyShot
  • 3. Enter Server Information
3. Click Browse and browse to your new license file
4. Click Stop
5. Click Start/Restart

The service will restart. Client computers will be able to connect as usual.

**How to Restart a Linux Server**

Using the command line on a Windows system running the FlexLM license server:

1. Stop server: Enter
   `lmutil lmdown -c [path to license file]`

2. Start server: Enter
   `lmutil lmgrd -c [path to license file]`

The service will restart. Client computers will be able to connect as usual.

**How to move the license server**

Should you need to move the KeyShot Floating license server to a new computer, please follow the following instructions to ensure you are up and running quickly.

1. Follow the steps above for installing the license server on the new machine.
2. Send the following information to `license@luxion.com`.
   - Old license file
   - New Computer Host name
   - New Computer MAC Address
   - Letter on company letterhead stating the old license server will be removed.

We will usually send your license file within 24 hours during business days (Mon-Fri). Should you have any questions please contact us at `license@luxion.com`.

**KeyShot Pro Floating - Client Installation**

1. **Gather Server Information**

Before installing, make sure that the KeyShot Floating license server has been installed on a computer in the network and gather the following information from that computer:
   - Computer Host name
   - Computer IP Address

2. **Install KeyShot**

Install the KeyShot Pro Floating (FL) client software on all the user's computers. You can download KeyShot [here](#).

3. **Enter Server Information**

When first installed, the KeyShot Floating client application will ask you to **Specify the License Server System**.
Windows - Enter the Computer Name at the first prompt
Mac - Enter [port number][server's IP address] (e.g. 27000@192.168.1.123)

KeyShot Pro Floating will remember the server location from now on. For more information please refer to the relevant section for your installation in the Pro Floating Installation manual.

If you have any questions, please contact license@luxion.com.
Luxion License Server Installation

The instructions below will walk you through a typical first-time license service setup. Our licensing team will provide you with a license file and the appropriate software links. You may reach our licensing team at license@luxion.com.

1. Install Server

Install Luxion License Server. Our licensing team will provide software download links once your purchase has been processed.

2. Request License

Click on the Request License tab to generate a request-message for our licensing team.

1. Name: Enter your name
2. Company Name: Enter your company name
3. Serial: Enter the 20 character serial code that was provided to you by our licensing team
4. Hostname: Is pre-filled with your computer information.
5. MAC address: Is pre-filled with your computer information.
6. Message: The information entered above will be combined into the message for our licensing team.
7. Email: this will send the request by email to license@luxion.com
8. Copy to clipboard: allows you to easily copy the entire message.

3. Install License

Click on the Install License Tab to install the .lic file you have received from our licensing team.

1. Click the Install License button.
2. Locate and select the .lic file in the explorer/finder window.
3. The License info is displayed.
4. Check that the service is started.
5. The Luxion License Server window can now be closed, it is not necessary to keep it open for the floating licenses to be available, they can be accessed as long as the server is online, and the service is not stopped.

4. Status - available/used licenses

To monitor available/used licenses:

1. Click Status button to trigger the status window
2. The Status window will display the types of licenses available and how they are in use.

Notice that "keyshot2" are Floating pro licenses and "keyshot_vr" are the XR add-on licenses.
5. Set Server Ports

If you have a Firewall or have other License servers running on the same machine you may need to change the Server Ports, this can be done by clicking the Server Ports button.

- **FlexLM Port**: Change this to avoid port conflicts. If you have other License servers, the default is 27000.
- **Deamon Port**: This is only used for network setups with a Firewall. If a Firewall is used, both ports need to be set and opened in the Firewall.

6. License Folder

The License Folder button is mainly present for support purposes. It leads to the License Folder where log files, etc. regarding the License Server are stored.

Default locations for the License folder are:

- **Windows**: C:\ProgramData\Luxion\License
- **Mac**: /Applications/LuxionLicenseServer.app/Contents/License
License Server Installation (Linux)

The instructions below will walk you through the typical first-time license service setup on Linux. Our licensing team will provide you with a license file and the appropriate software links. You may reach our licensing team at license@luxion.com.

License Server Setup Instructions

If you are running RedHat Linux skip steps 3, 4 and 5.

1. Download and unzip the "KeyShot_Floating_License_Server_Linux.zip" file into your home folder ("/home/<your username>" or "~/")

2. Open the terminal (usually Ctrl + Alt + T) and change your current directory to the luxion_flexlm folder ("~/luxion_flexlm")

   cd luxion_flexlm/

If you are running RedHat Linux skip the next 3 steps.
3. Run the following command:

```
ls -l /lib64/ld*
```

4. Take note of the return value before the arrow (highlighted in the picture).

5. Run the following command where `<value from step three before the arrow>` is the value from step 3 before the arrow.

```
sudo ln -s `<value from step 3>` /lib64/ld-lsb-x86-64.so.3
```
6. Move your license file to your luxion_flexlm folder, where your file would have your computer name instead of MyCompany.

mv ~/Desktop/keyshot_floating_MyCompany.lic ~/luxion_flexlm/
7. Run the following command to make sure everything is executable.

```
sudo chmod 766 *
```

8. Run the following command to start the service, where your file would have your computer name instead of *MyCompany*.

```
./lmgrd -C keyshot_floating_MyCompany.lic
```
9. Run the following command to check the service status:

./lmstat -a

The lmstat output will confirm that the license server is up. The output message will also show you how many license seats are issued (available).
KeyShot Pro Floating Installation

Now that your server is up and running, you are ready for the client setup on your computer. The instructions below will walk you through the registration process for floating licenses.

KeyShot Pro Floating Setup Instructions

1. Download and install the KeyShot Pro Floating application. To download KeyShot, click here.

2. Launch KeyShot 9.

3. Select Floating License and click Continue. If you are currently in demo mode, open the registration wizard from
   - Windows: Help > Register License
   - Mac: KeyShot > Register License (Mac)

4. Enter the hostname of your license server. If the server uses another FlexLM port than the standard (27000) you need to specify the port number.
followed by the "@" sign and the server's hostname (for example, 27000@KeyShotServer.local). Click Connect.

You may also use the server's IP Address (use the IP Address if your license server is a PC). For example, 27000@192.168.1.123. Click Connect.
4. Review your license features, select the type of license you want to use and if you need KeyShot XR and Click Done.
KeyShot Pro Floating will start. From now on, KeyShot will remember the server information. You will be able to check out the license as long as your system can connect to the computer acting as the license server.

**Technical Tip:** If your service status window does not look similar to the above image or if you are getting an error message when you start the server, you can use the troubleshooting guide for diagnosis. You may also contact Luxion Customer Support at support@luxion.com for assistance.
Borrowing A License

As you know, to check out a KeyShot Pro Floating license, your computer must be connected to the license server. To continue using KeyShot Pro Floating, the connection must be maintained at all times. But what if you want to work from a remote location and take KeyShot with you? Well, then you borrow the license.

The client and server must be connected during the borrowing process. Once you've borrowed the license, you can take your laptop and KeyShot anywhere for up to 30 days. Educational license holders must submit a request with their IT staff to activate this feature.

How To Borrow A License

1. Ensure that your client computer can connect to the server.
2. Open KeyShot Pro Floating.
3. **Windows**: In the Main menu click Help, Borrow Floating License.  
   **Mac**: In the Main menu click KeyShot, Borrow Floating License.
4. Select a return date and click **OK**.
5. You will receive a confirmation message. Click **OK**.

How To Return A Borrowed License

1. Ensure that your client computer can connect to the server (otherwise, this will not work).
2. Open KeyShot Pro Floating.
3. **Windows**: In the Main menu click Help, Return Borrowed Floating License.  
   **Mac**: In the Main menu click KeyShot, Return Borrowed Floating License.
4. You will be asked to confirm this action. Click **Yes**.
5. You will receive a confirmation message. Click **OK**.

Note: Other clients cannot checkout or borrow a license seat that has already been borrowed. The borrowed license seat remains with the client that borrowed it until the return date expires or until the client manually returns the license seat. If your license server holds more than one license seat, the remaining seats can still be checked out normally.
Changing Server Connection

For larger companies, there may be more than one KeyShot license server at the same or multiple locations.

KeyShot allows you to choose between different license servers. Below you will find instructions for changing the license server connection within KeyShot.

Please contact your IT department for VPN connection instructions when trying to connect to a remote license server.

How To Change Your License Server Connection

1. Ensure that your client computer can connect to the current server.
2. Open KeyShot Pro Floating.
3. **Windows**: Go to the main menu and click Help, Change Floating License Server.
   **Mac**: Go to the main menu and click KeyShot, Change Floating License Server.
4. Change the port number and the hostname/IP address as needed. Click OK.

Technical Tip
Please refer to the included troubleshooting section if you are unable to establish your new client-server connection.
Enabling KeyShotWeb

KeyShotWeb is included with the KeyShot Enterprise license. Otherwise, it is sold separately as an add-on.

KeyShotWeb includes:

- **KeyShotXR** which enables you to create interactive (touch-enabled) visuals for your website. Please refer to the KeyShotXR section for additional information regarding KeyShotXR features.
- **Web Configurator** which enables you to output your Configuration to web. Visit Configurator Output in the Render section for more information.

How To Enable KeyShotWeb

1. **Windows**: Go to the main menu and click Help, Select Floating License Type.
2. **Mac**: Go to the main menu and click KeyShot, Select Floating License Type.
3. Enable Check out KeyShotWeb feature from license server.
4. Click OK. KeyShot will restart and KeyShotWeb will be enabled.

**Note**

If your license does not contain the KeyShotWeb feature, then KeyShot will tell you that there are "no additional options available".
Pro Floating Troubleshooting

This troubleshooting guide will help you diagnose the cause of an error message and assist you in finding a solution. Below, we list errors under two main categories: server errors and client errors. Errors inside KeyShot License Manager are server errors. Errors from KeyShot Pro Floating are client errors. Please find your error in the categories shown below.

In this section
- Server Error: Invalid Mac Address (HostID)
- Server Error: License File Not Found
- Client Error: Looping Prompt
- Client Error: No Licenses Available
- Client Error: Unsupported KeyShot Version
- Client Error: Unknown Error
**Server Error: Invalid Mac Address (HostID)**

**Reason:** The Mac Address (or HostID) in the license file does not match your computer’s active mac address (or HostID).

**How To Fix It:**

<table>
<thead>
<tr>
<th>On Windows PC</th>
<th>On Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open your license file with any text editor (e.g., Notepad, Notepad ++) and look at the SERVER line. Make a note of the expected Mac Address. This is a 12-digit hexadecimal number.</td>
<td>1. Click OK and go to the Request License tab. Make a note of the Mac Address.</td>
</tr>
<tr>
<td>2. Launch the Command prompt (cmd.exe) and type the following command: <code>ipconfig /all</code> Press Enter and you will see a list of devices; each listed with its corresponding mac address (aka Physical Address).</td>
<td>2. Open your System Preferences application.</td>
</tr>
<tr>
<td>3. Once you find a match for the mac address in your license file, you will want to turn on/connect that device (i.e. turn on Wi-Fi and connect to a network or connect Ethernet cable).</td>
<td>3. Go to Network and select a device: Ethernet or Wi-Fi.</td>
</tr>
<tr>
<td><strong>Note:</strong> If you found a typo in the license file or wish to use another device, then skip to step 6 below.</td>
<td>4. Click Advanced, Hardware for that device and check the Mac Address. Once you find a match for the mac address in Step 1 above, you will want to turn on/connect that device (i.e. turn on Wi-Fi and connect to a network or connect Ethernet cable).</td>
</tr>
<tr>
<td>4. Close and re-open Luxion License Server Configurator. Then, click Start Server in the Install License tab.</td>
<td><strong>Note:</strong> If you found a typo in the license file or wish to use another device, then skip to step 7 below.</td>
</tr>
<tr>
<td>5. Click Service Status. Your license server’s status will appear in the service status window. The service status window will tell you how many seats are available and how many seats have been issued. You can now open KeyShot on your client computer (ignore steps 7 and 8 below).</td>
<td>5. Close and re-open KeyShot License Manager. Then, click Start Server in the Install License tab.</td>
</tr>
<tr>
<td>6. If it does not start, you will need a new license file. Send an email to <a href="mailto:license@luxion.com">license@luxion.com</a> describing the error. Please make sure to specify which Mac Address to use in your new license. Also, you will want to attach your current license file to your email.</td>
<td>6. Click Service Status. Your license server’s status will appear in the service status window. The service status window will tell you how many seats are available and how many seats have been issued. You can now open KeyShot on your client computer (ignore steps 7 and 8 below).</td>
</tr>
<tr>
<td>7. Once you receive your new license file, you can follow the license replacement instructions.</td>
<td>7. If it does not start, you will need a new license file. Go back to KeyShot License Manager and fill the request form. Click Email and send an email to <a href="mailto:license@luxion.com">license@luxion.com</a> describing the error. Please make sure to specify which Mac Address to use in your new license. Also, you will want to attach your current license file to your email.</td>
</tr>
<tr>
<td>8. Once you receive your new license file, you can follow the license replacement instructions.</td>
<td>8. Once you receive your new license file, you can follow the license replacement instructions.</td>
</tr>
</tbody>
</table>

**Technical Tip:** If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also contact Luxion Customer Support at support@luxion.com for assistance.
Server Error: License File Not Found

Reason: The licensing software (lmgrd) is unable to read the license file in your FlexLM folder.

How To Fix It:

1. Browse to C:\ProgramData\Luxion.
2. Right-click the License folder and select Permissions.
3. Select "Properties"
4. Disable "Read only"
5. Go to the Security tab
6. Click the Edit button. Ensure that all users have read and write permissions
7. Click Apply and OK
8. Click Apply and OK once more.
9. Once all users have read and write permissions into the License folder and its contents, re-start the license service from LMTools.

Technical Tip: You may also contact Luxion Customer Support at support@luxion.com for assistance.
Client Error: Looping Prompt

Reason: This means that KeyShot is unable to connect to KeyShot License Manager on your license server.

Please check

Server status
Is your license server running properly? You can check the service status within the LUXION.log file (found inside your License Folder). If you find any problems, see server errors for troubleshooting.

Computer connection
Make sure that your client computer can ping the license server and that your client computer can “see” the server in your office network. Contact your IT department if you are using a VPN connection.

Server Ports
Remember that KeyShot uses port number 27000 by default. It is possible that another application in your computer is using this port. You can try to change the port number in the license first and then inside KeyShot Pro Floating. Please refer to instructions on how to change the port number.

Firewall/Anti-virus settings
Turn off the firewall on the server and the client. If this is already the case, then you can try to add LUXION.exe and lmgrd.exe to the list of programs allowed through the firewall and through the anti-virus. Please consult your IT representative for further assistance with firewall/anti-virus settings.

Client Environment Variable/Registry
Depending on your system’s restrictions, it is possible that KeyShot is unable to save the Server information. If so, you can manually edit this:

- PC: registry entry
- Mac: environment variable.

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also contact Luxion Customer Support at support@luxion.com for assistance.
Edit Registry (PC)

Earlier you learned how to connect KeyShot Pro Floating to the license server system. When you specify the server name in KeyShot, a registry entry is created. Depending on your system’s restrictions, it is possible that KeyShot is unable to write into the Windows registry. If so, you can manually edit this registry entry.

How To Edit The Registry Entry

1. Make sure that the KeyShot application is closed. Then, click the Windows Start button and search for “regedit.exe”.
2. Launch the Registry Editor (regedit.exe)
3. Go to HKEY_CURRENT_USER > Software > FlexLM License Manager.
4. While the FlexLM License Manager key is selected you will see a string called LUXION_LICENSE_FILE. If you don’t see this string, then create a new string. You can go to Edit > New > String Value and name it LUXION_LICENSE_FILE.

Note: You may also create the FlexLM License Manager key inside HKEY_CURRENT_USER, Software (i.e. Edit > New > Key).
5. Right-click the LUXION_LICENSE_FILE string and select “Modify”.
6. Change the Value data to the correct port number at the server’s IP Address (e.g. 27000@192.168.1.123). Click OK, then close the Registry Editor.
7. You may now open KeyShot on your client computer.
Environment Variable (Mac)

Earlier, you learned how to connected **KeyShot Pro Floating** to the license server system. When you specify the server name in KeyShot, an environment variable is created. Depending on your system’s restrictions, it is possible that KeyShot is unable to write into the environment variable. If so, you can manually edit this file.

**How To Edit The Environment Variable**

1. Open up the terminal. Make sure you are in the home directory.

2. Type the following command to open the environment variable in vim (text editor): `vim .flexlmrc`

3. Press `Enter`.

4. Press the ”i” key to start insert mode.

5. Change the IP Address or hostname to the correct server location (e.g. 27000@192.168.1.123). Once done, Press ESC on your keyboard to exit insert mode.

6. Hold Shift and press the semicolon/colon key.

7. Type the following command to write and quit: `wq`

8. Press `Enter`. You will be brought back to the screen shown in step 2 above.

9. You may now open KeyShot on your client computer.
Client Error: No Licenses Available

Reason: There are no more licenses available on the server. This means that the license server has issued all the available license seats to other clients in your office network.

How To Fix It:

1. Close KeyShot Pro Floating on one of your other clients.
2. Re-open KeyShot Pro Floating on the desired client.

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also contact Luxion Customer Support at support@luxion.com for assistance.
Client Error: Unsupported KeyShot Version

Reason: Your current floating license does not support the version of KeyShot that you are trying to open.

How To Fix It:

1. Send an email to license@luxion.com describing the error message. You will want to attach the Luxion.log and your current license file found in the License folder.

2. Once you receive your new license file, follow the license replacement instructions.

3. If KeyShot is not connecting to the server automatically, change the Server information manually:
   - PC: Editing the registry entry
   - Mac: Editing the environment variable.

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also contact Luxion Customer Support at support@luxion.com for assistance.
Client Error: Unknown Error

Reason: The Unknown Error error means that your license server is running outdated software.

How To Fix It:

1. Download the latest Luxion License Server update.
   - Luxion License Server - Windows
   - Luxion License Server - Mac OS X

2. Run the installer file and follow the prompts on the installation wizard.

3. Launch the Luxion License Server application and click New License to reload the license.

4. It is also a good idea to update KeyShot itself. You can check for updates from the Help menu inside KeyShot.

5. Once your server is up to date and running, KeyShot will start properly.
Pro Floating Advanced Setup

FlexNet licensing tools and methods are commonly utilized in the software industry. This licensing method includes a myriad of different advanced features. In fact, there is an entire FlexNet licensing manual on the web.

In this section, you will find definitions of common terminology and useful information for your advanced IT specialist.
License Server Installation (PC) - Custom

The Floating License Configurator application automatically creates a service in LMTools.

If you want to create a custom license service, you will need to understand LMTools in greater detail. The instructions below will walk you through creating your very own custom license service. Our licensing team will provide you with a license file and the appropriate software links. You may reach our licensing team at license@luxion.com.

If you already have a license server set up you can proceed to the Changing Server Connection page, to learn about setting up more than one KeyShot license server at the same or multiple locations.

Custom License Server Setup Instructions

1. Download and run the "keyshot_floating_license_server.exe" installer. Follow the prompts and make sure that "Run Luxion License Server" is disabled. Click Finish.

2. Launch the LMTools application (found inside C:/FlexLM) and go to the Config Services tab.

3. Write a new service name.

4. Browse to the lmgrd.exe, license (.lic), and debug.log files. You should be able to find all of these files in your C:/FlexLM folder. Note that the debug.log is created after you start the service. For now, you can simply specify the correct path: C:/FlexLM/debug.log

5. Enable Start Server at Power Up and Use Services. Then click Save Service and confirm.

6. Launch LMTools and go to the Start/Stop/Reread tab. Enable Force Server Shutdown and click Stop Server. You may also stop the KeyShot Floating service within the Windows Services dialog (services.exe).

7. Click Start Server. You may also start the KeyShot Floating service within the Windows Services dialog (services.exe).

8. Open the debug.log file inside your C:/FlexLM folder (this folder contains the licensing software). The debug log will reference your license file and tell you that the server started on your computer system.

Setting The License server up with a Fire-Wall:

It is important to note that FlexLM uses 2 Ports for the license server the LMGRD port(27000 by default) and the LUXION Vendor Daemon Port(assigned randomly unless Fixed in the License file).

These ports can be set in the License File.

- The lmgrd Port is set after the Computers Mac Address on the "SERVER Line".
- The vendor daemon port is set on the "VENDOR Line" after the Vendor Name using the syntax: port=<your port>
Below is an example, for the ports 27000 and 27010:

```
SERVER Hostname ffffffffffff 27000
VENDOR LUXION port=27010
FEATURE keyshot2 LUXION 7.0 permanent 2 DUP_GROUP=UHD BORROW=720 \ 
SIGN="XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX \ 
XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX \ 
XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX"
```

In the given example you will have to open the ports 27000 and 27010 in the firewall for the server to function.

**Tip**
If your debug log does not look similar to the above image or if you are getting an error message inside *Floating License Configurator*, then you can use the troubleshooting guide for guidance. You may also contact Luxion Customer Support at support@luxion.com for assistance.
License Server Installation (Mac) - Custom

The KeyShot License Manager application is just a graphical user interface to FlexNet licensing tools. KeyShot License Manager is great for quick setups. However, for better troubleshooting and customization your IT department may prefer to have direct access to the license manager (lmgrd) and the license manager status application (lmstat). In that case, you can create your license service manually.

Custom License Server Setup Instructions

1. Launch the Activity Monitor.app. Organize your processes by name. Find the lmgrd process and click Force Quit (click the crossed-stop-sign button). This will stop any existing license services.

2. Download the latest FlexLM license server update from here.

3. Once downloaded, move the FlexLM.zip file to your Applications folder and unzip it. Your FlexLM folder contains the main license management application, lmgrd and other useful applications that help you check the status of your service such as lmstat. Inside the FlexLM folder you will also be able to find the installation guide PDF.
4. Rename your KeyShot license file to “keyshot.lic” and move it into the FlexLM folder. This is very important.
5. Right-click the FlexLMAutostart.app and select Open. If you are asked to confirm, then click Open once more. Your KeyShot license service will start right up.
6. To confirm that your service is up and running, you can run the `lmstat` application inside the FlexLM folder.

Launch Terminal.app and change the directory to `/Applications/FlexLM`:

```
cd /Applications/FlexLM
```

Press `Enter`. Then, type:

```
sudo ./lmstat -a
```

Press `Enter` and type your password (no characters will appear as you type). If you think you made a mistake, simply delete and start over.
Press Enter one more time. If your service is running, `lmstat` will return a message stating that the "license server is UP (MASTER)…" and it will tell you the number of license issued as well as the number of licenses in use. Otherwise, please send a screenshot of the `lmstat` output to support@luxion.com for further assistance.
To ensure that your license service starts every time that you restart your computer, open your System Preferences.app and go to Users&Groups > Login Items. Click the Add button (+) and browse to your Applications/FlexLM folder. Select the FlexLMAutostart.app and click Add.
These items will open automatically when you log in:

<table>
<thead>
<tr>
<th>Hide</th>
<th>Item</th>
<th>Kind</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Alfred</td>
<td>Application</td>
</tr>
<tr>
<td></td>
<td>WDDriveUtil</td>
<td>Application</td>
</tr>
<tr>
<td></td>
<td>nightly</td>
<td>Folder</td>
</tr>
</tbody>
</table>

To hide an application when you log in, select the checkbox in the Hide column next to the application.

Click the lock to make changes.
8. Close System Preferences.app. You can now launch KeyShot and point it to the server as outlined in the KeyShot Pro Floating Installation.
Replace License File

If you’ve received a new license file from us, you can easily replace the old license and update the license server.

How To Replace The License File:

1. Save the license file to your computer.
2. Launch the Luxion License Server
3. Go to the Install License tab
4. Click New License
5. Browse to the License file.
   - The Server should now Load the License file and restart.
   - If you changed the port number in the original file, Click Set Server Ports and make sure the ports are set.

Client computers will be able to connect as usual.

Tip
If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also contact Luxion Customer Support at support@luxion.com for assistance.
Floating License Definitions

Floating License

This is a type of license that can be accessed by various computer systems. The actual license file is saved on the license server system. Your license file is an encoded text file that tells the license server which port to use, how many seats are available for checkout, and when will the license expire.

Seat

The number of seats in a license file tells the license server how many client computers can check out the floating license at the same time. This number is displayed and encoded in the license file.

License Server

The computer that hosts and manages the license file. Any Windows PC or Mac computer can be a license server. We recommend that you select a desktop computer in your office network that your design team can access during regular business hours or later if needed.

Client

In this manual, we refer to any computer in which KeyShot Pro Floating is installed as the client. If KeyShot Pro Floating is installed on your license server, then your license server computer is also a client.

Server Host Name

This is the name of your computer as listed under your computer network. The host name is a label used for identification.

Server MAC Address

Your computer has various ways to connect to other computers on your network and to the internet. The most common connections are the ethernet adapter and the wireless adapter. Each of your adapters has a unique physical address also known as the mac address. The KeyShot Pro Floating license is tied to your server’s MAC address.
Silent Install (PC)
You or your IT department may wish to run the KeyShot Installer for PC* as a silent installation. The KeyShot installer takes the following arguments:

Commands

- `/S` – for a silent installation.
- `/AllUsers` – installs for all users with shortcuts in start menu.
- `/USERNAME=somepath` – changes the destination folder for the KeyShot Resources folder.
- `/FLEXLM=27000@myserver` – set the FlexLM server’s port and hostname. Only use this command if you have a floating license for multiple computers.
- `/D=C:\Program Files\KeyShot 9` – set the program files destination. This must be placed at the end of the command line.
- `/FloatingFeature=feature` – set the feature to check out (if more than one is available): keyshot2, keyshot_enterprise, or keyshot_base.
- `/NO_AUTOUPDATE` – disable updates.
- `/NO_CLOUD` – disable KeyShot Cloud Library.

Examples

**KeyShot HD/Pro**

```
keyshot_w64_9.x.x.exe /S /USERNAME=C:\Users\Luxion\Documents\KeyShot 9
/D=C:\Program Files\KeyShot 9
```

**KeyShot Pro Floating**

```
keyshot_w64_9.x.x.exe /S /USERNAME=C:\Users\Luxion\Documents\KeyShot 9
/FLEXLM=27000@myserver /D=C:\Program Files\KeyShot 9
```

**Unattended Uninstall**

```
C:\Program Files\KeyShot 9\uninstall.exe /S _?=C:\Program Files\KeyShot 9
```

*Silent install commands for Mac are currently not available.*
Preferences

This section describes where to find the KeyShot Preferences (options/settings) and what they do.

You can find the KeyShot Preferences in the Main Menu

- **Windows**: Edit, Preferences...
- **Mac**: Keyshot, Preferences...

After making changes, make sure to select the Save Changes button. In some instances you maybe required to restart KeyShot in order for the changed settings to take effect. To prevent any changes from taking effect simply select the Cancel button.

The follow sections describe what preferences are available in each tab of the Preferences window.
Interface Preferences

### Interface

- **Language** - Select the desired language in the menu.
- **Theme** - Select desired color for the KeyShot interface. This can also be set from the Ribbon > Workspaces drop-down.
- **Font Size** - Select the desired font size in the drop-down. This is useful when working on high-resolution displays without system scaling applied.
- **Selection outlines** - Displays an orange outline around selected parts.
- **Use CPU for selection outlines** - Enable this if selection outlines are unstable on GPU.
- **Include camera changes in undo/redo** - This will include all camera movements in the undo stack.
- **Reverse camera distance scrolling** - Reverse the scrolling direction when dollying the camera.
- **Enable sub menus in Real-time View** - Rather than showing a long list of functions in the context menu, these functions will be logically grouped into sub menus.
- **Disable scene tree hierarchy changes** - Prevents you from making any changes to the scene tree hierarchy by dragging and dropping parts.
- **Lock pivot to target** - When enabled the Camera Pivot moves with the Camera Target when you pan the camera.
- **Scene Tree object preview tool-tips** - When checked you will see a rotating OpenGL shaded preview when hovering an object it in the scene tree.
- **Respect animation ordering** - If you perform multiple animations on a part/group any translations will by default be executed last, as this will move the pivot point. With this setting you can force the animation to respect the order set in the Scene Tree (top to bottom).
- **Use GPU (enable effects)** - When checked, enables the Bloom, Vignetting and Chromatic Aberration effects under Project panel > Image > Image Styles.
- **Progressive Image Sampling** - When checked, KeyShot will down-sample the scene while the camera is moved to enable faster performance. On machines with many cores this function may be turned off to ensure a smooth camera movement without loss of quality.
- **Disable outline for large models** - If Selection outlines are enabled (above) you may want KeyShot not to show them if performance will be impacted. In this drop-down you can limit when they will be shown.
  - **Never** - Always show selection outlines.
  - **Auto** - disables the outlines based on the available GPU memory
  - **Custom** - disables outlines when your model reaches the specified amount of triangles.
- **Render Output window memory limit** - This controls the amount of memory reserved for the image buffer in the output window. If the rendered image takes up more memory than this limit, it will be down-scaled until it is below the limit. This is useful if you are rendering gigapixel images and your scene takes up a lot of memory. It does not affect the output image itself (as specified in the Render Settings), but does affect images saved directly from the output window.

### Materials

- **Show in-project material list under material properties tab** - All in-project materials will be displayed. These are also displayed below the Scene Tree.
- **Use gloss instead of roughness for materials** - Replaces all roughness sliders with gloss sliders and converts all roughness values to gloss values. Useful if you are working with a Gloss-meter to measure your materials.
- **Use UV mapping as default** - Replace the default mapping type from Box to UV-mapping
- **Link materials of duplicate parts** - When checked the material of duplicate parts will be linked. Learn more about linked materials on the Assigning Materials page.
- **Link duplicate materials when assigning from Library** - When checked all instances of a material applied to parts in the scene will be linked. Learn more about linked materials on the Assigning Materials page.

### Log
The log can be accessed under the Help menu in the KeyShot menu bar. It will contain a log of all errors that occurred while running KeyShot.

- **Threshold** - This drop-down menu contains the lowest level of warning that will be captured in the log. Warning levels are: Information (default), Warning, Critical, Fatal.
- **Display log window on critical errors** - When checked, the log window will open up automatically as soon as a critical error occurs.
- **History back buffer** - Sets the number of entries in the log.

### 3Dconnexion Settings

KeyShot supports input devices from 3Dconnexion on both Windows and Mac. Make sure a 3Dconnexion device is connected in order to be able to change these settings. Learn more about 3Dconnexion.

- **3D mouse sensitivity** - Set the sensitivity of the 3D mouse.
- **Restrict to dominant axis** - Only allows one axis movement at a time.
- **Invert axis** - Inverts camera movement direction.
- **Use global up axis** - When checked (default) the camera will always rotate around the global up axis, even when tilted.
General Preferences

General

- Show Welcome Window at Start Up - Displays a splash-screen at startup with recent scenes, demo scenes, news and info.
- Adjust aspect ratio to backplate - Automatically resizes the Real-time View to the same aspect ratio of any backplate image that is loaded into the Real-time View.
- Auto Update - Prompts you to download and run the update installer when a newer version becomes available.
- Pause KeyShot when sending jobs to Network Rendering - Pause rendering in the Real-time View and stop the usage of your CPU when jobs are submitted to KeyShot Network Rendering.
- Pause Real-time Render after time or samples - Select an amount of time or render samples to automatically pause the rendering in the Real-time View and stop the usage of your CPU.

Denoise

- Refresh time - Sets the interval for re-calculation of Denoise.

Screenshots

- Format - Select the format for the saved screenshot (JPEG or PNG).
- Quality - Determines the compression of the saved image. Higher settings mean less compression yet better quality, but the file size will also increase.
- Include Alpha (Transparency) - If the format is set to PNG you can choose to include alpha, this will hide the lighting environment and make ground shadows transparent.
- Ask where to save each screenshot - KeyShot will prompt you to specify a location when saving a screenshot from the Real-time View. When un-checked, Screenshots will be saved in your default Renderings folder.
- Save a camera with each screenshot - When checked, KeyShot will save a camera view for every screenshot that is saved out. These views can be accessed from the camera tab in the project window.
- Save metadata with each screenshot - When checked, KeyShot will save a metadata file next to the screenshot. In the settings drop-down you can choose the format of the metadata.

Default Startup Scene

This lets you set the default startup scene when you start KeyShot. The startupt.bip scene is set as the default. Any KeyShot scene may be set as a startup scene. To change, simply click on the Folder icon and browse to the scene you want KeyShot to load on startup.

Backup Revision

- Create a serialized backup revision with each save - When checked, the Revision Manager will become enabled. KeyShot will create a serialized backup every time that you save rather than overwriting the scene. This results in a full copy of the original scene.
- Backup history depth - Determines how many instances of the scene will be saved before the oldest one get overwritten. By default the value is 5. When the scene is saved a 6th time, the first (oldest) version of the scene will be overwritten. The maximum value is 99.
Save Reminder

Display save reminder notification every:
KeyShot will prompt you to to save the interval selected. These times include every 5, 10, 15, 30 and 60 minutes. Select Never if you do not want a Save Reminder to appear.

Cloud Library

This shows the login status for the KeyShot Cloud Library. Learn more about KeyShot Cloud.

- Clear Cache - Resets the KeyShot Cloud window to default, by clearing visited links, http cache and local storage.
- Show Move tool when adding Cloud Models to scene - When enabled the standard move tool widget will be launched every time a model is added to the scene from the Library.

Clear don’t show again

- Restore All Messages and Warnings... - All dialogs that can be disabled by marking "Don’t show again" will be enabled and shown when applicable.

Network

This section allows the user to configure the proxy settings in order to communicate with Luxion's software update server and the KeyShot Cloud Library. This may be necessary when KeyShot is installed in environments with tight firewall security.

- Proxy type dropdown - This dropdown menu provides four options: No proxy, Automatic proxy detection (default), HTTP, SOCKS v5.
- Host - This option becomes available when HTTP or SOCKS v5 are selected. Enter the hostname of the proxy server as recognized on the network, or the host's IP address.
- Port - Enter the port the proxy server is using to communicate through the firewall.
- Enable proxy authentication - It may be necessary to enable proxy authentication on the server. To do so, check this checkbox.
- Username - Enter the user name that the user has been assigned to communicate with the proxy server.
- Password - Enter the password for the user account on the proxy server.

LiveLinking

LiveLinking connects KeyShot to a modeling application via a custom plugin. When enabled, LiveLinking allows you to run KeyShot in parallel with supported 3D modeling software, and update the geometry inside of KeyShot without losing any of the material assignments, cameras, lighting, etc. All plugins developed by Luxion or a partner company can be found here.

- Enable LiveLinking - When checked (default), KeyShot will start and connect to supported 3D modeling software through the installed plugin.
- LiveLinking Network port range - This is the port range the installed plugin is using.

Scripting

This section provides the setting to take advantage of using local Python library installations for KeyShot's Scripting capabilities. Learn more about Scripting here.
Use local Python paths - If checked, and if the user has Python libraries like PIL or SciPy installed locally, it will be possible to use those libraries inside of KeyShot. However, only version 3.7 is supported which is the same version that is being used inside KeyShot. If not checked, then only the Python modules exposed inside KeyShot will be available to the scripts running inside.
Folders Preferences
The folders tab allows you to specify folders or shared folders for following KeyShot Resources:

- Textures
- Backplates
- Environments
- Materials
- Renderings
- Scenes
- Animations (including KeyShotXR files)
- Material Templates
- Colors
- Scripts
- Plugins
- Models.

Specify location for all folders
This option sets the default location for all resource folders.

Resources
Select the folder icon to set the default location for all KeyShot Resource folders.

Customize each folder
This option allows you to set the locations for each resource independently or add additional folders or shared directories.

Shared Folders
Shared folders will allow you to point KeyShot to access files in folders that are shared on a server or local computer. All shared folders will show inside of the KeyShot Library.

To use shared folders you will need to select Customize each folder and click the folder icon to the right. The Configure Folders dialog will open. From there you can select the plus icon to add a new folder path. Selecting a folder and clicking Edit will allow you to edit the folder and change the path or switch to a default folder. At least one default folder is required for each resource.
Plugins Preferences

Plugins are primarily used for connecting KeyShot with various modeling applications. Most plugins will be executed in the modeling application but some will be run from KeyShot (e.g., OnShape). The Plugin Preferences are only concerning plugins that executed inside KeyShot.

Visit our Plugins page to see available plugins.

Plugins

Enable/Disable
The Plugins window will show all installed KeyShot compatible plugins with checkboxes to enable or disable the plugin when KeyShot starts.

Uninstall
Plugins are installed via Windows or Mac OS X installation files and uninstalled through the operating system options.
Color Management

Compensate for Image Gamma when applying Library Colors

Gamma corrects color values when applying them to a material directly from the Color Library. This will try to keep the appearance of the color in the Library. With this option selected, the color of the material in the Real-time View and in the Library will always match, if you don’t change the Image Gamma after applying the color.

Enable Color Management

Enable this option to use ICC color profile files in KeyShot. Select the folder icon to load your desired color profile. Both .ICC and .ICM file formats are supported. The status window will show if the color profile was loaded and color profile created. Select Save Changes to save your color profile settings. To delete the color profile simply remove the file location or disable by unchecking Enable Color Management.

FAQ

If I activate the Adobe RGB (1998) color profile, why does everything looks great in the Real-time View, but different in the final render?

KeyShot uses the sRGB color profile internally. The color profile set in the Preferences is only applied to the Real-time View to ensure the color output is correct on your screen.

It is important to note that the rendering is not done in the Adobe RGB. When the color profile is set in Preferences, the Real-time View output is just translated from sRGB to Adobe RGB to ensure the colors look correct on your screen.

The rendering result will still be in sRGB and is directly saved to the output file as sRGB without applying the color profile.

Since sRGB is a widely used color profile for web applications this is sufficient for most users. And since it’s a widely use color profile, most image editing applications are able to translate from sRGB to Adobe RGB for further editing.
Hotkeys Preferences

You can customize all existing hotkeys inside KeyShot. Hotkeys are categorized as Simple Hotkeys, Mouse Actions and Camera Controls. Depending on the type of hotkey you select, either the Simple Hotkey or the Mouse Action input fields will become active. Camera Controls are always active.

Filter/Hotkey List

This allows you to search for a specific Action/Group or Hotkey in the list. The Hotkey List shows all of the KeyShot commands capable of having a key combination assigned. Actions with empty Hotkey entries do not have a hotkey assigned.

Simple Hotkey

Select a Simple Hotkey, i.e. a hotkey that doesn’t contain any mouse actions from the list of hotkeys. To edit, simply start typing in the input field. You can always change the hotkey back to its default setting by selecting Change to Default.
Mouse Action

Select a Mouse Action hotkey from the list, and start modifying the hotkey by changing the mouse action from the pull-down menu, and select up to three modifier keys, i.e. Alt, Shift, Ctrl/Cmd

Camera Control

This function allows you to change the camera controls based on your favorite modeling application. In the hotkey list you can see what application has been selected to change the camera controls.

- **Hotkey Presets** - Simply select the 3D modeling software from the drop-down menu, and all camera controls will adjust accordingly. Support is included for:
  - 3ds Max
  - Alias
  - Alibre
  - Fusion 360
  - Maya
  - NX
  - PTC Creo
  - Rhino
  - Solid Edge
  - SOLIDWORKS
  - SpaceClaim
  - ZBrush

Import/Export Hotkeys

- **Import**... You can import your own custom hotkeys file that has been exported from a KeyShot installation previously. KeyShot hotkey file format is .KSH. Note that with the Migration Assistant custom hotkeys will be migrated when upgrading from KeyShot 7 or later.
- **Export**... Choose this function to export your custom hotkeys to use on another machine.

Reset to Default

- **Reset selection** - This will reset the hotkey that is currently selected in the HotKey List
- **Reset All** - This will reset all hotkeys to their default settings.
Import Settings

Import Settings are the settings used for quick import. You can enable quick import in the Import or by un-checking the Always Show Import dialog when importing... option for the type.

**Filetype** - Select a file type to determine the settings for that specific type

**Always Show Import dialog when importing XX files** - when enabled all Import methods will show the import dialog.

**Settings** - The Settings will vary depending on which filetype you have selected. See the Import page for detailed descriptions of all the settings.
User Interface

This section provides information on the KeyShot user interface and its elements (windows, menus and commands). Its purpose is to explain

1. the location of elements
2. purpose of elements
3. menus and commands
4. customization.

Information on the function of elements and how they work are located in the latter sections.

KeyShot is a single interface built around the Real-time View of your scene. The docking windows allow scene authoring capabilities while the floating windows contain setting and output options.

You can customize and save the interface to suit your workflow with Workspaces.

<table>
<thead>
<tr>
<th>Main Interface</th>
<th>Docking Windows</th>
<th>Floating Windows</th>
<th>Extras</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Real-time View</td>
<td>• Library Window</td>
<td>• Preferences</td>
<td>• Welcome Window</td>
</tr>
<tr>
<td>• Main Menu</td>
<td>• Project Window</td>
<td>• Render</td>
<td>• Hotkeys</td>
</tr>
<tr>
<td>• Toolbar</td>
<td>• Animation Timeline</td>
<td>• Output Window</td>
<td>• Gestures</td>
</tr>
<tr>
<td>• Ribbon</td>
<td>• Geometry View</td>
<td>• HDR Editor</td>
<td>• Workspaces</td>
</tr>
<tr>
<td></td>
<td>• Material Templates</td>
<td>• Material Graph (Pro Only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Studios</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Cloud Library</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Welcome Window
Hotkeys
Gestures
Workspaces
Real-time View

The KeyShot Real-time View is the main viewport in the KeyShot user interface. All real-time rendering of your 3D model will occur here. You can navigate your scene using the camera controls, multi-select objects and right-click directly on your model or in the area around it to view more options.

1. Heads Up Display

For information concerning the Real-time View you can turn on the Heads-Up Display via the Main Menu under View > Heads-Up Display.

The Heads-Up Display will be located in the top left corner of the Real-time View. It shows

- **FPS**: frames per second - shows the rendering speed in CPU mode
- **Samples per Second**: shows the rendering speed in GPU mode
- **Time**: how long the Real-time View has been rendering
• **Samples:** Number of samples the *Real-time View* has been rendering.
• **Triangles:** the amount of triangles present in the scene, excluding hidden Parts/Model Sets.
• **NURBS:** the amount of NURBS present in the scene, excluding hidden Parts/Model Sets.
• **Res:** the *Real-time View* resolution.
• **Focal length:** The current Focal length of the camera.
• **Denoise:** shows the current state of the Denoiser.
• **GPU Memory:** shows the GPU memory usage in relation to the total memory. If the GPU runs out of memory, KeyShot will revert to CPU mode.

2. Coordinate Legend

To help orientate in the *Real-time View* you can turn on the Coordinate Legend. This will show the X, Y and Z axis of the current view. Turn on the Coordinate Legend via the Main Menu under View > Coordinate Legend.

3. In-view indicators

Under some circumstances in-view indicators will be displayed in the top right corner of the *Real-time View*.

- The **Render Nurbs** indicator will be displayed when Render Nurbs is active and the button is hidden.
- The **Performance Mode** indicator will be displayed when Performance mode is active and the button is hidden.
- The **Lock** indicator will be displayed when the camera is locked and the button is hidden.
- The **GPU** indicator will be present when in GPU mode and the GPU button is hidden.
- The **Denoise** indicator will be present when Denoise is active and the Ribbon button is hidden.
- The **Generate Environment** indicator (pro) will be displayed when you have made changes in the HDRI editor and these are not yet generated in the full resolution. You can click the indicator to generate the environment in full resolution.
- The **Execute Geometry Nodes** indicator will be displayed when the scene contains geometry with Geometry Nodes (displacement/bubbles/flakes) or RealCloth which have not been executed. Click the indicator to execute all geometry nodes in the scene.
- The **Warning** icon will be shown if your scene contains something that is not being shown correctly in GPU mode - e.g. Cutaway materials.

**Resolution**

The *Real-time View* will respect the resolution/aspect ratio set in the Image tab.

**Docking windows**

Windows with resources and editing options (see which [here](#)) can be docked inside the *Real-time View*. You can dock windows on the sides and in the bottom of the view - and in multiple columns/rows if desired. To dock a window drag it by the title-bar towards the middle of the edge you want to
dock it to, when a grey docking area is expanded, simply drop the window there. To un-dock drag the window, by the title bar, away from the dock area. If the Real-time View has a locked image size, the docked windows will respect the size limiting how much they can be resized, and where they can be docked.
Main Menu

File

- **New...**
  Open a new blank scene in KeyShot.
- **Import...**
  Import a 3D file into an open or new scene. If quick import is enabled for the file type, this will import the file without showing the dialog. See the Import section for more details.
- **Import Dialog...**
  This will always lead to the Import, where you can adapt the import settings for the current import.
- **Open...**
  This will open a KeyShot scene, or opens the import panel.
- **Open Recent**
  KeyShot lists the last 10 scenes that were opened/saved so you can quickly open them.
- **Save**
  Save the currently open scene in KeyShot (.bip).
- **Save As...**
  Save the current scene in KeyShot (.bip) with the option to change the name of the file.
- **Save Package...**
  Save a KeyShot Package (.ksp) which includes the model as well as all associated resources (materials, environments, textures, cameras, and back and frontplates) used in a given scene.

  **Note**
  It is very important to use this the Save Package method when sharing or moving a scene across different computers, otherwise you will have problems with missing textures etc. when the scene is loaded.

- **Save for KeyShot Viewer...**
  Save a KeyShot Package (.ksp) for viewing in KeyShot Viewer. The file can be Passwrd protected and you can choose to show the KeyShot logo and/or watermark.
- **Save Active Model Sets...**
  Save only the Model Set(s) displayed in order to share Model Sets with non-Pro users.
- **Revisions Manager...**
  Opens Revision Manager to preview, revert to or delete revisions. This is not enabled by default. To enable the Revision Manager, enable Backup Revisions under Edit >Preferences > General (Windows) or KeyShot > Preferences > General (Mac).
- **Export (Pro only)**
  Export model file to OBJ, FBX, GLTF, STL, and ZPR file formats.
- **Connect to Onshape...**
  Launch the Onshape integration dialog. This menu item is only present if you have the plugin installed. Onshape and account are required. The Onshape plugin can be downloaded here.
- **Exit**

  - **Quit**
  Quit and leave KeyShot.

Edit

- **Undo**
  Undo previous actions. The fly-out will list the undo-able actions.
- **Redo**
Redo an action that was undone. The fly-out will list the redo-able actions.

- **Add Geometry**
  Add pre-installed primitives into your scene, with one click. These can also be found in the Model library. You can change which models are available in this menu - see how.

- **Clear Geometry**
  Clears all geometry in the scene.

- **Set Scene Units**
  Change the set units used in the scene. For accurate results, use the same units the model was created in.

- **Preferences** (PC only - On Mac Preferences are located under KeyShot in the Main Menu)
  Set KeyShot preferences. See Preferences for more details.

**Environment**

- **Background**
  Toggle background mode between Lighting Environment, Color, and Backplate image.

- **Ground Shadows**
  Toggle Ground Shadows on and off.

- **Occlusion Ground Shadows**
  Toggle Occlusion Ground Shadows on and off. Ground Shadows must be enabled for this option to be available.

- **Ground Reflections**
  Toggle Ground Reflections on and off.

- **Flatten Ground**
  Toggle Flatten Ground on and off.

**Lighting**

- **Performance Mode**
  Toggle the performance mode on/off.

- **Basic, Product, Interior, Jewelry, Custom**
  Choose a lighting preset that best suits your scene. if you have a created a custom preset, this option becomes available under Custom.

- **Self Shadows, Global Illumination, Ground Illumination, Caustics, Interior Mode**
  Toggle these settings on/off. See Lighting for more information.

**Camera**

- **Cameras**
  Choose a saved camera. Cameras that are saved from your list of saved cameras is populated here.

- **Lock Camera**
  Lock the camera in the Real-time View.

- **Add Camera**
  Add a Camera to your saved camera list.

- **Tumble/Pan/Dolly**
  Toggle the default left mouse button action. See Navigating Your Scene for more information.

- **Perspective/Orthographic/Shift/Panoramic**
  Toggle camera lens settings. See Lens Settings for more information.

- **Standard Views**
  Choose from the preset orthographic camera views.

- **Stay Above Ground**

---

Manual, KeyShot 9
• Grid
  Enable grid.
• Ground Grid
  Enable ground grid.
• Match Backplate Perspective
  Enable the match backplate tool.
• Walkthrough Mode
  Adds a new camera and enables Real-time View navigation controls.
• Enable VR
  When you have a VR headset connected to your computer, the Enable VR option enable the Head Mounted Display option in the Stereo section of the Project, Camera tab and add a Panoramic camera to the Camera List. See the Virtual Reality section to learn more.
• Adaptive Performance mode
  Toggle the use of performance mode if FPS is lower than 20 in the Real-time View.

Image

• Resolution Presets
  Select from a list of Real-time View Resolution Presets.
• Lock Aspect
  Toggle Lock Aspect of the Real-time View.
• Lock Resolution
  Toggle Lock Resolution of the Real-time View.

Render

• Pause Real-time Render
  Toggle pause of the Real-time View.
• GPU Mode (Windows only, and only if the GPU meets requirements)
  Toggle the GPU mode on/off.
• Render NURBS
  Toggle on/off the display of NURBS in the Real-time View.
• Motion Blur
  Toggle on/off the display of Motion Blur when animations are present in the scene.
• Save Screenshot
  Create an image file of the current Real-time View.
• Add to Queue
  Create a render job in the Render Queue using the current Render Options.
• Render
  Open the Render Options window.

View

• Model Sets
  Cycle Model Sets or select a specific Model Set from the list.
• Show Fullscreen
  Toggle fullscreen mode.
• Presentation Mode
Toggle presentation mode.

- **Retina mode** (Mac only)
  Toggle Retina mode.
- **Heads-Up Display**
  Hide or show the Heads-Up Display which contains frames per second, time and number of samples the Real-time View has been rendering, the amount of triangles and NURBS in the scene, the Real-time View resolution, and the current focal length of the camera.
- **Show Coordinate Legend**
  Hide or show the coordinate legend on the lower left corner of the Real-time View.
- **Selection Outlines**
  Toggle selection outlines to be shown.
- **Show Light Sources**
  Hide or show physical light sources.

**Window**

- **Toolbar**
  Hide or show the Toolbar.
- **Ribbon**
  Hide or show the Ribbon.
- **Cloud Library...**
  Hide or show the Cloud Library window.
- **Library**
  Hide or show the Library window.
- **Project**
  Hide or show the Project window.
- **Animation...**
  Hide or show the Animation window.
- **KeyShotXR...**
  Open the KeyShotXR wizard (only available with applicable licenses).
- **Show Geometry View**
  Hide or show the Geometry View window.
- **Material Templates...**
  Hide or show the Material Templates window.
- **Studios**
  Hide or show the Studios window.
- **Configurator Wizard**
  Hide or show the Configurator Wizard.
- **Scripting Console...**
  Hide or show the Scripting console window.
- **Enable Docking**
  Toggle to allow window docking in the Real-time View.
- **Dock Windows**
  Auto-docks all open windows to default locations.
- **Restore Tab Order**
  Restores the default tab order for the Library and Project windows.

**Help**

- **Help...**
Loads [https://help.keyshot.com/](https://help.keyshot.com/) for quick access to the Luxion Support staff, FAQs, Troubleshooting and more.

- **Manual...**
  Loads the KeyShot online manual, which also contains links to download the PDF manual.
- **Hotkeys Overview...**
  Displays the KeyShot hotkeys panel (or toggle off/on using the K-key).
- **Welcome Dialog...**
  Displays the Welcome Window for access to the latest learning and 'What's New' content along with recent and demo scenes.
- **Learning**
  Opens the “Keyshot Learning” page for tutorials, webinars and quick tips.
- **Register License...** *(PC only - On Mac* Register License... *is located under KeyShot in the Main Menu)*
  Opens the KeyShot license registration window.
- **Activate KeyShotWeb...**
  If you have purchased the KeyShotWeb add-on separately, click here to activate it.
- **Deactivate License on this Computer...** *(PC only - On Mac* Deactivate License on this Computer... *is located under KeyShot in the Main Menu)*
  Deactivate your license so it can be used on a different computer.
- **Show License Information...** *(PC only - On Mac* Show License Information... *is located under KeyShot in the Main Menu)*
  Shows KeyShot version and active licenses.
- **Disclaimers...**
  Opens disclaimers pertaining to KeyShot partners.
- **Check for Updates...** *(PC only - On Mac* Check for Updates... *is located under KeyShot in the Main Menu)*
  Checks online for the latest version of KeyShot. Requires an internet connection.
- **Log...**
  Opens log window to view the source of any errors.
- **About...** *(PC only - On Mac* About... *is located under KeyShot in the Main Menu)*
  Displays the KeyShot About window, including KeyShot version number and link to Disclaimers
- **Open (Recovery mode)...**
  This will open your scene in performance mode without execution geometry nodes.
- **Report a problem**
  Launches a report dialog, where you can report any bugs you may encounter while using KeyShot. The Dialog asks you to describe the issue and enables to you attach files (e.g. scenes where you experience the bug). The report is by default anonymous - but you can choose to add your contact information, if you are open to being contacted by Luxion with any questions that may arise concerning the issue. If KeyShot crashes, this dialog will be triggered automatically next time KeyShot is launched.
Toolbar

KeyShot Toolbar

The Toolbar provides quick and easy access to the most common windows and features in KeyShot. The center grouping of icons provides a general order of operations when working in KeyShot from Import to Render. You can right-click on the Toolbar for icon size options and the ability to disable text. Click and drag on the handle on the left side of the Toolbar to tear it off from the main window to leave it floating or to dock along the top or either side.

Cloud Library
Opens the Cloud Library window. See Cloud Library for more details.

Import
Opens the browse to file dialog to import scenes and 3D data into KeyShot. See Working With Models for more details.

Library
Opens the Library window. See Library Window section for more details.

Project
Opens the Project window. See Project Window for more details.

Animation
Opens the Animation Timeline and Animation Properties window. See Animation Timeline for more details. Note that Animation is a KeyShot Pro feature.

KeyShotXR
Opens the KeyShotXR Wizard. See KeyShotXR for more details. Note that KeyShotXR requires the KeyShotWeb add-on to be installed, otherwise the icon will be disabled.

Presentation
Enters full-screen Presentation Mode. This button is only displayed on the Toolbar for KeyShot Pro users, if the Configurator has been set up in the scene. See Configurator for more details.

KeyVR
If you have KeyVR installed this button will bring your model into KeyVR with a single click. Visit the KeyVR manual to learn more.

Render
Opens the Render window. See Render for more details.
Screen Shot
 Takes a Screenshot of the Real-time view and saves it to your Renderings resources folder.
Ribbon

The KeyShot Ribbon

The Ribbon provides quick access to commonly used settings, tools, commands, and windows in KeyShot.

The Ribbon can be customized and saved in Workspaces. To customize what is shown in the Ribbon, right click and enable relevant buttons.

- **Workspaces**
  Select a predefined Workspace, create and manager your own, or select between the Light and Dark theme interface.

- **CPU/GPU Usage**
  Select the number of cores allocated for KeyShot.

- **Pause**
  Pauses Real-time View rendering.

- **Performance Mode**
  Toggle on to lower real-time render settings for faster performance. Performance Mode is also accessible via the Lighting tab.

- **GPU Mode**
  If your PC has a GPU which meets the requirements, this button will be present in the Ribbon, and enable you to switch to GPU Mode. If the Icon is disabled it means that the GPU Driver needs to be updated.

- **Denoise**
  Toggle denoising. Denoise is one of the Image style options, and as such the state will follow current Image Style. If the image style is locked, the Denoise button in the Ribbon will be disabled.

- **NURBS Mode (Pro Only)**
  Enables NURBS Data to be rendered in the Real-time View.

- **Region (Pro Only)**
  Enables Region rendering.

- **Tumble, Pan, Dolly Camera**
  Select the default left mouse button behavior. This is especially helpful when working on a laptop with only a track pad, as the 3 modes require a mouse with scroll wheel.

  The Hotkey Overview also offers modifier keys for camera navigation, so you don't have to switch between modes via the Ribbon.

- **Perspective**
  Quick access to the Camera Perspective value.

- **Add Camera**
Add a new Camera to your saved Camera list.

Cycle Cameras
Cycle through saved Cameras.

Reset Camera
Reset the current Camera to its saved state.

Lock Camera
Lock the properties of the current Camera.

Studios
Show/hide the Studios window.

Add Studio
Add a new Camera to your saved Camera list.

Cycle Studios
Cycle through saved Studios.

Tools
This groups a number of Tools for easy access.

Move Tool - Enables the Move Tool and prompts to make a selection if nothing is already selected.

Edit Normals - Launches the Edit Normals tool and prompts to make a selection if nothing is already selected.

Re-Tessellate - Launches the Re-Tessellate tool and prompts to make a selection if nothing is already selected.

Close Mesh - Launches the Close Mesh tool and prompts to make a selection if nothing is already selected.

Split Object Surfaces - Launches the Split Object Surface tool and prompts to make a selection if nothing is already selected.

Split Separate Objects - Launches the Split separate objects tool and prompts to make a selection if nothing is already selected.

Material Templates - Show/hide the Material Templates window.

Material importer - The Material Importer lets you import .kmp, .mtl, .U3m, .AxF or Substance Painter texture sets into KeyShot.

Match Perspective - launches the Match Perspective tool, which lets you match the camera to the backplate perspective.

Set Camera Target - Launches the Set Camera Target Widget.

Geometry View
Show/hide the Geometry View window.

Configurator Wizard
Opens Configurator Wizard.

Retina Mode (Mac only)
Toggles the Retina Mode.

High DPI mode (Windows Only)
If High DPI has been enabled in Preferences, the High DPI button lets you toggle between normal and High DPI mode.

Scripting Console
Launches the Scripting console.
Workspaces

Workspaces allow you to select preset user interface (UI) arrangements or save your own custom arrangements of the KeyShot UI to best suit the way you work.

Workspaces store:
- window dock state
- position and size
- Library and Project tab order
- tab visibility
- torn-off tab state
- Toolbar and Ribbon position
- Ribbon icon visibility.

Using Workspaces

The Ribbon at the top of the KeyShot UI now contains a dropdown menu at the far left where you can select, add, and manage Workspaces. To create your own custom Workspace make adjustments to any of the items mentioned above, click the Workspaces dropdown and select Add… to launch a name entry field and save. To save changes to an existing Workspace click Apply Changes…. To adjust display order, import, export, or delete Workspaces click Manage…

Theme Options

KeyShot has both light and dark theme options. From the Workspace dropdown, select Light Theme or Dark Theme.
Library Window

The KeyShot Library has stock materials, colors, textures, environments, backplates and models that you can use in your scenes.

File location

Files in the Library are stored locally on your computer and they are read from your KeyShot resources folder by default. To pull resources from a different folder, you can point to it from KeyShot Preferences > Folders.

Additional resources

More materials, textures, environments, backplates and models are available for download from the Cloud Library.
Materials Library

The Materials tab is located in the Library window and contains all the preset and saved materials in your library.

1. **Search**
   Type in any keyword to search for a material by name.

2. **Add Folder**
   Click this button to add custom material folders.

3. **Import**
   Import a material file. You may import the following formats directly into the library: MTL, AxF, U3M, and KMP (KeyShot's native material format).

4. **Refresh**
   Refresh material list if any changes were made.

5. **Folder Tree**
   Contains the folder structure of the material folders.

6. **Material Thumbnails**
   Mat ball swatches of materials within the selected folder.

7. **List/Thumbnail Toggle**
   Switch displaying the materials with thumbnails and in a list view.

8. **Zoom Slider**
   Slide to change the size of the thumbnails. You can also use +/- to change in steps.

9. **Upload to Cloud Library**
   Click this button to upload a custom material to the Cloud Library.

10. **Export**
    Export a saved material as a KMP file.

Learn more about the Material Library [here](#).
Colors Library

The Colors tab contains all preset color libraries and saved colors.

1. **Search**
   Type in any keyword to search for a color by name.
2. **Add Folder**
   Click this button to add custom color folders.
3. **Import**
   Import a KCP or CSV color file.
4. **Refresh**
   Refresh color list if any changes were made.
5. **Color Search**
   Opens color picker panel to search by closest color match.
6. **Folder Tree**
   Contains the folder structure of the color folders. It contains folders for RAL and Pantone Color Libraries.
7. **Color Swatches**
   Displays color swatches within the selected folder.
8. **List/Thumbnail Toggle**
   Switch between displaying the color with thumbnails and in a list view.
9. **Zoom Slider**
   Slide to change the size of the thumbnails. Use +/- to change in steps
10. **Export**
    Export a KCP color file.

See the Color Library page for more info.
Textures Library

The Textures tab contains all preset and saved textures in your library.

1. Search
   Type in any keyword to search for a texture by name.
2. Add Folder
   Click this button to add custom texture folders.
3. Import
   Import an image file.
4. Refresh
   Refresh texture list if any changes were made.
5. Folder Tree
   Contains the folder structure of the texture folders.
6. Texture Thumbnails
   Thumbnails of textures within the selected folder.
7. List/Thumbnail Toggle
   Switch between displaying the textures with thumbnails, or a list view.
8. Zoom Slider
   Slide to change the size of the thumbnails use +/- to change in steps.
9. Upload to Cloud Library
   Click this button to upload a custom texture to the Cloud Library.
10. Export
    Export an image file.
Environments Library

The *Environments* tab contains all preset environments and any saved environments in your library.

1. **Search**
   Type in any keyword to search for an environment by name.
2. **Add Folder**
   Click this button to add custom environments folders.
3. **Import**
   Import a HDR, HDZ, EXR, DDS file.
4. **Refresh**
   Refresh environments list if any changes were made.
5. **Folder Tree**
   Contains the folder structure of the environment folders.
6. **Environment Thumbnails**
   Thumbnails of environments within the selected folder.
7. **List/Thumbnail Toggle**
   Switch displaying the environments with thumbnails and a list view.
8. **Zoom Slider**
   Slide to change the size of the thumbnails. Use +/- to change in steps.
9. **Upload to Cloud Library**
   Click this button to upload a custom environment to the Cloud Library.
10. **Export**
    Export environment file.
Backplates Library

The Backplates tab contains all preset or saved backplates in your library.

1. **Search**
   Type in any keyword to search for a backplate by name.
2. **Add Folder**
   Click this button to add custom backplate folders.
3. **Import**
   Import an image file.
4. **Refresh**
   Refresh backplate list if any changes were made.
5. **Folder Tree**
   Contains the folder structure of the backplate folders.
6. **Backplate Thumbnails**
   Thumbnails of backplates within the selected folder.
7. **List/Thumbnail Toggle**
   Switch between displaying the backplates with thumbnails, or a list view.
8. **Zoom Slider**
   Slide to change the size of the thumbnails use +/- to change in steps.
9. **Upload to Cloud Library**
   Click this button to upload a custom backplate to the Cloud Library.
10. **Export**
    Export an image file.
Favorites Library

The Favorites tab allows you to organize commonly used resources into collections for a faster workflow. Right-click a resource in your library, select Add to Favorite, and select the folder you would like to add the resource to or select Add to new Favorite to create a new collection.

1. **Search**
   Type in any keyword to search for a resource by name.

2. **Add Folder**
   Click this button to add a favorites folders.

3. **Refresh**
   Refresh favorites list if any changes were made.

4. **Folder Tree**
   Contains the folder structure of the favorites folders. Each favorites folder contains categories for backplates, colors, environments, materials, and textures.

5. **Favorites Thumbnails**
   Thumbnails of resources within the selected folder.

6. **List/Thumbnail Toggle**
   Switch between displaying the favorites with thumbnails, or a list view.

7. **Zoom Slider**
   Slide to change the size of the thumbnails use +/- to change in steps.
Models Library

The Models tab located in the Library window contains a selection of models you can use to add context in your scene as well as whole scenes in which you can display your products.

1. **Search**
   - Type in any keyword to search for a model by name.

2. **Add Folder**
   - Click this button to add custom folders for your model library.

3. **Import**
   - Import a scene to your library

4. **Refresh**
   - Refresh model list if any changes were made.

5. **Add**
   - Add current scene to the library

6. **Folder Tree**
   - Contains the folder structure of the model folders.

7. **Model list**
   - The list contains all the models that match the current filtering (folder and search)

8. **List/Thumbnail Toggle**
   - Switch displaying the model thumbnails in a list or grid view.

9. **Zoom Slider**
   - Slide to change the size of the thumbnails. You can also use ‽ to change in steps.

10. **Export**
    - Export a model as KSP.

Visit the Library Models page for more information.
Project Window

The Project window contains all the setup and setting for everything in your scene, organized into six tabs: Scene, Material, Environment, Lighting, Camera and Image.

You can show/hide the Project window via the Toolbar in the Main Menu > Project or with a hotkey (Space bar).
Scene Tab

The Scene tab contains all the items in your scene:

1. Scene tree

The hierarchy of elements in your scene, Models > Groups > Parts, Animations (Pro Only) and Cameras. See Working With Models > Scene Tree for more details.

2. Model Sets (Pro only)

With Model Sets you can have several independent Scene Tree variations within your file, making it easier to handle product variations. See Working With Models > Model Sets for more detail.

3. Properties

Properties of the currently highlighted item the Scene Tree.

4. Position

Here you can set the size/position of the selected Model, Group or Part. Also see Working With Models > Moving Models and Parts.

5. Materials

This is the In-Project library which lists all materials in the current scene.
Material Tab

The Material tab is where you can edit the properties of your material such as changing the roughness, adding textures or labels.

1. Material Name

The name of the material as it appears in the In-Project library - if the project has multiple instances of the same material (unlinked) a number will be appended to the materials.

2. Save

Saves a copy of the material in the Material Library

3. Preview

Preview of the current material. The current material can be replaced by dragging another material from the Material Library onto the preview.

4. Material Graph (Pro Only)

The Material Graph opens in a separate window and displays materials, textures, labels and more as nodes in a graph view to visualize connections and relationships within complex materials. See the Material Graph section for more details.

5. Multi-Material (Pro Only)

Any material can be turned into a Multi-Material to facilitate non-destructive material swapping, variations or color studies. The Multi-Material allows you to cycle through a variety of materials within a single “container” material. See Multi-Materials section for more details.

6. Type

Here you can change the type of material on the selected part. See Material Types for description of the types available. When changing material types KeyShot will transfer any properties that can be translated between the types.

7. Properties/Textures/Labels

Each type of material has a set of properties that can be adjusted as well as the option to add labels and textures.

The texture icon denotes settings that are able to have textures applied.

8. In-Project Library

Lists all materials in the current scene. See the In-Project Library section for more details.

9. Material View

Tree-view showing all Labels/textures etc. (nodes) of the current material.
Environment Tab

The Environment tab is located in the Project window and is where you can add and edit the HDR lighting of your scene as well as the background and ground properties.

1. Environment List

With the Environment List you can set up and easily toggle between multiple environments in your project.

2. HDRI Preview

Preview of the HDRI. In the Pro version light pins can be adjusted here as well as in the HDRI Editor Canvas.

3. Settings

The Settings tab located below the Environment List and HDRI preview allows you to control the properties of the selected Environment. See Adjusting Environments for more details about the individual properties in the settings tab.

4. HDRI Editor (PRO)

The HDRI Editor tab located below the Environment List and HDRI preview allows you to edit the selected HDRI, add light pins and change background options. See HDRI Editor for more details about the individual properties in the settings tab.
**Lighting Tab**

In the *Lighting tab* you can control the interpretation of lighting in your scene. The actual light sources are set up via *Lighting Environments* and *Light Source materials*.

1. **Lighting Presets**

   KeyShot comes with 5 *Lighting Presets* which make applying global light settings faster. You can find the description of each preset in the *Lighting Presets* section.

2. **Custom**

   If you have created a lighting setup that you are happy with and want to be able to reuse in other scenes you have the option of saving it as a custom preset.

   Just press the + icon, give it a name and it will appear in the Custom Presets list. You can delete a custom preset by selecting it in the list and press the trash icon.

3. **Lighting settings**

   This allows complete control over lighting options. Learn more about the individual settings on the *Custom Lighting Presets* page.
Camera Tab

The Camera tab is used to create cameras to capture the desired area of your project as well as various effects to enhance your camera view.

1. Camera List

With the Camera List you can set up/save multiple cameras in your scene. This facilitates cameras to be re-used, modified, animated or used in Studios.

In the camera list, the Free Camera is always available and cannot be locked or overwritten, it can always be selected and remains independent of camera animations.

Go to the Camera List section for more details.

2. Position and Orientation

While the camera position can be changed by clicking and dragging the scene, this section will give you a more precise way of positioning the camera and allows you to set the camera target.

See the Position and Orientation section to learn more.

3. Lens Settings

As the title indicates, this section allows you to change the camera lens settings.

- Perspective
- Orthographic
- Shift
- Panoramic (pro only)

4. Stereo

The Stereo mode will allow you to either render a VR-ready image that can be viewed through a head-mounted VR display or to see the scene in real-time through a VR headset such as the Oculus Rift or the HTC vive. See the Stereo (VR) page and the Virtual Reality section for more information.

5. Depth of Field

Depth of Field allows you to set the focus distance and the f-stop of the camera just like you would with a regular camera.

See the Depth of Field section for more details.
**Image Tab**

**Resolution**

The Resolution can be set in specific pixels or with a fixed ratio. You can also choose from a number of standard presets - and even add your own presets to suit your workflow.

The Resolution page offers more details.

**Image Styles**

**Image Style List**

The Image Style List allows you to create multiple Image Styles in the same scene.

- **Add Image Style** - Adds a new Image Style to the list.
- **Duplicate Image Style** - Adds a copy of the current Image Style to the list.
- **Delete Image Style** - Deletes the current Image Style.

**Image Style type**

- **Basic** - Almost identical to the Image Adjustments and Image Effects options in previous versions of KeyShot. If you open a legacy scene with Image Adjustments/Effects they will be added as a Basic Image Style.
- **Photographic** - Offers more versatile adjustments e.g via Tone Mapping and Curves. See the

**Properties**

This is where you set up the current Image Style - Learn more in the Image Styles section.

**Note:** In KeyShot 8 the Region Rendering settings have been moved from the Image tab to the Ribbon - see more on the Render Region page.
1. **Time Stamp**
   This will show where the preview line currently is on the timeline.

2. **Current Time Indicator Line**
   This line is the marker for the where in the timeline the real-time render window is rendering from. When you play a real-time preview, this line will move with in time with the animation. Click and drag the line to scrub to a point in the animation you would like to preview.

3. **Start/End Markers (Work area)**
   Use this to designate the actual animation to be rendered. The space between these markers is called the *Work Area*.

4. **Ruler**
   This shows the timeline in the units chosen (seconds or frames.)

5. **Nodes**
   Each animation is represented in the timeline as a colored bar called a “Node.” Most nodes can be selected at the ends and dragged to change the duration of the animation. Click on the body of the node to move along the timeline. Hold SHIFT while dragging to snap to another node.
   - Green nodes - Part animations
   - Blue nodes - Camera animations
   - Red nodes - Material animations

6. **Folder Nodes**
   Yellow Nodes are “Folder Nodes.” Changing the duration and location of a folder node affects all animation nodes contained within it.

7. **Node List**
This lists all animation nodes and folders. Use the check boxes to toggle the active state of the animation nodes.

**Timeline Toolbar**

1. **Animation Wizard**
   - This opens the Animation Wizard.
2. **FPS drop-down**
   - Select from common frame rates used in video production.
3. **Real-time Preview Buttons**
   - These buttons will allow you to quickly jump to the beginning or end of your animation, scrub through the animation one frame at a time, and play a real-time preview of your animation in the real-time render window. To see a more accurate portrayal of materials and motion, click the “preview” button on the animation toolbar.
4. **Loop**
   - Enable this to loop the animation when playing in the real-time window.
5. **Motion Blur**
   - Enable this to create motion blur in your rendered animation output.
6. **Animation Settings**
   - Click the settings icon to open the settings panel where you can select from Max seconds per frame to limit the render time of the preview, or choose Max samples per frames to limit the quality of the preview. You can also choose to in-/exclude the last frame and if Geometry nodes should be executed for the animation - see the Geometry Node Types page for more info.
7. **Render Preview**
   - Click this button to begin rendering a small video file of your animation with more accurate results than the real-time preview.
8. **Zoom Slider**
   - Use this to change the scale of the Animation Timeline.

See the Animation section for more info on working with animations.
Geometry View Window

The Geometry View window provides a secondary OpenGL viewer for use as a secondary view for lighting, camera or animation setup.

The Geometry view is dock-able and can be launched from the Ribbon, via the Main Menu, Window or via the hotkey O.

Geometry View

1. **Settings**
   - Set the background color and customize what is visible: ground grid, lights, cameras, etc.
2. **Display Style**
   - Controls your model's display style: shaded, flat, wireframe, shaded wireframe, and bounding.
3. **Camera Type**
   - Choose to sync with the active camera or navigate independently in this view.
4. **Standard Views**
   - Snap to a pre-defined standard camera view: front, right, top, etc.
5. **Move Tool**
   - Click this button to launch the Move Tool.
6. **Geometry View**
   - OpenGL viewer that can be viewed next to the Real-Time View.

Learn more about what you can do in the Geometry View section

**Geometry tools**

The geometry tools, that in previous versions were located in the Geometry view, have in KeyShot 9 been moved to the Tools menu in the Ribbon.
Material Template Window

The Material Templates window can be accessed from Window under the Main Menu or via the Material Template button in the Tools section of Ribbon.

1. Search
   Type in any keyword to search for a material template.
2. Add Template
   Click this button to add a material template.
3. Import
   Import a KMTP material template file.
4. Export
   Export a KMTP material template file.
5. Delete
   Click this button to delete a material template.
6. Material Templates List
   Contains a list of all material templates available in your resources folder.
7. Add Rule
   Click this button to add a rule.
8. Delete Rule
   Click this button to delete a rule.
9. Template Rules
   Contains a list of all the rules in the template.
10. Apply
    Applies the template to your scene or selection.

Go to the Material Templates page to learn more.
Welcome Window
The KeyShot Welcome Window will appear after you launch KeyShot. The Welcome Window will display:

- Recently opened scenes
- Demo scenes
- Latest KeyShot News
- Latest KeyShot Tips

Click on a recently open scene to open it immediately or select Import Model or Open Scene to load another model or scene.

You can disable/enable the Welcome Window on startup in the Preferences:

- Windows: Go to Edit, Preferences and in the General section, uncheck/check Show Welcome Window at start up.
- Mac: Go to Help, Preferences and in the General section, uncheck/check Show Welcome Window at start up.
Hotkeys

Learning and using the KeyShot hotkeys will speed up the process of working inside KeyShot. You can access the list of hotkeys and their functionality by pressing the K-key on PC or Mac.

Hotkey Overview

Display the Hotkey Overview window by hitting the K-key or selecting Help, Hotkeys Overview...

Setup/Details...
Opens the Hotkeys Preference window to set custom hotkeys.

Save as Image...
Allows you to save an image of the Hotkey Overview for reference or print.

Customizing KeyShot Hotkeys

KeyShot also allows you to assign custom hotkeys for many KeyShot commands. The Hotkeys preferences can be accessed by selecting Edit, Preferences (windows) or Keyshot, Preferences (mac) and selecting the Hotkeys section or by pressing the K-key to show the Hotkeys Overview where you will see a button for Setup/Details... in the bottom right corner. This will take you to the Hotkeys section of the Preferences page. Here you can set custom Hotkeys for any of the listed actions.
Hotkeys for Library Models

You have the option of adding up to 10 hotkeys to models in your library. This way you can have the models you add most frequently to your scenes right at your fingertips.

The 10 hotkeys are by default applied to the first 10 Primitives in the Geometry folder in the Model library (sorted by a-z). If you add a model to the Geometry folder it will also be included in the automatic hotkey assignment.

If you want to circumvent the alphabetical assigning of hotkeys or if you want to assign a hotkey to a model outside the Geometry folder you can right-click the model and select Assign Hotkey, now you can tie one of the 10 hotkeys to the model, and it will appear in the Add Geometry list in the Main Menu.
Gestures

Touch screens
KeyShot supports multi-touch input for touch-enabled screens and tablets. The following gestures can be used on the touch screen when running KeyShot:

- **1 Finger drag**: The active camera mode (default is tumble)
- **2 Finger pinch**: Adjust Focal length

Track pads

- **Click + 1 finger drag**: The active camera mode (default is tumble)
- **Tab & hold, then drag**: Pan camera (Only some track pads)
- **2 Finger up/down movement**: Dolly camera
- **2 Finger pinch**: Adjust Focal length
- **2 finger rotate**: Camera Twist

Alternative camera controls

- **Pan**: Ctrl+Shift drag on Windows and Cmd+Shift on Mac
- **Dolly**: Alt+Shift drag

These can be customized in the Hotkey Preferences.
Working With Models

Overview

This section covers import, export, model setup and working with 3D CAD data.

With KeyShot, you can directly import all major 3D file formats, plus KeyShot has many free plugins for 3D modeling software. On import, KeyShot will automatically recognize your model's up orientation and match it. Other import options allow you to quickly adjust the location and import quality.

KeyShot allows you to control the model units, show/hide parts, group, duplicate parts/assemblies and create patterns of your imported data. We'll start with bringing your model in, then go over navigation and manipulating the models in your scene.

KeyShot Pro brings additional export options to KeyShot, allowing you to export formats to use in other 3D modeling and 3D printing software or upload to view in a web browser.
Supported File Formats

**File Formats**

KeyShot supports the following 3D file formats on both Mac and PC.

- 3ds Max (.3ds) [1]
- ALIAS 2019 and prior (.wire) [2]
- AutoCAD (.dwg, .dxf)
- CATIA v5-6 (.cgr, .catpart, .catproduct, .catdrawing)
- Cinema 4D R20 and prior (.c4d)
- Creo 6.0 and prior (.prt, .asm)
- Creo View (.pvz, .pvs, .edz, .ed, .c3di, .ol)
- Inventor 2019 and prior (.ipt, .iam)
- Maya 2018 and prior (.ma, .mb) [2]
- NX 12 and prior (.prt)
- Onshape [1]
- Pro/ENGINEER Wildfire 2-5 (.prt, .asm)
- Revit 2019 and prior (.rvt)
- Rhinoceros 6 and prior (.3dm)
- SketchUp 2018 and prior (.skp)
- Solid Edge 2019 and prior (.par, .asm, .psm)
- SOLIDWORKS 2019 and prior (.sldprt, .sldasm)
- Acis (.sat)
- Alembic (.abc) [3]
- 3DXML (.3dxml)
- COLLADA (.dae)
- FBX (.fbx) [3]
- IGES (.igs, .iges)
- JT (.jt)
- OBJ (.obj)
- Parasolid (.x_t)
- STEP (.step, step)
- STL (.stl)
- ZPR (.zpr)

[1] Plugin only
[2] Requires licensed installation of software
[3] Includes animation

**Plugins**

See list of plugins with LiveLinking [here.](#)

Download plugins [here.](#)
Import

How to Import

Supported file types can be imported into KeyShot in several ways:

1. by pressing Import on the Toolbar.
2. by drag and drop into the Real-time View.
3. via the hotkey combination Ctrl+I/Cmd+I
4. via the Main Menu > File > Import…
5. via the Main Menu > File > Import Dialog…

Quick import

The first time you import using any of the methods listed above, the Import Dialog will appear. But in the bottom left corner of the Import dialog you have the option Enable Quick Import. This will allow you to skip the Import Dialog on import, using on of the first 4 methods - Main Menu > File > Import Dialog… will still show the Dialog.

You can edit the Import Settings in Preferences where you also can opt out of the Quick Import again.

Import Dialog

Depending on the type of model you are importing, some of the options below might not be displayed in your Import Dialog.

Scene (only KeyShot Pro)

- **Add to Scene/Update Geometry** - If you have imported the model once already you can choose to add the model to the scene again or update the geometry. If you choose to update, some of the options in the dialog will be hidden and KeyShot will compare the geometry with what is in the scene already, and remove/add the differences. Note that if you have altered the geometry (eg. via Tools) or renamed parts inside KeyShot this will have an impact on the ability to Update Geometry.
- **New model Set** - This will create a new Model Set and import the file to that.
- **Select Model Set(s)** - Select which Model Set(s) you want to place your model in. The currently active Model Sets will be selected by default.

Position

- **Center Geometry** - When checked, “Center Geometry” will import the model and place it in the very center of the environment. Any original 3D coordinates for the model are removed when center geometry is selected. If this option is not selected, the model will be placed in the same position in 3D space where it was originally created.
- **Snap to Ground** - When checked, “Snap to Ground” will import the model and position it directly on the ground plane. This will also remove any original 3d coordinate information.
- **Keep position relative to native origin** - When checked this will place the geometry in relation to the original origin point. Use this for multi-import assemblies with a shared CAD origin.
- **Up Orientation** - Not all modeling applications define the up-axis in the same manner. Depending on your application, you may need to set a different orientation other than the default “Y Up” setting. Although KeyShot will recognize the up orientation of the 3D modeling software, your model may have been built in a different orientation. If your model comes in on its side, try setting a different orientation.
Geometry

- **Geometry Unit** - Use this drop-down menu to choose the correct units the geometry was modeled in for the first import. The model scale will be adjusted accordingly upon second import if a different unit is selected. Available only for .wire, .3ds, .obj and .stl file formats.
- **Tessellation Quality** - Use this slider or input box to input the tessellation quality of the geometry. Lower values will import faster and higher values will import slower. It is recommended to use the default value of 0.2.
- **Accurate Tessellation** - This option will optimize tessellation triangle size for improved performance. It is suggested to enable this option if available for your import format.
- **Import NURBS Data (Pro)** - This option will bring in NURBS geometry that ensures no faceting on the model for completely smooth curves.
- **Cached Geometry** - This option allows importing of an assembly without the contained part files. Available for SolidWorks and SolidEdge only.
- **Calculate Normals** - Available for .obj only. It is recommended to try importing first with this option disabled as normals may already be included in the file.

Environment and Camera

- **Adjust Camera to Look at Geometry** - When checked, the camera will center to fit the imported geometry in the scene upon import.
- **Adjust Environment to Fit Geometry** - When checked, the environment will size to fit the imported geometry in the scene upon import.
- **Import Cameras** - This will add native CAD cameras to the KeyShot camera list. Only available for .fbx, .ma, .mb, .bip, .ksp.

Materials and Structure

- **Separate Materials by Part/Layer** - This option will isolate linked materials to each part by prefixing a part name to each material name.
- **Keep Individual Parts** - This option avoids merging of objects for troubleshooting purposes. It is recommended to try importing with this option disabled first to avoid excess separation of surfaces. Only available for .wire, .dwg, .dxf, .igs, .obj and .skp.
- **Retain Materials** - This option appears for Update and Add to Scene imports to ensure that materials that have already been assigned in the scene will be applied to the new import if the native CAD materials names match.
- **Import Layers as Groups** - Uses Layers setup in Maya to define tree structure. Available for .ma and .mb only.
- **Collapse Hierarchy** - Flattens tree structure to simplify Scene Tree. Available for .ma and .mb only.
- **Assign Materials from Library** - When this is enabled materials will be auto-assigned upon import if the native CAD materials have the same name as materials in the KeyShot Library.
- **Material Template** - If you have Material Templates set up in KeyShot you will have the option of using one to with the import. Material Templates can bulk assign materials from the KeyShot library to the imported parts based on the name of each part's original material. See the Material Templates page to learn more.
- **Scene Tree hierarchy by** - Use this drop-down to set up the Scene Tree structure. Different options will show depending on file format.
  - **Object (name)** - retains assembly structure and naming for accuracy and flexibility
  - **Material (type)** - flattens the hierarchy for a simpler tree structure by creating a single part for each material
  - **Layer** - retains assembly structure and naming for accuracy and flexibility
  - **Shader** - flattens the hierarchy for a simpler tree structure by creating a single part for each shader.

Additional Options

- **Animation** - Keyframed Transforms imports non-deformation animations. Specific Frame imports i.e. deformations at a specified frame and does not import animations to the Timeline. Available for .abc, .ma and .mb only.
- **Curve Import Options** - Curve Radius Modified adjusts imported curve thickness. Available for .abc, .fbx, .ma and .mb only.
**BIP import**

First you need to select if you want to open the file or import it into the current scene. If you select to

- **Open file** - Will hide the rest of the options in the dialog, close your current scene and open the new scene.
- **Import file** - When checked, the import dialog will show the various Import settings for how to add the model to the current scene.

In addition to some of the options described above, you will see following choices:

**Scene**

- **Import** - Select what to include from the bip/ file.

**Materials and Structure**

- **Apply Materials from Scene to matching source names** - Update and link materials in the imported model, if they share a name with a material in the local Library.
- **Apply Materials from Library to matching source names** - Update and link materials in the imported model, if they share a name with a material in the local Library.

Note that if both options are enabled, and different versions of a material exist in the library and the current scene, the material from the scene will be applied to imported geometry.

**Note**

If you experience problems with opening scenes with e.g. heavy displacement, you can try to open it in recovery mode. This means that the scene will be opened in Performance mode and that no Geometry nodes are executed. You can find the option in the **Main menu > Help > Open (Recovery mode)**.
Missing resources

When you import/open a scene, where the scene-resources (e.g. textures) are no longer available, in the location where KeyShot expects to find them. The Resolve Missing Resources dialog will appear. Here you can point to the new resource location, and that way fix all problems at once. That way you don’t need to find and replace each resource manually.

1. **List:** The list shows all the resources that KeyShot cannot find in the expected location
2. **Search folder:**
   a. Click *Search Folder* and browse to the folder where the resources are located now
   b. When you have the folder located press *Open*
   c. KeyShot refresh the links to any missing resources it can find in that folder, based on the name of the resources.
   d. Repeat step a-b, if all resources have not been resolved.
   e. When all missing resources have been successfully restored, the dialog will automatically close and the scene finish loading.
3. **Skip:** if you can’t or don’t want to resolve the list of missing resources, you can press Skip and manually replace the resources.
KeyShot Plugins

KeyShot offers free plugins to make your workflow from CAD to KeyShot as seamless and effortless as possible. By installing a plugin for your chosen CAD package, you can export your active geometry from within the CAD application directly into KeyShot. To download a plugin and to find the most up to date information of the plugins we offer, please visit the KeyShot Plugins page. To learn more about installing plugins see KeyShot Plugins.

LiveLinking

Plugins developed by Luxion (and some third-party plugins) include Luxion’s LiveLinking technology. LiveLinking connects your modeling application with KeyShot, and allows you to update the model inside KeyShot without losing any material assignments, animations, lighting, and camera settings.

KeyShot Plugins

- 3DS Max 2014-2017
- Cinema 4D 19 and prior
- Creo 3.0 and prior
- Fusion 360
- Maya 2016-2018
- NX 8.5-12 and prior
- Pro/ENGINEER Wildfire 4-5
- Rhinoceros 6 and prior
- SketchUp 2018 and prior
- SolidWorks 2019 and prior

Note: All KeyShot plugins include LiveLinking

Third-Party Plugins

- Geomagic Control
- Geomagic Design
- Geomagic Design X
- Geomagic Freeform
- Geomagic Freeform Plus
- Geomagic Sculpt
- Geomagic Studio
- Geomagic Wrap
- IronCAD
- JewelCAD
- Siemens Solid Edge*
- SolidThinking Evolve
- SpaceClaim
- Pixologic ZBrush 4.7*
- ZWSOFT ZW3D

*Include LiveLinking
LiveLinking

Luxion's LiveLinking technology allows you to establish a link between your 3D modeling software and KeyShot. This keeps the software separate, allowing you to continue working and refining your model in the CAD application, then send all changes over to KeyShot with the click of a button. All without losing any views, materials, textures or animations already applied.

Download Plugin

To establish LiveLinking between your CAD application and KeyShot, you must first download and install the KeyShot plugin for your CAD application. Each plugin comes with its own installer and unique setup instructions. For specific setup instructions, click here.

Enable LiveLinking

LiveLinking is enabled by default. To change this go to Edit, Preferences, General on Windows and Keyshot, Preferences, General on Mac.

Unable to connect

If the your 3D modeling software is unable to connect to KeyShot via the plugin, try to change the Port Range in the KeyShot Preferences.
Scene Units

Scene units control model scale, light intensity, color density, and texture mapping.

To achieve physical accuracy and better control over your material and texture settings, the scene units should match the scale of your model. For example, if you wish to render a car, you should set the scene units to meters or feet. On the other hand, if you wish to render a pair of sunglasses, you should set the scene units to centimeters or inches.

When you start with an empty scene in KeyShot, it will use non-specific scene units. The units will either be set when you import a model into the empty scene or when you manually set/change the scene units.

Changing the Scene Units

1. To change the model units, go to Edit > Set Scene Units and choose the new unit.
2. Select one of the two options: Keep Scene Size or Scale Scene.
Applies the proper unit-conversion multiplier to your model and the KeyShot environment. When you convert scene units, say from centimeter to millimeter, you are telling KeyShot to make your 1 centimeter model into a 10 millimeter model. Yes, mathematically they are both equivalent to each other. However, in KeyShot your model will occupy ten times as much space as it did before. Use this option when you wish to correct model size, light intensity, color density in glass, or your camera distance slider.

**Scale Scene**
Re-calibrates texture mapping on your model. When you correlate scene units, say from centimeter to millimeter, you are telling texture maps that one centimeter along your model is now treated as one millimeter along your model. Your model will keep its size, but texture images will re-size according to the new scale. Use this option when you wish to correct texture units.
Scene Tree

The Scene Tree displays Model Sets/models and their hierarchies along with any cameras that exist in a scene. Animations are also represented in the scene tree in versions of the software that include the animation add-on.

Collapse Scene Tree

Collapsing the scene tree hierarchy can be very useful if your model has a lot of parts. You can collapse/expand single groups or models by clicking the -/+ button. You can also right-click the section you would like to collapse and select “Collapse.” The full hierarchy can be collapsed when you select “Collapse All.”

Hide/show

Models and parts can be hidden and shown using the icon next to the name. The icon displayed next to animations can be used to disable and enable animations that are applied. See more on Hiding And Showing Parts

Lock

If there is a icon next to a model or part, the geometry is present in the scene, but can not be moved/edited. Models and parts can be locked/unlocked either by right-clicking the part/model and selecting lock/unlock or in the properties tab just below the Scene Tree, where the icon can be clicked to lock/unlock.

Re-order

Models and parts can be re-ordered in the Scene Tree via drag-and-drop.

Rename

Models and parts can be renamed in the properties tab just below the Scene Tree. The Properties section always show the details for the selected part/model, including the name.

Note: It is best practice to control the naming and ordering in CAD but if you decide to do it in KeyShot it is recommended to do so before assigning textures or labels as it may cause mapping to shift. Changing the scene hierarchy will also break Live Linking and Update Geometry.

On this page

- Collapse Scene Tree
- Hide/show
- Lock
- Re-order
- Rename

Also See:

- Organizing the Scene Tree
Organizing the Scene Tree

Reordering

You can reorder the Scene Tree via drag and drop or you can Cut and Paste parts.

Grouping

Grouping gives you the ability to organize the scene tree.

Add to Group

When you use Add to Group you can either add to an existing group or create a new group in the desired location.

1. Right-click the part or group (model) you want to re-group in the Scene Tree.
2. Select Add to Group - the Add to Group Dialog is displayed.
3. Add to existing: Select the group you want to add to and click OK.
4. Create new group: Select the group to which you want to add the new group and click New Group.
   - Name the new group and click OK.
   - Click OK.

Add Sub-Group

When you are dealing with groups, you can also Add sub group, without moving anything immediately - maybe to be ready for drag and drop reorganizing.

- Right-click the group (model) to which you want to add a sub-group.
- Give the group a name.

Note: Reordering parts and sub-assemblies will disable LiveLinking and Update Geometry. If you want to make sure that your scene tree hierarchy is intact, you can Disable scene tree hierarchy changes in Preferences.
Hiding And Showing Parts

In some cases, materials may need to be assigned to parts that are enclosed in or hidden behind other pieces of geometry. In such cases hiding a part/model may come in handy.

Hiding Parts.

- Right-click on a part/selection of parts/model in the Real-time View and select Hide Part/Selection/Model.
- Use the hotkey modifier Ctrl+Alt+Click (windows) and Cmd+Alt+Click (mac)
- Click the icon in the Scene Tree.

A single part/selection of parts can be isolated, by clicking Show Only in the context menu. This will hide all other parts in the scene (except locked parts).

Showing Parts

To display a hidden part,

- Right-click in the Real-time View and select Undo Hide.
- Click the icon in the Scene Tree.

You can also bring back all previously hidden parts by selecting Show All Parts in the Real-time View context menu.
Moving Models and Parts

You can move your translate, rotate and scale your part/model in 2 ways, either via the Move tool or via the position settings for the selected of the model/part below the Scene Tree in the Scene tab of the Project panel.

**Move tool**

The move tool can be triggered in different ways:

- Right-click a selected part/model in the **Scene Tree** and choose **Move**.
- Right-click a part in the **Real-Time View** and choose **Move Selection, Move Part or Move Model**, depending on what you want to move.
- Click the **Move** button in the **Tools** section of the **Ribbon** or in the **Scene** tab of the **Project Panel**. If no part(s) are selected, this will trigger a dialog, where you can choose which part(s) you want to move.
- Use the hotkey Ctrl+D on Windows and Cmd+D on Mac. If no part(s) are selected, this will trigger a dialog, where you can choose which part(s) you want to move.

Learn more about the **Move tool**.

**Scene tree - Position**

**Translation XYZ**

Determines the center position of the selected part or group.

**Rotation XYZ**

Sets the object’s rotation on each of the axes. This uses the local coordinates.

**Scale XYZ**

Enables you to scale the object on each or all of the axes. This factor is relative to the current uniform scale factor.

**Scale slider**

Uniform scaling of the object. The factor is relative to the size the object had when it was imported into the scene.

**Snap to Ground**

The Snap to Ground quickly moves the model in the Y-direction (up-down), to snap the lowest point on the models bounding box to the ground plane. This is useful when the model has been moved and is no longer touching the ground plane.

**Center**

Center will reposition your object so it is centered on the X and Z axes, but will not affect the Y position.

**Reset**

Reset will undo all transformations on the element and reset to the original values the item had in the imported model. Notice that the positioning can be applied on both part and group level. Resetting will only apply to the currently selected level.

**Copy/Paste position**

This enables you to copy the position, rotation and scale from one object to another.
Note:
When importing a model into your scene the position is set on the group (model) level. This will be positioned in the center of the scene. If you want the position the model was created in, relative to 0, just select the model and hit Reset.
Duplicating Models/Parts

**Duplicate entire Models/groups**

1. Select the Model/Group(s) in the Scene Tree
2. Right click and select Duplicate.

This action duplicates the model along with any assigned materials and animations, to the same level in the Scene Tree.

**Duplicate part or selection of parts**

This can be done both in the Real-time View and the Scene Tree

1. Select the part(s) you want to duplicate
2. Right click and select Duplicate/Duplicate Selection

This will duplicate each part into the group where their original is located.

**Hotkey**

Finally there is a hotkey for duplicating (Ctrl+W/Cmd+W), which will duplicate the selection as described above.

**Tip:** If you want a copy of the entire model, maybe to try out model variations - take a look at Model Sets.
Pattern Tool

The Pattern Tool allows you to create instances of models instead of duplicates, which increases speed and decreases file size.

Right click a model in the Scene Tree, and select Make Pattern to open the Pattern Tool dialog.

Linear pattern

Instances (Linear)
This allows you to set how many instances are created along the X, Y, and Z axes.

Spacing (Linear)
This allows you to set the spacing of the instances for X, Y, and Z.

Rotate Objects
Instances can be rotated along the Y of each local access to dynamically position them in the scene. Use this field to choose how far instances will be rotated along the Y axis.

Scattering

Use this to randomly place patterned objects. useful for scenes where a more random distribution of objects is desired.

Displacement
This controls the amount of deviation occurs from the original pattern matrix.

Y Rotation
This changes the amount an object is randomly rotated by in the Y axis.

Center
Centers the pattern to the scene.

Resize Environment
Automatically increase the environment size to accommodate all instances.

Adjust Camera
Enable this to have the camera automatically shift to include all instance within the field of view.
Circular pattern

**Count**
This allows you to set how many instances are arrayed around an axis.

**Radius**
This allows you to set the distance from the instances to center or pattern axis.
Fill Angle
The angle at which to array the instances. 360 is a full circle.

Rotate Objects
Instances can be rotated along the Y of each local access to dynamically position them in the scene. Use this field to choose how far instances will be rotated along the Y axis.

Scattering
Use this to randomly place patterned objects. useful for scenes where a more random distribution of objects is desired.

Radial
This determines how much the instances may differ from the given radius.

Angular
This determines how much the instance-angle may differ from the default position on the given Fill Angle.

Y Rotation
This changes the amount an object is randomly rotated by in the Y axis.

Center
Centers the pattern to the scene.

Resize Environment
Automatically increase the environment size to accommodate all instances.

Adjust Camera
Enable this to have the camera automatically shift to include all instance within the field of view.

Tip
When you are cloning parts/groups with the Pattern Tool, all materials will be duplicated by default. If you want to link all material instances, you can check the Link materials of duplicate parts options in the Interface section of your Preferences, prior to creating your pattern.

Editing Patterns
In the scene tree, right click on patterned object and select "edit pattern" to open the Pattern window where you can make changes to the pattern.
Rounded Edges

The Rounded Edges feature allows you to simulate fillets on parts, without actually altering the geometry in your modelling software and thus causing an increase of triangle-count.

The adjustment sliders can be accessed by selecting one or more part-level objects in the Scene Tree, which will then display the Rounded Edges accordion in the Properties sub-tab below.

Radius

The *Radius* slider is unit-aware to your Scene Units. Because it is a simulated effect, you will experience the best results if you keep this value low.

Minimum Edge Angle

The Minimum Edge Angle slider allows you to limit Rounded Edges to corners greater than the set degree value.
Revision Manager

Instead of overwriting the BIP file, the Revision Manager will create a serialized backup every time that you save your scene. The result is a .BIP.XX file (where "XX" is the revision index number) every time that you save. This allows you to revert to any saved version of your BIP file or delete revisions that you don't need anymore.

Enable Revision Manager

You enable the Revision manager in Preferences

- **Windows**: Edit > Preferences > General > Backup Revisions
- **Mac**: KeyShot > Preferences > General > Backup Revisions

Manage your revisions

The instructions below assume that you've enabled Backup Revisions, and that you've saved your scene at least twice.

1. With your scene open, go to File > Revision Manager.
   The Revision Manager window appears.
2. From the Revisions list, select the version (revision) of your scene to which you wish to revert. Then, click Revert to selected version.
3. To delete a revision, simply select it and click *Delete old revisions.*
Geometry View

This highly responsive OpenGL secondary viewer complements the Real-time View to add more capabilities and a faster workflow for setting up your scene. Some benefits of the Geometry View are:

- Animations can be played back at a true 1:1 speed.
- A secondary camera can be used to position physical lights easily in a scene.
- Scene transformations and composition setup are faster.
- All Camera Path Animations can be viewed and edited.

Geometry Editor

Note that the Geometry editor has been converted into 4 individual Geometry tools, which can be found in the Tools section of the ribbon or via the context menu in the Real-time View/Scene Tree.

- Edit Normals
- Close Mesh
- Split Object Surface
- Split Separate Objects
Geometry View Settings

On the Geometry View Ribbon, click on the gear icon to access the Geometry View Settings panel.

**Background Color**
Select the background color of the Geometry View.

**Checkboxes**
Click each checkbox to toggle the display of the different elements in the Geometry View.

**MatCap**
Add/Refresh/Delete image file to use for MatCap shading of the Geometry View.
To activate the MatCap shading see Display Style.
# Display Style

On the Geometry View Ribbon, click on the Display Style dropdown to change the Display Style of models in the Geometry View. The style choices are: Shaded, Flat, Shaded Wireframe, Wireframe, or Bounding.

<table>
<thead>
<tr>
<th>Shaded</th>
<th><img src="image" alt="Shaded Display State" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>The Shaded Display State displays the geometry with solid colors and shaded areas.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Flat</th>
<th><img src="image" alt="Flat Display State" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>The Flat Display State displays the geometry with solid colors and no shading.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Shaded Wireframe</th>
<th><img src="image" alt="Shaded Wireframe Display State" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>The Shaded Wireframe Display State displays the geometry with solid colors and shaded areas with the geometry wireframe on top.</td>
<td></td>
</tr>
</tbody>
</table>

On this page
- Shaded
- Flat
- Shaded Wireframe
- Wireframe
- Bounding Box
- MatCap
- MatCap+Color
### Wireframe

The Wireframe Display State displays the geometry with only a representation of the wireframe.

![Wireframe Image](image1)

### Bounding Box

The Bound Box Display State displays the geometry with wireframe box representations of the extents of the model and part geometry.

![Bounding Box Image](image2)

### MatCap

The MatCap Display State displays the geometry with a MatCap shading. If you want to use another MatCap this can be set via Geometry View Settings.

![MatCap Image](image3)
**MatCap+Color**

The MatCap Display State displays the geometry with a MatCap shading, where the colors of the objects also are displayed.
Camera Type

The Camera Type options change the view mode in the Geometry View.

Choose Camera type

From the Camera Type drop-down, choose a camera from these available options—Active Camera, Perspective, or Orthographic.

Active Camera

The Active Camera option changes the view mode to display what is seen in the frame of the current active camera. This is the camera that is active in the Real-Time View as well. This allows you to adjust the camera just as you would in the Real-time View.

Perspective

The Perspective option changes the view mode to display a perspective view of the entire scene.

Orthographic

The Orthographic option changes the view mode to display an orthographic view of the entire scene.

Controlling the Active camera

When you use the Perspective or Orthographic camera inside the Geometry View, you can control the Active Camera of the Real-Time View. As the camera is moved in the Geometry View, the Real-time View and camera properties in the Project window update as well. The active camera is highlighted in red, while any other cameras in the scene are gray. You can switch to a camera by clicking it. If a camera is locked, you will need to right-click and select Unlock Camera to unlock the camera prior to moving it.

The Active Camera can be manipulated with a move tool inside the Geometry View. This feature makes positioning cameras in interiors much easier.

Move Active Camera Position

This changes the actual position of the camera. With the camera unlocked, right-click in the Geometry View and select Move Active Camera Position. Use the Move Tool to change the position.

- **Show**: Toggle the visibility of the Translation and Rotation handles.
- **Keep View Direction**: When Keep View Direction is on, the translation will move the camera parallel to the field of view, and not pivot the camera target which is the default behavior.
- **Axis**: Select Local or Global axis as the base of the Translation. Note that Rotation can only be done based on the Local scale.
**Move Active Camera Target**

This changes the 'look at' point of the camera. With the camera unlocked, right-click in the Geometry View and select *Move Active Camera Target*. The Move Tool will appear on the Camera Target. Use the Move Tool to change the position.

- **Keep View Direction**: When *Keep View Direction* is on, the translation will move both the camera and camera target, and not pivot the camera which is the default behavior.

**Saving Active Camera Changes**

Any changes you have made to a camera are still *unsaved* and will be reset if you switch camera.

Right-click and select Save Camera to update the current camera position or target, or select Add Camera to create a new camera. The new camera will appear in the Project window, Camera tab where the camera changes may be saved or added as well.
Standard Views

From the Standard Views dropdown, you can also select a display orientation of Front, Back, Left, Right, Top, Bottom or Isometric.

**Note**
Selecting a Standard View when the Active Camera Type is selected will also update the Real-Time View.

Choose the Perspective or Orthographic Camera Type to unlink the real-time viewing mode from the Geometry View allowing you to control the two views independently of each other. However, you will still see the real-time movement and position of the active camera.
Model Sets

Model Sets allow you to save independent Scene Tree variations in a single .bip file.

The Model Sets interface is located in the Project > Scene tab as a sidebar on the left side of the panel.

When a Model Set is selected in the sidebar its properties will be displayed in the sub-tab below and the contained Models will be listed in the Scene Tree.

- **Show/Hide**: Visibility of Model Sets can be toggled via the checkbox in the sidebar or by right-clicking and selecting Make Model Set Active. More than one Model Set can be active at a time.
- **Switch**: Double-clicking a Model Set in the sidebar will make it active and deactivate all others (except Always Visible).
- **Lock/Unlock**: Locking a Model Set will lock all contained models and parts.
- **Reorder**: Model Sets can be reordered by drag-and-drop in the sidebar list.
- **Rename**: Model Sets can be renamed via the right-click menu in the sidebar or in the Model Set properties sub-tab.
- **Always Visible**: Model Sets can be set to Always Visible via the right-click menu in the sidebar or in the Model Set properties sub-tab. This will hide the checkbox in the sidebar. This is mostly useful for staging geometry such as a ground plane or props.

Adding Model Sets

A new Model Set can be added by clicking the Add Model Set icon above the Model Sets sidebar, which will launch the Add Model Set dialog. Here you can give it a name, specify some options and see an overview of the models to be cloned into the new Model Set.

You can also access this dialog by selecting the models/parts in the Scene Tree you wish to include in the new Model Set > right-click and select Create Model Set from Selection.

Model Set Preview Thumbnails

A preview thumbnail will automatically be generated at the time of creation based on what is currently visible in the Real-time view.

**Render Preview**: The preview thumbnail can be manually generated at any time by clicking the Render Preview button in the Model Set properties tab, via the right-click menu in the Model Sets sidebar or via the icon above the Model Sets sidebar.

**Thumbnail Size**: Also available via the icon is the ability to select the size of the thumbnails that are displayed in the sidebar or the option to not show them at all.

**Thumbnail Render Settings**:

- **Samples**: number of samples used to render the thumbnails and enable
- **Center and Fit**: If you wish to use the current camera for the thumbnail preview make sure Center and Fit is disabled.
- **Render High Res**: If you are using the Configurator and wish to display your Model variation thumbnails larger than 256px you will have to select Thumbnail Render Settings from the settings drop-down menu and enable "Render High Res".
Export

There are three primary methods for generating output from KeyShot.

1. Screenshots

A screenshot of the Real-time View can be generated by selecting the Screenshot button on the Toolbar or by hitting the P-key. Screenshots will by default be saved in your Resources/Renderings folder. If you want to store your screenshots elsewhere you can check the Ask where to save each screenshot option Preferences, where you also can select the output format and select if you want to save a camera when you take a screenshot and if you want to output metadata as well. Finally you can use the option to Copy screenshot to clipboard in the Main Menu>Render.

File format output:
- JPEG
- PNG

2. Render Output

KeyShot can create still images, animations, and interactive web visuals with unlimited resolution. Learn more about render output options here.

File format output:

<table>
<thead>
<tr>
<th>Still Images</th>
<th>Animations 2</th>
<th>KeyShotXR 3</th>
<th>Configurator 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Output</td>
<td>Video Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JPEG</td>
<td>AVI (MPEG4)</td>
<td>JPEG</td>
<td></td>
</tr>
<tr>
<td>TIFF 1 (8bit)</td>
<td>AVI (Uncompressed)</td>
<td>PNG*</td>
<td></td>
</tr>
<tr>
<td>TIFF 1 (32bit)</td>
<td>Quicktime (MPEG4)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXR 1 (32 bit)</td>
<td>Quicktime (Uncompressed)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSD 1,2</td>
<td>Flash Video</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSD (32 bit)1,2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame Output</td>
<td>Supporting Files</td>
<td>Other</td>
<td></td>
</tr>
<tr>
<td>JPEG</td>
<td>HTML</td>
<td>iBook</td>
<td></td>
</tr>
<tr>
<td>TIFF 1 (8bit)</td>
<td>JS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIFF (32bit)1</td>
<td>PNG</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXR (32 bit)1</td>
<td>PSD 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PNG 1</td>
<td>PSD (32 bit)1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1 Alpha channel option
2 Requires KeyShot Pro
3 Requires the KeyShotWeb add-on

3. Export Options
KeyShot Pro adds additional 3D output options to extend operations for specific workflows. The export options can be found in the KeyShot File menu.

File format output:

- **OBJ** - A simple, but ubiquitously supported 3D format.
- **FBX** - Widely supported 3D format owned by Autodesk.
- **GLB/GLTF** - "The jpeg of 3D". Designed to bridge the gap between 3D content creation tools and modern 3D applications. See the following guides for additional information on working with glTF data: [GLB Tutorials on Facebook](https://www.facebook.com)
- **STL** - A common 3D format mostly used in 3D printing.
- **ZPR (Windows only)** - A 3d format developed by Z Corporation. Used in 3D printing.

**Note**
The GLTF format does not support following material types: Flat, Thin Film, Translucent, Advanced, Anisotropic, Gem.
Library Models

In the **Models tab** in the Library panel you can find Models, which you can easily add to your scene. These can be everything from primitive geometry and regular products to entire scenarios, with lighting ad cameras, where you can display your product in context. **KeyShot Cloud** also offers a bunch of models just waiting for you to download.

**Adding Model resources to your scene**

From the local library you can add models in 3 ways.

- **Drag and drop:** When you drag and drop, a bounding box will show you the size of the model. You can drag it round in the scene and drop it exactly where it suits you.
- **Double click:** When you double click a model in the library, it will be added to the center of your scene, placed on the ground plane.
- **Context menu:** If you right click a model in the library, you can select **Add to scene**. This will also add the model to the center of your scene, placed on the ground plane.

From **KeyShot Cloud** you can also add models by drag and drop onto the Real-time View. Alternatively you can download the models and add them from the local library. In both cases the model will be added to the downloads folder in the library, from where you can drag it to the relevant folder.

**Create your own model resources**

You can also populate the model library with your **own models**, either by **import** or via **Add to library**, which will create a resource based on the current scene.

![Add Model to Library from scene](image)

**Add to library**

- **Name:** Give the the name you want it to be listed under in the library
- **Folder:** Select where in the model library to store the resource.
- **Include:** When you create your own models for the library, you can select what to include in the resource.
  - **Geometry:** if you select to include geometry, you can choose which Model Sets you want included. By default all visible Model Sets are selected
  - **NURBS:** If your scene contains NURBS data you can choose to strip it in order to save space
  - **Cameras:** Select if you want to include cameras in the resource.
  - **Environments:** Select if you want to include environments in the resource
  - **Image styles:** Select if you want to include Image styles in the resource
  - **Studios:** if you select to include studios with your resource, notice that it will only include cameras/environments/image styles that are also included in the resource.
  - **Animations:** If the scene contains animations you can choose to include those in the model. Notice that if you choose not to include geometry/cameras, related animations will not be included either.
Deleting Models from the library

You can always delete a model from your library by right-clicking the item in the list and selecting *Delete*. Models and the used textures/backplates etc. are stored in self-containing folders in the general Models folder. This means that if you choose to delete a model from your library, all associated resources will also be deleted. So if you want to reuse e.g. a texture from a model it is a good idea to save it in the texture folder and apply it from there or save the new scene as .ksp otherwise you might run into missing resources.

Model library hotkeys

In earlier versions of KeyShot you had the option to add Primitives from the *Main menu > Edit > Add Geometry*. These are now included in the Model library in the Geometry folder. There are 10 hotkeys (ctrl/cmd+0-9) available for easy adding of models. These are by default applied to the first 10 Primitives in the Geometry folder (sorted by a-z).

If you add a model to the Geometry folder it will also be included in the automatic hotkey assignment.

If you want to circumvent the alphabetical assigning of hotkeys or if you want to assign a hotkey to a model outside the Geometry folder you can right-click the model and select *Assign Hotkey*, now you can tie one of the 10 hotkeys to the model, and it will appear in the Add geometry list.

Tip: Create start-up studios with models

If you want to use the same camera angles, environments and studios for a series of products you can create a Model with no or prop-only geometry which you can easily use across various scenes.
Materials

The sections here cover where to find materials, how to work with materials, common material parameters, and all of the material types and their parameters. Since KeyShot is designed for anyone to create realistic visuals, an understanding of these concepts is not necessary, but can help you gain a deeper understanding of how rendering and material creation work.

In this section
- Material Library
- Assigning Materials
- Editing Materials
- Copying Materials
- Saving Materials
- In-Project Library
- General Parameters
- Material Types
- Color Library
- Color Picker
- Material Graph
- Multi-Materials
Material Library

Material presets are found in the KeyShot Library, Material tab.

The material presets you see are all created using a KeyShot Material Type. Each library material has been designed to be easy to use with as few parameters as needed. For example, the Metal library materials use the Metal material type and will only display the parameters needed for metal materials. Likewise, the Plastic library materials use the Plastic material type will have only the parameters needed for plastic materials.

Stock Materials

KeyShot ships with 750+ materials ranging from cloths and leathers to metals, plastic and even smoke. The materials are arranged in folders:

- **Library Updates**
The KeyShot Library has been updated to take advantage of the latest KeyShot material, texture and environment capabilities. Learn more about the new updates here.

Custom Materials

You can create your own materials use the library materials as a starting point to edit, copy and save your own materials.

Import Materials

You can import materials into the library directly (MTL, KMP, AxF and U3M) or use the Material Importer in the Tools section.

When importing into the library directly, select the folder you want to import into, press the Import icon and select the file you want to import.

KeyShot Cloud Materials

Thousands of KeyShot materials generated by Luxion, KeyShot partners and KeyShot users are available on KeyShot Cloud. You can access KeyShot Cloud from the far left side of the KeyShot Toolbar or at https://cloud.keyshot.com. Learn more about KeyShot Cloud here.

Additional Materials

A KeyShot Content installer is available for KeyShot 8 users on both Windows and Mac. The installer contains high-quality materials with textures from Poliigon that have been excluded form the regular Keyshot installer because of their size. ...The materials in the Installer are the same as offered in the Content installer for KeyShot 7 and KeyShot 8, but they have been updated to take full advantage of the improvements to KeyShot 9 materials....

Download the installer here:
- KeyShot 9 Content (Win) 745 MB
- KeyShot 9 Content (Mac) 745 MB

Content Installation
After downloading, run the installer. During installation, the new resources will be added to your KeyShot Resource folder and visible in the KeyShot library, Materials tab next time KeyShot is launched. The new Poligon folder will be added to your Materials folder.

**Note**
If you installed the Poligon material pack in KeyShot 7/8 and chose to migrate your resources to KeyShot 9. The Poligon materials will only be overwritten with the new version, if the folder has been moved from the migration folder to the root of the Material library at the time you install the KeyShot 8 Content pack - Otherwise you will have 2 versions of the "same" material.
Poliigon Textured Materials

Poliigon textures in KeyShot are encrypted and can only be used inside KeyShot. Below is a cross-reference for all KeyShot Materials using Poliigon textures. If you need the textures for other purposes.

<table>
<thead>
<tr>
<th>Folder</th>
<th>KeyShot Material Name</th>
<th>Poliigon Texture Name</th>
<th>Poliigon Texture Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bricks</td>
<td>Poliigon - Bricks Grey 1,</td>
<td>Bricks 03</td>
<td><a href="https://www.poliigon.com/texture/50">https://www.poliigon.com/texture/50</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Bricks Grey 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Bricks Red 1,</td>
<td>Bricks 02</td>
<td><a href="https://www.poliigon.com/texture/49">https://www.poliigon.com/texture/49</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Bricks Red 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Concrete</td>
<td>Poliigon - Concrete Pitted 1,</td>
<td>Concrete 24</td>
<td><a href="https://www.poliigon.com/texture/186">https://www.poliigon.com/texture/186</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Pitted 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Plates 1,</td>
<td>Concrete Plates 01</td>
<td><a href="https://www.poliigon.com/texture/207">https://www.poliigon.com/texture/207</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Plates 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Spots 1,</td>
<td>Concrete 03</td>
<td><a href="https://www.poliigon.com/texture/165">https://www.poliigon.com/texture/165</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Spots 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Stripes 1,</td>
<td>Concrete 04</td>
<td><a href="https://www.poliigon.com/texture/166">https://www.poliigon.com/texture/166</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Stripes 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Textured 1,</td>
<td>Concrete 36</td>
<td><a href="https://www.poliigon.com/texture/198">https://www.poliigon.com/texture/198</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Textured 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Grunge Wall 1,</td>
<td>Grunge Wall 039</td>
<td><a href="https://www.poliigon.com/texture/959">https://www.poliigon.com/texture/959</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Grunge Wall 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stone</td>
<td>Poliigon - Granite,</td>
<td>Marble 40</td>
<td><a href="https://www.poliigon.com/texture/1125">https://www.poliigon.com/texture/1125</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Granite Shiny</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Marble</td>
<td>Marble 11</td>
<td><a href="https://www.poliigon.com/texture/1096">https://www.poliigon.com/texture/1096</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Solid Surface Countertop 1,</td>
<td>Tiles 19</td>
<td><a href="https://www.poliigon.com/texture/1661">https://www.poliigon.com/texture/1661</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Solid Surface Countertop 1 Shiny,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Solid Surface Countertop 2,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Solid Surface Countertop 2 Shiny</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
<td>Reference Code</td>
<td>URL</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------</td>
<td>----------------</td>
<td>----------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Plaster</strong></td>
<td>Plaster 1, Plaster 2</td>
<td>Plaster 35</td>
<td><a href="https://www.poliigon.com/texture/1402">https://www.poliigon.com/texture/1402</a></td>
</tr>
<tr>
<td><strong>Tiles</strong></td>
<td>Poligon - Tiles Marble White, Poligon - Tiles Marble White 2</td>
<td>Tiles Rectangular Marble 001</td>
<td><a href="https://www.poliigon.com/texture/2303">https://www.poliigon.com/texture/2303</a></td>
</tr>
<tr>
<td></td>
<td>Poligon - Tiles Polished Black</td>
<td>Rectangular Mirror Black 001</td>
<td><a href="https://www.poliigon.com/texture/2304">https://www.poliigon.com/texture/2304</a></td>
</tr>
<tr>
<td></td>
<td>Poligon - Tiles Polished White</td>
<td>Rectangular Mirror White 001</td>
<td><a href="https://www.poliigon.com/texture/2308">https://www.poliigon.com/texture/2308</a></td>
</tr>
<tr>
<td></td>
<td>Poligon - Tiles Rectangular Brushed,</td>
<td>Rectangular Brushed 001</td>
<td><a href="https://www.poliigon.com/texture/2299">https://www.poliigon.com/texture/2299</a></td>
</tr>
<tr>
<td></td>
<td>Poligon - Tiles Rectangular Brushed Shiny</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poligon - Wood Flooring Dark Neutral,</td>
<td>Wood Flooring 067</td>
<td><a href="https://www.poliigon.com/texture/2267">https://www.poliigon.com/texture/2267</a></td>
</tr>
<tr>
<td></td>
<td>Poligon - Wood Flooring Dark Neutral Shiny</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Fabric</strong></td>
<td>Poligon - Linen 1, Poligon - Linen 2</td>
<td>Fabric Linen 001</td>
<td><a href="https://www.poliigon.com/texture/241">https://www.poliigon.com/texture/241</a></td>
</tr>
<tr>
<td>Material</td>
<td>Name</td>
<td>Fabric ID</td>
<td>URL</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------</td>
<td>-----------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Poligon - Wool Basic 1,</td>
<td>Fabric Wool 002</td>
<td></td>
<td><a href="https://www.poliigon.com/texture/249">https://www.poliigon.com/texture/249</a></td>
</tr>
<tr>
<td>Poligon - Wool Basic 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Wool Woven 1,</td>
<td>Fabric Wool 001</td>
<td></td>
<td><a href="https://www.poliigon.com/texture/248">https://www.poliigon.com/texture/248</a></td>
</tr>
<tr>
<td>Poligon - Wool Woven 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Ash natural Shiny</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Ash Dark,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Ash Dark Shiny</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Beech,</td>
<td>Wood Flooring 063</td>
<td></td>
<td><a href="https://www.poliigon.com/texture/2218">https://www.poliigon.com/texture/2218</a></td>
</tr>
<tr>
<td>Poligon - Beech Shiny</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Birch,</td>
<td>Wood Flooring 064</td>
<td></td>
<td><a href="https://www.poliigon.com/texture/2219">https://www.poliigon.com/texture/2219</a></td>
</tr>
<tr>
<td>Poligon - Birch Shiny</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Cherry 1,</td>
<td>Wood Fine 11</td>
<td></td>
<td><a href="https://www.poliigon.com/texture/1692">https://www.poliigon.com/texture/1692</a></td>
</tr>
<tr>
<td>Poligon - Cherry 1 Shiny,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Cherry 2,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Cherry 2 Shiny</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Oriented Strand Board (OSB) 1,</td>
<td>Wood Fine 28</td>
<td></td>
<td><a href="https://www.poliigon.com/texture/1709">https://www.poliigon.com/texture/1709</a></td>
</tr>
<tr>
<td>Poligon - Oriented Strand Board (OSB) 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Plywood Old 1,</td>
<td>Wood Fine 01</td>
<td></td>
<td><a href="https://www.poliigon.com/texture/1682">https://www.poliigon.com/texture/1682</a></td>
</tr>
<tr>
<td>Poligon - Plywood Old 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Plywood Side 1,</td>
<td>Wood Fine 04</td>
<td></td>
<td><a href="https://www.poliigon.com/texture/1685">https://www.poliigon.com/texture/1685</a></td>
</tr>
<tr>
<td>Poligon - Plywood Side 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Walnut Dark,</td>
<td>Wood Fine 14</td>
<td></td>
<td><a href="https://www.poliigon.com/texture/1695">https://www.poliigon.com/texture/1695</a></td>
</tr>
<tr>
<td>Poligon - Walnut Dark Shiny</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Walnut Light,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Walnut Light Shiny</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Assigning Materials

To assign materials to models, drag and drop them from the *Materials* library onto a part in the *Real-time View* or in the *Scene Tree*. Before you drop the material onto the part, you will see a preview of the material on the part beneath the mouse cursor. The material will not be assigned until you let go of the left mouse button.

Once the material has been loaded from the library, a copy will be placed into the *In-Project Library* in the *Material Tab* of the *Project Window*. Any additional materials assigned to the model will also be added to the *In-Project Library*. If the same material already exists in the *In-Project Library*, a copy will be created and a number will be appended to that material.

### Linked Materials

In some cases a user may want to have one material assigned to multiple parts to be able to make changes to that material, and to have the changes affect all parts. You can add Linked Materials in 3 ways:

- Drag an existing material from the *In-Project library* onto the parts you want linked.
- Copy a material by selecting a part in the *Real-time View* with the desired material, right-click and choose *Copy Material* > Select the part you want linked, right-click and choose *Paste Linked Material*.
- Drag the same material from the *Material Library* repeatedly and KeyShot will ask if you want to link the materials.

You can unlink materials by right-clicking on the part and choosing *Unlink Material* - this will create a numbered copy of the material in the *In-Project Library*.

### Multi-Materials

Users of KeyShot Pro can create/add to Multi-materials by pressing Shift while dropping materials from the library onto a part.

### Retaining Textures and Labels

If you are dragging a material onto a part that has an existing texture or label, you can retain them and apply them to the new material by holding Alt for textures, or Ctrl for labels.
Editing Materials

There are multiple methods of navigating to the material properties to make changes, but all editing is done in the Material Tab of the Project Window.

You can access the Material Properties using any of the follow four methods:

1. Double-click a part on a model in the Real-time View.
2. Double-click the material thumbnail in the In-Project Library.
3. Right-click a part in the scene tree and select Edit Material.
4. Select the part in the Scene Tree and select Edit Material from the Properties pane.

Any of these methods will activate the Project window, Material, Properties for the material assigned to the part. All material edits made will update interactively in the Real-time View. For more detailed information on material settings and types please see the Material Types.

If you are a KeyShot Pro user you can also use the Material Graph for editing the materials.
Copying Materials

When Copying materials it is important to decide if you want separate versions of the same materials or if the materials should be linked.

Linked Materials

When two parts have a linked material any edits made to the material will affect all parts.

There are several methods of copying and pasting materials you want to be linked

- Press “Shift + Left Click” on a material assigned to a model. That will copy the material. Next, to paste the material, press “Shift + Right Click” on another part. That will copy the same material from the In-Project Library and paste it to another part. this will paste the material as a linked material.
- Drag and drop a material from the In-Project Library onto a part that does not already have that material assigned.
- Right-click a part and select Copy Material in the context menu. Right-click another part and select Paste Linked Material.

Separate Materials

Every time you apply materials that are not linked, an instanced copy of the material will be created in the In-Project Library.

- Press “Shift + Left Click” on a material assigned to a model. That will copy the material. Next, to paste the material, press “Shift + Alt + Right Click” on another part. That will copy the material in the In-Project Library and paste it to another part.
- Drag and drop a material from the Material Library on different parts, Keyshot will ask if you want to link.
- Right-click a part and select Copy Material in the context menu. Right-click another part and select Paste Material.

Hotkeys

Shift + Left Click – Copy Material (Select Material)
Shift + Right Click – Paste Linked Material (Apply material)
Shift+ Alt + Right Click – Paste Material (Apply Copy)
Saving Materials

There are two ways to save materials.

- Right-click a material directly on the model and select Add Material to Library.
- Click the Save to Library icon on the Material Tab in the Project Window.

Once you have gone through either step, a dialogue will prompt you to designate a destination folder in the material library. After the folder location has been selected, the new material will be saved to the library.

Note

You can create your own folder to save custom materials. Simply click the add folder icon in the Material Library.
In-Project Library

The “In-Project Library” is found in the lower half of the Scene tab (under materials) and in the Material tab below the properties of the current material. Here all materials in the scene will be represented in the form of material ball thumbnails or in a list view.

When a material is pulled from the material library and assigned to a model, a copy of that material is placed in the In-Project Library. If the material is already present in the scene you will be asked if you want to link the materials. If you say no, an instanced version of the material will be added to the In-Project library.

If a material is no longer being used in the scene, it will be automatically removed from the In-Project Library. For example, if a material is assigned to only one part and a new material is assigned to that part, the previous material will be removed from the “In-Project Library” since it is no longer used in the scene.

Multi-Materials (pro feature) will be labeled for easy discovery.

Below the material thumbnails you can select list/grid view, set the thumbnail size and choose to filter what is shown in the In-Project Library.

Material View

The In-Project library in the material tab also has a Material View option. This will show the structure of advanced materials, created in KeyShot Pro, and allows you to adjust the effects of the nodes even if you are not a KeyShot Pro user.

In this example you see the properties of the displaced ground material in the displacement.bip demo scene which is bundled with KeyShot 9.
General Parameters

Each material has its own set of parameters, which can be adjusted to get the exact appearance you are going for.

Some parameters are the same across the material types, these are described in this section.

- Diffuse Parameter
- Specular Parameter
- Refractive Index
- Roughness Parameter

The rest of the parameters will be described in the Material Types section.
Diffuse Parameter

The Diffuse parameter will be found throughout many of the material types.

The most basic way to think of diffuse when working in KeyShot is a material's overall color. However, there is a more technical explanation of what this is that can help when creating materials “scattered” or “spread out.”

Diffuse in the rendering world refers to how light reflects off of materials. Depending on the surface of a material, light rays will behave differently when they hit the surface. If a surface has few or no imperfections, like a polished surface, light rays will bounce straight off. This will produce a shiny or reflective surface. If the surface has many imperfections, like concrete, light rays will be scattered across the surface creating a matte look. This is why concrete is not reflective or shiny.

The diffuse slider on many materials will control the color of the diffuse rays on a material.
Specular Parameter

The *Specular* parameter is another parameter that will be found with many material types.

Specular reflections are reflections that are bounced off a material surface without scattering. Materials appear reflective or shiny when a surface is polished and has few to no imperfections. When the specular color is set to black, a material will have no specular reflections and will not appear reflective or shiny.

Specular color set to white will give 100% reflectivity for that material. Metals do not have diffuse color so any color will be derived entirely from the specular color. The specular color of plastics should be set to a grayscale value.

The specular parameter will control the color and intensity of the specular light reflections on a material.

![Diagram of light rays and specular reflections](image-url)
Refractive Index

Refractive Index is a material parameter that is found in multiple KeyShot material types. The term might not be familiar, but refraction is something that is seen every day. A good example is when a person sticks their hand in a pool. The light is bent, or “refracted” and the arm looks broken.

Refraction occurs because light travels through different media at different speeds. This reduction in speed is referred to as a material’s refractive index (or index of refraction) and is represented by a number. For example, water has an index of refraction of 1.33, glass has an index of refraction of 1.5 and diamonds have an index of refraction of 2.4. This means that light travels through water 1.33 times slower than it does through a vacuum. Light travels through glass 1.5 times slower, through diamonds 2.4 times slower and so on. The slower light travels, the more it is bent and distorted.

Refractive indices for different materials can be easily found online. Once the value is found, it may be entered into the Refractive Index property of a material, and will be accurately represented in KeyShot.

Caustics

Caustics is the pattern of light and color that occur when light rays are refracted or reflected. In
everyday life you encounter caustics when you for example place a glass of water on a table.

**Known issues**
Caustics will now work inherently with volumes (e.g. scattering media), however, caustics will only be applied to light sources outside the volume and this is only supported in interior mode.
**Roughness Parameter**

The *Roughness* parameter is another setting that will be found on multiple material types in KeyShot. This is a slider that will add microscopic levels of imperfections to surfaces to create rough materials. The diagram that explains the Diffuse parameter can also help explain why materials appear rough. When roughness is added, light rays are scattered across the surface which causes specular reflections to break up. Due to the additional light scattering, rough materials are more challenging and take more processing power to render than perfectly reflective surfaces.

**Samples**

Since glossy materials with some roughness are more complex to render, KeyShot has a setting built in that can improve the accuracy of these rough materials. This setting is called *Samples*. This allows you to set how many rays are emitted from a pixel in a rendered image. Each ray collects information from its surrounding environment and returns this information back to the pixel to determine the final appearance. You will see the *Samples* slider when you click the expand arrow next to the *Roughness* slider.

**Note**

Interior Mode uses a different and more intelligent approach to samples than the one Product mode uses. The improved approach means that customization of *Samples* only has effect in Product Mode as it is not necessary in Interior Mode.

**Roughness Texture**

If the Roughness parameter has a checkered box next to it, this means a texture can be applied.
to control the glossy appearance of the surface. When a texture is applied, dark areas of the texture will have a glossy appearance and white areas of the texture will have a matte appearance.

Read more on the difference between Roughness Textures and Bump Maps here.
Material Types

Material Types bring the power to quickly apply real world, physically accurate material properties to your parts. Each Material Type comes preset with settings to quickly apply or change material with the option to adjust each setting as desired. There are five categories of KeyShot Material Types:

<table>
<thead>
<tr>
<th>Basic</th>
<th>Advanced</th>
<th>Light Sources</th>
<th>Special</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Diffuse</td>
<td>• Advanced</td>
<td>• Area Light</td>
<td>• Cutaway</td>
<td>• Axalta Paint</td>
</tr>
<tr>
<td>• Flat</td>
<td>• Anisotropic</td>
<td>• Point Light</td>
<td>• Emissive</td>
<td></td>
</tr>
<tr>
<td>• Glass</td>
<td>• Dielectric</td>
<td>• IES Light</td>
<td>• Ground</td>
<td></td>
</tr>
<tr>
<td>• Glass (Solid)</td>
<td>• Gem</td>
<td>• Spotlight</td>
<td>• Toon</td>
<td></td>
</tr>
<tr>
<td>• Liquid</td>
<td>• Generic</td>
<td></td>
<td>• Wireframe</td>
<td></td>
</tr>
<tr>
<td>• Metal</td>
<td>• Measured</td>
<td></td>
<td>• Xray</td>
<td></td>
</tr>
<tr>
<td>• Paint</td>
<td>• Metallic Paint</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Plastic</td>
<td>• Multi-Layer Optics</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Thin Film</td>
<td>• Plastic (Cloudy)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Translucent</td>
<td>• Plastic (Transparent)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Change material type

This quicktip shows how to change the material type of all parts in the scene in one action. It was made for a previous version of Keyshot, so some elements have changed (e.g. Model Sets) but the overall tip may still be useful.
**Diffuse**

The *Diffuse* material type is useful for easily creating any kind of matte or non-reflective material. It has only one setting, the diffuse color. Since it is an entirely diffuse material, specular maps are not available.

**Color**

This setting controls the color of the diffuse material. Select the color box to display the Color Picker and select the desired color.
Flat

The Flat Material Type is a very simple material type that produces an unshaded, perfectly even color over the entire part to which it is applied.

This material is often used as a black-out material behind car grills or other meshes. It is also useful to create "Clown Pass" areas, which has uniquely colored flat materials applied to the different parts of a model so that these solid colors can be used to easily create selections in an image editing software. See Layers and Passes to automatically create a Clown Pass.

Color
Click the color thumbnail to launch the Color Picker, which allows you to select the color of the material. The flat material has no shading or other surface properties. It will show the solid color you have selected over the entire part that the material is applied to.
Glass

This is a simple Material Type for creating glass materials.

Compared to the **Solid Glass** material, this material type lacks the roughness and color density settings. However, it adds the two-sided option which is very useful when you have a part that is just a single surface (no thickness) and you want to make it reflective and transparent, but not refractive. This is commonly used for car windshields.

**Color**
This sets the overall color of the glass material. Click the color box to open the Color Picker and select your desired color.

**Refractive Index**
This controls how much light will bend or “refract” as it passes through parts that have this type of material. The default of 1.5 is accurate for simulating most types of glass, but you can increase the value to create a more dramatic refraction within the surface.

**Refractive**
This can enable or disable the refractive property of the material. When enabled, the material will appear refractive. When it is disabled, the material will not be refractive. You will see reflections on the surface and the surface will be transparent, but light will not bend as it passes through the surface. Disabling this option is very useful when you want to see things that lay behind a surface without the distorted effect that results from refraction.
Glass (Solid)

The Glass (Solid) Material Type provides a physically accurate glass material. Unlike the simpler glass material type, you will find that solid glass simulates the effect color in the glass accurately as it takes into account the thickness of your model.

Color
This controls the overall color of this material type. When light enters the surface, it will take on the color set here. The amount of color that you see in this material is highly dependent on the transparency setting as well. If you have set a color, but it looks too faint, skip down to the transparency section.

Transparency Distance
(Formerly Color Density) This slider controls the depth of the color selected in the Color setting, depending on the thickness of the part to which the material is applied. After setting a color in the Color setting, use Transparency Distance to make that color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at the color of the shallow water at a beach versus the deep blue of a deep ocean. Without this you would see through to the bottom of the deepest ocean as easily as to the bottom of a swimming pool.

Refractive Index
This controls how much light will bend or "refract" as it passes through parts on your model that have this type of material. The default of 1.5 is accurate for simulating most types of glass, but you can increase the value to create a more dramatic refraction within the surface.

Roughness
Roughness on this type of material will spread out highlights on the surface similar to what you see on other, non-transparent, materials. However, it also spreads out the light that is transmitted through the material. This is used to create a frosted glass look. Expand this parameter and you will see a samples setting. This can be set to a low value to produce a more imperfect/noisy result or to a higher value to smooth out the noise/grain for a smoother frosted look.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.
Liquid

The Liquid Material Type is a variant of the Solid Glass material that has the added ability to set the outside refractive index. This allows you to accurately create surfaces that represent the interface between, for example, a glass container and water. See description here.

Color
This controls the overall color of this material type. When light enters the surface, it will take on the color set here. The amount of color that you see in this material is highly dependent on the transparency setting as well.

Transparency Distance
This slider controls the depth of the color selected in the Color setting, depending on the thickness of the part to which the material is applied. After setting a color in the Color setting, use Transparency Distance to make that color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at the color of the shallow water at a beach versus the deep blue of a deep ocean. Without this you would see through to the bottom of the deepest ocean as easily as to the bottom of a swimming pool.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts that have this type of material.

Advanced

Color Out
This option controls the color of the light on the outside of the material. It is an advanced and complex setting, but it is needed when rendering containers with liquid. In the example of a water glass, you will need to have a dedicated surface for where the liquid and glass meet. On this surface, you should set the color of the glass with the transmission out setting and control the color of the liquid with the transmission setting. If the glass and liquid are both clear, set both transmission and transmission out to white.

Refractive Index Outside
This is an advanced, but powerful, setting that allows you to accurately simulate the interface between two different refracting materials. The most common use for this is when you are working on a container with liquid inside, like a water glass. In such a scene you will need a single surface to represent where the glass and water meet. On this surface, you have the liquid on the “inside” and therefore, you should set the refractive index to 1.33. On the “outside,” you have the glass, and you should set the refractive index outside to 1.5.

Liquid interfaces
Prior to KeyShot 8 you would have to split your liquid geometry and set the refractive index separately in order to produce a good result. Now you can use any material e.g. glass or cloudy plastic to create your liquids. All you have to do is make sure that the liquid and the glass geometry overlap ever so slightly.

Liquid interfaces made with overlapping geometry.
Metal

The Metal material type is a simple way to create polished or rough looking metal materials. It provides quick color adjustment, metal presets and simple settings for quick creation of metal materials.

Metal Type

The Metal material type gives you the option to control the metal by Color or by Measured material preset or complex IOR file.

Color

The Color option provides a quick preset metal appearance with control over Color and Roughness.

Color

This setting is visible when Metal Type is set to Color. This controls the color of reflected light on the metal surface. Select the color box to display the Color Picker and select the desired color.

Roughness

This adds microscopic levels of imperfections to the surface of the material when the values are increased. When this is set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

You can also add a roughness texture by clicking the texture icon next to the roughness setting. Click the texture thumbnail to view and adjust the texture settings or right-click and select Delete to remove it.

Some of the Library materials have a slider icon next to the Roughness setting, in these cases extra adjustment controls have been added for finer tuning of the roughness.

Samples

A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.

Measured

Metal Presets

The Measured option includes 13 scientifically accurate metal presets including Aluminum, Brass, Chromium, Copper, Gold, Iron Magnesium, Nickel, Niobium, Platinum, Silver, Titanium, and Zinc, along with the ability to load Complex IOR files (.ior, .nk, .csv). All metal presets and Custom IOR files provide the additional ability to add an anodized coating with control of Film Refractive Index, Film Extinction Coefficient, and Film Thickness.

Roughness

This adds microscopic levels of imperfections to the surface of the material when the values are increased. When this is set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

Samples

A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.

Anodized

Anodized settings are available for all metal presets selected from the Metal Type dropdown as well as loaded Complex IOR files. The colors you see when Anodized is enabled are the result of light interfering with itself in the anodized film and can therefore be hard to predict the outcome. However, the following setting descriptions will help you learn better how to control it.
**Film Refractive Index**
The *Film Refractive Index* setting for anodized metals provides more or less reflection on the surface. Increase the value to get more reflection intensity. The actual film color will be affected by the *Refractive Index*. However, you can shift the colors with the *Film Thickness* setting, so typically you will focus only on finding the desired amount of reflection with the *Film Refractive Index* setting.

**Film Extinction Coefficient**
The *Film Refractive Index* and *Film Extinction Coefficient* determines how light reflects and refracts through the thin film on the metal. The *Film Extinction Coefficient* controls the absorption of light through the film. For small to moderate values, a positive extinction coefficient will darken the color but large values will lead to a bright white metallic reflection. Use an extinction coefficient of 0 for dielectric coatings and use a non-zero extinction coefficient for metallic coatings.

**Film Thickness**
Changing the *Film Thickness* setting will shift the colors you see for the metal with *Anodized* enabled. Increasing the setting to a very high value will result in the effect of layers of colored rings on the surface. It is generally a good idea to stay within a range of 100-1000 nm.

### Controlling Anodized Color
In general, a larger *Film Thickness/Refractive Index* leads to more colors and an *Film Extinction Coefficient* will darken colors and dampen variation. For all the metal presets, even if anodized is enabled or not, the color can depend on the viewing angle (just as with the color of real-world metals). You will notice slight color tints at grazing angles, especially for Gold and Aluminum.
Paint

The *Paint* Material Type is used when a plain, non-metallic paint appearance is desired. It provides a quick way to set a base color and then control the clear-coat on top.

**Color**

Color is your base layer of paint and the overall color of the material. Click the color thumbnail to open the Color Picker and select your desired color.

**Roughness**

This will add microscopic levels of imperfections to the surface of the material when the values are increased. When this is set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

**Samples**

A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will smooth out and provide a more evenly distributed roughness.

**Refractive Index**

This controls the intensity of the clear-coat. 1.5 is a good general starting point. If a more shiny paint is desired, increase the value. Bringing the value down closer to 1 reduces the clear coat effect. This can be useful for making a matte finish.
Plastic

The Plastic Material Type provides the basic settings needed to create simple plastic materials. Set the diffuse (overall color) and add some specular (reflections), then adjust the roughness. This is a very versatile material type that is used for anything from concrete to woods.

Diffuse
This can be thought of as the overall color of the material. Click the color box to open the Color Picker and select your desired color.

Specular
This is the color and intensity of the reflection of light sources within the scene. Black will completely turn off reflections, while white will provide a very shiny plastic look. Realistic plastic does not have color in the specular value, so generally you should use some level of gray or white. However, adding color can give the plastic material a metallic effect.

Roughness
This will add microscopic levels of imperfections to the surface of the material when the values are increased. When set to 0 a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts that have this type of material. The default of 1.5 is accurate for simulating most types of plastics, but you can increase the value to create a more dramatic refraction within the surface.
Thin Film

The Thin Film material type produces an iridescent effect similar to a soap bubble.

Refractive Index
The Refractive Index setting for Thin Film provides more or less reflection on the surface. Increase the value to get more reflection intensity. The actual colors you see in the thin film will be affected by the Refractive Index. However, you can shift the colors with the Thickness setting, so typically you will focus only on finding the desired amount of reflection with the Refractive Index setting.

Thickness
Changing the Thickness setting will shift the colors that you see on the surface set as Thin Film. Increasing the setting to a very high value will result in the effect of layers of colored rings on the surface. It is generally a good idea to stay within a range of 100-1000.

Color Filter
The Color Filter setting acts as a color multiplier for the Thin Film material type. When the Color Filter is set to white the color of the material will be determined by the Thickness setting. Less saturated colors can be used to add subtle hue shifts while fully saturated colors have a greater influence. The Color Filter setting can be textured with color maps to create material breakups such as those seen on solar cells or to add surface imperfections to an optical lens or automotive headlight.
Translucent

The Translucent material type provides control over subsurface scattering properties that are found in many skin, plastic and other materials.

Surface Color
This controls the diffuse color of the outer surface of the material. Consider this the overall color of the material. Something to be aware of with this unique material type is that you will not see the translucent effect of the subsurface color if the surface color is completely black.

Subsurface Color
This setting controls the color that light will take on as it passes through the material. Your own skin is a great example of the subsurface scattering effect. When a bright light shines through the thin parts of an ear or the thin skin between fingers, the light is colored by what lies beneath the surface and comes back more red.

While the light is passing through the surface, it is bounced around in many random directions. This creates the soft translucent effect rather than the direct refraction effect of glass and similar materials.

For plastic materials, you will often set this color to something very similar to the surface color, but perhaps a a bit brighter.

Translucency
This controls how deep light penetrates into and through the surface depending on the units set under Edit, Set Scene Units. The higher your translucency value, the more of the subsurface color you will see coming through the surface. Higher translucency values will also create a softer looking material.

Texture
This affects the Surface Color setting. This color multiplies and blends the surface color. For instance, when the Surface Color is yellow and the Texture Color is blue, the result will be green. When set to white, it will not affect the surface color.

Specular
This controls the intensity of the reflections on the surface. This works together with the Refractive Index setting to further increase or decrease the strength of the reflections on the surface.

Roughness
Increasing roughness will spread and distribute reflections over the surface and create a more matte surface.

Advanced

Refractive Index
This controls how much light will bend or refract as it hits and passes through parts that have this type of material. The default of 1.4 is a good starting point, but you can increase the value to create a more dramatic refraction within the surface.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.

Global Illumination
This options enables Global Illumination for the material independent of the General Lighting setting for Global Illumination.
Advanced

The Advanced material is the most versatile of all KeyShot material types. There are more parameters in this material than in any other. With this variety of parameters, materials such as metals, plastics, transparent or cloudy plastics, glass, leathers and diffuse materials can all be created from this single material type. Material types that cannot be created are translucent materials and metallic paints.

Diffuse
This can be thought of as the overall color of the material. Transparent materials will have little or no diffuse. Metals will have no diffuse with all the color derived from the specular. To fully understand this parameter see the section on diffuse.

Specular
This is the color and intensity of the reflection of light sources within the scene. Black will be 0% intensity and the material will not be reflective. White will be 100% intensity and will be completely reflective. If a plastic material is being created, the specular color should be gray to reduce reflectivity.

Ambient
This will control the color of self shadowing on the material in areas that are not receiving direct light. It can produce unrealistic looks, so it is recommended to keep this set to black unless it is needed.

On the left the material has a green ambient color - on the right the ambient color is black.

Roughness
This will add microscopic levels of imperfections to the surface of the material when the values are increased. When set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.
On the left the material has a roughness of 0 - on the right it is 0.04.

Refractive Index
This will control the level of refraction on the material.

On the left the refractive index is 1.3 - on the right it is 2.3

Diffuse Transmission
This will cause additional light to be scattered across the surface of the material, which can simulate a translucent effect. It will increase render time, so if it is not needed, the recommendation is to leave it at black.

Specular Transmission
This can be thought of as the transparency of the material. Black will be 100% opaque and white will be 100% transparent.
If a transparent glass or plastic is being created, the diffuse should be black with all the color derived from this parameter. Transparent glasses or plastics should also have the specular set to white. If a cloudy plastic is desired, the diffuse can be set to a very dark version of the color set here.

**Roughness Transmission**
This will control the roughness of the refraction. The main difference between this parameter and roughness is that roughness is on the internal portion of the material. This can be used to create a frosted look while still maintaining a shiny surface. The material needs to have some transparency through the specular transmission for the effect to show.

**Samples**
This will control the accuracy of glossy (rough) reflections by increasing the samples that are used.

**Fresnel**
This will control the intensity of the reflections that are perpendicular to the camera. In the real world, materials are more reflective around the edges of objects than they are on areas of objects that are directly facing the viewer or camera. This is enabled by default.

The material on the left has Fresnel checked - the one on the right does not.

**Use Diffuse Map Alpha**
This setting is present for legacy purposes. If you want to have opacity maps on your material, please use the opacity texture.
Anisotropic

The Anisotropic material type gives you advanced control over the highlights on the material surface. On other material types that have a single “Roughness” slider, increasing this value causes the highlights on the surface spread out evenly in all directions. Anisotropic gives you control over the highlight shape by controlling the roughness in two directions with two independent sliders. This material type is often used to simulate a finely brushed metal surface.

Color

When trying to create a metal, the diffuse should be set to black. When set to anything other than pure black, this material type will take on more a plastic look.

Specular

This is the color and intensity of the reflection of light sources within the scene. Black will be 0 intensity and the material will not be reflective. White will be 100% intensity and will be completely reflective.

If a metal material is being created, this is where the color is set.

Roughness X and Y

These sliders control the spread of the highlights on the surface. The X and Y roughness sliders control the highlight spread in independent directions. As you offset the values, the highlights on the surface will stretch out and give a finely brushed effect.

Setting both sliders to the same value will yield reflections that are spread evenly in all directions. In the image,

![Image of two spheres with anisotropic highlights]

The material ball on the left has offset values and the right has equal values.

Angle

This rotates the stretched highlights that are produced when the roughness x and y values are offset. The value is in degrees and goes from 0 to 360.
The material ball on the left has an angle of 0 and the right an angle of 90.

**Mode**

This advanced setting controls how the highlights are stretched. There are three unique modes.

- Linear (default) which will stretch highlights in a linear way, and is independent of any UV coordinate mapping you may have on the model.
- Radial mode is an anisotropic method which simulates the effect you might observe on the play side of a CD. Enabling this mode allows you to choose the center point of the radial roughness with the
- UV mode is dependent on your UV coordinates. You can use this to manipulate the anisotropic highlights based on the mapping from your modeling software.

**Samples**

A low samples setting (8 or lower) will tend to make the surface look more noisy which will give a more imperfect and rough look. As you increase the value the noise will even out more and provide a more evenly distributed roughness.
Dielectric

The Dielectric material type is a more advanced way to create glass materials. Compared to the Solid Glass Material Type, you will find additional settings for dispersion (Abbe Number) and it can also be used to create an accurate interface between glass and liquid.

Transmission
This option controls the overall color of this material type. When light enters the surface it will take on the color set here. The amount of color that you see in this material is highly dependent on the Transparency Distance setting as well. If you have set a color in the transmission, but it looks too faint, try to decrease the Transparency Distance.

Transparency Distance
This slider controls the depth of the color selected in the Transmission setting, depending on the thickness of the part to which the material is applied. After setting a color in the Transmission setting, use Transparency Distance to make that color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at the color of the shallow water at a beach versus the deep blue of a deep ocean. Without this you would see through to the bottom of the deepest ocean as easily as to the bottom of a swimming pool.

Refractive Index
This slider controls how much light will bend or refract as it passes through parts on your model that have this type of material. The default of 1.5 is accurate for simulating most types of glass, but you can increase the value to create a more dramatic refraction within the surface.

Transmission Out
This option controls the color of the light on the outside of the material. It is an advanced and complex setting, but it is needed when rendering containers with liquid. In the example of a water glass, you will need to have a dedicated surface for where the liquid and glass meet. On this surface, you should set the color of the glass with the transmission out setting and control the color of the liquid with the transmission setting. If the glass and liquid are both clear, set both transmission and transmission out to white.

Refractive Index Outside
This slider is an advanced but powerful setting that allows you to accurately simulate the interface between two different refracting materials. The most common use for this is when you are working on a container with liquid inside, like a water glass. In such a scene, you will need a single surface to represent where the glass and water meet. On this surface, you have the liquid on the “inside,” and therefore you should set the refractive index to 1.33. On the “outside,” the glass the refractive index outside should be set to 1.5.

Roughness
Roughness on this type of material will spread out highlights on the surface similar to what you see on non-transparent, materials. However, it also spreads out the light that is transmitted through the material. This is used to create a frosted glass look.

Expand this parameter, and you will see a samples setting. This can be used with a low setting to produce a more imperfect/noisy result or a higher value to smooth out the noise/grain for a smoother frosted look.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.

Abbe Number (Dispersion)
The Abbe number slider controls dispersion of light as it is transmitted through the surface and produces a prismatic effect. This prismatic color effect can be used to create the “fire” effect often desired when rendering gem stones.

A value of zero will disable the dispersion effect entirely. A low value will show heavy dispersion, and as you increase the value, the effect will become more subtle. A setting around 35-55 is a good starting point if a subtle dispersion effect is desired.

Dispersion Samples
A low samples setting (8 or lower) will produce a more imperfect/noisy result while a higher value will smooth out the noise/grain and give a smoother look.

**Roughness Transmission**

This will control the roughness of the refractions. The main difference between this parameter and roughness is that the roughness is on the internal portion of the material. This can be used to create a frosted look while still maintaining a shiny surface. The material needs to have some transparency through the specular transmission for the effect to show.
Gem

The Gem Material Type is related to the Solid Glass, Dielectric, and Liquid Material Type. The settings have been optimized to be relevant to rendering gem stones. The Abbe Number (dispersion) control is especially important for gem stone rendering as it produces the “fire” effect that is often desired.

Color
This controls the overall color of the gemstone. When light enters the surface it will take on the color set here. The amount of color you see in this material is highly dependent on the transparency setting as well.

Transparency Distance
(Formerly Transparency) This slider controls the depth of the color selected in the Color setting, depending on the thickness of the part to which the material is applied. After setting a color in the Color setting, use Transparency Distance to make that color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at the color of the shallow water at a beach versus the deep blue of a deep ocean. Without this you would see through to the bottom of the deepest ocean as easily as to the bottom of a swimming pool.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts on your model that have this type of material. The default of 1.5 (the Refractive Index of Lapis Lazuli) is a general setting and will need adjusted depending on the gem you desire. A Table of Refractive Index for Gemstones can be found on the International Gem Society website.

Roughness
Roughness on this type of material will spread out highlights on the surface similar to what you see on other, non-transparent, materials. However, it also spreads out the light that is transmitted through the material. This is used to create a frosted glass look.

Samples
This can be used with a low setting to produce a more imperfect/noisy result or a high setting to smooth out the noise/grain for a smoother frosted look.

Abbe Number (Dispersion)
The Abbe number controls dispersion of light as it is transmitted through the surface and produces a prismatic effect. This prismatic color effect can be used to create the “fire” effect often desired when rendering gem stones. A value of zero will disable the dispersion effect entirely. A low value will show heavy dispersion, and as you increase the value, the effect will become more subtle. A setting around 35-55 is a good starting point if a subtle dispersion effect is desired.

Dispersion Samples
This can be used with a low setting to produce a more imperfect/noisy result or a higher value to smooth out the noise/grain for a smoother look.

Ignore intersecting geometry
When enabled overlapping geometry will be ignored. This is useful for e.g. the prong setting of diamond ring, where the real life deformation made to the prongs when fixing the gemstone is not modeled and the geometry is in fact overlapping.
The Generic material type is based on the Disney BRDF shader. When you use the Material Importer to import materials such as a Unified 3D Material (.u3m) or Substance Painter Project (.sp) their properties will be mapped to the properties of the Generic material.

**General Properties**

*Base Color*

This is the surface color and can be replaced by a texture.

*Metallic*

Controls the "metallicness" of the material. Increasing the value will produce a more metallic appearance.

![Metallic values of 0, 0.5 and 1.](image1)

*Roughness*

This will add microscopic levels of imperfections to the surface of the material. When set to 0, the material will appear perfectly smooth and polished. When the value is increased, the material will appear rougher as light is diffused across the surface.

![Roughness values of 0, 0.5 and 1.](image2)

*Specular*

The value determines the intensity of the reflection of light sources.
**Specular Tint**

Determines how much the color the specular reflection gets from the base color. Value between 0-1. At 0, the specular reflection is achromatic.

**Anisotropic**

This value determines the amount of anisotropy. Anisotropy (the opposite of isotropy) is the property of being directionally dependent. At 0 the surface will be isotropic and will reflect light evenly. Increasing the Anisotropic value add direction to the reflections.

**Anisotropic Angle**

Adjust the angle of the anisotropy.
Sheen

The perceived shininess at grazing angles on a surface. Increase the value to add sheen to the material. Primarily used for cloth materials.

Sheen Tint

Determines how much the color the sheen gets from the base color. Value between 0-1. At 0, the sheen is achromatic (doesn't tint incoming light).

Clear-coat

Adds a clear coat on top of the material. Increasing the value will make the layer more prominent.
**Clear-coat Roughness**

Controls the roughness of the clear-coat. A value of 0 will make the surface glossy while increasing the value will give the surface a satin finish.

**Advanced**

**Anisotropic Direction**

When the value is at 0 the anisotropy follows the UV's on the object, when it is at 1 they are straight.

---

**Note**

The Disney BRDF shader has values going from 0-1. In the *Generic* material type, we have, for artistic purposes, allowed some of the parameters to have values exceeding this.
The *Measured* material type supports the import of the X-Rite Appearance exchange Format (AxF) and Radiance BSDF format. These formats contain vendor neutral digital material representations that captures the light scattering characteristics for specific physical materials.

### The X-Rite AxF Material Format

AxF is a digital file format developed by X-Rite that delivers a standardized appearance representation. AxF materials are created from physical material samples scanned using an X-Rite TAC7 Scanner which captures and creates the accurate digital material specifications in the AxF file. AxF files can be accessed from digital material catalogs such as the PatoneLIVE Cloud and imported directly into KeyShot using a Measured material type. Learn more about AxF and how to create them at [xrite.com/axf/](http://xrite.com/axf/).

**Download AxF sample files from X-Rite**

### The Radiance XML BSDF Format

BSDF (bidirectional scattering distribution function) is a mathematical model used to describe light interactions with surfaces. Developed for the Radiance Renderer, the BSDF file format supported in KeyShot is an XML format containing measured BSDFs defining the distribution function that dictates how the light is scattered and how the material appears.

### Importing Measured Materials

You can import AxF materials directly into the material panel or to the Library, either directly or using the Material Importer.

While editing a material in the Projects, Material tab, select *Measured* from the Material Type drop-down, the part will appear black and a File location on field will appear in the Properties tab. Select the folder icon to select a measured file format. Both the .axf and .xml file extensions are supported.
Metallic Paint

The Metallic Paint material type simulates a two-layer paint job: a base coat and a clear-coat that provides a clean reflection over the entire material.

Paint Settings

Base Color
This is the overall color of the material for the base coat of paint.

Metal Color
This can be thought of as a coat of metal “flakes” sprayed over the base coat. You can choose a color that is similar to base color to get a subtle metal flake effect, or you can choose a contrasting color to get some interesting results. A white or gray metal color is also commonly used for realistic paints. The metal color in the material will show more in the directly lit or brightly highlighted areas of the surface while the base color will show more in the less illuminated areas.

Metal Coverage
This controls the ratio of base color to metal color. When it is set to 0, you will see only the base color. When it is set to 1, the surface will be almost entirely covered in the metal color. For most metallic paint materials, you will want this value set close to 0. A setting of 0.25 is the default and a good starting point.

Metal Roughness
This controls the spread of the metal color over the surface. When it is set to a low value, you will see the metal color only in small areas around the highlight areas. When it is set higher, the metal will spread more evenly across the entire surface. A setting of 0.15 is the default and a good starting point.

Metal Flake Size
Controls the size of the metal flakes - extremely large values recreate a “bass boat” paint.

Metal Flake Visibility
Controls the opacity of the metal flakes, on a scale form 0 - 1.

Samples
This will control how imperfect or refined the metal effect in the paint will look. A low setting will result in a more noticeable “flake” effect. A higher setting will smooth out the distribution of the metal effect, and it will have less noise/grain. When seeking a pearl effect, use a higher setting.

Clear-coat Settings

The clear-coat settings control the top clear-coat layer. Settings are unit-aware and can have a bump map applied that does not affect the base coat.

Clear-coat Color
Sets the color for the clear-coat layer. The lighter the color, the lighter the clear-coat. The default is white (completely clear).

Clear-coat Roughness
The metallic paint clear-coat layer, by default, provides perfectly clean reflections. However, if a satin or matte paint effect is desired, the clear-coat roughness value may be increased. This will spread out the reflections on the surface for a matte look.

Clear-coat Refractive Index
This slider controls the intensity of the clear-coat. 1.5 is the default and a good starting point. If a more shiny paint is desired, increase the value. Bringing the value down, closer to 1, reduces the clear-coat effect. This can be useful for making a matte finish or simulating plastics that have a
metallic flake effect.

**Clear-coat Thickness**
Sets the thickness of the clear-coat. This is set as a thickness multiplier that can be textured. A higher value will darken the clear-coat. This setting can be textured by clicking on the texture icon next to the setting. This will override the value and provide additional settings for the texture type selected.

**Clear-coat Bump**
Right-click on the icon to add a texture to the Clear-coat Bump. This will only affect the Clear-coat layer while adding a Bump through the Textures tab will affect both the base and the clear-coat.
Multi-Layer Optics

Layer list
Lists all layers of the material. Note that the first layer is the "base" layer (substrate).

Add layer
You can either add a layer from a file, add a new dielectric layer or add a copy of an already defined layer.

Delete layer
This will delete the current layer from the layer list, but the definition will still be available in the Layer Material dropdown.

Layer properties
These properties apply to the layer that is highlighted in the Layer list

- **Layer Thickness** Set the thickness of the layer. The thickness of first layer can not be set, as it is the main material (substrate) of the part.
- **Layer material** Select the material for the layer. The list contains all the materials you have had in the list, also ones from layers that have been deleted. The next to the material drop-down will delete the specification of the current material and replace all instances.
- **Material Name** Here you can edit the name of the material, note that the name will change the name of the material not the layer.
- **Refractive index** This slider controls how much light will bend or refract as it passes through the material. The default of 1,5 is accurate for simulating most types of glass.
- **Abbe Number** The Abbe number controls dispersion of light as it is transmitted through the surface and produces a prismatic effect. A value of zero will disable the dispersion effect entirely. A low value will show heavy dispersion, and as you increase the value, the effect will become more subtle. A setting around 35-55 is a good starting point if a subtle dispersion effect is desired.

Edit specification
Allows you to enter/edit the entire material, including all layers in plain text.

Encrypt Specification
If you want to protect the specifications of your material, you can encrypt it. This will hide information about the layers in the material and the material can no longer be edited.

When the material is encrypted you can **Clear Specification**. This will delete the specification of the the current material and let you start from scratch. Encrypted materials can not be un-encrypted!

Color
This option controls the overall color of this material type. When light enters the surface it will take on the color set here.

Transparency Distance
This slider controls the depth of the color selected in the Transmission setting, depending on the thickness of the part to which the material is applied. After setting a color in the Transmission setting, use Transparency Distance to make that color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at the color of the shallow water at a beach versus the deep blue of a deep ocean. Without this you would see through to the bottom of the deepest ocean as easily as to the bottom of a swimming pool.

Refractive Index Outside
This slider is an advanced but powerful setting that allows you to accurately simulate the interface between two different refracting materials.

Simulate Substrate Dispersion
Enabling this will simulate caustics in the substrate if it is a transparent material.

You can learn more about Caustics on the [Refractive Index](#) page.
Plastic (Cloudy)

The Plastic (Cloudy) material contains light-scattering particles to replicate complex, scientifically accurate materials such as Polycarbonate or ABS. This material has parameters to control light Transmission, Roughness, Refractive Index, Transparency Distance and Cloudiness. When editing an existing material select Plastic (Cloudy) from the Material Type drop-down.

Transmission
This sets the overall light transmission of the cloudy plastic material. A lighter color will allow more transmission. A darker color will provide less transmission. Click the color thumbnail to open the color picker then select your desired color.

Transparency Distance
Controls the distance at which the transparency is affected.

Cloudiness
This setting affects the overall cloudiness of the plastics. A value of 0 is no cloudiness at all.

Refractive Index
This controls how much light will bend or "refract" as it passes through parts that have this type of material. The default of 1.5 is accurate for simulating most types of plastic, but you can increase the value to create a more dramatic refraction within the surface.

Roughness
This will add microscopic levels of imperfections to the surface of the material when the values are increased. When set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

Advanced

Cloudiness Color
This sets a specific color for the internal cloudiness of the plastic.

Scattering Directionality
Controls how the light is scattered. A value of 0 is uniform scattering, a negative value will scatter light backwards, a positive value with scatter light forwards.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.
Plastic (Transparent)

The Plastic (Transparent) material provides the basic settings needed to create simple plastic materials. Set the diffuse (overall color) and add some specular (reflections), then adjust the roughness. This is a very versatile material type that is used for anything from concrete to woods.

Diffuse
This can be thought of as the overall color of the material. Transparent materials will have little or no diffuse color applied.

Specular
This is the color and intensity of the reflection of light sources within the scene. Black will completely turn off reflections, while white will provide a very shiny plastic look. Realistic plastic does not have color in the specular value, so generally you should use some level of gray or white. However, adding color can give the plastic material a metallic effect.

Roughness
This will add microscopic levels of imperfections to the surface of the material when the values are increased. When set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

Samples
Within the roughness parameter, you will find a samples setting. A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will smooth out and provide a more evenly distributed roughness.

The material on the left has no roughness - the one on the right has a roughness of 0.15.
Base material: Clear Shiny Plastic Blue from the Material Library

Diffuse Transmission
This will cause additional light to be scattered across the surface of the material which can simulate a translucent effect. It will increase render time, so if it is not needed, the recommendation is to leave it at black.
The material on the left has black Diffuse Transmission Color - the one on the right has a red.
Base material: Clear Shiny Plastic Grey from the Material Library

**Specular Transmission**
This can be thought of as the transparency of the material. Black will be 100% opaque and white will be 100% transparent.
If a transparent glass or plastic is being created, the **Diffuse Color** should be black with all the color derived from this parameter. Transparent glasses or plastics should also have the specular set to white. If a cloudy plastic is desired, the **Diffuse Color** can be set to a very dark version of the color set here.

The material on the left has grey Specular Transmission Color - the one on the right has a blue.

**Refractive Index**
This controls how much light will bend or “refract” as it passes through parts on your model that have this type of material. Increase the value to create a more dramatic refraction within the surface.
**RealCloth**

The RealCloth™ procedural material enables you to create woven fabrics, with your custom weave patterns, detailed down to the ply. And make the cloth appear even more tactile with flyaway fibers.

Note that the RealCloth™ Material requires that your geometry has UV coordinates.

---

**Edit Weave Pattern (Pro feature)**

Click the *Edit Weave Pattern* button to set up the repeating pattern that will make up your cloth, this will bring out the Pattern Editor. The pattern editor is a KeyShot Pro feature. If you don't have a Pro license the *Edit Weave Pattern* button will be disabled, and you won't be able to edit the pattern.

**Pattern Size:** This determines how many threads the pattern will span.
- **Warp**: The threads that are strung over the loom vertically, and holds the tension during weaving. The warp runs in the longitude of the fabric. In the preview it is the vertical threads.

- **Weft**: This is the thread that you weave between the warp threads, creating your patterns and structure in the weave. In the preview it is the horizontal threads.

- **Pattern Presets**: Here you can select between a number of the most commonly used weave patterns - plain, basket, twill and satin. Selecting a pattern will set the appropriate number of warp/weft threads and apply the pattern to the preview. The Step value in the pattern names determines how many warp threads the weft crosses over, before going under the warp again.

**Pattern preview**: Here you can edit the pattern. Each crossing between a warp and weft makes up a cell in the grid. Click a cell to switch which of the threads are in front.

- **Invert Weave Pattern**: This will switch all thread crossings around.

**Warp**

- **Width**: This determines the width of the warp threads. The scale goes from 0-1, where 1 means that the threads are as wide as the cells.
- **Tension**: Here you set how tightly the warp threads are strung.
- **Shape**:
  - Ribbon: The ribbon shaped thread is highly compressed and flat. Note that if you are using the ribbon shape, *Ply Count* and *Ply Pitch* will not be relevant.
  - Round: The round thread is not highly compressed.

**Weft**

- **Width**: This determines the width of the weft threads. The scale goes from 0-1, where 1 means that the threads are as wide as the cells.
- **Tension**: Here you set how tightly the weft thread is strung while woven through the warp.
- **Shape**:
  - Ribbon: The ribbon shaped thread is highly compressed and flat. Note that if you are using the ribbon shape, *Ply Count* and *Ply Pitch* will not be relevant.
  - Round: The round thread is not highly compressed.

**Close/Apply**: The changes to the weave pattern won’t be applied instantly. Because calculating the weave pattern may take a some time you have to press apply Apply to see the effect on the cloth in the Real-time View. When you are happy with what you see in the Real-time View you hit Close to hide the dialog.

**Mapping (UV)**

- **Size**: this lets you select how you want to control the size of the weave pattern.
  - **Use Units**: If you choose to set the size in Units, a slider controlling the *Max. Thread Width* will appear. With this you can determine the physical size of the threads, which then will be converted the appropriate UV scale. This scaling is recommended, if you are using the cloth across multiple parts, which may not have the same UV scaling.
  - **Use UV Scale**: If you choose UV scale, the *UV scale* slider will appear. This determines the width of the pattern in relation to 1 UV-unit. This scaling method is recommended if you are going to animate the object.

- **Angle**: This enables you to change the direction of the weave.

- **Distortion**: Increasing the distortion will introduce irregularities/imperfections to the UV map.

- **Anti aliasing**: Reduce moire artifacts by adding noise to the image. This may require more samples when rendering.
Warp/Weft

The warp describes the long threads held under tension during weaving. The weft is the that thread that is passed through the warp threads across the width of the cloth.

Color: This controls the overall color of this material type. When light enters the surface, it will take on the color set here. The amount of color that you see in this material is highly dependent on the transparency setting as well.

Specular: This is the color and intensity of the reflection of light sources within the scene. Black will completely turn off reflections, while white will provide a very shiny plastic look. To achieve the most realistic look use some level of gray or white. However, adding color can give the material a metallic effect.

Roughness: This will add microscopic levels of imperfections to the surface of the material when the values are increased. When set to 0 a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

Refractive Index: This controls how much light will bend or ‘refract’ as it passes through parts that have this type of material. The default of 1.5 is accurate for simulating most types of plastics, but you can increase the value to create a more dramatic refraction within the surface.

Color Variation: Will add variation of the color of the thread within the weave, running along the pattern. When set to 0 the threads will be perfectly uniform in color. Increasing the value will add subtle variations that can help emphasize the pattern and give a more “handcrafted look”.

Fiber Density: This will set the density of the fibers in each thread.

Fiber Detail: This controls how pronounced the fibers appear in the threads. 0 is not at all and increasing the value adds detail.

Ply Count: Ply is the number of strands that are twisted around one another to create a single thread

Ply Pitch: Pitch is the metric approach to measuring "thread count". The value determines the distance between plies (measured along the length of the thread, not the length of the twisted strand)

Geometry

Add flyaway fibers: When enabled, this will add stray fibers on the cloth surface. The fibers are based on displacement, so they won’t be visible, until the the displacement has been executed. Flyaway fibers will follow the direction of the normals.

Note

Whenever a scene contains un-executed changed to a displacement parameter, you will see the Execute Displaced Geometry button in the top right corner of the Real-time View.

Flyaway Density: Determines the number of flyaway fibers. The density is calculated in relation to the weave pattern. With a density of 1 you will on average get 1 flyaway fiber per yarn crossing.

Flyaway Radius: Determines how thick the fibers are.

Flyaway Length: Determines how long each fiber is.

Flyaway Length Variation: Adds variation to the length of the fibers. The fibers will be varied up to the selected length + length * variation value.
**Flyaway Randomness:** by default the flyaway fibers are straight. Adding randomness will warp the fibers.

**Flyaway Direction:** Determines the angle at which the flyaway fiber comes out of the plies in the yarn. At 0 the fibers will have a 90° angle to the ply, and at 0 the fiber will follow the direction of the ply.

**Flyaway Max Curves:** Adding large amounts of curves can make the scene very heavy. The amount of curves is impacted by both the density and length variation values. Flyaway Max Curves enable you to limit the overall amount of flyaway curves added per part. When the limit is reached, the density of flyaway fibers will be impacted. The limit value is measured in millions and is only an approximate. If you don’t want to set a limit just leave the value at 0.

**Flip Normals:** This will change the direction the normals on your geometry, so they face the other way. Use this if the flyaway fibers are facing the wrong way.

**Transparent Weave:** Enable this if you want the gaps between threads to be transparent. Notice that this is not the same as adding translucent qualities to the woven parts.

**Execute Geometry Node:** After any edits to the flyaway fibers, you must "execute geometry" before you can see the effect in the Real-time View.

---

**Tip**
For the best result, the UV coordinates should be "in proportion", in the sense that 1 unit in the U direction matches 1 unit in the V direction. Consider the UV map as a cut pattern applied to the cloth - any warping in the UV coordinates will appear as stretched fabric.

**Prerequisites and Limitations:**
- Your objects must be UV mapped when using RealCloth\textsuperscript{TM}, otherwise they will appear black.
- The RealCloth\textsuperscript{TM} material does not apply to Labels.
- If used on Cutaway Caps, the cloth material cannot have flyaway fibers.
- The displacement and flyaway fibers on the cloth material and are not supported in Render NURBS Mode.
Scattering Medium

With scattering medium you can simulate particle scattering to create such effects as fog or smoke or volumetric lighting such as visualizing beams or rays of light.

Applying Scattering Medium

In the Project window, Material tab, select Scattering Medium from the Type dropdown menu. Textures can be assigned to the Density Texture in the Textures tab. OpenVDB files can be loaded by selecting Volume Map from the Texture dropdown or via the Material Graph and applying it to Density Texture on the Scattering Medium material node.

Adjusting Scattering medium

Properties

Transmission
This option controls the overall color of this material type. When light enters the surface it will take on the color set here. The amount of color that you see in this material is highly dependent on the color density setting as well. If you have set a color in the transmission, but it looks too faint, skip down to the color density section.

Transparency Distance
This slider controls the depth of the color selected in the Transmission setting, depending on the thickness of the part to which the material is applied. Use Transparency Distance to make the Transmission color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

Density
Determines how close the particles are - High Density values will make the scattering medium seem more solid, where a low density

Multiple Scattering
When checked the rays will bounce multiple times inside the geometry. This will create a more physically correct representation of the material, but it affects the processing time.

Advanced

Albedo
Albedo is the color of the light scattered by small particles inside the scattering medium. Note, that in media with Multiple Scattering the color of the medium may be the inverse of the albedo color, since the scattering process can prevent light from reaching the observer as it travels through the medium.

Scattering Directionality
Controls how the light is scattered. A value of 0 is uniform scattering, a negative value will scatter light backwards, a positive value with scatter light forwards.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.

Textures
Density Texture
The density texture will act as a sort of mask on the material - where the texture is black, no particles will be shown and the amount of particles will increase where the texture is lighter. To use VDB filed on the density texture, add a Volume Map.

Labels
With labels you can add another material onto the surface of the scattering medium. Control the label with the 4 primary Map Types - Diffuse, Specular, Bump and Opacity. Just make sure to add an opacity map when using a label - otherwise you won't be able to see the scattering medium.

Volume Caustics
Caustics work inherently with volumes (e.g. scattering media), however, caustics will only be applied to light sources outside the volume and this is only supported with interior mode.

Quick Tip
Translucent (Advanced)

The Translucent material type provides control over subsurface scattering properties that are found in many skin, plastic and other materials. Compared to the Translucent material type, this generally will resolve faster.

Surface Color
This controls the diffuse color of the outer surface of the material. Consider this the overall color of the material. Something to be aware of with this unique material type is that you will not see the translucent effect of the subsurface color if the surface color is completely black.

Subsurface Color
This setting controls the color that light will take on as it passes through the material. Your own skin is a great example of the subsurface scattering effect. When a bright light shines through the thin parts of an ear or the thin skin between fingers, the light is colored by what lies beneath the surface and comes back more red.

While the light is passing through the surface, it is bounced around in many random directions. This creates the soft translucent effect rather than the direct refraction effect of glass and similar materials.

For plastic materials, you will often set this color to something very similar to the surface color, but perhaps a bit brighter.

Translucency
This controls how deep light penetrates into and through the surface depending on the units set under Edit, Set Scene Units. The higher your translucency value, the more of the subsurface color you will see coming through the surface. Higher translucency values will also create a softer looking material.

Specular
This controls the intensity of the reflections on the surface. This works together with the Refractive Index setting to further increase or decrease the strength of the reflections on the surface.

Roughness
Increasing Roughness will spread and distribute reflections over the surface and create a more matte surface.
Refractive Index
This controls how much light will bend or refract as it hits and passes through parts that have this type of material. The default of 1.4 is a good starting point, but you can increase the value to create a more dramatic refraction within the surface.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.
**Velvet**

The Velvet material is very useful for creating soft fabrics that have the distinct light catching effects that result from the soft fibers in finely woven fabrics.

You will generally be able to do fabric materials well with the plastic or advanced material types - but the velvet material provides control over parameters not found in other material types.

**Diffuse**
This can be thought of as the overall color of the material. A dark color is generally preferred for both the diffuse and sheen settings as this material can become unnaturally bright when light colors are used.

**Sheen**
The sheen color is observed as light that appears to be reflected back across the surface from behind, almost as though the surface is backlit. This setting is combined with the edginess control to add a soft sheen across the entire material. The backscatter parameter also gets its color from the sheen setting. Generally, this should be set to a color very similar to the diffuse color, but a bit brighter.

**Roughness**
The roughness setting determines how evenly the backscatter effect is distributed across the surface. When this is set to a low value, the backscattered light will stay contained within smaller areas. A high value will spread the light across the entire object evenly.

**Backscatter**
This is light that is scattered across the entire object and is especially apparent in the shadowed areas of the object. It can be used to give an overall soft look to the surface. The color of the backscatter light is set with the sheen control.

**Edginess**
This controls how far the sheen effect spreads over the surface. A low value will cause the sheen to fade out gradually, while a high value will produce a bright border of sheen around the edges of the surface. A setting of zero disables the sheen effect.

**Samples**
The samples setting controls how imperfect or refined the backscatter effect appears. A higher value will smooth out this scattered light and will cause it to appear more even. A low value will show a coarser grain/noisiness in the backscattered light. A higher setting, around 32, is often preferred for this setting as it provides a smoother result.
Light Sources

In KeyShot, physical lights are designed as materials that may be applied to parts. Any geometry can be turned into a light source. You can either import new geometry, use existing geometry or add a primitive (*Edit, Add Geometry...*). Light sources are labeled in the *Project* window, *Scene Tree* by a light bulb icon 🗻 next to the part name.

**Light Source Material Types**

- Area Light
- Point Light
- IES Light
- Spotlight
Area Light

*Area Light* is a material type that will give you a wide range of light dispersion. This will function similarly to a flood light.

![Area Light material properties](image)

**Color**

Here, you can choose the color the light will cast. You can also place a texture in front of the light source to color and mask the emitted light.

The example below shows a planar area light with a *Color Gradient* texture.

**On this page**

- Color
- Power
- Lumen
- Lux
- Apply to Geometry
  - Apply to Front of Geometry
  - Apply to Back of Geometry
- Visible to Camera
- Visible in Reflections
- Visible in Shadows
- Samples
For accurate lighting colors, use the Kelvin scale to select accurate lighting temperatures.

<table>
<thead>
<tr>
<th>Color</th>
<th>Temperature</th>
</tr>
</thead>
<tbody>
<tr>
<td>3000</td>
<td>3000 Kelvin</td>
</tr>
<tr>
<td>4000</td>
<td>4000 Kelvin</td>
</tr>
<tr>
<td>5000</td>
<td>5000 Kelvin</td>
</tr>
<tr>
<td>6500</td>
<td>6500 Kelvin</td>
</tr>
</tbody>
</table>

**Power**

The power of the light can be controlled in either Watt, Lumen or Lux. Lumen or Lux are recommended for best results. The choice between Lumen or Lux depends on the preferred workflow.

*Lumen*
When the Power unit is set to Lumen, then the light output is specified as luminous flux. **Total light output will be constant** for area light objects of different sizes.

The examples below show the effect of increasing the size of a square area light from 10 to 200 mm. Power is a constant 250 Lumen.

<table>
<thead>
<tr>
<th>Size</th>
<th>Lux</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 mm x 10 mm</td>
<td>50 Lux</td>
</tr>
<tr>
<td>50 mm x 50 mm</td>
<td>5000 Lux</td>
</tr>
<tr>
<td>100 mm x 100 mm</td>
<td>50000 Lux</td>
</tr>
<tr>
<td>200 mm x 200 mm</td>
<td>100000 Lux</td>
</tr>
</tbody>
</table>

**Lux**

When the Power unit is set to Lux, then the light output is specified as luminous emittance. 1 Lux equals 1 Lumen per square meter of light-emitting surface. **Total light output will vary** for area light objects of different sizes. Small area lights are dim, while large area lights are brighter, since the light-emitting surface area is larger.

The examples below show the effect of increasing the size of a square area light from 10 to 200 mm. Power is a constant 25000 Lux.
Apply to Geometry

There are two checkboxes to make an area light emit from the front, back or both sides of the geometry. Which side of the geometry is interpreted as front or back depends on the orientation of the surface normals.

Toggling these options is most useful for surface geometry without thickness.

Apply to Front of Geometry

Select this to make the light source emit from the front side of the surface geometry.

The example below shows a planar area light, emitting from the front side.

Tip!

The softness of shadows from an area light is closely related to its size. A large area light produces soft shadows, while a small area light results in harder shadows with crisply defined, sharp edges.
Apply to Back of Geometry

Make the light source emit from the back side of the surface geometry.

The example below shows a planar area light, emitting from the back side.

The example below shows a planar area light, emitting from both the front and back side.
Visible to Camera

Here, you can toggle whether or not the light source geometry is shown in real-time window and renderings.

The examples below show the effect of toggling visibility to camera.

Visible in Reflections

Here, you can toggle whether or not the reflection of the light source is shown in real-time window and renderings.
The examples below show the effect of toggling visibility in reflections.

<table>
<thead>
<tr>
<th>Reflections in Plastic material</th>
<th>Reflections in Metal material</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible in Reflections = checked</td>
<td>Visible in Reflections = checked</td>
</tr>
<tr>
<td>Visible in Reflections = unchecked</td>
<td>Visible in Reflections = unchecked</td>
</tr>
</tbody>
</table>

Visible in Shadows

Here, you can toggle whether or not the light source geometry casts a shadow in the real-time window. Disabling allows light to pass through the area light object. This option is disabled by default so as not to block any other light sources, including HDRI lighting.

The examples below show the effect of toggling visibility in shadows. The scene is lit by a large area light with a warm color (HSV: 30°, 90%, 100%) and a slightly smaller area light with a cool color (HSV: 225°, 35%, 100%) directly below it. Visible in Shadows is toggled for the smaller, cool area light.
With Visible in Shadows checked, the cool area light blocks the warm area light. As a result, the cool area light is the predominant light source in the scene, causing a clear blue cast.

With Visible in Shadows unchecked, light from the warm area light is able to pass through the cool area light. As a result, both area lights are contributing more or less equally to the scene's lighting. The cool and warm light now blend, causing a warmer cast.

Samples

Use this slider to control the amount of samples used in the render.

Limitation

ZSpheres transferred from ZBrush are not yet supported as Area Lights.
**Point Light**

Applying a *Point Light* to geometry replaces it with a point located in the parts center.

**Type:**

- **Point Light**

**Properties**

- **Color:**
  - Color = 3000 Kelvin
  - Color = 4000 Kelvin
  - Color = 5000 Kelvin
  - Color = 6500 Kelvin

- **Power:**
  - 1,808 Watt

- **Radius:**
  - 2,165 mm

**Color**

Here, you can choose the color the light will cast. For accurate lighting colors, use the Kelvin scale to select accurate lighting temperatures.
Power

Power determines how strong the light source is. It can be set in Lumen or Watt, where Lumen is recommended for the most accurate result.

Radius

Adjust the radius to control the softness of shadows cast from this light. A large radius gives soft shadows, while a small radius results in harder shadows with crisply defined, sharp edges.

<table>
<thead>
<tr>
<th>Radius</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 mm</td>
<td>(The unit depends on the Scene Units.)</td>
</tr>
<tr>
<td>5 mm</td>
<td></td>
</tr>
<tr>
<td>10 mm</td>
<td></td>
</tr>
<tr>
<td>20 mm</td>
<td></td>
</tr>
</tbody>
</table>

Note

The effect of radius depends on the size of models. Larger models may require a higher radius value for a similar effect.
IES Light

When using *IES Light*, you will need to load an IES profile by clicking on the folder icon in the editor. As soon as you load the profile you will see the shape of the IES profile in the material preview. You will also see the shape in form of a mesh in the Real-time View.

**File**

This displays the name and location of the IES profile being used. Click the folder icon to change to a different IES profile.

**Color**

Here, you can choose the color the light will cast. Use the Kelvin scale to select accurate lighting temperatures.

**Multiplier**

Adjust the intensity of the light with this slider.

---

*On this page*

- File
- Color
- Multiplier
- Radius
- Light Axis
**Radius**

Adjust the radius to control the softness of shadows cast from this light. A large radius gives soft shadows, while a small radius results in harder shadows with crisply defined, sharp edges.

<table>
<thead>
<tr>
<th>Radius = 0 mm</th>
<th>Radius = 5 mm</th>
<th>Radius = 10 mm</th>
<th>Radius = 20 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>(The unit depends on the Scene Units.)</em></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:**
The luminous flux (luminous power of the light) is embedded in the IES file itself as a value in Lumen. The Multiplier adjusts this value. For the most accurate result, the Multiplier should be left at a value of 1. Values between 0 and 1 can be used to simulate the behavior of a dimmer.

**Light Axis**

Here you can control the axis of your IES Light source.

**Tip**
If you have imported a scene where the axis orientation is different from the one in your light sources, you don't have to rotate them - just choose the appropriate up-axis.

**Note**
The effect of radius depends on the size of models. Larger models may require a higher radius value for a similar effect.
Spotlight

A Spotlight can be thought of as a Point Light where the output is clipped, so that the light is emitted in a cone. This will function similarly to spotlights used in stage lighting to create pools of light.

Color

Here you can set the color of the light. You can also place a stencil texture in front of the light source to control the shape and color of the emitted light - as you see it in real-life gobos.

Color Stencil Diameter

If you use a texture on the spotlight, this slider specifies the width of a virtual stencil disc that always fits the Spotlight's beam exactly.

Tip

The stencil diameter is related to the width of the texture. If both are the same width the texture will fit the beam. If the texture is wider than the stencil it will be cropped, while textures that are smaller than the stencil will be repeated.

Color Stencil example

The following image is used as a Color texture.

![Color Stencil example image](image-url)
Power

Power determines how strong the light source is. It can be set in Lumen or Watt, where Lumen is recommended for the most accurate result.

Constant Light Output

This checkbox does not change the physical behavior or correctness of the Spotlight, but is there for convenience when adjusting Power or Beam Angle, depending on the preferred workflow. This setting allows to switch between constant total light output (checked) and constant illuminance (unchecked) when adjusting the Beam Angle.

Note

Illuminance is the luminous power incident on a surface.

Constant Light Output is checked

The entered Power value is the luminous flux of the clipped point light, i.e. the light emitted in the beam cone. The power of the Spotlight beam will be identical to the Power value. This also means that total light output with a large or small Beam Angle will be constant. Thus, illuminance will not be constant when changing the Beam Angle. Illuminance with a small Beam Angle will be higher than with a large Beam Angle, since the light is concentrated into a narrower beam.

The animation below shows the effect of checking Constant Light Output with an animated Beam Angle.
Constant Light Output is unchecked

The entered Power value is the luminous flux of the unclipped point light, i.e. the light ignoring the beam cone. The actual power of the Spotlight beam will be a fraction of the Power value, since the light output is clipped by the beam. Thus, total light output with a large Beam Angle will be higher than with a small Beam Angle. At the same time, **illuminance** will be **constant** when changing the Beam Angle.

The animation below shows the effect of unchecking Constant Light Output with an animated Beam Angle.

---

**Beam Angle**
Sets the angle that determines the size of the beam - the higher the angle the wider the beam.

**Falloff**

Falloff determines the point from where the beam is dimmed toward the edges. The scale reflects the radius of the beam, where 0 is on the outer edge of the beam and 1 is in the center.

The higher the number, the softer the transition from light to dark will be.
Radius

Adjust the radius to control the softness of shadows cast from this light. A large radius gives soft shadows, while a small radius results in harder shadows with crisply defined, sharp edges.

Note
The effect of radius depends on the size of models. Larger models may require a higher radius value for a similar effect.
Increasing the radius will also blur any stencil texture projections.

Radius = 0 mm
Radius = 5 mm
Radius = 10 mm
Radius = 20 mm
Cutaway

The Cutaway material enables you to non-destructively subtract geometry from your model.

Setting up the Cutaway Material

Simply add the geometry you want to use for the cut, place it so it cuts into your model and assign the cutaway material to it.

Tip
You can import simple geometry (sphere, cube etc.) into your scene from the Main Menu, Edit, Add Geometry.

Cap Types

- **No Caps** - The cuts will be left open.
- **Inherit Caps** - The cuts will be capped with the material of the part that is cut into.
- **Color** - The cuts will be capped with a solid color. When this option is selected the cap color will be shown - click the color input to set another color.
- **Material** - Use another material for the caps. Drag a material from the Library to the material field in the cutaway material properties. Click the material field to edit the material.

Excluded Objects

If you only want to cut into some of the parts of your model you can exclude objects from the cutaway. Click the add button and select the nodes you want to exclude. To remove a part from the exclusion select it in the list and click the delete button.

Limitations

- Opacity maps on cutaway caps are not supported.
- Fade Animations are not supported with cutaway materials.
- Show Caps is intended to be used together with fully closed surfaces (solids). Caps may show artifacts with non-closed geometry.
- Cutaway material is not supported in GPU mode.

Known Issues

- **Co-planar surfaces**: If you have two co-planar parts where one is excluded from the cutaway and you use inherit caps or material caps, artifacts can occur on the surface of the excluded material.
- **Shadows**: Cutaway material may interfere with shadows on the environment ground. If the cutaway object touches the environment ground it will cut that just as it cuts into regular parts.
  - **Workaround**: Add a ground plane (Edit > Add Geometry > Add Ground Plane) and exclude it from the cutaway.
- **Camera inside cutaway object**: When the Camera is inside the cutaway object, Color caps do not show and when using Material caps, all objects in the scene will be displayed with the cap material.
- **Excluded objects**:
  - Excluded objects have incorrect reflections - Objects excluded by cutaway show reflections of the inside of the object being cut.
  - Bad Shadows on excluded objects.
  - *Basic Glass* and *Thin Film* appear as metal when applied to an excluded cutaway object - Product mode only.
Quick tip
Emissive

The Emissive material type can be used for small light sources such as LEDs, lamps or even illuminated screen displays. It is not meant to illuminate scenes as a main light source. The emissive material will need “Global illumination” enabled in “lighting” to illuminate other geometry in the realtime view. It will also need ground illumination to illuminate the ground plane as shown. Color textures can be mapped to the material and any colors included in the texture will be emitted as light. When using emissives, it is a good idea to enable “Bloom” under effects in realtime settings. This will create the glowing effect shown in the image.

Intensity
This will control the intensity of the light that is emitted.

Color
This will control the color of the light emitted from the material.

Advanced

Visible to Camera
Hide the emissive material from the camera, but the emissive material will still emit light.

Visible in Reflections
Hide the emissive material from any specular reflections. The effect of the emissive will only be seen on the diffuse component of materials.

Two-Sided
This will cause the emissive light to display on both side of the surface.

Use Color Map Alpha
This will allow you to use the alpha channel in the color map.
Ground

The *Ground* material type is a specialised material type for creating a ground for rendered objects. It is a shadow and reflection catching material that blends with the Environment Background. The shadows and reflections will also have transparency when rendering to an image format that supports it.

Simply click *Edit* and select *Add Ground Plane*. This will add a ground plane into your KeyShot scene. The ground material can also be applied to imported geometry.

**Shadow Color**
The shadow that is being cast from the object will be displayed in this color. Clicking the color block will allow you to edit the color.

**Specular Color**
Controls the color of the specular light reflections on a material. When the specular color is set to black, a material will have no specular reflections and will not appear reflective or shiny. Specular color set to white will give 100% reflectivity for that material.

**Refraction Index**
This controls the shape of reflected objects on the surface.

**Reflection Contrast**
Controls the contrast for specular reflections. Can be used to enhance reflections on light backgrounds.

**Clip geometry below ground**
If any geometry is being displayed below the ground plane material, this option will clip the geometry below the ground plane, hiding it from the camera.

![Ground with shadows and reflections rendered with a Backplate Image](image)

![Ground material properties](image)
The Toon material type allows you to apply a solid color with contour lines to your 3D model. You are able to control the contour width, the number of contour lines, and whether or not shadows are cast onto surfaces. This is useful for creating sketches, product concepts, or technical illustrations.

The Toon material type contains the following properties:

**Color**
This will control the fill color of the Toon material.

**Contour Color**
This will control the outline of the model.

**Shadow Color**
This controls the color of the shadows on the model. Activated when the Environment Shadows under Advanced settings setting is enabled. A texture may be applied to control the appearance of the shadow.

**Contour Width**
This will control how thin or how thick your contour lines will be.

  - **Outline Width Multiplier**
    Increase this value to create a “perimeter line” effect with your Toon material. This will help pop the part from your scene and create a stronger visual contrast.

  - **Part Width Multiplier**
    Use this to increase the line width of part contours and interior edge contours. It will not affect the scene unless Part Contour is enabled.

**Contour Angle**
This will control the number of interior contour lines in the toon sketch. The value determines the angle of the curvature where contour lines will appear. A lower value will increase the number of interior contour lines and a higher value will decrease the number of interior contour lines.

**Shadow Strength**
When the Environment Shadows or Light Source Shadows setting is enabled, this controls the strength of each shadow type cast onto the Toon material.

**Transparency**
Increasing this value will allow light to pass through the geometry. Use this feature on transparent parts, or to show interior views of your model.

**Advanced**

**Contour Quality**
This will control the quality of the contour lines. Use a lower value to obtain a rough sketch look, or a higher value for a more clean and precise stroke.

**Contour width is in pixels**
When enabled, the contour lines are defined using pixels. When this setting is disabled, the contour lines are defined using scene units.

**Interior Edge Contour**
This will show or hide the interior contour lines in your sketch.

**Material Contour**
This will allow you to show or hide the contour line that separates each unlinked Toon material. If the Toon materials are linked, this setting will not have an effect.
Environment Shadows
This will reveal the shadows cast by the model onto itself due to the selected lighting environment.

Light Source Shadows
Controls the visibility of shadows produced by a Light Source (Point Light Diffuse, Point Light IES Profile, or Area Light Diffuse). The shadow appearance will change depending on the settings of your light source.
**Wireframe**

The *Wireframe* material type exposes the lines and vertices of each polygon of a surface.

**Width**
Controls the width of the lines (wires) in the wireframe.

**Width in pixels**
When enabled, the wires are defined using pixels. When this setting is disabled, the wires are defined using scene units.

**Wire Color**
This controls the color of the lines of the wireframe.

**Base Color**
This controls the overall color of material, excluding the wires.

**Base Transmission Color**
This value controls the base color transmission. A lighter color will give the appearance of transparency.

**Backside Base Color**
This controls the backside of the base color. On a cube this would be the inside of the cube.

**Backside Wire Color**
This controls the backside of the wire color.
Axalta Paint

As the leading manufacturer of auto body paints, Axalta has created several collections of KeyShot materials that are an accurate representation of the real world paints they provide.

You can find a selection of the materials in the Material Library and find even more materials on the Axalta Collections website.

As the paints are developed by Axalta you can not create new ones from scratch, but you can tweak the colors and make adjustments to roughness and reflection.

Color Tweaker
Advanced option for fine adjustments to the way the paint behaves when viewed at certain angles.

Roughness
This adds microscopic levels of imperfections to the surface of the material when the values are increased. When this is set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more matte as light is diffused across the surface.

Advanced

Refraction Index
This slider provides controls the reflection on the surface. Increase the value to get more reflection intensity.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will smooth out and provide a more evenly distributed roughness.
Xray

The Xray material type provides a useful tool for illustrative renderings. It is often used to create a faded view through an outer shell.

Color

When applied to a part, the Xray effect works by showing more of the material color on areas of the surface that are being viewed at more of an angle. The surface is nearly completely transparent where it is viewed at a direct angle.

Note: the Xray material does not cast shadows.

Xray material with different colors.
**Color Library**

**Applying Colors**

The KeyShot Color Library lets you drag and drop predefined colors onto any part or object in the Real-Time View. This will replace the primary color of the material. If you want to replace any of your materials other color parameters, you can press Alt while you drag the color onto the material. This will give you a choice between all color values of the material.

**Search**

Searching for colors can be done by clicking in the search box in the top right and typing the name of the color.

**Find similar colors**

Searching can also be achieved by clicking the crosshair icon in the top right area of the dialog. This will open a window with a color picker, where you can either enter the color you are looking for or use the eyedropper to select a color in the scene. This will filter the swatches in the current color group so only colors similar to the one you searched for are shown. Click refresh to clear the search again.

**Import**

You can import Color libraries from .KCP or .CSV files. Note that the imported colors will be placed in the currently active Color Group - So you may want to create a folder for the purpose before importing.

When creating a CSV file, the color entries need to follow these formats:

- **RGB** - Name; R; G; B;
- **RGB (0-1)** - Name; R; G; B;
- **HEX** - Name; hex code (incl. #);
- **CMYK** - Name; c; m; y; k;
- **HSV** - Name; H; S; V;
- **CIE-L*ab** - Name: L; A; B;

The values can be separated by comma, semicolon, or tab.

**Add color groups**

You can create your own color groups for your custom colors. Select the folder where you want to add a color group to. Click the add folder icon and give the group a name.

**Add color**

You can add your own colors in two ways:
• When you are defining a color with the color picker e.g. for a material, click to save the color, choose Color Group and give the color a name.
• Right-click inside the color library and select Add Color. This will launch a color picker where you can define your color. Click OK to save the swatch an.

Export Color Group

You can also export color Groups - this will create a .kcp file.

Read-only color groups

Color groups that have a little lock icon next to the name, contain industry standard colors such as PANTONE, RAL and FED-STD 595 and these can not be added to or exported.

Quick tip

Colors from the library will be gamma corrected when applied to the image.
Color Picker

The Color Picker can be accessed anytime a color property is clicked. The Color Picker gives you the ability to both change colors quickly or test colors visually. Colors may be changed using the Color Bar, Color Map, Color Sliders (and their numerical inputs), or by dragging and dropping from the Color Swatches.

Color Bar

The Color Bar area contains the current color and a comparison of the New/Old color if the current color is changed. It also has the Eye Dropper tool and the option to save a color to the Library.

Color Map

KeyShot contains both a Hue Color Field (default) and a Traditional Triadic Color Wheel. These can be toggled at the lower left of the Color Map. The current color will be located on the Color Map by a white/black circle.

Color Sliders

The Color Picker also provides Color Sliders for various Color Spaces and Value scales. The Color Space can be changed from the Color Space dropdown menu at the lower right corner of the Color Map. The following options are available:

- **RGB** - Color channels for Red, Green and Blue
- **CMYK** - Color channels for Cyan, Magenta, Yellow, and Black
- **HSV** - Color channel for Hue, Saturation, and Value
- **Grayscale** - Value channel for Brightness
- **CIE-L*ab** - Value channels for Lightness (L), red-green (a), and blue-yellow (b)
- **Kelvin** - Value channels for Temperature

When a Color Map is selected, the Color Sliders will update to provide input for the corresponding Color Space. Though you won't see the Color Map change when a new Color Space is selected, as you adjust the sliders and inputs the Color Bar and the Color Map will change to display the color selected or values entered. Likewise, the Model will display the new color in the Real-time View.

- You can switch between Color Spaces without changing your color, however switching to Grayscale or Kelvin Value scales will limit the color range to those scales.

Color Options

Directly below the Color Map, you will see a gear icon with additional color options.

- **Use gamma corrected values for input**
  Checking this option will apply Gamma correction to the Color Sliders. (Selected on by default.)
- **Apply Image Gamma to colors in Swatches and Color Pickers**
  Checking this option will apply gamma correction to both the color swatches of materials and the Color Picker. This will only adjust the
actual color preview, not the values. (Selected on by default.)

**Color Swatches**

The Color Swatch grid at the bottom of the Color Picker provides quick access to colors you regularly use across scenes. Here, you can quickly add color swatches, refine them and, if desired, save the individual colors to a color folder later. The Color Swatches are loaded with preset colors.

**Add new swatch**
The color(s) represented in the Color Bar at the top of the Color Picker (both New and Old) can be dragged and dropped to the Color Swatch grid to create your own color palette. Color swatches can be overwritten by simply dragging and dropping new colors onto existing colors or by dragging and dropping within the Color Swatch area itself.

**Using the Color Picker**

When you open the Color Picker you will see the Color Bar, the Color Map, the Color Sliders and the Color Swatches. The current color will be shown in the Color Bar, located in the Color Map by a white/black circle, and on the Color Sliders with vertical lines and a value corresponding to the Color Space selected from the Color Space dropdown menu.

With the cursor on another area of the Color Map, click to select a new color, or click-hold and drag to change colors dynamically. For finer control over the color, select a Color Space that corresponds to the color control you desire, then use the color/value channels and input fields to adjust to the color desired.

**Using the Eye Dropper Tool**

The Eye Dropper tool gives you the ability to select any color on your display. When you select the Eye Dropper tool, the color under your mouse cursor will appear in the New Color Bar area. Use the left mouse button to select the color or hit Esc to exit the Eye Dropper selection mode.

**Saving a Color**

When you have selected your desired color, you may drag and drop the color from the new area of the Color Bar to the Color Swatch grid for later use. To save a New color to your library, click the Save icon. A prompt will appear to choose a Color folder in the KeyShot Library where you would like to save your new color.

Add folder
To add a new folder to the Color Library, go to the Library, Color tab and select the New Folder icon or right-click, at the location in the
folder list where you want to add the new folder, and select Add. Likewise, the rename or remove a folder, right-click the folder and select Rename or Remove.
Material Graph

The Material Graph facilitates advanced material editing/creation. The feature is available only for users of KeyShot Pro.

You can access the Material Graph from the Material Tab in the Project window. Click the Material Graph button to launch the Material Graph. It opens in a separate window and displays materials, textures, labels and more as nodes in a graph view to visualize connections and relationships within complex materials.
Material Graph User Interface

There are five components of the Material Graph window: Menu bar, Ribbon, Materials & Textures Library, Material Properties, and the Work Area.

1. Material Graph Menu Bar

Material
- **New** This will replace the working material and any textures with a basic diffuse material to start from scratch.
- **Save to Library** will save the working material to the specified folder in your KeyShot Library.
- **Export** This will allow you to export your material as a KeyShot MTL file type in a specified folder.

Nodes
This provides quick addition of nodes to the Work Area.

View
- **Align nodes** This automatically arranges connected nodes in the Work Area.
- **Zoom** With complex materials the Work Area can quickly get crowded - the zoom options allow you to quickly adapt the Work Area to your current material.
- **Preview** Options for previewing individual node settings such as color, alpha, and bump in the Real-Time. You can also stop the preview within this menu as well.
- **Save Graph Screenshot** Will save a PNG if the nodes in the current material, to your selected location.

Window
This gives access to hide/show the Material Properties window (4), Materials & Textures Library (5), and the Material Graph Ribbon (2).

2. Material Graph Ribbon

- **Save to Library** - saves the current material to your Material Library

- **Add material node** - adds an “Advanced Material” node. The new node will be the default node of the category - you can easily switch the node to another type of the same category in the Material Properties window.

- **Add Texture node** - adds a traditional texture map and opens the file browser window to select your image file*

- **Add Animation node** - adds a Color Fade node*

- **Add Utility node** - adds a Bump Add node*

- **Duplicate selected node**
Delete Selected node

Preview color

Preview alpha

Preview bump

To activate a preview mode, select a node you would like to preview. After selecting a node, the available preview modes will become selectable. Click on a preview mode to activate it, which will make the selected node red in the Work Area. To disable the preview mode, click on the activated preview mode again on the ribbon.

Align nodes - align the nodes within the Work Area

Zoom to fit - fit all the nodes within the Work Area

Zoom to 100% - view the nodes at 100% zoom level

Create Multi-Material - will convert the current material to/from Multi-Material

Refresh Geometry nodes - The geometry shaders (displacement, bubbles and flakes) need to be refreshed before any edits will be visible in the Real-Time View.

3. Material Graph Work Area

The Work Area displays all nodes their connections in a graph view.

In the work are you have following options:

- Select a node or connection - left click.
- Select multiple nodes - left-click and hold Ctrl (Cmd on Mac).
- Select multiple nodes - Shift + left-button hold and drag to use the marquee selection.
- Delete/duplicate node - Right click on a (selection of) node(s) to delete or duplicate.
- Remove/disable connection - right click on the connection and remove/disable/activate.
- Add node - Right click in the Work Area to access the context menu, where you can access the same nodes as those found in the Nodes menu.
- Zoom in or out of the Work Area - Use the middle mouse wheel.
- Move the Work Area - Click and drag the work area to move it around.

4. Material Graph Properties

The Material Properties dialog shows the associated properties for the current node being edited - similar to the Material tab in the Project window but with the option to change node type.
5. Material Graph Libraries

The Materials and Textures Library contains an organized thumbnail display of all the nodes available.
Material Graph Nodes

Nodes are displayed as gray boxes in the Work Area. Each node has different input and output channels depending on the type.

**Connected nodes** Connections are made by clicking on an output channel and dragging and releasing directly onto an input channel or onto the node itself. When it is released onto the node, a context menu will show all the available channel options. Once a connection is made, a blue line will appear connecting the 2 nodes. Right click the line to remove or disable the connection. A disabled connection will be displayed as a grey dashed line. If you select a connection, it will turn light blue.

**Root Node** All materials have one Root node (marked with a thicker border) to which all nodes must be connected (either directly or through other nodes) to have effect on the material.

**Multi-Materials** If you have a Multi-Material shown in the Material Graph, all variations will be visible. The active material will have an orange outline

**Material Properties** If the material properties are shown in the material graph the node that has a lighter grey background is the one that is shown in the material panel

---

Node categories:
- Material Node Types
- Texture Node Types
- Geometry Node Types
- Animation Node Types
- Utility Node Types
Material Node Types

Setting up Material nodes is initially the same as setting up Materials in the Material tab of the project panel - But with the Material Graph you can set up much more advanced materials using a combination of nodes - one thing you can do is add multiple bump textures to your material using Utility nodes ...and much more.

All Material Types are covered in our Materials section:

- Diffuse
- Flat
- Glass
- Glass (Solid)
- Liquid
- Metal
- Paint
- Plastic
- Thin Film
- Translucent
- Advanced
- Anisotropic
- Dielectric
- Gem
- Generic
- Measured
- Metallic Paint
- Multi-Layer Optics
- Plastic (Cloudy)
- Plastic (Transparent)
- RealCloth
- Scattering Medium
- Translucent (Advanced)
- Velvet
- Light Sources
- Cutaway
- Emissive
- Ground
- Toon
- Wireframe
- Axalta Paint
- Xray
Texture Node Types

Texture nodes are initially the same as adding textures in the Material Tab of the Project panel - But with the Material Graph you can set up much more advanced materials using a combination of nodes - one thing you can do is add multiple bump textures to your material using Utility nodes ...and much more.

See our Texture Types covered in our Textures section.

- Texture Map
- Tiled UV
- Tri-Planar
- Video Map
- Brushed
- Mesh
- Weave
- Brushed (Radial)
- Camouflage
- Cellular
- Color Gradient
- Contour
- Curvature
- Granite
- Leather
- Marble
- Noise (Fractal)
- Noise (Texture)
- Occlusion
- Scratches
- Spots
- Vertex Color
- Volume Map
- Wood
- Wood (Advanced)
Geometry Node Types

The Geometry nodes will transform the shape of your geometry in a non-destructive manner. This way you can always replace the material and the geometry will return to the original shape.

Bubbles in mango juice, Styrofoam displacement, Gold sprinkle flakes and Fuzz applied to the same model.

Execute Geometry

Geometry nodes are the only nodes that does not update your material in real time when you edit/set them up. After any edits to the material you make you must "execute geometry" before you can see the effect in the Real-Time View. This can be done in a number of ways.

- The Execute Geometry Node button in the properties panel will only refresh the current material.
- The Geometry Nodes button in the Material Graph ribbon will refresh all geometry nodes in the scene.
- The hotkey Alt+G will refresh all geometry nodes in the scene.
- In the Real-time View an indicator in the top right corner will show that the scene contains un-executed geometry nodes. Click it to refresh all geometry nodes.

Tip

If you want to bake your displacement into the geometry, you can export your displaced object and re-import it into your scene.

Note

If you experience problems with opening scenes with e.g. heavy displacement, you can try to open it in recovery mode. This means that the scene will be opened in Performance mode and that no geometry nodes are executed. You can find the option in the Main menu > Help > Open (Recovery mode)...

On this page

In this section:
- Bubbles
- Displace
- Flakes
- Fuzz
Known Issues and Limitations

- Bubbles, Displacement and Flakes are not supported in Render Nurbs Mode
- When applying Displacement to geometry with hard edges, these edges become split.
- When applying a single Displace node to multiple sub-materials of a Multi-Material, some sub-materials may become corrupt.
Bubbles

Use the Bubbles node when you want to add spheres of air inside the material of your object. Make sure the material is transparent to some degree, otherwise the bubbles will not be visible. To make the bubbles appear in your geometry, connect the Bubbles node to the Geometry socket of the root Material node.

Bubbles Settings

Size

The Size slider sets the size of the bubbles.

The animation below shows the effect of varying the bubble size between 0.01 cm and 0.1 cm. The material is Liquid, applied to a 1 cm cube.
Size Variation

The Size Variation slider applies a fractional variation to the bubble size.

The animation below shows the effect of varying the bubble size variation between 0.1 and 3.

Density

The Density slider will adjust how close the bubbles are to each other.

The animation below shows the effect of varying the bubble density between 1/cm and 10/cm.

Bubble Limit

The Bubble Limit slider allows you to limit the amount of bubbles used. The limit is per object, not the overall for the material in the scene. The limit value is expressed in millions.

Seed

The Seed slider randomizes the distribution of the bubbles within the geometry.
**Density Texture**

If you do not want the bubbles to be distributed evenly inside the object, you can add a texture to control the density. This will act as a mask on the density. Where the texture is black, no bubbles will be shown and the amount of bubbles will increase where the texture is lighter. The density will increase until it (at 100% white in the density texture) reaches the density that has been defined on the bubbles node.

**Note**

When working with Bubbles, it is important that your geometry is a closed mesh. If there are gaps in the mesh, the texture will not be applied. You can use the Close Mesh tool, to fix gaps in your mesh.
Displace

Use the Displace node when you want to transform the surface of the object. Add a Displace node to the Geometry socket of the root Material node, then add a Texture Map to the Displace socket of the Displace node.

Displace Settings

Displacement Height

The textures's white areas are displaced with the value set in Displacement Height while black areas will not be displaced. Negative values will cut into geometry.

Offset

The Offset slider adjusts the origin of the displacement. When the Offset is set to 0 (default) the black areas will be on the surface of your geometry.

Triangle Size

The Triangle Size slider allows you to set the size of the triangles that makes up the displacement.

Triangle Size in Pixels

By default the triangle size is set in the current scene units. Enable this if you want to set it in pixels.

Max Triangles

The Max Triangles slider allows you to limit the amount of triangles (in millions) used to displace each part. Note that the value is the targeted max, the actual amount produced can be slightly higher.

Connected nodes

Displace

The Displace socket of the Displace node is where the texture is applied. In order for the displacement to have effect on your geometry you need to connect a texture. The light areas of the texture will raise the surface of the geometry while black areas stay.
Displacement Map Settings

**Contrast:** The Contrast slider under the Texture Map properties, Color settings will control the linear displacement height.

- The Texture has concentric circles of grey. From the center, 0% black, 20% black, 40% black etc.
- Contrast = 1: The increase in displacement height is not linear.
- Contrast = 0: Each step adds the same increase in displacement height.

*Quick tips*
**Flakes**

Use Flakes when you want your object to be made up of flakes of a specific material. Add Flake node to the geometry socket of the Root node.

*Flake Settings*

**Flake Shape**

Choose if you want the flakes to be square or spheres. Note that if you want to use UV maps on the flakes, they need to be set to *Square*.

**Size**

Set the size of the flakes.

The animation to the right shows the effect of varying the flake size between 0.01 cm and 0.1 cm. The material is Plastic, applied to a 1 cm cube. A duplicate cube with transparent Toon material was added to indicate the bounding geometry of the flakes.

---

On this page:
- Flake Settings
  - Flake Shape
  - Size
  - Size variation
  - Density
  - Flake Limit
  - Seed
  - Vertex Colors
  - Flake UV
  - Flakes Only
  - Connected nodes
  - Surface
  - Density Texture
Size variation
Fractional variation of flake size

The animation to the right shows the effect of varying the flake size variation between 0.1 and 3.

Density
This slider will adjust how close the flakes are to each other

The animation to the right shows the effect of varying the flake density between 1/cm and 10/cm.

Flake Limit
The Flake Limit slider allows you to limit the amount of flakes used. The limit is per object, not the overall for the material in the scene. The limit is a count expressed in millions.

Seed
The Seed slider randomizes the distribution of the flakes within the geometry.
Vertex Colors

With vertex colors enabled you can make the flakes different shades. In the example below the vertex is combined with a color gradient to make the flakes grey, light blue and dark blue.

Flake UV

Enables the use of UV maps on your flakes. In the example below the KeyShot Logo is applied as a UV map to each flake which are made round using the same texture as an alpha opacity map.

Note:
Vertex Colors and Flake UV only work with Square flakes

Flakes Only

With the Flakes Only checkbox you have the option to keep/hide the enclosing geometry, when generating the flakes.
If you choose to disable the *Flakes Only* option the flakes will appear inside the original geometry, which means that they are only visible if your base material is transparent to some degree.

**Connected nodes**

**Surface**

Gives you the option to add a surface to the flakes. If you choose to show the enclosing geometry, the flakes will by default share the base material with the original geometry.

In this example the flakes are given a different material, than the base material, via the *Surface* slot on the *Flake* node.

**Density Texture**

If you do not want the flakes to be distributed evenly inside the object, you can add a texture to control the density. The *Density Texture* will act as a mask on the flake density. Where the texture is black, no flakes will be shown and where the texture is lighter, the amount of flakes will increase until it (at 100% white in the density texture) reaches the density that has been defined on the flake node.
**Fuzz**

The Fuzz node enables you to add fibers coming out of your surface. To make the fuzz appear on your geometry, connect the Fuzz node to the Geometry socket of the root Material node.

**Fuzz Settings**

**Length**: This determines the base length of the fuzz fibers.

**Length Variation**: Adds variation of the fuzz fiber length. The fibers will be varied up to the selected length + length * variation value.

**Randomness**: By default the fuzz fibers are straight. Increasing Randomness will add variation to the flow of each fiber.

**Radius**: Set the width of each fuzz fiber.

**Density**: Adjust how many fibers are added within 1 unit.

**Segments**: Determines the number of segments each fuzz fiber consists of. Increasing the number of segments will produce a smoother fiber. If you have added length variation to the fuzz, the varying fibers will have proportionally more/less segments.

**Shape**: Select if you want the fuzz fibers to have *Ribbon* or *Cylinder* shape.

**Max Curves**: This value limits the amount of curves the fuzz material can generate for each part. Adding large amounts of curves can make the scene very heavy. The amount of curves are impacted by both density, length variation and segment values. If the curve limit is reached the density will be impacted. The Max curve value is measured in millions and is an approximation. If you don't want to limit the amount of curves just leave the value at 0.

**Appearance**

The following parameters will only affect the fuzz fibers, not the base geometry.

**Color**: Sets the base color of the Fuzz fibers.

**Specular**: This is the color and intensity of the reflection of light sources within the scene. Black will completely turn off reflections, while white will provide a very shiny plastic look. To achieve the most realistic look, use some level of gray or white. Adding color can give the material a metallic effect.

**Roughness**: This will add microscopic levels of imperfections to the surface the fibers, when the values are increased. When set to 0 the material will appear perfectly smooth and polished. When the value is increased, it will appear more rough as light is diffused across the surface.

**Transmission Roughness**: Increasing this value will spread out highlights on the surface similar to what you see on non-transparent, materials. However, it also spreads out the light that is transmitted through the material.

**Transmission Spread**: This controls the spreading of light, as it passes through the fuzz fibers.

**Refractive Index**: This controls how much light will bend or “refract” as it passes through the fuzz fibers.

**Connected nodes**

**Surface**

Adding a material to the Surface slot of the Fuzz node will enable you to customize the material of the fuzz fibers. This means that when a Surface
node is attached the Appearance parameters in the Fuzz node will be disabled.

**Density texture**

The Density texture enables you to add variation to the density of the fuzz fibers. In white areas, the density will match the value you entered in the Density parameter above while darker areas will have less fuzz fibers.

In this example the bottom plane shows the texture, used to manipulate the fuzz density in the top plane.

**Length texture**

Where the Length Variation adds a randomness to the length of the fuzz fibers, the Length Texture enables you to manipulate the length based on a texture. This will act as a mask to the length, while it still takes the Length Variation into account.

100% white will result in the length defined in the parameters above, while darker colors will produce shorter fuzz fibers.

In this example the bottom plane shows the texture, used to manipulate the fuzz length in the top plane.
Direction texture

By default the fuzz fibers will follow the normals of the part. The Direction Texture will enable you to manipulate the direction at which the fibers come out of the surface with a bump/normal map. In this example, the bottom plane shows the texture, used to manipulate the fuzz direction in the top plane.

Note that the direction texture determines the angle at the base of each fuzz fiber, if you increase the Random value this will make the direction less pronounced.

Limitations
- The Direction texture does not work with UV mapped textures
Animation Node Types

The Animation nodes are unique in that they allow you to create changing parameters of your materials.

When you add an Animation node to your material, it will automatically be added to the animation timeline as well.

You can select the node and change the settings in the animation properties window.

For more details about Animations, see the Working with Animations page.

Animation node types:

- **Color Fade** - this node type enables you to animate the color values of your material.
- **Curve Fade** - this node type enables you to animate a single value of one of parameters of your material.
Color Fade

The Color Fade animation node allows you to create changing parameters of any of your custom material color swatches.

Color Bar

Here you can set when and what colors will fade from one to the next. Click on the dropper circle to select it, then use the color swatch to choose a color.

The little triangles show where the 2 colors are mixed 50-50 and they can be dragged to control the course of the blend.

Add Color Stop

If you would like to fade between more than 2 colors, click on the Add stop button below the color bar to create another color swatch. click and drag the color pins and the gradient apex slider to your desired animation effect.

Delete Stop

If you want to remove a color stop, just select it and click delete.

Time

To control the color change more precisely than by dragging the individual color stops on the timeline (color bar), you can select a color enter in where in the timeline it will become the selected color.

Blend

Check Blend if you want the colors blend into each other otherwise the color change will be instant, at the point of the color stop.

Time Settings

Use these settings to control the timing and duration of the animation - see the Motion Ease types here.
Curve Fade

The Curve Fade animation node allows you to add changing parameters of any of your numerical properties within your custom material. To see the which parameters you can change for a specific node, connect the Curve Fade animation node to the + socket.

Animation

Here you can set the value of the parameter on any time during the animation duration.

Setting the value: Select a point (keyframe) on the curve and add the time and the value of it below the grid or simply drag it in the curve editor. Hold Shift to restrict to horizontal movement (adjusting time only).

Adding a keyframe: Double click in the grid or right click and select Add Key to add a keyframe.

Determining the flow between keyframes: Each keyframe determines the interval from the keyframe till the following keyframe. By default all keyframes will be curve points when you add them, but you can easily change the type:

- **Stepped:** This will keep a fixed value until the next keyframe in the timeline is reached.
  - The stepped keyframe will by default not have a tangent handle opposite the stepped section, but you can add it via the Tangent handle icon. This way you can ease into/out from a stepped value.
  - Use the value at the start of the interval.
  - Use the value at the end of the interval.

- **Curve:** Curve keyframes have tangent handles that can be manipulated to make the transition ease in/out.
  - Lets you enable/disable the left/right tangent handles
  - Keep tangent handles locked opposite to each other.
  - Unlock tangent handles.

- **Straight:** This is a variant of the curve point, where both tangent handles have been disabled by default. Simply click the tangent handle icons to make it a regular curve point.

Adjusting the curve: Drag the tangent handles to adjust the ease-in/out of a key. Hold Shift to restrict to horizontal movement.

Deleting a keyframe: Select a keyframe and press the Delete key or right click the keyframe and select Delete.

Time indicator and work area: The curve editor has the same Time and Work Area indicators as the regular Animation timeline, enabling you to scrub through the timeline and limit the animation from the curve editor.

Move the Grid: Click and drag inside the grid to move the timeline.
**Zoom in the grid:** Click in the grid and use the scroll wheel or Ctrl +/- (Win) Cmd +/- (Mac) to zoom in/out.

**Zoom to fit:** You can fit the current curve in the curve editor simply by clicking the 🔼 Zoom to Fit button above the grid.

**Time Settings**

Use these settings to control the timing and duration of the animation. Notice that manipulating the start/end points on the animation curve will impact the time settings and vice versa.

---

**Number Fade**

In KeyShot 9 the Curve Fade node replaces the Number Fade node. The nodes have the same abilities to change a value of a given parameter. The new feature is that where animation with the Number Fade was a straight line between the 2 values, the Curve Fade enables you to control the animation curve.

Scenes containing a Number Fade will be converted to a Curve Fade, where the easing option has been replaced with the animation curve.
Utility Node Types

Utility nodes allow you to combine, modify and add to other node types.

<table>
<thead>
<tr>
<th>Utility Note types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bump Add</td>
</tr>
<tr>
<td>Color Adjust</td>
</tr>
<tr>
<td>Color Composite</td>
</tr>
<tr>
<td>Color Invert</td>
</tr>
<tr>
<td>Color Key Mask</td>
</tr>
<tr>
<td>Color To Number</td>
</tr>
<tr>
<td>Color Curve Randomize</td>
</tr>
<tr>
<td>Mapping 2D</td>
</tr>
</tbody>
</table>
Bump Add
Combine two bump texture maps or procedural textures. Control their interaction by defining the Ratio and Weight in which the two bumps are visible.

Bump Add Settings
The Ratio and Weights control the contribution of the two input bump maps to the final bump result.

Ratio: The Ratio parameter allows to balance the contribution of both input bump maps with a single slider. The default value of 0.5 defines that both bump maps contribute equally to the final bump result. With a value of 0 only Bump 1 affects the material, whereas with a value of 1 only Bump 2 is visible.

Weight: The two Weight parameters work like a multiplier for each of the two bump texture's Bump Height. The default values of 1 keeps the bump height as defined on the texture. When the Weight for a bump input is 0, the effect of that bump is nullified. Values higher than 1 amplify the bump effect in the final result.

Bump Add example
The following examples show a Plastic material with Bump Add to illustrate the concepts of Ratio and Weight
Plastic material with two bump textures

**Bump Add with Ratio = 0.5, Weight 1 = 3 and Weight 2 = 1**

**Variations**

- **Bump Add with Ratio = 0**
- **Bump Add with Ratio = 1**
- **Bump Add with Weight 1 = 1 (Ratio = 0.5 and Weight 2 = 1)**
- **Bump Add with Weight 1 = 10 (Ratio = 0.5 and Weight 2 = 1)**
Color Adjust
Colorize and/or modify the existing color of a texture map or procedural texture by adjusting Hue, Saturation, Value, and Contrast. Each of these parameters can be textured.
At default values the texture remains unchanged.

Color Adjust example
The examples below show how a Color Adjust node can be used to easily adjust the color of wood textures.
Wood material with procedural wood texture.

The Material Graph structure of this example

**Color adjusted examples**

<table>
<thead>
<tr>
<th>Color Adjust with Colorize with a red color (HSV: 320, 65, 80)</th>
<th>Color Adjust with Colorize with a green color (HSV: 185, 65, 80)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Adjust with Value = 0.2</td>
<td>Color Adjust with Value = 2</td>
</tr>
<tr>
<td></td>
<td>Color Adjust with Value = Noise texture</td>
</tr>
</tbody>
</table>
Color Adjust with Contrast = 0.2

Color Adjust with Contrast = 3

Color Adjust with Contrast = Noise texture
Color Composite

Layer and combine two texture maps or procedural textures with control of Blend Mode and Alpha (transparency). The functionality is similar to working with image layers and blending modes in image editing software.

Color Composite nodes are commonly used to create Opacity masks from multiple textures or to add gradients to textures.

**Color Composite Settings**

**Alpha**
This defines the transparency of the composited result. The transparency can be set by either using the slider or applying a texture. The behavior is very similar to the Clipping Mask parameter, but the Clipping Mask has additional controls.

**Blend Mode**
This defines how the Source and Background layers are blended together. The following Blend Modes can be chosen: Normal, Multiply, Screen, Overlay, Soft Light, Hard Light, Darken, Lighten, Burn, Difference and Sum. The behavior of these is equivalent to the same blend modes found in most image editing applications.

**Source**
This is the first and top layer of the texture composite. If the Source texture has alpha (transparency), then this will be propagated to the composite.

**Source Alpha**
This defines the transparency of the Source layer. The transparency can be set by either using the slider or applying a texture.

**Background**
This is the second and bottom layer of the texture composite. If the Background texture has alpha (transparency), then this will be propagated to the composite.

**Background Alpha**
This defines the transparency of the Background layer. The transparency can be set by either using the slider or applying a texture.

**Mask Mode**
The following Mask Modes can be chosen: Red, Green, Blue, Alpha, Color. The Red, Green and Blue options refer to the individual RGB channels of the Clipping Mask texture.

Clip Using Source

If the Source texture has alpha (transparency), then this will be used to mask out the composite. The composited result will only show where the Source texture is non-transparent.

Invert Mask

Use this to invert the Clipping Mask texture.

Color Composite example with Label Opacity

The examples below show how a Color Composite node can be used to create interesting Opacity masks for Label materials.

| Flat material showing a Mesh texture | Flat material showing a Color Gradient texture | Flat material showing the blended result using Color Composite with Blend Mode Multiply |
The Material Graph structure of above composite

**Applying the Label mask**

This Color Composite builds on the material graph above, but the material node has been altered.

**Mold-Tech plastic material with Metal Label using above composite texture as Opacity**

**Color Composite example with Complex Label**

The examples below show how a Color Composite node can be used to create a complex Label material.

**Source Layer**
Plastic material with Metal Label using a Color Composite for Color.
An Occlusion texture drives the transparency of the Source texture.
The Background Alpha is set to 0.

<table>
<thead>
<tr>
<th>Plastic</th>
<th>Metal Label</th>
<th>Color Composite</th>
<th>Tri-Planar</th>
<th>Noise (Fractal)</th>
<th>Plastic</th>
<th>Metal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface</td>
<td>Offset</td>
<td>Bump</td>
<td>Bump</td>
<td>Bump</td>
<td>Offset</td>
<td>Bump</td>
</tr>
<tr>
<td>Reflect</td>
<td>Reflect</td>
<td>Reflect</td>
<td>Reflect</td>
<td>Reflect</td>
<td>Reflect</td>
<td>Reflect</td>
</tr>
<tr>
<td>Stencil</td>
<td>Stencil</td>
<td>Stencil</td>
<td>Stencil</td>
<td>Stencil</td>
<td>Stencil</td>
<td>Stencil</td>
</tr>
</tbody>
</table>

Adding the Background layer
Same material from above with a Background texture added to the Color Composite. The Blend Mode is set to Normal.

The Material Graph structure of this example.

Applying the Clipping Mask
Same material from above with a Clipping Mask defined for the Color Composite.

The Material Graph structure of this example.

Applying the Alpha
| Same material from above with an Alpha texture defined for the Color Composite | The Material Graph structure of this example |

*Quick tip*
Color Invert

Invert the color of a source texture map or procedural texture. This is commonly done to convert glossiness maps (white = perfectly shiny) to roughness maps (white = maximum roughness), or invert opacity masks.

On this page
- Color Invert example with Label Opacity

Color Invert example with Label Opacity

Mold-Tech plastic material with Metal Label.
Flat material showing the Opacity texture.
Mold-Tech plastic material with inverted Opacity for the Metal Label.
The Material Graph structure of this example.
Color Key Mask

Mask a specified color within a texture map or procedural texture. Control the strength of the mask by adjusting Tolerance and Fuzziness.

The Invert option allows to easily invert the mask. This effectively turns the Color Key in the unmasked color.

Tolerance and Fuzziness

The Tolerance and Fuzziness parameters define the extent of the color mask.

Any color in the source texture, at a "distance" below Tolerance from the Color Key color, will completely be included in the mask.

Fuzziness gradually (with falloff) includes more colors beyond that, but does not fade the mask inside the tolerance.

The examples below show a cubic lattice of spheres to illustrate the concepts of Tolerance and Fuzziness.

Cubic sphere lattice
Pure red (RGB: 255, 0, 0), green (RGB: 0, 255, 0) and blue (RGB: 0, 0, 255) axes with additive blending

Metal Label mask

A Color Key Mask is used to drive the opacity of a Metal label. The Color Key is RGB: 128, 0, 255

<table>
<thead>
<tr>
<th>Tolerance</th>
<th>Fuzziness</th>
<th>Invert</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

On this page

- Tolerance and Fuzziness
- Color Key Mask examples
- Masking individual colors
- Label masks
- Displacement mask
Color Key Mask examples

Masking individual colors

This example shows a model with a Mold-Tech plastic material onto which a solid-colored KeyShot logo Label is applied. Color Key Mask nodes can be used to mask out the individual colors.

The Label texture that will serve as the source for Color Key Mask.

Left image: Mold-Tech plastic material with Label.
The images below show the result of using a Color Key Mask node to mask out the texture's pink color. For illustration, the output from the Color Key Mask node is connected to the Color parameter of a Flat material.

Depending on a texture's colors, the Threshold and Fuzziness values may have to be adjusted in order to achieve a precise and sharp (black and white) mask.

![Color Key Mask examples](image)

*Color Key Mask with Tolerance = 0.25 and Fuzziness = 1 (default values)*

*Color Key Mask with Tolerance = 0.2 and Fuzziness = 0.4*

The basic Material Graph structure for using Color Key Mask to drive a material's parameter:

Texture > Color Key Mask > Material.

The following two examples show different applications of Color Key Mask

**Label masks**

Three Color Key Mask nodes are used to mask out the texture's three solid colors. The masks are connected to the opacity of three Label materials.
Displacement mask

Two Color Key Mask nodes are used to mask out two colors of the texture. One mask is connected to the opacity of a Label material, the other to a Displace node.
**Color To Number**

The Color To Number node converts color values to number values. This is usually done implicitly such that black is zero and white is 1, however there are times where you need more control. This is quite useful, for example, with roughness maps where you can use Color To Number to easily map a gray scale image to go from e.g. 0.05 to 0.10 – this would be hard to do otherwise.

**Color To Number example with Roughness**

The example below shows a model with a polished metal material onto which a roughness texture will be applied to achieve micro-imperfections on the surface. The third image shows the effect of directly applying above texture to the Roughness parameter of the metal material.

The examples below show the effect of using a Color To Number utility node between the texture and the Roughness parameter.

Color To Number effectively allows to limit the extent of the parameter it drives. The driving values will never exceed the range defined by the Output From and Output To parameters.
Color To Number with Output From = 0.01 and Output To = 0.25

Color To Number with Output From = 0.25 and Output To = 0.02

The basic Material Graph structure for using Color To Number for Roughness:
Texture > Color To Number > Material
Color Curve Randomize

Add color randomness to curve geometry that is assigned a solid color, texture map, or procedural texture. This node allows to randomize hue, saturation and value on a per-curve basis. This can be useful to create additional detail and variation in otherwise homogeneously colored curves.

These parameters are best changed in moderation, as too high values will lead to unrealistic results. This is especially true for the Hue parameter, where small changes will be highly visible.

With values of 0 the curves' colors remain unchanged. Use positive values to add color variation.

**Note:**
This node only works with curve geometry.
Importing curve geometry is supported through the KeyShot plugin for the following applications:

- 3ds Max
- Cinema 4D
- Maya

**Color Curve Randomize example**

The examples below show how a Color Curve Randomize node can be used to easily add variation to the color of curves.
Fur as curve geometry with UV-mapped texture

The Material Graph structure of this example
(Hue, Saturation and Value adjustments are set to 0)

Color randomized examples

The default settings of the Color Curve Randomize node allow to add subtle saturation and value variation to curves.
| Without Color Curve Randomize | Color Curve Randomize with default settings (Hue = 0, Saturation = 0.3, Value = 0.3) |

**Hue adjustments are highly visible.**

| Color Curve Randomize with Hue = 0.25 | Color Curve Randomize with Hue = 0.5 |

**Adjustments to Saturation and Value are much more subtle.**
Color Curve Randomize with Saturation = 0.25
Color Curve Randomize with Saturation = 0.5
Color Curve Randomize with Saturation = 1
Color Curve Randomize with Value = 0.25
Color Curve Randomize with Value = 0.5
Color Curve Randomize with Value = 1
This node enables you to synchronize and control the position of your textures and labels in one place.

Connect the Mapping 2D node to all the textures you want to control with it and make sure the Mapping type is set to Node in the properties of each texture.

The texture Size and Mapping that is set in the Mapping 2D node is propagated to all textures it is connected to, thus aligning them. When the Mapping Type for the connected textures is set to Node, the Size and Mapping properties of the texture nodes function as offsets from the Mapping 2D properties. For example, Width and Height become scalar (unitless) and are effectively multipliers of the Width and Height set in the Mapping 2D node.

**Note:**
To maintain alignment of textures, Move Texture should only be used inside the Mapping 2D node.

**Mapping 2D example**

The examples below shows how a Mapping 2D node can be used to perfectly align multiple Labels.
Labels without Mapping 2D

Mold-Tech plastic material with two Labels that should be aligned.
The Width and Height of the colored 'KeyShot Icon' texture is set to 0.02 meter.
The Width and Height of the 'KeyShot Icon White' texture is set to 0.04 meter.
Both textures use Planar mapping and have Repeat disabled.

Labels with Mapping 2D

Mold-Tech plastic material with a Mapping 2D node connected to the Label textures.
The Mapping Type in the Mapping 2D node is set to Planar.
The Width and Height in the Mapping 2D node is set to 0.04 meter.
The Mapping Type in both Label textures is set to Node.
The Width and Height of the colored 'KeyShot Icon' texture is set to 0.5 (effective size = 0.02 meter).
The Width and Height of the 'KeyShot Icon White' texture is left at 1.
The Material Graph structure of this example.
The result of using Move Texture inside the Mapping 2D node.

The result of resizing inside the Mapping 2D node.
Multi-Materials

Any material can be turned into a Multi-Material to facilitate non-destructive material swapping, variations or color studies. The Multi-Material allows you to cycle through a variety of materials within a single “container” material.

Converting to a Multi-Material

You can convert a material into a multi material in different ways:

- When editing a material select the three-arrow Multi-Material icon above the Material Type drop-down to convert a single material to a Multi-Material.
- Right click an item, with the relevant material, in the Real-Time View and select convert to Multi-Material
- Convert a material of an item in the Real-time View to a Multi-Material by Shift+drag and drop from the library.
- Right click a material in the In Project Library and select Convert to Multi-Material

Adding Sub-materials to a Multi-Material

There are several ways to add a new material to the Multi-Material list:

- Drag-and-drop onto Multi-Material list
  - Simply drag-and-drop a material preset from the Materials library into the Multi-Material list.
- Shift+Drag-and-drop onto part in the Real-time View
  - Holding Shift while dropping a material from the library onto a part in the Real-time View will add the material as a sub-material. If the material of the part is a single material it will be converted to a Multi-Material.
- Add new materials via the list
  - New Plastic - This will add a standard Plastic material.
  - Duplicate Material - This will duplicate the material selected along with any texture and/or label, but keep the textures and labels unlinked.
  - Duplicate Material and Link Textures - This will duplicate the material selected along with any texture and/or label, but keep the textures and labels linked.
- Convert multiple materials in the In Project Library
  - Select multiple materials in the In Project Library, right click and select Combine selection into a Multi-Material. This will combine the selected materials into a Multi-Material and apply it to all the objects that had one of the selected materials applied.

Viewing Multi-Materials

To view or edit the different materials in your list, simply select a material to make it active in the Real-time View. You may also use the arrow keys to cycle up or down through the list.

The thumbnail of the in the In-Project Library will show the active material combined with a label signifying that the material is a Multi-Material.

Saving Multi-Materials
Like regular materials you create, you can also save Multi-Materials. To save a Multi-Material, select the save icon and select the folder you would like to save it in.

**Removing Sub-materials from a Multi-Material**

To remove a material from the Multi-Material list, select the trashcan icon or hit Delete. Additionally, you may overwrite all materials added to the list by dragging and dropping another material onto the part or cancel Multi-Material setup by selecting the three-arrow Multi-Material icon to close the Multi-Material list.
Textures

Textures enable you to map images/procedural textures to materials, in order to create detailed effects such as wood grain, meshes, tile as well as fine imperfections like scratches, which will add that little "extra" to your renderings.

In this section we will cover the various types of textures, the way they are mapped both in regards to the the appearance and the position on the parts.

Adding textures

The textures of a material are located in the Texture tab of the Material panel. You can apply textures from the library, select local files or create/adapt textures based on the texture types (2) found in the panel.

1. Add textures from the Library: KeyShot comes with a number of textures which can be found in the Texture Library in the Library window - and more can be downloaded from KeyShot Cloud.
   - Drag the texture onto the part you want to apply it to in the Real-time view a map dialog will appear, where you can select which Map type you want to texture used as.
   - Drag the texture directly onto the relevant Map type in the material panel.

2. Add textures from file: If you want to use an image from your local directory, you can do it in various ways
   - Double click the relevant map type and browse to the file.
   - Select the map type, click the folder icon and browse to the file.
   - Drag an image from outside KeyShot onto the part in the Real-time View and a map dialog will appear, here you can select which Map type you want to texture used as.
   - Drag an image from outside KeyShot onto the relevant map type in the Material panel

3. Create/adapt textures based on the texture types: Below the the Map types you can find the Texture Type drop-down. In addition to the regular image texture it offers advanced image textures (eg. video maps) as well as 2D and 3D Procedural textures. Select a type and adapt it to fit your purpose.

Tip:
If you want to change the material but keep the textures you have applied to it. You can hold the Alt-key when you drag and drop the new material from the library/outside KeyShot onto the part in the Real-time view.

Working with Textures

- **Mapping Type:** Via the Mapping Type drop-down you can select the method for mapping the texture that fits your object best.
- **Move textures:** To get the position and size of the texture just right, you can launch the Move Texture widget. This will let you adjust the mapping parameters from the Real-time View.
- **Copy textures between Map types:** In some cases it makes sense to use the same texture on multiple Map types, you can easily copy a texture from one to another, simply hold Ctrl/Cmd while dragging the thumbnail from one map type to another.
  - **Sync textures:** If you want to make sure the textures are kept synchronized make sure to check the Sync checkbox for each map type.
Removing textures

If you for some reason want to remove a texture from the material you can do it in 2 ways:

- **Disable:** Unchecking the check box in the upper left corner of the texture map will disable the texture, so you can see the material without the texture applied, without losing all the work you have put in, to customize the texture.

- **Delete:** If you want to remove a texture completely from the material, simply select the map type, and hit the delete icon.
Texture Library

Access the KeyShot Textures Library by clicking the Library button on the main toolbar, selecting Window, Library from the main menu or by hitting the 'M-key'.

The textures located here provide a range of textures to use for bump maps, color maps, gradients, labels and more. These textures provide a fast way to start applying textures to your materials for added realism or a starting point for developing your own textures.

**Search**
Here you can search in the Texture Library. To narrow the search you can select a folder before you enter your keyword, then the search will be limited to that folder.

**Add Texture folder**
You can add your own custom folder to the library. Just press the Add folder icon and give the folder a name. Note that the folder will be placed inside the currently selected folder.

**Import**
If you have textures of your own you want added to the library you can import them.

**Refresh**
Clears the search and displays all textures again.

More textures are available on KeyShot Cloud.
Texture Types

KeyShot has three primary types of Textures that can be applied to materials: Image Textures, 2D Textures, and 3D Textures. Each of these are accessible from the Project window, Material tab, Texture tab. Image Textures use an image file as a texture. 2D and 3D Textures are procedurally generated textures. The three types of Textures include:

<table>
<thead>
<tr>
<th>Non-Procedural</th>
<th>Procedural</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Image Textures</strong></td>
<td><strong>2D Textures</strong></td>
</tr>
<tr>
<td>Texture Map</td>
<td>Brushed</td>
</tr>
<tr>
<td>Tiled UV</td>
<td>Mesh</td>
</tr>
<tr>
<td>Tri-Planar</td>
<td>Weave</td>
</tr>
<tr>
<td>Video Map</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Animation

In addition to the regular texture types users of KeyShot Pro can also add Animations (only to Color and Opacity maps)

- Color Fade
- Curve Fade

About Procedural Textures

Procedural textures are computer-generated, customizable textures that allow you to control the values and color of the texture. KeyShot allows you to create textures in real-time viewing the changes as you make them. In comparison to traditional texture mapping, procedural textures wrap around your model without leaving seams or stretching, regardless of the model’s shape. Use the Texture type drop-down to choose the procedural texture you would like to use.
Texture Map

A Texture Map is an type of Image Map. Texture maps and their settings can be viewed in the Project window, Materials, Textures tab.

Adding a Texture Map

Double-click the texture Map Type (e.g. Color, Specular, Bump...) you would like to add a texture to. This will open a window where you can choose the image file to apply as a texture map. You may also drag and drop textures from the Textures library.

Removing a Texture Map

If you want to delete a Texture Map, right-click on the texture Map Type and select Delete or select the trashcan icon next to the Texture dropdown. This will remove the selected texture from your material. If you make changes to the image file used for the Texture Map, select the Refresh icon to update the Texture Map and see the changes. If you would like to replace the image file used for the Texture Map, select the File icon to choose a new image file.
**Tiled UV**

A *Tiled UV* texture is a type of Image Map. *Tiled UV* textures and their settings can be viewed in the *Project* window, *Materials, Textures* tab.

*Tiled UV* is KeyShot's approach to UDIM where multiple textures are positioned on the model using UV coordinates. The *Tiled UV* texture requires that the model have been made ready for it in your modelling software.
Applying Tiled UV

Select your material and add a Tiled UV texture to e.g. the diffuse map.

Browse and select one of the texture tiles. If the tiles are properly named KeyShot will recognize the rest of the tiles and add them automatically.

Texture Tiles
To be sure the tiles are recognized and positioned correctly the tiles need to be named according to one of these conventions:

1. NameXXYY - Where you can choose to add a separator between the name and U and V values (e.g. cube_u0_v0, cube_u1_v0 ...)
2. NameUDIM - Where you can choose to add a separator between the name and the UDIM number (e.g. cube_1001, cube_1002 ...)

Filtering
For Tiled UV texture you can control the texture filtering for each texture directly:
• **Trilinear** is the simplest and fastest method, but may result in excessive blurring in certain cases.
• **Anisotropic** is higher quality than trilinear and should give less blurring and sharper textures in most cases
• **Elliptic** is the most accurate filtering but can be quite slow.

**Filter Bias**
Adjust the filtering method to give more blurry textures (negative values) or sharper textures (positive values).

**Color**

**Brightness**
Adjust the brightness of the texture tiles.

**Texture Gamma**
Specify the gamma of the source texture. If you use linear color textures set it to 1. If there is doubt about this value, it is likely 2.0 or 2.2. Can also be used as an ad-hoc control of the contrast of the texture.

**Note**
Most texture maps are created in 32 bit, which are not gamma corrected. This is why the default gamma value is set to 1. If you are using gamma corrected textures you will need to adjust the Gamma in order to get the right appearance of the colors.
Tri-Planar

*Tri-Planar* texture is an type of Image Map. Tri-Planar textures and their settings can be viewed in the *Project window, Materials, Textures* tab.

The Tri-Planar texture enables you to create materials that have different textures on the 3 planes of the object - which can be useful when creating such materials as plywood.

This texture type is only available as box mapping, as the essence of the texture type is that it projects a different texture onto each of the X Y Z planes.

![Tri-Planar Texture Example](image)

**Move Texture**
When using the *Move Texture* tool the 2 textures that are parallel to each axis will be moved when translating along an axis.

**Angle**
See the *Move Texture* page for description.

**Blend Seams**
If your planes does not meet in hard edges, you will need to blend the 2 textures at the seam. Increasing the value will create a softer blend.

**Projection X Y Z**

**File**
Select the texture you want to be projected onto the X/Y/Z plane of the model.

**Size**
Set the Width and Height of the texture. *Lock Aspect* will secure a uniform scale of the texture and with *reset* you can always return to the original aspect ratio.

**Angle**
This will rotate the texture on the current plane.

**Color**

**Brightness**
Adjust the brightness of all 3 textures.

Contrast
Adjust the contrast of all 3 textures.

Blend with color
This will add a color-blend to all 3 textures.

Sync
Check sync if you want to keep this texture synchronized with the other textures on this material.
Video Map

A Video Map texture is an type of Image Map. Video Map textures and their settings can be viewed in the Project window, Materials, Textures tab.

With a Video Map textures, image sequences can be set as Textures (or Labels) to animate device displays and much more.

Adding a Video Map

From Project, Materials, Textures select Video Map from the Texture drop-down menu or Add Label (Video) from the Labels tab. Select an image sequence in the file browser or a video file to extract the frames. This will create a node in the Animation Timeline in which you can position and adjust the animation similar to other Animation types.

Frames
To add frames you can:

- add a sequence of images
- select a video and KeyShot will extract the frames for you. Supported formats are: avi, mp4, mpeg, flv, webm, dv, f4v, mov, mlv, m4v, hevc, ogg, ogv. Some formats may have variants encoding which are not supported (for example, avi may include encodings which may not be directly supported.)

Blend Frames
When enabled the transition from one frame to another will be blended. This can be useful e.g. if the FPS of your video map is smaller than the overall animation in which case blending frames can prevent the video from flickering.

Size and mapping

See the Move Texture page

Brightness
Adjust the brightness of the frames.

Contrast
Adjust the contrast of the frames.

Blend with Color
Blend all frames with the selected color

Time Settings

Motion Ease - This will let you add acceleration and deceleration to the video texture. This not something you would usually use for regular videos. But the Video map can also be used for e.g. changing displacement textures in which case motion ease is relevant.

Start, End, Duration
By default the video map will start at frame 0 and have a duration of 1 second. The Time Settings enable you to edit that. You can also drag the Video Map animation in the Animation timeline to alter timing/duration. Notice that changing these value will impact the FPS

Playback mode
Determines how frames are distributed on the timeline.
• **Video** - All frames are distributed equally on the timeline so they will be visible for the same amount of time.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
</table>

• **Slideshow** - The last frame is moved to the very end of the timeline and the rest of the frames are distributed accordingly.

| 1 | 2 | 3 | 4 | 5 |

This is relevant e.g when operating with few FSP and blend frames are enabled as shown in the example below, where the green cube is in video playback mode and the blue is in slideshow mode. Notice that in video mode the 5th frame is visible relatively longer than the other frames.

### Playback Count
Here you can set the number of times the video is played.

### FPS (Frames Per Second)
This sets the frame rate - increasing the frame rate will give a smoother video while decreasing the frame rate will produce a more blurred or even flickering result. Note that changing the FPS will impact the Duration and End time of the video texture.
**Brushed**

The Brushed procedural texture simulates the effects of brushed metal. It is best used as a bump on a metal material with a low roughness value.

**Size and mapping**

See the [Move Texture](#) page

- **Bump Height** Use this to set the depth of the brushed texture.

**Grooves**

- **Length** - Use this to control the length of the brush strokes.
- **Contrast** - Use this to control how defined the brush strokes are as a whole.
- **Levels** - controls the amount of brush strokes.
- **Levels falloff** - Use this to control how defined each brush stroke is.

**Variation**

- **Grain** - This slider controls the amount of grain that is added to the brushed texture.
- **Grain size** - Here you can control the size of the grain.
- **Distortion** - this slider will add distortion to the brush strokes.
- **Apply Bump to Labels** - When enabled the bump map will also be applied to any labels on the material.

Here the Brushed texture is used to add texture to the Nickel Brushed 90° material, which is available in the Material Library.
**Mesh**

Create a pattern of shapes that can be used for meshes in the opacity map, or a shape pattern in color maps.

**Clipping and Mapping**

**Clipping width/height**
If clipping has been enabled for the texture, this is where you set the size of the mesh texture.

**Mapping dependent parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Depth</strong></td>
<td>(planar mapping only) If you don't want the texture to apply to the entire object you can limit the dept of the texture. This way the texture will only apply to the areas on the surface that are within the depth measured from the position of the texture.</td>
</tr>
<tr>
<td><strong>Wrap</strong></td>
<td>(Cylinder mapping only) This determines width of the map that is wrapped around the cylinder, set by an angle measured from the center of the cylinder. The height will match the width.</td>
</tr>
<tr>
<td><strong>Diameter</strong></td>
<td>(Cylinder mapping only) This will adjust the diameter of the cylindrical map, measured from the center. If you want the diameter to match your object you can launch the <em>Move Texture</em> widget and press <em>Fit to X/Y/Z</em>.</td>
</tr>
<tr>
<td><strong>Shift U / Shift V</strong></td>
<td>(Box, Sphere, UV and Camera mapping) Offsets the texture in the U or V direction without moving the center</td>
</tr>
</tbody>
</table>

In the example to the right, the planar texture is positioned exactly on the surface and has a depth of 0.2cm (the sphere is 2cm).

Here the mesh texture have been used as an opacity map to add holes in the surface, without having to model them.
Angle UV (Box, Sphere, UV and Camera mapping)
This will rotate the UV plane of the Map.

In the example to the right the texture is clipped and the UV is angled - notice the orange squares are rotated.

Angle
This will rotate the entire map around the local Y axis. This is the same as rotation in the Move Texture tool the texture will be rotated around the green Y axis.
Expand the setting for even more precise control.

Axis Tilt
This will tilt the local axes around the Global X axis.

Axis Azimuth
This will rotate the map around the global Y axis
If the tilt is 0 adjusting the azimuth will be the same as adjusting the overall angle.

Center X
Will move the center of the map along the global X axis.

Center Y
Will move the center of the map along the global Y axis.

Center Z
Will move the center of the map along the global Z axis.

Flip Horizontal
Will mirror the texture over the local Y axis.

Flip Vertical
Will mirror the texture over the local X axis.

Two Sided
This is only relevant for Planar and Box Mapping and has slightly different behavior for the two.

- Planar; When enabled the texture will be visible on both sides of the model, with a mirrored version on the "backside".
- Box: when enabled the texture will be mirrored on the back faces of the box, when disabled the texture is the same on all faces.

Clip Horizontal / Clip Vertical
Enables clipping of the texture, so it is not covering the whole height/width of the object. When enabled the values can be controlled by Clipping Width/Height.
Sync
Textures on this material node with sync enabled will be scaled/moved/adjusted concurrently.

Color
Color
This sets the shape color. Set the color to black to create holes if you are using the texture as an opacity map.

Background
This sets the background color. Set the color to white if you are using the texture as an opacity map.

Show Outline
This enables you to add a colored/textured outline to the shape. The outline is placed on the inside edge of the shape.

Blend Outline with Color
When enabled the outline color/texture is blended with the color/texture of the shape.

Outline Size
Determines the width of the outline on a scale from 0-1, where 0 is right on the edge and 1 is in the center of the shape.

Shape and Pattern
Scale Mesh
Scales the size of the mesh affects both the size of the shape and the spacing.

Shape
Here you can choose between different shapes for your mesh.

Falloff
Adds feather to the edges of the shapes. The slider sets the width of the falloff. A value of 0 is equal to no falloff.

Shape Diameter/Width and Height
Depending on the shape size you can set the size of the shapes with diameter/width and height. When setting the width and height you can lock aspect to scale uniformly and reset to revert to the original aspect ratio.

Shape Angle
This will rotate the shape.

Mesh Pattern
Set the pattern you want to use for your mesh. You can either choose one of the standard patterns or define a custom pattern.

Variation
Jitter
Increase this value to add deviation to the pattern.

Distort
Increase this value to randomly distort the shape.
**Distort Scale**
Values above 1 decreases the distortion scale. Values below 1 increases the distortion scale.
Weave

The Weave procedural texture can be used to simulate many types of fabrics and fine woven meshes.

Color

Background Color
This sets the color of the gaps between the threads.

Warp Color
Sets the color of the vertical threads in the weave.

Weft Color
Sets the color of the horizontal threads in the weave.

Variation

Fibers
Adds a stroked effect to the threads that creates the appearance of fibers in the thread.

Grain
Adds grain to the threads.

Weave Distortion
Makes the threads uneven in thickness.

Color Variation
Adds variation to the intensity of the thread colors.

Width Variation
Makes some threads thinner and some thicker, giving the weave a more handcrafted look.

Threads

Warp Width
Adjust the width of the horizontal threads in the weave.

Weft Width
Adjust the width of the vertical threads in the weave.

Shape
With this slider you can adjust how flat/round the threads are. A value of 0 produces flat threads and 1 gives round threads. This setting is only relevant if the Thread Shadows are enabled.

Thread Shadows
Enables the shadows that create the illusion of round threads.

Tip!
if you are interested in visualizing cloth materials, give the RealCloth material (PRO feature) a try. The material enables you to create woven fabrics with your custom weave patterns and make the cloth appear even more tactile with flyaway fibers...
<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warp Width</td>
<td>0.9</td>
</tr>
<tr>
<td>Weft Width</td>
<td>0.9</td>
</tr>
<tr>
<td>Shape</td>
<td>1</td>
</tr>
</tbody>
</table>

- **Thread Shadows**: checked
**Brushed (Radial)**

Use the Brushed (Radial) procedural texture for a spun brushed metal finish.

**Mapping Tool**

Use the mapping tool to place the center of the brushed texture. Visit the [Move Texture](#) page for more information.

**Scale**

Use this to control the scale of the texture.

**Angle**

See description [here](#).

**Color 1/Color 2**

Choose contrasting colors here to create a ringed brushed pattern.

**Radius**

**Radius**

Use this to control the amount of rings are generated, by setting the radius of the radial brush.

**Falloff**

Increase this value to reduce the contrast between the colors selected.

**Variation**

**Angular Noise**

Increase this value to vary the width of the rings.

**Distortion Noise**

Increase this value to deviate the rings from a perfect circle. For a traditional spun brushed finish, you will want to leave this parameter at 0.

---

**Advanced**

**Radial Axial Blend**

Use this to create continuous textures on a cylinder that continues into a rounded cap. For most applications you will leave this at default.

**Sync**

Textures on this material node with sync enabled will be scaled/moved/adjusted concurrently.
**Camouflage**

Use the Camouflage procedural texture to simulate camouflage textures used in the real world.

**Scale**
Change the scale of the overall texture to fit the model.

**Color 1/2/3/4**
Set the mix of colors to be used in the texture.

**Color Balance**
Colors 1-4 are dispersed through the pattern in descending order, so there are more spots of color 1 than color 3 or 4. Increase this parameter to balance the ratio of colors, or reduce the parameter to increase the difference.

**Distortion**
Change this parameter to control the amount of shape complexity the spots have.

  **Distortion Scale**
  This controls the size of the grain that makes up the spots. Decreasing the scale will make the spots consist of many small irregular spots, while decreasing it will produce blocks of color.

**Variation**

**Spray**
Increase this parameter to feather the edges of the spots.

**Mix Colors**
Enable this option to allow the colors to blend as they overlap.

In this example the Camouflage texture is used as a Diffuse map.
Cellular

The Cellular procedural texture is an advanced tool that can create a wide variety of texture maps. You can create a crumpled texture as shown here, or you can create cracked surfaces, orange peel paint, hammered metal and many more.

Scale
Use this to adjust the scale of the texture to fit your model.

Cell Type
Choose between circular, square or diamond shaped cells.

Bump Height
Use this to control the overall intensity of the texture map.

Contrast
Contrast refers to the difference in the peaks and valleys of the bump map. Control them globally, or expand for finer controls.

Shape 1
Control the fractal shapes generated with this slider. Control them globally, or expand for finer controls.

Levels
Increase or decrease the levels of fractals being generated. Control them globally, or expand for finer controls.

Noise
Use this slider to add noise to the line quality of the fractal shapes.
Color Gradient

The Color Gradient Procedural Texture allows you to mix two separate colors on a surface without having to create a custom texture map.

Mapping Tool
Use this to move the center line of the gradient.

Angle
Use this to rotate the texture on the surface in degrees.

Color bar
Here you can set up the color gradient by selecting/adding colors, and dragging them to position. Click on a dropper circle to select it, then use the color swatch to choose a color.

The small triangles between colors show where the 2 colors are mixed 50-50 and they can be dragged to control the course of the blend.

Double click a color slider to select what color will be applied to the color gradient. Use the triangle slider to determine the midpoint of the gradient. To add another color to the gradient, click the + Add Color Stop button. To delete a color, select the color slider to be deleted, and click the - Delete Stop button.

Location
Adjust this to numerically control the selected color slider. The color bar spans the interval from 0-1.

Gradient Type
Use the drop-down to choose a gradient type that suits your needs.

Scale
Use this to set the scale of the texture. This sets the distance in scene units from the first to the last color slider of the gradient.

Shift
Use this to incrementally shift the texture on the surface.

In this example the Color Gradient is used as a Diffuse map.
Invert
Reverse the direction of the gradient.

Repeat
Enable repeat of the color gradient. If not enabled and the gradient scale is smaller than the object is applied to the start/end colors will cover the rest of the object.

Blend
Check Blend if you want the colors blend into each other otherwise the color change will be instant, at the point of the color stop and extend to the next color stop.
Contour

The contour texture will add an edge detail to your parts, similar to the Toon material, but applied to any material.

**Background:** This will determine the fill color of the part, replacing the main color of the material.

**Color:** This is the color of the contour

**Contour Width:** Determines the how thick/thin the contour lines will be. This will be set in the current scene units, unless you have checked *Contour Width in Pixels* below.

  - **Outline Contour Multiplier:** Enabling the Outline Contour Multiplier multiply the contour around the part(s).
  - **Part Contour Multiplier:** Enabling the Part Contour Multiplier will intensify the contour in the intersection between parts (with the material applied).

**Contour Angle:** This will control the number of interior contour lines on the part. The value determines the angle of the curvature where contour lines will appear. A lower value will increase the number of interior contour lines and a higher value will decrease the number of interior contour lines. This will only have effect if Interior Edge Contour is enabled below.

**Contour Quality:** Increasing the Contour Quality yield a sharper line.

**Material Contour:** This will allow you to show or hide the contour line that separates the individual parts, that does have the same material. If the materials are linked, this setting will not have an effect.

**Interior Edge Contour:** When enabled interior angles will be shown, where and amount of interior edges that are shown is determined by the Contour Angle.

**Contour Width in Pixels:** When enabled the Contour Width will be set in pixels, otherwise it will be set in the current scene unit.

**Sync**

Textures on this material node with sync enabled will be scaled, moved, and/or adjusted concurrently.

---

**Examples:**

Same model without and with the contour texture. Model by Glen Fox.
Curvature

Use the Curvature procedural texture to analyze surface curvature in your model and parts or as opacity maps to create materials with worn edges etc.

Negative Curvature
Choose a color to display when surface curvature is going into the negative direction. The more severe the the angle, the closer to the set color the texture will be.

Zero Curvature
Choose a color to display where there is zero curvature. The closer to flat a surface is on the model, the closer color will become to the the chosen color.

Positive Curvature
Choose a color to display where the surface curvature is going into the positive direction.

Cutoff
Control the scale of the curvature. Decrease the value to have a smaller range of curvature. Increase to have a larger range of curvature.

Radius
Radius refers to the radius around each point on the surface in which curvature is estimated.

Advanced

Samples
Increase the samples to improve the quality of the gradations. Increasing this parameter also increases render time.

Radius in Pixels
If disabled the radius will be defined in the current scene unit.

Sample Same Material Only
Enable this toggle to use the curvature data from this material only.

In this example the Curvature texture is applied as an opacity map on a metal label on top of a black plastic.
Granite

The Granite procedural texture allows you to simulate the granite texture of a counter top, tile, or stone.

**Color**
This is the overall color of your granite texture.

**Scale**
This controls the scale of the grain in the granite.
Leather

The Leather procedural texture allows you to easily replicate a leather textured material.

**Scale**
This controls the scale of the leather grain.
It is highly suggested that you add a synced procedural leather bump to further simulate realistic leather.

**Color 1**
This is the color of the high points (bumps) in leather. This color should be lighter than color 2, but it should be as close to color 2 as possible for realistic looking leather.

**Color 2**
This is the color of the low points in leather. This color should be darker than color 1, but it should be as close to color 1 as possible for realistic looking leather.

In this example the Leather texture is applied both a diffuse and Opacity map.
Marble

The Marble procedural texture allows you to simulate the marble material on a counter top, tile, or stone.

Scale
This controls the scale of the veins in your marble texture.

Color
This is the overall color of your marble texture.

Vein Color
This is the color of the veins in the marble texture.

Vein Thickness
This allows you to adjust the thickness of the marble veins.

Vein Noise
This adds random fluctuations to the marble veins.

Vein Noise Scale
This adds fluctuations to the overall direction of the marble veins.
Noise (Fractal)

The Noise (Fractal) procedural texture also allows you to simulate ripples and bumps in your material.

Colors 1 and 2
The noise procedural has light and dark colors that you can modify using these two settings.

Scale
This controls the scale of the fractal noise.

Levels
This adds more detail to the fractal noise.

Fall-off
This controls the color balance. Low values accentuate color 2, and high values accentuate color 1.

In this example the Noise texture has been added as a bump map to a glass material.
Noise (Texture)

The Noise (Texture) procedural texture is very similar to the stock noise texture in the textures library, and it allows you to simulate ripples in glass and liquid materials when used as bump.

**Colors 1 and 2**
The noise procedural has light and dark colors that you can modify using these two settings.

**Scale**
This controls the scale of the noise.

**Magnitude**
This increases the intensity of color 2 and the contrast between the two colors.
Occlusion

The Occlusion procedural texture allows for the addition of proximity-based shading on a material. It can be used to accentuate or augment the self shadows cast on a material and along with the Material Graph, create interesting texture effects based on occluded and unoccluded areas.

Occluded
Choose a color that will be used where there are surface near each other. Examples would be a parting line, a fold of skin, or a narrow alley. For more natural results, choose a color that is a darker value of your "Unoccluded" color to create deeper shadows.

Unoccluded
Choose a color that will be used where there is least amount of surfaces near each other. This will most likely be the base color, although there are other creative applications of this procedural texture.

Radius
It is the maximum distance towards any occluding object. If an object is further away it will not be considered in the occlusion computation. This value will control how deep or far the shaded "Occluded" color will reach on the model.

Falloff
This value controls how blended the two colors are.

Bias
The bias settings control the intensity of the occlusion on the model.

Normal
This setting adjusts the contrast between the "Unoccluded" and "Occluded" colors on the model.

X/Y/Z Bias
These settings increase the intensity of the "Occluded" color in relation the X, Y, and Z directions of your scene.

Advanced

Samples
This setting controls the quality of rendered image.

Sample Same Material Only
Enabling this option will only calculate the occlusion in relation to parts with this material applied, ignoring other parts.

Inside
This will invert the normal values to determine occlusion. This is useful when applying this material on a part that was not modeled with interior surfaces.

Fast
Since the Occlusion procedural texture emulates what is happening with global illumination, you can choose to ignore GI calculations on this material for faster renders.
Scratches

Using the procedural Scratches texture is a great way to add weathering and wear to materials, and to metal materials in particular. These are the settings available for the Scratches procedural.

**Color**
Set the color of the scratches. In cases where the texture is used for opacity maps set this to black.

**Background**
The color between the scratches.

**Scale**
Use this to set the overall scale of the scratch pattern generated.

**Bump Height**
Increase this value to obtain deeper scratches. It can also be set to a negative value to obtain very subtle scratches.

**Density**
Use this to control the number of scratches generated.

**Size**
Use this to set the size of the individual scratches. Expand to control the scratch thinness (width) and falloff (fade).

**Directional Noise**
This controls the randomness of the direction of the scratches. Decrease this value to have scratches in a more aligned direction. Expand to choose Direction Field mapping.

**Noise**
Controls the straightness of the scratches. Increase the value to have more irregular scratches. Expand to access the Noise Scale slider.

**Levels**
Controls the number of unique scratches that are generated. Expand to access the level scale.

In this example a layer of paint have been applied (as a label) on a metal material. The Scratches texture is applied as an opacity map on the label revealing the metal under the paint.
Spots

The Spots procedural texture is a an interactive method of creating a texture map of scattered spots on a surface.

**Color**
Use this to set the color of the spots generated.

**Background**
Use this to set the color of the background.

**Scale**
Use this to control the overall scale of the texture map.

**Cell type**
select if you want circular, square or diamond shaped dots.

**Density**
Use this to control the number of spots that appear on your surface.

**Radius**
Use this to change the overall size of the spots generated.

**Falloff**
Feather the edges of your shapes with this parameter. Higher values produce softer edges.

**Distortion**
Increase this parameter to randomly warp the shape of the spots.

  **Distortion Scale**
  Use this parameter to change the amount of distortion is applied to the spots.

**Levels**
Increase the amount levels of sizes that appears.

  **Levels Scale**
  This changes the difference in sizes between the various levels. Increase the value to greater than one to decrease the smallest spot size. Decrease the value to less than one to increase the largest spot size.

  **Intensity Modifier**
  Increase this parameter to have the spots decrease in opacity as they decrease in size.

**Advanced**

**Invert**
Enable this option to have the spots feather in to the outside color, creating rings or bubble like silhouettes.

In this example the Spot texture is applied both as a Diffuse map and as an Opacity map.
**Vertex Color**

The Vertex Color texture is used only with geometry imported from other 3D applications that support vertex color texture maps, such as ZBrush. Only use this texture if you are importing from a compatible 3D application, as it will have no affect otherwise.

- **Default color**
  controls the background color that is used for the alpha channel from an imported vertex texture.

- **Multiplier**
  Blend a color with the imported vertex color texture.
**Volume Map**

The volume map texture enables you to use OpenVDB files for your textures. It is primarily used as a density texture with *Scattering Medium*.

**File**
Browse for the texture file. Only .vdb files can be used af volume maps.

**Center on**
This enables you to quickly position the texture to the center of either the model or the part. For finer adjustment of the position use the *Move Texture* tool.

**Move texture**
This enables you to move the texture - see the *Move Texture* page for details

**Scale**
Adjust the size of the texture with the slider. The scale is measured in the current scene units.

**Fit to part**
Scales the texture to fit the part.

---

*This example shows a cube with a scattering medium material and a volume map as a density texture.*
Wood

The Wood procedural texture allows you to customize the look of your wood materials. Most often, you will want to start out with the plastic material type and change the specular color to white.

General Settings

Scale
Use this to increase size of the grain. For best results, keep the scale small.

Angle
See description of angle on the Move Texture page.

Color 1
This sets the base color of the wood.

Color 2
This sets the color of the wood rings.

Ring Width
This adjusts the thickness of the wood rings.

Variation

Ring Noise
This adds random fluctuations in each ring.

Axial Noise
This adds fluctuations or waviness of the overall direction of the grain.

Color Noise
This creates random thick and thin areas to give a more organic look to the wood ring.
**Wood (Advanced)**

The Wood (Advanced) procedural texture gives finer control than the basic wood procedural texture, and creates more realism in the map.

**Scale**
Use this to control the overall scale of the texture map.

**Angle**
See description of angle on the Move Texture page.

**Winter/Spring/Summer/Fall**
New wood formed in a tree during spring and summer is light in color. Toward the end of a growing season, new cells formed are smaller and have darker, thicker walls. Choose the color swatches to accurately color the rings in accordance with the seasons.

**Ring Width**
This adjusts the thickness of the wood ring.

- **Ring Width Variation**
  This enables you to add variation to the width of the wood rings.

**Variation**

**Ring Spacing Variation**
This parameter controls the contrast of thick and thin ring shapes to represent different rates of annual growth.

**Ring Noise**
This adds fluctuations or waviness to the rings.

**Axial Noise**
Increase this parameter to add variations to the circular shapes of the rings.

**Color Noise**
Increase this parameter to add more splotches of color in the rings.

**Seasonal Color Noise**
Add variation to each color swatch as it blends from each color.

**Knots**

**Knot Color/Border**
The knot color is blended into the main colors of the texture. Choose a grey value to darken the knots. The knot border should be darker than any of the other colors.

**Knot Density**
This parameter controls how many knots appear in the texture.

**Knot Age**
Increase this parameter to increase the number of rings that appear in the knots.

**Knot Border Size**
This parameter changes the thickness of the knot borders.

**Knot Distortion**

*In this example the Wood (advanced) texture has been used both as diffuse map and bump map. This material is from the KeyShot library - Oak wood satin - only the size of rings and knots have been adjusted, to match the model.*
Use this to control the fluctuations and add irregularities in the knot shape.

**Branch Scale**
Control the overall size of the knots with this parameter.

**Grain**

**Grain Color Bleed**
This parameter controls the amount of color each ring blends into the rings on either side. Decrease to have very clearly defined rings or increase to give the rings a more blended appearance.

**Axial Graininess**
Increase this parameter to blur the texture.

**Ring Graininess**
This adjusts the thickness of the wood rings.

**Grain Scale**
This adjust the size of the grain striations between the rings.

**Grain Thinness**
Control the size of the grain striations with this parameter.

**Advanced**

**Seed**
Scrub through this parameter to add randomness to all of the previous parameters to create a more natural look.
Map Types

KeyShot has four primary Map Types along with a number of material and texture settings that can also accept textures.

Each material type uses texture map types depending on the material type and settings. You will see the available map types in the Project window, Material, Textures tab.

The Primary Map types are not the only texture maps you will encounter - Anywhere you find the texture icon in the material properties you will be able to add a texture to the property. Texture icon. Apply a texture by drag and drop from the library, right-click to select a type or click to load a texture from a file. When a property has a texture applied you can click it to adjust.

Primary Map types

Diffuse

The Diffuse (also seen as Color or Transmission) map type allows an image texture or 2D/3D procedural texture to be applied to replace the basic solid Diffuse/Color/Transmission setting.

This map type provides full color information and will show transparency when a PNG with alpha transparency is used.
**Specular**

The Specular map type can use black and white values to indicate areas that have varying levels of specular intensity. Black will indicate areas of 0% specular reflectivity, whereas white will indicate areas of 100% specular reflectivity.

Notice on the example that while the material in itself is emitting specular reflections, the dots are not.
Bump

The *Bump* map type is used to create fine details in materials that would be unrealistic to include in the model, like the brushed metal in the example. Bump uses the texture to simulate deformation of the surface.

There are two methods of applying bump maps. The first and easiest is using a black and white image. The second way is by using a *Normal map*.

**Black and White Image**
When using a black and white image for a bump map, the black values are interpreted as lower and the white values are interpreted as raised.

**Normal Maps**
Normal maps contain more colors than the standard black and white bump maps. These additional colors represent different levels of distortion on X, Y and Z coordinates. This can create more complex bump effects than a black and white bump map which represents only two dimensions. However, most bump effects can look very realistic without the need for normal maps. Enable this setting when a Bump map is selected by checking *Normal Map*.

**Bump Height**
With Bump maps, *Bump Height* controls the effect of the map. Increasing this raises the peaks of the bumps, and helps exaggerate the bump when the texture needs to be more visible.

Opacity

The *Opacity* map type can use black and white values or alpha channels to make areas of a material transparent. This is useful for creating materials like the mesh material shown, without actually modeling the holes.

**Opacity Mode**
The opacity mode can be set to three different methods:

- **Alpha**
  This will use any alpha channel that is embedded in the image to create the transparency. If no alpha channel is present, no transparency will be shown.
- **Color**
  This will interpret black areas as completely
transparent and white areas as completely opaque. 50% gray will be 50% transparent. This method is available to avoid the need for alpha channels.

**Inverse Color**
Inverse color is the opposite of color. White will be completely transparent, black will be completely opaque and 50% gray will be 50% transparent.

**Tip**
You can easily drag and drop textures from one Map Type to another (e.g. from Bump to Specular) by simply holding Ctrl (Windows) or Command (OS X) and dragging the texture to another Map Type. To Copy a texture press Alt while dragging the texture from one map type to another.
Mapping Types

Image Textures and 2D Textures allow you to take 2D images and place them onto 3D objects. How they are applied will affect how they appear. KeyShot provides seven different mapping types for these types of textures. When an Image Texture or 2D Texture is active, you will see a Mapping Type option with the following mapping types.

**Planar**

The Planar mapping type will project a texture on the X, Y or Z axis. The orientation is set in the Interactive Move Texture tool. Surfaces of 3D models that are not oriented on the chosen axis will show stretching of the texture in the other two axes.

**Box**

The Box mapping type will project a texture from six sides of a cube in towards a 3D model. A texture will be projected from a side of the cube until stretching occurs, then the next best projection side will take over. Box mapping is a quick and easy solution that will work in most cases because there will be minimal stretching of textures.

**Cylinder**

The Cylinder mapping type will project a texture inwards from a cylinder. The texture will project the best on surfaces that are facing the inside of the cylinder. The texture on surfaces that do not face the inner walls of the cylinder will stretch inwards.

**Sphere**

The Sphere mapping type will project a texture inwards from a sphere. The texture will resemble the original image the most at the equator. The texture will start to converge as it reaches the poles of the sphere. As with box mapping, stretching is less of an issue when working on multi sided objects than it is with any of the planar mapping modes.

**UV**

The UV mapping type is a completely different method of applying 2D textures to 3D models. Using 3D applications such as 3D Studio Max or Maya, you can design how the texture map is applied to each surface. It is more time consuming and is much more widely used in the entertainment industry as opposed to the design/engineering world.

**Camera**

The Camera mapping type will keep the texture oriented with respect to the camera. This will provide a consistent texture appearance on the surface regardless of the position of the camera.

**Node**

The Node mapping type allows you to drive a texture with a UV mapped procedural. An example of this can be seen below.
Box Map as shown in the Move Texture Tool.

Cylinder Map as shown in the Move Texture Tool.
Move Texture

Move Tool

Fine tune the position of textures mapped to your mode with the texture move tool. The tool is accessed from the texture tab within the material editing menu, and it is available when in Planar, Box, Cylindrical and Spherical mapping modes.

Position
Use this to establish exactly where you want the center of your texture image to project. Once in position mode, you can simply click on the surface of the model to change the where your texture is projecting.

Translate
Use arrow handles to move the texture mapping position on the XYZ axes. To translate the mapping, click on any of the three axis arrows. The red, green and blue arrows correspond to the X, Y and Z axes.

Rotate
Use circle handles to rotate and align the texture mapping to your model. Hold SHIFT to constrain the rotation to 15 degree increments.

Axis
Select if the translation/rotation should use the global or the local axis.

Fit
Fit the texture to match geometry on the X, Y, Z axis.

Center on
- Model - This will position the texture relative to the model.
- Part - This will position the texture relative to the part.

Cancel or Confirm Changes
After adjusting the texture mapping with the mapping tool, click the green check mark to confirm the changes and close the mapping tool. Click the red X to cancel the changes and close the mapping tool.

Tip
Enable the sync option in the Size and Mapping section to move all your textures on the current material concurrently.

Size and mapping

Size and Mapping lets you scale and adjust the orientation of the texture. The parameters vary a little with the Texture Types and Mapping Types but the overall options are the same.

Use DPI for size
This lets you set the size of the texture in DPI instead of defining width and height.

Width and Height
Sets the width and height of the texture using the current scene unit.
**Lock Aspect** - Will secure a uniform scale of the texture.

**Refresh** - Will reset to the original aspect ratio of the texture.

**Shift U**
Moves the texture in the U direction. On the example to the right, the UV plane is shown with the orange box, where the V direction is shown with the small arrow. - this means that in the example Shift U will move the texture sideways.

**Shift V**
Moves the texture in the V direction. In the example to the right Shift V will move the texture up/down.

**Angle UV**
This will rotate the UV plane (the orange squares in the example to the right) of the Map

**Angle**
This will rotate the entire map around the local Y axis. This is the same as rotation in the Move Texture tool and means that the entire box will be rotated around the green axis in the example to the right. Expand the setting for even more precise control.

**Axis Tilt**
This will tilt the local axes around the Global X axis.

**Axis Azimuth**
This will rotate the map around the global Y axis
If the tilt is 0 adjusting the azimuth will be the same as adjusting the overall angle.

**Center X**
Will move the center of the map along the global X axis.

**Center Y**
Will move the center of the map along the global Y axis.

**Center Z**
Will move the center of the map along the global Z axis.

**Flip Horizontal**
Will mirror the texture over the local Y axis.

**Flip Vertical**
Will mirror the texture over the local X axis.

**Two Sided**
This is only relevant for Planar and Box Mapping and has slightly different behavior for the two.

- Planar: When enabled the texture will be visible on both sides of the model, with a mirrored version on the "backside".
- Box: when enabled the texture will be mirrored on the back faces of the box, when disabled the texture is the same on all faces.

**Repeat Horizontal**
When enabled the texture will be tiled horizontally.

- **Repeat Vertical**
  When enabled the texture will be tiled vertically.

- **Sync**
  Textures on this material node with sync enabled will be scaled/moved/adjusted concurrently.
Labels

Labels are designed for easy placement of logos, stickers or video that need to be placed freely onto a 3D model. You can also use Labels to create a layered appearance with another material on top of the main material.

Essentially labels are layers with materials/textures on top of your material.

In this example the material ball has 3 labels - 2 individually positioned “stickers” and a coat of paint with subtle scratches revealing the golden base material.

To make sure the scratches cut both the sticker and the paint, the same opacity map is used on both.

Labels are added through the labels tab in a material’s properties or via drag and drop from the Library, either onto a part in the Real-Time View or into the Layer list.

1. Layer List

An unlimited number of labels can be added to a material. Each label can have its own mapping type. If an image has an alpha channel embedded, it will be retained and areas of transparency will not show.
Add Label

Labels are added by clicking the "+" icon and selecting Add Label (Texture), Add Label (Video) or Add Material. Once added, the label name will be displayed in the list. You can also choose "Duplicate" to create copies of existing labels.

Add Material will simply add a layer of the material selected in Label type (2) on top of your base material, while Add Label (Texture) and Add Label (Video) also will add a texture to the Diffuse map (4).

Delete Label

Labels can be deleted by selecting the label in the list and clicking the Trash Icon.

Layer order

Labels will be layered as they are added. If labels overlap on the model, they will stack in the same order as ordered in the Labels list. The label order can be shifted by pressing the up and down arrow buttons.

Pick Label

Lets you pick a label in the Real-Time View for editing.

2. Label Type

Each label will be assigned a material type. The default material applied to a label is plastic, but it can be changed to Diffuse, Flat, Metal, Paint, Translucent, Advanced, Anisotropic, Metallic Paint, Plastic (Transparent), Translucent (Advanced), Emissive, Toon, and Xray.

3. Label Properties

The Properties Tab will show the contextual settings for the label type selected. See the Material Types for more.

4. Label Textures

Map Types

Texture and video Labels will be added as Diffuse maps. In the Label Textures tab you can add other maps to your label similarly to the Textures tab for Materials. The type of texture maps available to a label type will be similar to the type of textures available to the material type.

Use the check-boxes in the list of texture types to enable or disable a texture map.

See the Map Types page for details about Bump, Diffuse, Opacity maps etc.
Mapping Type

The Textures are by default planar - see the Mapping Types section for more information about the different Mapping methods.

Move Texture

See the Move Texture page for details about Move Texture and Size Mapping.

---

Drag and Drop
You can add your label by drag-and-drop onto the model. This will add and align the label to the point on the model where you dropped it. This may insert it at a different angle in the Label properties than what you expect.

If you drop your label into the Labels list, it will be inserted at 0 degrees (or 90 degrees depending on how the model was imported).

---

Keep Label Size
If you would like to use the dimensions of the label stored in the file for the initial label size, use a Photoshop .PSD file. When you import your label as a .PSD, KeyShot will check the DPI settings and set the DPI value to that stored in the .PSD file.

---

Texture Properties

See the Texture Types section for details on the properties of individual texture types.

---

Quick tip
Environments

The primary method of lighting a scene in KeyShot is through Environment Lighting. Environment Lighting uses spherical High-dynamic-range imaging (HDRI) to represent the full, physically accurate lighting of an interior or exterior space.

Environment Library

KeyShot comes with many environment lighting presets to get you on your way fast. Access all environment preset from the Library window, Environments tab. Additional environments may be accessed on KeyShot Cloud. If you are a KeyShot Pro user, you can also add your own environments to the library.

Environment Tab

The Environment tab is where you control all the settings for your environment lighting. Access the settings from the Project window, Environment tab.

HDRI Editor

KeyShot Pro users will see the HDRI Editor button on the Environment tab directly beneath the HDRI preview.
Adding Environments

KeyShot is designed to provide real-world lighting right out of the box. Through environment presets and the ability to modify them or create your own, your scene can be lit just the way you need with everything visible in real-time.

You can find environment presets in the Environment Library or KeyShot Cloud Library.

Environment List

The Environment tab of the Project window includes the ability to save different Environments and their settings to a list for fast access and navigation.

When a new scene is opened the Environment List is populated with the environment used in the Default Startup Scene specified in the General Preferences. All changes made to the settings will be recorded and saved with that environment.

Adding an Environment

You can add environments in the following ways:

- drag and drop from the Environment Library/KeyShot Cloud Library onto the Real-time View - this replaces the current environment.
- double click an environment in the Environment Library - this replaces the current environment
- drag and drop from the Environment Library/KeyShot Cloud Library onto the Real-time View while pressing ALT - this adds a new environment in the Environment List.
- drag and drop from the Environment Library onto the Environment List - this adds a new environment in the Environment List

Creating a New Environment

To create a new Environment based your current settings, click the Add Environment icon at the top left of the pane.
Adjusting Environments

KeyShot allows you to adjust your HDRI lighting through a set of easily adjustable Settings found in the Project window, Environment tab.

File

Load a lighting environment from a file (.hdr, .hdz, .exr). Select the icon to open a new environment. Select the icon to reload the current environment. Hovering over the file name will display the file path. Right-click to display options to Copy Path, Show in Explorer, Reload or Open a new environment file.

Adjustments

- **Brightness** brightens or darkens the entire HDRI from the shadows to the highlights equally.
- **Contrast** increases the separation between dark and bright areas, making shadows darker and highlights lighter.

Transform

- **Size** determines the size of the environment.
- **Height** sets the vertical position of the environment in relation to the ground plane.
- **Rotation** allows you to rotate the environment.

Background

- **Lighting Environment** uses the image of the lighting environment as background in the scene.
- **Color** allows you to choose a solid color for the background.
- **Backplate Image** allows you to add and use an image as the background for the scene. Supported file formats include .jpg, .jpeg, .tif, .tiff, .bmp, .png, .gif, .dds, .hdr, .hdz, .exr, .tga, .ppm, .ktx, .psd.

Note

The background Color may also be set to a solid color through the Photographic Image Style, this will override any settings applied in the Environment tab.

Ground

- **Ground Shadows** is an option to change the visibility of ground shadows and allows you to set the base color.
- **Occlusion Ground Shadows** is an option to see occlusion shadows in place of drop shadows.
- **Ground Reflections** is an option to change the visibility of ground reflections.
- **Flatten Ground** will project the part of the environment that is below the ground onto the ground plane, correlating height and width if the lighting environment is visible as the background in the scene.
- **Ground size** allows you to set the size of the virtual ground plane and only affects the ground shadows.
HDRI Editor

The KeyShot HDRI Editor (Pro Only) is a simple way to make adjustments to lighting environments or create your own.

The HDRI Editor provides a unique system of adjustable light, image and gradient Pins to light your scene.

HDRI Editor Overview

The KeyShot HDRI Editor is fully integrated into the Environment tab located in the Project window.

All Pins and settings for Color, Adjustments and Transforms are embedded in the KeyShot file eliminating the need to save an individual .HDZ for each custom Environment you create. This provides a huge convenience and asset management benefit while greatly reducing the amount of data necessary to store locally and in KeyShot .KSP files.

The HDRI Editor has flexible features including:

- Export of HDR/EXR
- Gradient Background
- Draggable interactive Sun & Sky
- Sun & Sky Ground Color
- Sun Size parameter
- Rectangular Pin Rounded Corners
- Gradient Pins
- Image Pin Color Adjustments
- Extract pins from previous version HDZ files
- Pop out HDRI Editor canvas
**HDRI Editor Pins**

Pins are light sources that can be placed into the HDRI to further enhance the image file, and give the desired lighting effect on the object scene.

**Pin List**

Contains all the pins created in the HDRI editor. You can enable or disable a pin by clicking the checkbox to the left of its name. You can rename a pin by double clicking its name. Right click pins for options to delete or duplicate. The active pin being edited will be highlighted blue in the list and will be marked by a blue dot in the preview.

**Pin Options**

**Add Pin**

To Add a pin click one of the options above the Pin List, these include Add Pin, Add Gradient Pin, Add Image Pin, and Add Copy Pin. The Pin types will be described later on this page.

The new pin will be displayed in the Pin List as well as the preview window. To make a pin active for editing, select it in the Pin List or click on the pin handle in the preview window. Drag the pins by their handles to position them. The "Add Highlight"-pin is explained below in the “Set Highlight” section.

You can also copy a pin from one environment to another. Just select the pin press Ctrl+C/Cmd+C, go the the destination environment, click in the HDRI editor and press Cmd+V/Cmd+V.

**Delete Pin**

Click on the trash can icon to delete the active pin.

**Move Pin Up/Down**

Click on the arrows to change the pin order in the pin list. The order is important as it will display and layer pins from the top down.

**Pin Folders**

Use pin folders to organize all your pins in your HDRI. Click on the “Add Folder” icon to add a folder to the list and drag pins into the folder.

**Set Highlight**

With the Set Highlight option you can create your pin by selecting a region on the model you want to highlight. Simply CTRL+Click/CMD+Click in the Real Time View anywhere on the surface of the model and a pin will be generated facing that point on the surface. When finished, click “Done.” Pins added this way can be edited as normal.

To set an existing highlight click onto “Set Highlight”, and then select an existing pin in the editor. Click on the object to set the highlight using the selected pin, and use your left mouse button to drag it into the right position.

**Pin Types Explained**

**Standard Pin**

Add Pin creates a pin in the center of the unfolded HDRI. Grab it to place it in the desired location. Use the controls explained in section Adjusting Pins to get achieve the desired effect.
**Gradient Pin**
A Gradient Pin allows you to place a light source with color and opacity variations.

**Copy Pin**
When this option is selected, a snapshot of a section of the background is used as a new pin. A pin handle and a marker of the copy-origin (yellow dot) will appear on the preview window.

After creating the copy pin, move the pin by the handle to place it where desired. Adjustment sliders similar to those used with the regular pin will be available with the same effects.

**Image Pin**
The image pin allows you to use HDR, HDZ, EXR, JPG, PNG, JPEG, and BMP as a pin. There are limitless usages for this pin, such as creating specific reflections, simulating a lighting array and using part of an HDR with another HDR among others.

When adding an image pin, you will be prompted to select an image to be used. Once selected, the image will be placed in the preview window. You can also drag an image onto the HDRI editor and it will be added as an image pin.

Adjustment sliders will be available to edit the image pin. These sliders are similar to the regular pin sliders.

**Adjusting Pins**

**Circular/Rectangular**
This will toggle the shape of the pin. This is crucial when creating very specific shapes and reflections in your renderings.

**Half**
For either pin shape you can select the shape to be cut in half. This will cut the pin in half. All adjustments will work the same except that you are now only seeing half of the pin.

**Radius (Circular)**
This determines the pin size of circular pins.

**Width/Height/Angle (Rectangular)**
This determines the shape and size of rectangular pins.

**Color**
Use this to set what color the pin will project. For accurate real-world lighting, use the Kelvin scale.

**Blend Mode**
With this option, choose different ways to have the pins blend and interact with each other. Pin order becomes very important with this function.

**Falloff Mode**
This controls the falloff of the light from the center of the pin. Different modes have different behaviors. You can see the effect of the various modes both in the editor as well as in the KeyShot Real-Time View.

**Falloff**
This controls the softness of edge of the pin light. Increase the falloff for more blended, softer edges.

**Brightness**
Use this to adjust the overall intensity of the pin light.
**Editor Options**

**Generate Full Resolution HDRI**
While you are editing the pins the environment is using a "fast preview" mode, where you don't see the full effect of the changes. Click to force the environment to be displayed in the full resolution.

**Tip:**
If the environment has not been generated in full resolution, it will be indicated in the top right corner of the Real-time View. This indicator can also be clicked to force the environment to be displayed in the full resolution.

**HDRI Editor Canvas**
This will launch the HDRI editor, where you can edit the pins on a bigger canvas.

**Save Environment**
Here you can save your environment to the Library.

**Export Environment**
This enables you to export a .HDR/.EXR/.HDZ with your environment.
HDRI Editor Background

When you select the Background item in the HDRI Editor Pin List you have four options for your HDRI Editor Background: Color, Gradient, Sun & Sky and Image.

Resolution

The Image background is automatically set to the resolution of the selected image. But for the other 3 types you will have to set the Resolution. Overall a smaller resolution gives better performance, but a larger resolution gives better shadow and reflection quality. Normally it the default value will suffice. But if you are operating with highly reflective materials and half/square pins or pins with little/no falloff, you may need to increase the resolution.

In the example on the left the environment resolution is low. Notice that the edge of the highlight is not as sharp as in the example to the right, where the environment has a high resolution.

Color

Color
Select a solid color as background for your environment. This should not be confused with the setting of a solid background color (can be set in Environment settings or Photographic Image style) as it will affect the lighting in the scene.

Brightness
Adjust the brightness of the background color.

Gradient

On this page

- Resolution
- Color
- Gradient
- Sun & Sky
  - Color
  - Transform
- Image
  - Color
  - Transform
Color bar
Here you can set when and what colors will fade from one to the the next. Click on the dropper circle to select a color stop, then use the color swatch to choose a color.

The little triangles shows where the 2 colors are mixed 50-50 and they can be dragged to control the course of the blend.

Add Color Stop
If you would like to fade between more than 2 colors, click on the Add stop button below the color bar to create another color swatch. click and drag the color pins and the gradient apex slider to your desired animation effect.

Delete Stop
If you want to remove a color stop, just select it and click delete.

Stop Brightness
Select a color stop and adjust the brightness.

Latitude
Select a color stop and adjust the position of the color on the gradient. This can also be achieved by dragging the color stops on the color bar.

Brightness
Adjust the brightness of the whole gradient background.

Saturation
Adjust the saturation of the whole gradient background.

Sun & Sky
Resolution
Here, set the resolution of the sun and sky that will be generated. A smaller resolution has better performance, but a larger resolution has better shadow and reflection quality.

Location
Here, you can choose a preset city that is closest to where the scene is taking place for accurate portrayal of the sun and seasons at location.

Coordinates
Another option is to choose “Custom Location” and enter the geo coordinates of a location.

Date
Use this to set the date to the day the scene will be taking place for accurate portrayal of color temperatures of the seasons.

Custom Sun Position

Time
Use this to set the time the scene takes place for correct placement of the sun.

Turbidity
Increase this setting to add more haze to the sky. This will tint the sky with a warm tone and filter the sunlight that is cast in the scene.

Sun Size
Adjust the size of the sun.

Ground Color
Set the color of the ground on the background.
**Color**

**Brightness**
Adjust the brightness of the Sun & Sky background.

**Contrast**
Adjust the contrast of the environment

**Saturation**
Adjust the saturation of the environment

**Hue**
Adjust the hue of the environment

**Colorize**
Add a color that the environment will be blended with.

**Blur**
Adjust the blur of the environment background, increase to soften contours.

**Transform**

**Tilt**
This will tilt the vertical axis of the environment.

**Rotation**
Rotate the environment background without affecting any pins in the environment. If you want to rotate the entire environment you can do it in the Environment settings.

**Image**

**Resolution**
This is set by the image size. If you experience bad reflections with the environment you may need to use an image with a higher resolution.

**Image**
Select an image file for the environment background.

- 📂 Browse for another image file
- ⌘ Refresh the image file
- 🗑 Remove the image file - this will change the environment type to Color.

**Color**

**Brightness**
Adjust the brightness of the Sun & Sky background.

**Contrast**
Adjust the contrast of the environment

**Saturation**
Adjust the saturation of the environment

**Hue**
Adjust the hue of the environment

**Colorize**
Add a color that the environment will be blended with.

**Blur**
Adjust the blur of the environment background, increase to soften contours.

**Transform**

**Tilt**
This will tilt the vertical axis of the environment.

**Rotation**
Rotate the environment background without affecting any pins in the environment. If you want to rotate the entire environment you can do it in the Environment settings.
Adjusting Legacy (KeyShot 6 and earlier) HDRI Environments

Handling of environments and environment lights (pins) changed with KeyShot 7. To adjust environments created prior to KeyShot 7 you will need to extract the image pins and/or background images to take advantage of the new, more efficient, handling of environments and pins.

You can convert HDRI environments from KeyShot 6 and earlier to KeyShot 8 by clicking the Extract HDZ icon located just above the pin list in the HDRI Editor tab. When you click Extract HDZ you may be prompted to save any images present in the HDZ file to your hard drive.

Note: If there are no image pins and the background is uniform, no files will be written out.
Lighting

The light in your scene comes from the Environment and/or from Light Source Materials, but the Render technique also has an effect on the appearance of your scene - this is what you can control in the Lighting tab of the Project panel or via the Main Menu > Lighting.

Lighting tab - Render Technique

In the Lighting tab you can control the interpretation of lighting in your scene. KeyShot comes with a number of presets which you can select between or customize into your own Custom Lighting Presets.

Performance

This preset disables light source materials and shadows with reduced bounces for the fastest performance possible. This is useful for scene setup and quick manipulation. The option is also available in the Ribbon. The Performance mode can also be toggled from the Ribbon or the Main Menu.

Basic

This preset provides simple, direct lighting with shadows for basic scenes and fast performance. This is useful for rendering simple models illuminated by the environment.

Product

This preset provides direct and indirect lighting with shadows. This is useful for products with transparent materials illuminated by the environment and local lighting.

Interior

This setting features direct and indirect lighting with shadows that is optimized for interior illumination. This is intended for complex interior illumination with indirect lighting; although it can also be used to avoid noise created by local lights and provide more accurate sampling of HDRIs with very small and strong light sources such as Sun & Sky.

Jewelry

This setting features the same settings as the Interior preset with the addition of Ground Illumination, increased Ray Bounces, and Caustics.

Note:
The Global Illumination sampling for Interior Mode has been improved for KeyShot 8. This may cause scenes to be brighter than in previous versions of KeyShot.
Sources of light in the scene

Environment Lighting

The most general source of lighting a scene in KeyShot is through Environment Lighting. Environment Lighting uses spherical High-dynamic-range imaging (HDRI) to represent the full, physically accurate lighting of an interior or exterior space. See the Environments section for more details.

Light Source Materials

Any piece of geometry can be turned it into a local light source. It’s a completely different approach from traditional rendering applications allowing more flexibility for rendering light accurately in your scene.

Types of light sources

There are four Light Source Material Types that provide different lighting capabilities:

Area Light Diffuse

Turn any object into an array of light. View and adjust the position in the real-time window. Control the intensity of the light using Watts or Lumens. See the Area Light page for more details.

Point Light Diffuse

Turn any object into a point light. View and adjust the position in the real-time window. Control the intensity either using Power Watts or Lumens. See the Point Light page for more details.

Point Light IES Profile

Load an IES profile by clicking on the folder icon in the editor and see the shape of the IES profile load in the material preview and in the form of a mesh in the real-time window. See the IES Light page for more details.

Spotlight

Turn any object into a spotlight. View and adjust the position in the real-time window. Control the intensity either using Watts or Lumens. See the Spotlight page for more details.

Adding A Light

A light source may be applied to any model you like. A light can be applied to imported geometry, existing geometry or to geometry available in KeyShot via the Edit, Add Geometry menu.

Applying a light material is similar to applying other materials. Drag and drop a light material preset from the Library window, Materials tab, Light folder. You can also double-click on an model, go to the Material Type dropdown, and choose one of the Light Sources from the list. KeyShot will
change the object to a physical light.

When you change a model to a light source, KeyShot will identify the light source in the Project, Scene tree by adding a light bulb icon next to the model name.

<table>
<thead>
<tr>
<th>Apply a light to a sphere</th>
</tr>
</thead>
</table>
| **Tip:** Here’s a simple example for adding a light to a sphere. From the KeyShot menu, select *Edit, Add Geometry, Sphere.* Move the sphere to the location for the light. Go to the KeyShot Library, *Materials* tab and select the *Light* folder. Drag and drop a light onto the sphere. If you want to reduce the ambient environment light, go to the Project window, *Environment* tab, *Settings* and reduce the *Brightness*.

**Moving a Light**

Right-click the part that is assigned as a light and select 🗑️ *Move Model*. This will activate the Move Tool. You can also select the light source in the Project window, *Scene* tab, then select *Move Tool* from the *Position* tab. Additionally, the input boxes may be used for more precise positioning.

**Animating a Light**

Since light sources are materials applied to a part, they can be animated just like any other part. Simply select the light in the Scene Tree that you would like to animate, right-click and apply the animation you would like. Visit the Animation section to learn about the different types of animations.
Custom Lighting Presets

In the Lighting tab of the Project Panel you find the Lighting settings.

Environment Lighting

Shadow Quality
The slider determines the quality of shadows, in the sense of how high priority the rendering of shadows in the scene is when rendering with Maximum Samples or Maximum Time.

Ground Illumination
When Ground Illuminations are on, the rays bounced of the ground will produce indirect lighting.

Self Shadows
When Self Shadows are on, the objects in the scene will cast shadows on themselves, otherwise the objects will only cast shadows on the ground.

General Lighting

Ray Bounces
Ray bounces are the number of times rays of light are calculated as they bounce around a scene.

Global Illumination
Toggle if you want to see indirect ray bounces between objects in the scene.

Global Illumination Bounces
When Global Illumination is on, Global Illumination Bounces allow you to control the maximum number of times the light is reflected diffusely as it passes through the scene.

Note
The Global Illumination sampling for Interior Mode has been improved for KeyShot 8. This may cause scenes to be brighter than in previous versions of KeyShot.

Caustics
Enable/disable caustics in the scene. See the Refractive Index page for more info about caustics.

Rendering Techniques

The Rendering techniques are optimized for different scenarios.

Product mode
is best for scenes where the camera "looks" at the objects from outside.

Interior mode
The interior mode is optimized for enclosed spaces.

Note
Save Custom Preset

When you have customized the settings you can save them as your own preset by clicking the + icon next to the custom preset drop-down.
Cameras

The Camera tab controls the settings for all camera views in KeyShot and allows you to set the active KeyShot camera. It also allows you to save different camera views of your scene, which allows cameras to be re-used, modified, animated or used in Studios.

Cameras can be adjusted much like a real camera and include advanced functionality such as shift lenses, walkthrough mode and Depth of Field, along with KeyShot Pro features such as panoramic lenses, to produce cube or spherical maps for real-time VR rendering and output.

This section explains how to work with the different types of cameras and their respective settings.
Navigating Your Scene

The following explains how to use your mouse to change the view of your camera. It’s important to realize that the mouse is moving the camera and not the model, unlike a 3D modeling application. In other words, when you use Left Mouse Button (LMB) to rotate, the camera is rotating around the model.

To change the position of the models, see Moving Models and Parts.

Mouse Controls

The mouse is the main method for controlling the position and orientation of the camera. With it, you can rotate, pan and change distance.

Camera Tumble (Rotate)
To tumble your camera, press and hold LMB while moving the mouse. This changes both the azimuth and inclination of the camera.

Camera Pan
To pan your camera press and hold the MMB while moving the mouse. This changes the position of the camera.

Camera Dolly (Distance)
To dolly your camera, roll the scroll wheel forward to increase distance or back to decrease distance.

Keyboard Controls

KeyShot also provides additional ways to navigate your scene and control your camera using the keyboard.

Camera Dolly (Distance)
To dolly your camera, press Alt + RMB (Windows/Mac) while moving the mouse. This changes the Distance of your camera.

Camera Perspective
To change camera perspective, press Shift, Alt + RMB (Windows/Mac). This will adjust Distance, Perspective/Focal Length and Field of View.

Camera Twist
To twist the camera, press Ctrl, Alt + Wheel (Windows) or , Alt + Wheel (Mac).

Standard Views
To cycle through the standard view (front, back, left, right, top, bottom, isometric select Ctrl, Alt + 1-7 (Windows) or , Alt + 1-7 (Mac)

Focal Length
To change Focal Length press Alt + Wheel (Windows/Mac). This will adjust Perspective/Focal Length and Field of View.

Set Camera Target
To quickly center the camera on an area, select Ctrl, Alt + RMB (Windows) or , Alt + RMB (Mac).

Next Camera
To toggle through cameras, press Shift + N.

Toggle DOF
To toggle Depth of Field (DOF) press D.

All KeyShot hotkeys can be seen here.
**Gestures**

Basic touch controls allow you to orient the camera on track pads.

- **1 Finger** – Tumble camera
- **2 finger up/down movement** – Dolly Camera
- **2 Finger Pinch** – Change Focal Length (zoom)
- **2 finger rotate** – Twist camera

Learn more about multi-touch input [here](#).
Camera List

The camera list at the top of the Camera tab contains all the cameras for the scene. In the camera list, the *Free Camera* is always available and cannot be locked or overwritten. It can always be selected and remains independent of camera animations.

**Add Camera**

To create a new camera, select *Add new camera* to the left of the camera list. This will add the current camera view to the *Camera List*.

Cameras can be renamed for easy identification and better organization, simply right-click and select *Rename*.

**Add Camera and Environment Studio**

The *Add Camera and Environment Studio* is a Pro feature that allows you to add a Studio along with the currently active camera and environment. *Note: This replaces the Viewset functionality from KeyShot 5/6. Read more information about the Studio feature and Viewset to Studio conversion here.*

**Add Camera animation**

You can add a Camera animation via the context menu - right click the camera you want to animate, select Animation and the type of animation you want to add. Learn more about *Camera Animations*.

**Edit camera**

After a camera is saved, any change made while that camera is active will display *(unsaved)* after the camera name.

- **Save camera**: To save the changes simply select *Save Current Camera*.
- **Reset Camera**: If you do not want to apply changes, select *Reset Camera* to revert the active camera to its last saved state.

Adding a new camera to the list will add a camera with the current setup, while the previously selected camera will be reverted to the last saved state.

**Locked Camera**

Any camera can be locked/unlocked by right-clicking on the name or by selecting the lock icon. When a camera is locked the Tumble/Pan/Dolly options in the ribbon will be disabled.

**Delete Camera**
Any unlocked camera can be deleted using the Remove current camera.

**Duplicate Camera**

Select the camera, right click and select duplicate.

**Rename Camera**

Click the name of a selected camera to open the edit option or right click and select rename.
Position and Orientation

All KeyShot cameras are defined by their position in 3D space in relation to the Camera Target. The Camera Target specifies the exact mathematical point or location the camera is “looking at.” This relationship is critical to understand, especially when fine-tuning settings and creating camera animations.

Camera Mode - Spherical

Default setting for defining position and orientation of the camera.

When using the default Spherical definition all values reflect camera position in relation to the static Camera Target.

Distance

Distance between the Camera Target and Camera in scene units. Setting this value too low can lead to the camera being “inside” the 3D model. This can be controlled with the mouse scroll wheel. The direction can be inverted in Preferences.

Azimuth

Rotation around KeyShot up (Y) axis, measured in degrees.

Inclination

Defines camera tilt, or vertical rotation from horizontal plane.

Twist

Twists/rotates the camera around its own axis.

Camera Mode - Absolute

Here you can set the position of the camera (Position) and the camera target (Target) relative to the global X-axis, Y-axis, and Z-axis.

Position

Defines X/Y/Z coordinates of camera location in scene units.

Target

Defines X/Y/Z coordinates of Camera Target in scene units.

Keep View Direction

Locks View Direction for Position/Target changes. When unchecked, the camera will keep looking at the target while the Position values are changed. If the checkbox is checked, the camera direction will be kept and therefore the Target point will change as the Position is changed.
**Twist**
Twists/rotates the camera around its own axis.

**Set Camera Target**
With Set Camera Target you can click on a surface in the real-time view to define it as the camera target. The camera will now tumble, pan & dolly in reference to this exact point on the surface. In the Geometry panel you can always see where the camera target is.
Next to the button the position of the Camera Target is displayed as coordinate values.
The default Camera Target is always the center of geometry in the scene.

**Tip**
To reset the camera target, you can right-click in the Real-Time View and select Center and Fit Models. This will use the center of all objects in the scene and dolly to a distance where all parts are within view. You can also use the Set Camera Target tool, which will let you select what to target; point on surface, object or model.

**Walkthrough Mode**
See Walkthrough Mode.

**Standard Views**
Quickly access camera presets based on common orthographic directions. Note that this does not automatically change the camera to the orthographic lens only the position of the camera.

**Grid**
Enables on-screen grid which can be helpful for image composition and camera placement. The grid will not be visible in rendered output.

**Stay Above Ground**
This option allows all camera movements to be restricted to the upper hemisphere. This is useful for scenes where bottom views are undesirable.
Walkthrough Mode

Walkthrough Mode allows you to move around inside your scene and see it from a "first-person" point of view.

To enter Walkthrough Mode go to Project window, Camera tab, Position and Orientation. Select Walkthrough Mode and the Walkthrough Mode HUD will appear and a camera called First Person will be added to the camera list.

Eye height

The eye height indicates the height of the camera in relation to the lower object.

Lock Eye Height

Locking the eye height will keep the camera at a constant height and will ignore the ground detection setting covered below.

Ground Detection

Ground detection will automatically adjust the camera height in order to keep it at the set Eye Height specified above. If you move towards an object such as stairs, the camera will appear to be going up the stairs and will respect the "new ground".

Collision Detection

Selecting this setting will keep you from moving through objects. This is used to make the walkthrough more realistic by not allowing you to move through objects that you should not be able to go through.

Arrows

Click and hold the arrows to "walk" around your scene in the arrow's direction.

Sensitivity

Like its name describes it, this adjustment will control the sensitivity of the controls in order to move around the scene in Walkthrough mode. You can either move the slider around or type a value in the box.

Accept/Cancel

- Clicking the X at the bottom right cancels any changes and deletes the camera from the list.
- Clicking the V at the bottom right accepts any changes and saves the First Person camera.

Walkthrough Navigation

To navigate within the scene in Walkthrough Mode, you can:

1. Use the arrows on your keyboard or the arrows in the widget.
2. Hold the left mouse button and drag in the direction you would like to move.
3. Hold the right mouse button and drag to rotate in place.
4. Hold the middle mouse button to pan the camera.
Lens Settings
The various Lens Settings can be found in the *Projects* window, under *Camera* tab, *Lens Settings*. The Lens types include:

- Perspective
- Orthographic
- Shift
- Panoramic
Perspective

The Perspective lens closely represents how a physical camera lens works.

Tip
When trying to match perspective in an backplate image, it is recommended to set the Perspective value to the camera lens focal length which is often included in the Exif data.

Match Perspective

Perspective Matching allows you to interactively match the Perspective camera to the camera with which a background image was taken. In order to activate Match Perspective, please load a Backplate. See Adjusting Environments for further information on this topic.

When clicking on the Match Perspective button, a widget appears in the Real-Time View and you will also notice 2 or 3 sets of vanishing lines in different colors - The lines and colors correspond to the scene’s coordinate system. X is blue, Z is red, and Y is green.

Two-Point Perspective

This is the mode used in most cases.
Adjust the vanishing lines according to the plane on which the object is placed.

Three-Point Perspective

Three point perspective is most commonly used when trying to place building or object when the camera is placed at a low or high eye level.
Adjust the perspective with 3 sets of orthogonal lines to match the vanishing points to the plane on which the object is placed and of vertical lines.
Make sure the up axis of the matched perspective is the same as the one in the scene.

Lock Rotation

When the rotation is locked any adjustments to the 3 sets of lines will not affect the azimuth.

Ground Grid

Turn on ground grid in the scene to help match the perspective. the grid will not be visible in rendered output.

Reset lines

Reset all sets of lines to their default position. The camera will update accordingly.
For best results we recommend to turn on *Show Coordinate Legend*, found under the *View* menu. It can also be toggled on and off using the *Z* hotkey. This will help you identify the orientation of the model in the scene.

**Tip**
For the best results try to find orthogonal lines in the backplate image that you can use as guides when matching the perspective. Move the end points of the lines according to the coordinate layout to reference points in the background image. Notice the camera values update accordingly. Once aligned, pan and dolly the camera to position the object so it fits properly inside the scene.

**Perspective / Focal Length**

The *Perspective / Focal Length* controls the amount of distortion (convergence) seen in the Real-time View; real world values can be used here to replicate camera lens focal lengths.

**Field of View**

*Field of View* (FOV) is inversely related to Perspective and controls the “cone of vision” seen in the Real-time View. Larger Perspective values will result in a smaller Field of View, while smaller Perspective values increase the amount that’s visible in the Real-time View.

**Ground Grid**

*Ground Grid* will overlay a 1:1 grid on the KeyShot ground plane; the density of the grid is controlled by the Environment size. This grid is useful for matching perspective and camera angles and will not be visible in rendered output.

**Popular focal lengths**

(Source: [Wikipedia](https://en.wikipedia.org/wiki/List_of_camera_focal_lengths))

- 14 to 21mm: Ultra-Wide — Dramatic distortion due to very short focal length.
- 24 to 35mm: Wide — Wider field of view than a standard lens. The resulting perspective can show some distortion.
- 50 mm: Standard — Some distortion but generally acceptable for most use.
- 85 mm: Portrait — Less distortion than standard lenses.
- 135 mm: Telephoto — Commonly used to capture faraway objects or in product photography for
- 200 to 500 mm: Super Telephoto — Specialized lenses for minimal distortion.
Orthographic

An Orthographic lens uses parallel projection to view the scene: all lines parallel to each other appear parallel regardless of camera distance or position. An orthographic lens is most commonly found in CAD modelers and is not affected by perspective distortion, foreshortening, or parallax. This means that relative distance in the realtime view is always accurate for any parallel or perpendicular lines.
Shift

A Shift lens is useful for recreating two-point perspective camera views. It allows you to keep a camera’s position while shifting the viewing plane to eliminate vertical distortion. Most commonly seen in architectural photography, a Shift lens can be used to remove the third (vertical) vanishing point in product photography.

Estimate Vertical Shift

To use the Shift lens, press the Estimate Vertical shift button. This will set your camera facing forward and calculate the Vertical Shift value, needed to achieve a 2 point perspective lens.

Perspective/Focal Length and Field of View

Perspective/Focal Length and Field of View controls the amount of distortion (convergence) seen in the Real-time View, real world values can be used here to replicate camera lens focal lengths.

Vertical Shift and Horizontal Shift

These control the vertical and horizontal movement of the camera’s viewing plane; these values can be adjusted beyond the slider extents (including negative values!) to control what’s visible in the Real-Time View.

Any time the camera position is changed, it is necessary to re-calculate the shift values by pressing the Estimate Vertical Shift button. This ensures that the values are correct for the current camera position and orientation.

Ground grid

Ground Grid will overlay a 1:1 grid on the KeyShot ground plane; the density of the grid is controlled by the Environment size. This grid is useful for matching perspective and camera angles and will not be visible in rendered output.

Learn more

A blog post showing the use of the Shift lens can be found here: https://blog.keyshot.com/2016/use-shift-lens-setting-keyshot
Panoramic

The Panoramic Lens Setting for Cameras allows you to render a Spherical or Cube Map image in real-time or rendered output. This feature can be used to render out your own spherical EXR images to use as environments to light KeyShot scenes or to load in your VR headset image viewer.

Whenever a Panoramic lens is used, the camera position will be limited to spherical 360 degree viewing and the camera target is used as a position reference.

Using the Panoramic Camera

In the Camera tab, under Lens Settings, select Panoramic. Select your desired format of Spherical or Cube Map from the Mode radio buttons. The Real-time View will display a Panoramic Preview message at the top to indicate you are Panoramic mode. This means the camera can be rotated spherically and the real-time rendering in the Real-time View will not occur.

Cube Map mode

When using the Cube Map Mode the Resolution in the Image tab will be locked at a 6:1 ratio. Cube Maps are essentially 6 squares that make up a cube, and they are primarily used with VR Headsets

Spherical Mode

When using the Spherical Mode the Resolution in the Image tab will be locked at a 2:1 ratio. Spherical maps are 1 image and they can be used to create EXR images for

Tip

If the map does not appear clear, try to increase the pixel count of the current Resolution in the Image tab

Preview Map

Click the Preview Map button to open a flat preview of your Panoramic image.

Reset Panoramic Camera

In the bottom of the Real-Time View there is a button which enables you to return the camera to the original view.

Moving a Panoramic Camera

Since the Camera Position is limited to spherical 360 degree viewing, there may be times where you want to adjust the camera position. There are two ways to move a Panoramic Camera.

1. Position and Orientation
   You can use the Position and Orientation sliders or input boxes in the Camera tab to adjust Distance, Azimuth, Inclination and Twist. Grab the slider to make fast adjustments or enter a value into the input box for more precision.
2. Geometry View (Pro only)
   If you are using KeyShot Pro, you can move the camera in the geometry view. You can open the Geometry View (Window, Geometry

Tip

If the map does not appear clear, try to increase the pixel count of the current Resolution in the Image tab
In the Geometry View, right-click the active camera and select *Move Active Camera Position* to adjust the camera. When you move the active camera, you will see it automatically adjust to keep the same camera target.
Stereo (VR)

Stereo mode will display when Perspective or Panoramic is selected in Lens Settings.

The Stereo setting allows for a scene to be viewed in real-time or output as still images and animations using virtual reality (VR) hardware.

Spherical and Cube Maps offer a 360-degree stereo viewing experience while Stereo Perspective shows a stereoscopic image of the viewport. For more information on using KeyShot with VR devices, please see the Virtual Reality section.

Head-Mounted Display (HMD)

Support is available for real-time viewing using Oculus Rift and HTC Vive Head-Mounted Display (HMD) viewing (currently Windows only). From the Camera tab, enable the Stereo option for your Perspective or Panoramic camera. Click the Head-Mounted Display button to select Oculus Rift or OpenVR for HTC Vive to open the HMD viewing window.

Note
An HMD must be connected for the Head-Mounted Display button to be enabled and viewing window to be activated.
Depth of Field

Depth of Field allows you to set the focus distance and the f-stop of the camera just like you would with a regular camera.

To enable the depth of field, go to Project → Camera and click on the Depth of Field check box, or hit the D hotkey. Once enabled you can either use the Select Focal Point button or use the manual values to set the focal distance.

Select Focal Point

Click on the Select Focal Point icon (in front of the Focus distance input). This will enable you to select any part in the Real-time View to be the Focal point for the camera. KeyShot will focus on that point and blur out rest of the scene in accordance with the F-stop.

Focus distance

The distance from the camera to where the image is the sharpest.

F-stop

Adjusts the virtual aperture of the camera. This determines the extent of the area that is "in focus".

High F-stop values will produce the deepest images, while smaller f-stop values result in more shallow images, where the front/background are blurred.

Tip

When Depth of field is enabled, turn on the Geometry View to see a visual representation of Focus Distance and F-stop.

Depth of field is only used with Perspective, orthographic or shift lenses.
Image

This section covers all items found in the Image tab of the Project window.

Resolution

The Resolution determines the size of the image that is rendered in the Real-time View, and dictates the aspect ratio used in the Render dialog.

Image styles

Image Styles allow you to add non-destructive image adjustments to your scene and see the result instantly. The Image Style adjustments include tone, curve, color and image effect settings that can be applied and seen in the Real-time View or render output window.
Resolution

Resolution is the first item found in the Project panel > Image tab. You can also set the resolution to one of the presets via the Main menu > Image > Resolution Presets.

The resolution defines the width and height in pixels of the Real-time view and the aspect for final image output. For example, if you plan to render at 1920*1080px you want to make sure the resolution set in the Image tab has the same aspect.

🔗 Lock Aspect

When Lock Aspect is active, the Real-Time View will adapt to the size of the application window while maintaining the correct aspect ratio for the image. The aspect ratio set here also defines the aspect of the final image output.

🔒 Lock Resolution

If you do not want the Real-Time View to adjust size as you resize the docked windows and application window you can enable Lock Resolution. This will make sure your image always matches the given pixel size.

Presets

KeyShot comes with a number of standard presets which can be selected from the Presets drop-down. This will automatically lock the aspect to the selected preset and the image will fit within the Real-Time View. Meanwhile if you have Lock Resolution checked and the application window is not docked when selecting a preset, the Real-time View will adapt to the size of the image and may even exceed the size of the monitor.

If your desired output resolution is not populated in the Presets drop-down you can manually type in the values or you can create a custom resolution or aspect preset by selecting Edit Custom from the Presets drop-down. Once created, you can access your custom presets through the Custom fly-out menu in the Presets drop-down.

Tip

If the image does not adapt to the size of the Real-Time View automatically try to move the camera or resize one of the docked windows.

Known issue

If you open a scene where Lock Resolution is enabled and which has an image size that is larger than your screen, KeyShot will outgrow the screen.
Image Styles

Image Style allow you to add non-destructive image adjustments to your scene and see the result instantly. The Image Style adjustments include tone, curve, color and image effect settings that can be applied and seen in the Real-time View or render output window.

Image Style List

The Image Style list allows you to add an unlimited of Image Style variations. Additionally, when setting up Studios, you can combine them with Cameras, Environments, Model Sets and Multi-Materials.

Image Style Types

KeyShot has two types of Image Styles:

- **Basic Image Style** - Includes basic adjustments for Exposure and Gamma.
- **Photographic Image Style** - Offers more versatile adjustments including Tone Mapping, Curve, Color and Layers.

Both Image Style types have options for Denoise, Bloom, Vignette, and Chromatic Aberration. If you switch type, the current value of these will be retained.

---

**Note - Image Adjustments and Image Effects**

Basic Image Style is almost identical to the Image Adjustments and Image Effects options in versions prior to KeyShot 8. If you open a scene from a previous version with Image Adjustments/Effects they will be added as a Basic Image Style.

---

How Image Styles Are Applied

Image Styles are applied in two ways. First, they can be set up in real-time and seen in the Real-time View as you work. When rendering, they are applied post-process (after the rendering), so they will not affect render performance or time. This also means that render previews in Network Rendering will not show the Image style adjustments.

Quick tips
Basic Image Style

Adjustments

- **Exposure** - Determines how affected the scene is by the light. Increasing the EV (exposure value) by 1 will double the amount of light in the image.
- **Gamma** - Adjust the image's intensity with gamma. Decreasing the gamma will make the image darker while increasing the gamma will lighten the image.

Denoise

Denoising will even out noise in the image, both in the Real-time View and in the final rendering. In the Real-time View, it will kick in after 1 second and be refreshed every 5 seconds (the interval can be adjusted in Preferences). You can always follow the Denoise state in the Heads Up Display. Denoising can also be toggled from the Ribbon, but the button will be disabled, if you have locked your image style.

- **Denoise Blend** - The Denoiser creates a denoised image which is blended with the rendered image. The Denoise Blend slider enables you to control the strength of the denoise effect. Decreasing the value will allow more of the original noise in the image. If you have a scene with fine details or textures, the denoise may wipe out the details - try to decrease the Denoise Blend value.

Note

Real-time vs. Rendering with denoise: When Denoise is enabled, what you see in the Real-time View and the result of the rendering, may have slight variations. The difference is that when rendering images, the normal and diffuse maps are taken into account in order to produce the best possible result. These are not applied in the Real-time Denoiser. This is also why a rendering, with denoise enabled, will output the Normal and Diffuse passes, even if they are not selected in the Render Dialog.

Denoise and Custom Control rendering: Denoising will not have the same impact on renderings made with Custom Control, because the noise pattern in custom control is different from the one in Real-time or Maximum time/sample rendering where the denoiser is have more noticeable results.

Bloom

- **Bloom Intensity** - The brightness of the light fringing or glow.
- **Bloom Radius** - Determines how far the bloom glow extents in pixels.

Note

The Bloom radius is defined in pixels and this value is not relative to the resolution. This means that the bloom radius will not scale in the Render Output has a larger resolution than the Real-Time View.

- **Bloom Threshold** - The clipping of the bloom glow to bright pixels. A value of 0 means no clipping. Larger values focus the bloom on the brightest pixels.

Vignette

- **Vignette Strength** - Determines how strong the vignette is, the higher the value the more solid the vignetting color will seem in the corners.
- **Vignetted Color** - Choose the color that the vignette fades into, defaults to black. Click in the color-field to trigger the color selector.
Chromatic Aberration

Chromatic Aberration occurs in real life when the camera lens is unable focus all colors to the same point. This results in colored fringing along the edges of the object. With Image styles you get an approximation of the effect.

- **Aberration Strength** - Determines how strong the effect is.
- **Aberration Bias** - Controls the color of the distortion.

**Known Issue**
Using Chromatic Aberration on a model that exceeds the image size may cause artefacts near the edges.

**Legacy image styles**
If you open a KeyShot 7 scene with Image Adjustments/Effects they will be added as a Basic Image Style.
Photographic Image Style

The Photographic Image Style takes advantage of the HDR image and gives you more control when you want to enhance details in areas that would otherwise be perceived as underexposed or blown out. In the Basic Image Style, the range is linear and stops at pure white (Whites) while Photographic Image Style offers control of the range beyond Whites with Highlights.

Tone Mapping

- **Exposure** - Determines how affected the scene is by the light. Increasing the EV (exposure value) by 1 will double the amount of light in the image.
- **White Balance** - Adjust the color temperature of your image. Negative values will return warmer tones and positive will give cooler tones.
- **Contrast** - Determines the difference between black and white. When you lower the contrast, the colors will start melding together, while increasing the contrast will make bright parts brighter and dark parts even darker.
- **Response Curve** - Determines how the mapping curve is interpreted.
  - **Linear** - Linear response curve where highlights will be clamped. This is similar to the Basic Image style.
  - **Low Contrast** - Values near the minimum or maximum are compressed, to be suitable for high dynamic range scenes - Scenes with large contrast in light e.g. interiors with sun and sky.
  - **High Contrast** - Values near the minimum or maximum are compressed, to be suitable for medium dynamic range scenes - Scenes with low/moderate contrast in light e.g. Product shots with diffuse lighting.

Curve

- **Histogram** - The histogram gives a visual representation of the shadows, midtones, lights, whites and highlights in the image. Each control point is tied to a value and any changes made to either the input values or position of the control points will update respectively. The Histogram can be hidden/shown by toggling the little triangle next to the Histogram title.
- **Shadows** - Add detail in these areas by increasing the shadow value or make the dark areas of your image seem even darker by decreasing the value.
- **Midtones** - When adjusting the Midtones you affect the values mid-way between shadow and highlight. Increasing the value makes midtones lighter while decreasing makes midtones darker.
- **Lights** - Adjusting the Lights value will affect the lighter areas within the midtone range.
- **Whites** - This value represents the "white-point" i.e. the equivalent of white paper seen in daylight. Increasing the value will make whites seem "whiter" - while decreasing the value will make them more grey.
- **Highlights** - Adjusting Highlights affects the areas that are receiving the largest amount of light and are reflecting light source most efficiently. Add detail to these areas of your image by decreasing the highlight value or make the areas seem even brighter by increasing the value.

Color

- **Saturation** - Uniform increase/decrease of the intensity of the colors. Negative values will de-saturate your image while increasing the value will make the colors in your image more saturated. 0 is neutral.
- **Vibrance** - Increases the the intensity of more muted colors without adjusting the the saturated colors.

Denoise

Denoising will even out noise in the image, both in the Real-time View and in the final rendering. In the Real-time View, it will kick in after 1 second and be refreshed every 5 seconds (the interval can be adjusted in Preferences). You can always follow the Denoise state in the Heads Up Display. Denoising can also be toggled from the Ribbon, but the button will be disabled, if you have locked your image style.

- **Denoise Blend** - The Denoiser creates a denoised image which is blended with the rendered image. The Denoise Blend slider enables you
to control the strength of the denoise effect. Decreasing the value will allow more of the original noise in the image. If you have a scene with fine details or textures, the denoise may wipe out the details - try to decrease the Denoise Blend value.

**Note**

**Real-time vs. Rendering with denoise:** When Denoise is enabled, what you see in the Real-time View and the result of the rendering, may have slight variations. The difference is that when rendering images, the normal and diffuse maps are taken into account in order to produce the best possible result. These are not applied in the Real-time Denoiser. This is also why a rendering, with denoise enabled, will output the Normal and Diffuse passes, even if they are not selected in the Render Dialog.

**Denoise and Custom Control rendering:** Denoising will not have the same impact on renderings made with Custom Control, because the noise pattern in custom control is different from the one in Real-time or Maximum time/sample rendering where the denoiser is have more noticeable results.

**Bloom**

- **Bloom Intensity** - The brightness of the light fringing or glow.
- **Bloom Radius** - Determines how far the bloom glow extents in pixels.

**Note**

The Bloom radius is defined in pixels and this value is not relative to the resolution. - This means that the bloom radius will not scale if the Render Output has a larger resolution than the Real-Time View.

- **Bloom Threshold** - The clipping of the bloom glow to bright pixels. A value of 0 means no clipping. Larger values focus the bloom on the brightest pixels.

**Vignette**

Vignetting adds a light fall-off where the image typically gets darker towards the corners.

- **Vignette Strength** - Determines how strong the vignette is, the higher the value the more solid the vignetting color will seem in the corners.
- **Vignetting Color** - Choose the color that the vignette fades into, defaults to black. Click in the color-field to trigger the color selector.

**Chromatic Aberration**

Chromatic Aberration occurs in real life when the camera lens is unable focus all colors to the same point. This results in colored fringing along the edges of the object. With Image styles you get an approximation of the effect.

- **Aberration Strength** - Determines how strong the effect is.
- **Aberration Bias** - Controls the color of the distortion.

**Known Issue**

Using Chromatic Aberration on a model that exceeds the image size may cause artifacts near the edges.
**Layers**

- **Background Color** - Checking the background color will place model on a solid colored background, you can set the color here - click the color-field to trigger a the color selector.

**Environment background**
Using a background color in the Photographic Image style will override the Environment background setting. However the colors of the shadow will still be influenced by the environment settings - So to achieve the best shadows it is a good idea to use a black background in the environment, when using a Image Style Background color

- **Use Frontplate** - With Frontplate you can add an image-layer in front of the image.
  - Add image by pressing the folder icon or by dragging an image onto the input field either from a local folder or from the library. Supported file formats include .jpg, .jpeg, .tif, .tiff, .bmp, .png, .gif, .dds, .hdr, .hdz, .exr, .tga, .ppm, .ktx, .psd.
  - You can refresh the Frontplate by clicking the refresh icon .
  - To delete a Frontplate click the trash icon .

**Note**
Images used as Frontplates will be stretched to fit the current aspect ratio.

- **Opacity** - Set the opacity of the Frontplate by adjusting the slider or by entering a value from 0-1, where 0 is fully transparent and 1 is solid.
Studios

KeyShot Studios allow you to combine and save scene/model/material variations in one file for quick creation and presentation. Studios may contain any combination of Camera, Environment, Image Styles, Models Sets or Multi-Materials.

The Studios window

The Studios window is a dockable window - launch it via:

- Main menu under Window, Studios...
- The Studios icon in the Ribbon
- Hotkey: U

In the top of the Studios window is a list of all the Studios in the scene. The active studio will be highlighted with a blue background. Inline with the Studio name are icons that indicate what elements are included in that Studio.

You can reorder the studios list by drag and drop.

Next to the Studios list you find the options to Add new Studio, Delete Studio and Thumbnail settings.

Under the Studios list you find five drop-down menus that display the currently active Camera, Environment, Image Style, Model Sets and Multi-Materials.

Setting up a Studio

Click the Add Studio icon in the top left corner to add a new Studio. The new Studio will be pre-populated with the active elements in the scene - but only the active Camera and Environment are included (checked) by default. You can always check/uncheck any checkbox to include/exclude that element from the Studio.

To modify a Studio simply select a different Camera, Environment, Model Set or Multi-Material from the drop-down menus.

Camera

Select which Camera you want to use in your studio. If this is not set, the studio will use the active Camera.

Environment

Select which Environment you want to use in your studio. If this is not set, the studio will use the active Environment.

Image Style

Select which Image Style you want to use in your studio.
You can add an *Image Style* to your Studio, this includes among other things Frontplates. If no Image Style is selected the active Image style will be used.

**Model Sets**

Multiple Model Sets can be added to a Studio by checking the corresponding boxes within the Model Sets drop-down menu.

**Multi-Materials**

When The Multi-Material is checked, you can select which material (of each of the multi-materials in the scene) you want displayed in the Studio. Select a multi-material in the drop-down and you will see a list of the materials (within that Multi-Material) below the drop-down.

---

**Note**

When you are using Studios with the Configurator, any Model Sets/Multi-Materials that are selectable in the configuration will not be considered to be tied to a studio. This means that only Model Sets containing “props” will switch with the Studio. This also applies to multi-materials where only materials of props can change with a studio.

---

**Thumbnails**

When a Studio is created a thumbnail is automatically generated. If the Camera is set to *Free Camera* the thumbnail will show the environment. You can generate thumbnails for each Studio by clicking the *Render Thumbnail* button in the bottom of the window. This will create a thumbnail using the active elements of the Real-Time view.

**Thumbnail Settings**

- **Preview size:** Set the size of the thumbnails in the list, or choose not to show thumbnails in the list.
- **Thumbnail Render Settings:**
  - **Samples** - set the number of samples you want to use for rendering each thumbnail.
  - **Use environment thumbnail for Studios without thumbnails** - if a studio does not have a camera included the thumbnail can either be rendered from the free camera or the thumbnail can show the environment thumbnail.
  - **Render High Res** - if you need the thumbnails in better resolution - eg. for use with the Configurator
  - **Render Thumbnails** - This will Render all thumbnails. If you only want to render a thumbnail for a specific studio, select the studio and press the button below the preview
  - **Reset all to Environment Thumbnails** - this will discard all current thumbnails and replace them with the Environment thumbnails - if no environment is included in the studio, the current environment will be used.
Viewset to Studio Conversion

Viewset to Studio Overview

Prior to KeyShot 7, you could create a Viewset, a combination of a Camera and Environment, or a Scene Set, a combination of Camera/Viewset and Models. A Studio simplifies this by combining options for Camera, Environment, Models and Materials in one window.

Opening Scenes with Viewsets

In KeyShot 7, when a scene with Viewsets and/or Scene Sets is imported, each Viewset and Scene Set is converted to a Studio. When you import a scene that contains Viewsets or Scene Sets, you will see this message:

The Studio window should appear after you open the scene. If you do not see it, select Windows, Studios... or hit the U-key. Any previous Viewset or Scene Set will appear with the same name in the list of Studios.

Studio Workflow for Adding Camera/Environment Combos

Prior to KeyShot 7, when selecting 'Add new viewset' a Viewset would appear in the camera list with a unique Camera and Environment. The same can be done using Studios using the following workflow:

1. Adjust Camera to desired position.
2. Select *Add Camera and Environment Studio*, Add Locked.

Another approach is to set a Camera and Environment, then Add a Studio.

1. Select an existing Camera or *Add New Camera*.
2. Select an existing Environment in list or drag-and-drop an Environment into Environment list and select.
3. Select *Add Studio* from Ribbon or Studios dialog.

You can now cycle through the Studios to view the different Camera and Environment combinations you've created.

Notes on Studios
• When you add a Studio, it enables the active Camera and Environment
• If you add a new camera to the camera list, it will use the camera selected
• If the Free Camera is active when a Studio is created, Camera will not be enabled for the Studio
• If you add an Environment to the Environment list, it will use the environment selected
In the Ribbon you can find a selection of tools, which are organized in sections relating to what they will impact.

- **Geometry Tools** - The Geometry Tools offer different ways in which you can affect/alter the geometry in the scene.
- **Material Tools** - The Material tools offer alternative ways of importing and applying materials
- **Camera tools** - The Camera tools will impact the position of the camera

### Geometry tools

- Move Tool
- Edit Normals
- Re-Tessellate
- Close Mesh
- Split Object Surfaces
- Split Separate Objects

### Material tools

- Material Template
- Material Importer

### Camera tools

- Set Camera Target
- Match Perspective
- Move tool
- Edit Normals
- Re-Tessellate
- Close Mesh
- Split Object Surface
- Split Separate Objects
- Material Templates
- Material Importer
Move tool

The Move tool can be triggered in different ways:

- Right-click a selected part/model in the Scene Tree and choose Move.
- Right-click a part in the Real-time View and choose Move Selection, Move Part or Move Model, depending on what you want to move.
- Click the Move button in the Tools section of the Ribbon or in the Scene tab of the Project Panel. If no part(s) are selected, this will trigger a dialog, where you can choose which part(s) you want to move.
- Use the hotkey ctrl+d on Windows and cmd+d on Mac. If no part(s) are selected, this will trigger a dialog, where you can choose which part(s) you want to move.

Once you have selected what to transform, the Move Tool will be visible in the Real-Time View. The Move Tool consists of different handles that control translation, rotation, and scale in the X, Y, and Z directions.

Mode

Select which handles you want to see on the move tool. When rotating you can press Shift while dragging to make the rotation snap in 15° increments.

Axis

Choose an axis from which to reference your transformations.

- Local uses the axis inherent in the part or model.
- Global uses the XYZ coordinates from the KeyShot scene.

Pivot

By default the Pivot is in the center of the current selection. To select another pivot point click Pick to launch the Pivot Selection dialog.

- Pick: When the Pivot Selection dialog is displayed you can select a part or a model/group to use as Pivot - either in the Pivot Selection dialog itself or by clicking on the part in the Real-Time View - followed by OK. This effectively sets the center of the selection as the pivot. The name in the pivot field is changed to the name of the part/group and the Move tool is moved to the pivot point.
- Reset: The reset button will return the pivot point to the original position in the center of the part(s) and the text in the pivot field now says Self again.

Snap

Snap to Pivot

The Snap to Pivot option will move the part(s) to the selected pivot. More precisely will the option align the center of the part(s) with the center of the pivot object.

Snap to Lower Object

The Snap to Lower Object option will automatically move the bottom edge of the object’s bounding box to the top edge of the bounding box of the part located below.

Snap to Ground
The *Snap to Ground* quickly moves the model in the Y-direction (up-down) to snap the lowest point on the model's bounding box to the ground plane. This is useful when the model has been moved and is no longer touching the ground plane.
Edit Normals

What does the tool do?

If your model appears to have a hole or flat areas, the Edit Normals tool can help you to unify the normals.

A normal is the direction that is perpendicular to a mesh surface. In a 3D model. The normals should all be facing the same direction, otherwise "holes" might appear. Also if your vertex normals are not aligned, flat spots might appear on what was intended to appear as a curved surface.

How to Edit Normals

You can launch the Edit Normals tool either via the Tools section in the Ribbon or via the context menu in the Real-time View or the Scene tree.

Minimum Edge Angle
Adjust the Minimum Edge Angle to ensure that edges that do have a crease are not aligned as well.

Calculate Vertex normals
If you see the normal of the missing polygon pointing in the opposite direction or if the vertex normals from adjacent polygons are not aligned, use the Calculate Vertex Normals. Note that calculating will give you a preview of the new normals. You have to Apply to submit the new normals to the model.

View

- Show Vertex Normals: toggle visibility of the (green) vertex normal indicators.
- Show Face Normals: toggle visibility of the (blue) face normal indicators.
- Display Height: enables you to adjust the height of the normal indicators.
- Wireframe: toggle the visibility of the part's wireframe, to help you read the surface topology.
Re-Tessellate

Models that contain NURBS data can be re-tessellated directly in the scene without having to import the model all over again.

What Does the Tool do?

The Re-Tessellate tool enables you to fine-tune tessellation quality of entire models or individual parts in your scene. Increasing the tessellation value will yield smoother surfaces on your model, but also increase scene file size.

How to Re-Tessellate

1. Launch the Re-Tessellate tool
   The Tesselation tool can be launched either from the Tools Section in the Ribbon, or via right-click on a model, part, or multi-selection of parts in the scene tree or Real-time view. If nothing has been selected when you launch the tool, a selection dialog will appear. Here you can select the part you want to alter in the list or by clicking in the Real-time View, which will highlight the part in the list.

2. Adjust the Tessellation quality
   Increase will make the surface smoother and a decrease will make the scene faster, as the it will contain fewer triangles.
   - Distance Tolerance: The maximum allowed distance deviation – expressed as a percentage of the model's bounding box – measured from any triangle to the actual NURBS surface. A lower value with yield smooth surfaces.
   - Angle Tolerance: The maximum allowed angle measurement between adjacent triangles on your model's surface.
   - Maximum edge: The maximum allowed distance deviation – expressed as a percentage of the model's bounding box – measured from any triangle to the actual NURBS surface. A lower value with yield smooth surfaces.

3. Click Tessellate
   In order to see the effect you need to press Tessellate after adjusting the values. Use the Preview settings Wire-frame/Glossy to inspect the effect of the Tessellation in the preview

4. Click Apply
   This will let you view the current tessellation quality in the Real-time View, so you can inspect the effect in context, with the current materials, lighting etc. Notice that at this stage the process can still be canceled, and if you close/cancel the tool now, the tessellation quality will be reverted to the state before the tool was launched

5. Click Done or Cancel
   Click Done to commit the changes to the scene. Cancel will revert all changes and exit the dialog. Notice that once the re-tessellation has been committed, it can be undone with Ctrl/Cmd+z, but as long as the part includes NURBS data, you can always re-tessellate.

Note:
In order to Re-Tessellate, you must enable the Import NURBS Data checkbox when importing (More about the Import dialog).

Tool UI

1. Tessellation Quality
   The quality of your surfaces. A lower value will yield rough surfaces. A higher value will yield smooth surfaces.

2. Angle Tolerance
   The maximum allowed angle measurement between adjacent triangles on your model's
surface.

3. **Distance Tolerance**
   The maximum allowed distance deviation – expressed as a percentage of the model’s bounding box – measured from any triangle to the actual NURBS surface. A lower value will yield smooth surfaces.

4. **Maximum Edge Length**
   The maximum side length – expressed as a percentage of the model’s bounding box – for any one triangle on your model’s surface. A lower value will yield smooth surfaces.

5. **Tessellate**
   Click to make your model appear in the Tessellation Preview at the specified Tessellation Quality.

6. **Apply**
   This will apply the current tessellation quality to the Real-time View, so you can inspect the effect in context, with the current materials, lighting etc. Notice that at this stage the process can still be canceled, and if you close/cancel the tool now, the tessellation quality will be reverted to the state before the tool was launched.

7. **Tessellation Preview**
   Shows you a preview of the detail on your model’s surface.
   - **Triangles**
     Displays the total number of triangles that make up your model’s surface.

8. **Appearance**
   Select Wireframe for a polygon view or Glossy to see how smooth the surfaces will look.

9. **Cancel**
   Click to undo any changes to your model’s tessellation and close the Tessellation Settings window.

10. **Done**
    Click to accept your changes and apply them to your scene. Note that you cannot undo the changes once you click Done.
Close Mesh

What does the tool do?

If you have a polygon with a holes in it you can use Close Mesh to fill in missing polygons or close the gap between holes.

How to Close Mesh

1. Launch the tool either via the Tools section in the Ribbon or via the context menu in the Real-time View or the Scene tree.
   - The tool will list the open edges of the part you selected. In the preview any open edges will be displayed with a green line.
2. Choose the open edge(s) you want to fix in the list, these will be highlighted with an orange outline in the preview.
3. Now you can choose 2 methods for closing the holes
   - Close Selected Edges: this will create the polygons to fill in the hole
   - Join Selected Edges: if the part has multiple holes, you can choose to create a solid connection between holes. Just select the 2 edges you want to join, and click Join Selected Edges.

Tool UI

1. Preview: The preview shows the selected object with any open edges highlighted in green
2. List of edges: The list shows all the open edges in the object. Edges selected in the list will be highlighted in orange in the preview. Hold Shift and click in the list to multi select.
3. Close Selected Edges: This will cap the selected open edges
4. Connect Selected Edges: This will connect 2 edges into a single edge.
5. Show Wireframe: Enable this to show the wireframe of the object.
6. Cancel/Apply: Click Apply to commit the new geometry to the scene. Cancel will abort the process and the part will be as it was when the tool was launched.
Split Object Surface

What does the tool do?

Use the Split Object Surfaces option if you would like to split specific polygons from a single part. This is useful if you would like to apply separate materials to a single part, or when parts are modeled together and you would like to work with the separately.

How to Split Object Surfaces

1. Select a part and launch the Split Object Surfaces tool, via the Tools section in the Ribbon, or via the context menu in the Real-time View
2. Choose Splitting Method - By Splitting Angle or by Polygons
3. Now you can choose to split out either a single surface via the Surface Selection or all surfaces with the Part Selection
   - Surface selection:
     a. Click on the surface you want to split out in the preview. This will be highlighted in green. Holding Ctrl/Cmd while picking surfaces will let you pick multiple.
     b. Click Split Surface to split out the selected area into a separate surface. Now the surface appears in the list of parts.
     c. Select the part in the list and click the name again, to rename the surface.
   - Part selection:
     a. Select the part to split (will be shown with an orange outline in the preview)
     b. Click Split all - depending on the splitting method, a number of new surfaces will now appear in the list.
4. If you have split something that should not be split, but otherwise are happy with the surfaces you have created, you can merge the relevant surfaces again.
   a. select the relevant surfaces in the list, Holding Shift while selecting will select multiple.
   b. click Merge

Tool UI

1. Preview The preview shows the object you have selected to split. Surfaces highlighted in green can be split into a single surfacem using the Split Surface button. Objects marked in an orange outline can be split into multiple surfaces (depending on splitting method) using the Split All button
2. Splitting Method This determines how the surface(s) will be split out.
   a. Splitting Angle: Determine where you would like to split the part based on the angle adjacent polygons. Any polygon that has a face at an angle that is less than the value entered will be highlighted. This is useful when the split is a clear crease or angle in the part.
   b. Polygons: Use this to select individual polygons from the surface.
3. Surface selection This lets you select and split out single surfaces. Click in the preview to select the surface (Hold control to select multiple)
   • Split Surface Split the selected (green) area into a separate surface.
4. Part Selection This enables you to split out all surfaces of a selected part, based on the splitting method.
   • Parts List: Lists all the parts
5. Split All: Select a part in the list and press Split All
6. **Merge** If you would like to merge certain split parts back, hold shift and select the parts you would like to merge and click *Merge Selection*.

7. **Show Wireframe** Enable this to show the wireframe of the part.*

8. **Cancel! Apply** To finalize the split, click *Apply* to create the new parts in the scene tree. Cancel will abort the process and the part will be as it was when the tool was launched.
Split Separate Objects

What does the tool do?

The **Split Separate Objects** Tool enables you to split up objects that were originally modeled separately, but inside KeyShot are perceived as one.

How to Split Separate objects

1. Select a part and launch the **Split Separate Objects** tool, via the **Tools** section in the Ribbon, or via the context menu in the Real-time View.
2. You can either split one object out from the part or split the part into all the original parts it was modeled as.
   - **Split single object:**
     a. Select the part you want to split out as a separate object by clicking in the preview - your selection will be highlighted in green. Hold Ctrl/Cmd while selecting to select multiple parts that will be split out in one object.
     b. Click **Split Object** - now you will see one more part in the **Parts** list.
     c. Select the part in the list and click the name again, to rename the part.
   - **Split all:**
     a. Select the part to split (will be shown with an orange outline in the preview)
     b. Click **Split all** - depending on the splitting method, a number of new surfaces will now appear in the list.
     c. Select a part in the list and click the name again, to rename the part.

Tool UI

1. **Preview:** The Preview shows the object you have selected to split. Objects highlighted in green can be split into a single object using the **Split Object** button and objects highlighted with an orange outline can be split into multiple objects using the **Split All** button.
2. **Split Object:** this will split out the green selection into a single part.
3. **Parts list:** The Parts list will show all the parts the current preview shows, splitting out an object will make it appear on the list. Selecting in the list will high light the parts in the preview with an orange outline.
4. **Split All:** Select a part in the list, Split all, will split it into all the parts that is originally was created form.
5. **Merge:** Enables you to merge parts selected in the list.
6. **Show Wireframe:** Enable this to show the wireframe of the part(s).
7. **Cancel/ Apply**
   - To finalize the split, click **Apply** to create the new parts in the scene tree. Cancel will abort the process and the part will be as it was when the tool was launched.
Split Separate Objects

Pick Object:
Select objects in the preview, to split into a single part.

Parts:

<table>
<thead>
<tr>
<th>Name</th>
<th>Triangles</th>
<th>Locked</th>
<th>Visible</th>
</tr>
</thead>
<tbody>
<tr>
<td>254f39201</td>
<td>1275</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Options:
- Split Object
- Split All
- Merge
- Show Wireframe

Cancel | Apply
Material Templates

Material templates automate the material application process e.g. when importing CAD models to the scene.

Material Templates is a powerful feature in KeyShot, that automate the materials applied to your model in a scene. Anyone working with large assemblies can save time using Material Templates to automatically apply materials to parts in a scene. Once a material template has been created, it can be used to apply materials to a new model upon import.

With a material template, materials from the KeyShot library are applied to your model’s parts based on the name of each part’s original materials.

Launch the Material Template window from the Main menu > Window or from the material template icon in the Tools section of the Ribbon.

Create Template

Create a new template by clicking on the add icon.

Method

Two methods can be used in creating a material template, Automatic and Manual.

- **Automatic** – If a model is in KeyShot when you create a new template, the source and material names are automatically populated based on the material applications in the current scene. Only parts that have a KeyShot material will be recorded.
- **Manual** – An empty template is created and you can add template rules manually.

Type

You also have to choose whether the template should apply materials based on part name or original material name.

- **Part name** - This method will apply materials based on the names of the parts, so it requires that the naming of the models are consistent - You can use wildcards to target parts that are named alike e.g. parts with Holder in the example to the left.
- **Source material** - This will make the naming of the parts less important and apply materials based on the source material. If your models have been colored consistently, the source material may be the way to go.

Wildcard

The wildcard refers to the practice of applying a material to several parts using the source name. This can be activated by inserting asterisks (*) to the source name - e.g. `Holder*` this will apply the material in the destination to all the parts containing “Holder” when the material template is applied.

Each new template is added to the template list, which can be accessed with any scene opened in KeyShot.

Add Template rules

The Automatic approach will populate the template with rules for all KeyShot materials in the scene while the Manual approach requires you to pick the parts you want to set up rules for. You can at any time add rules to the template, no matter if it was created using the Manual or the Automatic
A template rule consists of a Source (either part name or source material name) and New Material name.

Use the + button next to the template to create a new rule and add a source. Or drag a part from the Scene Tree onto the list - this will create a rule with the name or source file from the part.

Add a Material to the rule by dragging a material from the Material library/Material tab onto the rule in the template list.

**Applying Templates**

Applying templates can be done through the “Material Templates” window or the import window.

**Material Template Dialog**

Templates can be applied using the Apply button. This will give you two options: To Scene or To Selection.

- **To Scene**
  Apply the current template to the entire scene.
- **To Selection**
  Apply the current template to the selected model or part.

**Import Dialog**

Expand the Materials and Structure section to reveal the Use material template checkbox.

Enable this setting and select the desired template from the list.

Click Import to complete the import.
Material Importer

In addition to importing native formats as KMP and MTL, the Material Importer tool enables you to import following 3rd party formats and convert them into KeyShot materials.

AxF (Appearance Exchange Format)

When you import AxF files, KeyShot will convert them into the Measured material and add them into the selected folder in the Material Library.

If you don’t want to add the material to the library, but only use it in the current scene you can also select the Measured material in the Material Tab (in the Project panel). Here you can load the material directly.

U3M (Unified 3D Material)

When you import U3M files, KeyShot will convert them into the Generic material and add them into the selected folder in the Material Library. More information on u3m format can be found here.

Substance Painter (Texture Sets)

Exporting Texture sets in Substance Painter.

In order to use the Material Importer tool to apply Substance Painter Texture Sets to your model, you will need to select the KeyShot 9+ preset when exporting. If it is not available in your version of Substance Painter, you may find the installer to add the export preset on the Substance Painter plugin page along with instructions on how to install it. Substance Painter projects that have been exported with the correct settings, will have .sp added to the folder name.

Importing into KeyShot

The Material Importer converts Texture Sets from Substance Painter into the Generic material. Because Substance Painter Projects generally are created for a specific model the generated materials will not (unlike the other formats) be added to the Library automatically. The Materials will be made available, in a sort of temporary library, from where they can be applied to the model by drag and drop. This way your library won’t be flooded with materials, that you will only need once.

What to do:

1. Select the Material Importer tool
2. Select your exported Substance Painter project (folder ends in .sp)
3. KeyShot will generate a material from each texture set in the project and list it with the name of the texture set.
4. Drag and drop the materials onto the model in the Real-time View or the Scene Tree.

More information on Substance Painter Texture Sets is available here.
Set Camera Target

What does Set Camera Target do?

With the Set Camera Target tool you can select the point to where the camera is oriented.

When you have selected a camera target, *Tumble* will revolve the camera around this point and *Dolly* will make the camera move closer/farther away from it - even if the camera has been panned, so the target is no longer in the center of the Real-time View.

You can set the camera target in 2 ways:

- via the Tool
- via the Real-time View Context menu

How to Set Camera Target with the tool

1. Launch the Set Camera Target tool in the Tools section of the Ribbon. This will bring out a widget, where you can choose what you want as your camera target:
2. Select what to target
   - **Point**: This will make the clicked point on the surface, the camera target.
   - **Model**: This will make the center of the clicked model, the camera target - note that all groups in the Scene Tree are considered models, but Set Camera Target will use the top level model.
   - **Part**: This will make the center of the clicked part, the camera target.
3. Click in the scene to set the camera target.
4. When you are happy, close the tool by clicking the green check mark. If you want to revert to the camera target from before the tool was launched, click the red X.

Set Camera Target via the Real-time View context menu.

1. Right click an object
2. Select *Select Camera Target* this will make the clicked point on the surface the camera target.
Match Perspective

What does the tool do?

*Perspective Matching* helps you interactively match the Perspective camera to the camera angle with which a background image was taken. In order to activate *Match Perspective*, please load a Backplate. See Adjusting Environments for further information on this topic.

For best results we recommend to turn on *Show Coordinate Legend*, found under the *View* menu. It can also be toggled on and off using the *Z* hotkey. This will help you identify the orientation of the model in the scene.

How to Match Perspective

1. Make sure you have a backplate present in the Real-time View

2. Launch the Match Perspective tool from the Tools section of the Ribbon. A widget appears in the Real-Time View and you will also notice 2 or 3 sets of vanishing lines in different colors - The lines and colors correspond to the scene's coordinate system. X is blue, Z is red, and Y is green.

3. Select the two-point or three-point perspective depending on what matches your backplate.

4. Adjust the vanishing lines so they match the perspective in the image.

For the best results try to find orthogonal lines in the backplate image that you can use as guides when matching the perspective. Move the end points of the lines according to the coordinate layout to reference points in the background image. Notice the camera values update accordingly. Once aligned, pan and dolly the camera to position the object so it fits properly inside the scene.

5. Click the green check mark to keep the changes and close the tool

Tip
When trying to match perspective in an backplate image, it is recommended to set the Perspective value to the camera lens focal length which is often included in the Exif data.

Tool UI

Two-Point Perspective

This is the mode used in most cases, where the image has 2 vanishing points in the horizon and all vertical lines appear parallel.
Adjust the vanishing lines according to the plane on which the object is placed.

**Three-Point Perspective**

Three-point perspective is most commonly used when trying to place a building or object and the camera is placed at a low or high eye level. Adjust the perspective with 3 sets of orthogonal lines to match the vanishing points to the plane on which the object is placed and of vertical lines. Make sure the up axis of the matched perspective is the same as the one in the scene (coordinate legend).

**Lock Rotation**

When the rotation is locked, any adjustments to the 3 sets of lines will not affect the azimuth.

**Ground Grid**

Turn on ground grid in the scene to help match the perspective. The grid will not be visible in rendered output.

**Reset lines**

Reset all sets of lines to their default position. The camera will update accordingly.
Render

Rendering

In KeyShot we have the Real-time View, which renders the scene in Real-time, and the Render dialog where you can select what to render and how. The following pages will take you through the Render Output, Render Options and the Render Queue. You find the Render dialog on the KeyShot Toolbar or in the Main Menu > Render > Render...

Screenshot

In the Real-time view the image will slowly res-up, and if you only need draft images, sometimes a screenshot from the Real-time view is all you need. The screenshot button in the toolbar or Main Menu > Render > Save Screenshot will save a snapshot, of the current state in the Real-time view, to your Renderings folder. If you want to keep the snapshot on your clipboard you can use the Copy Screenshot to Clipboard option in the Main Menu > Render.

CPU/GPU

KeyShot has traditionally been CPU based rendering, but if you have the right GPU, you can switch to GPU mode in the Ribbon. This will increase rendering speed noticeably. Learn more about the requirements and limitations of GPU mode in KeyShot here.
Render Output

The Output page is where you define the file specifications. The first step is to select the type of output you desire. There are four types of output:

**Still Image**
A static image and the default rendering output. [View output options.](#)

**Animation**
An animation with optional video and individual frame output. Note: This option is only available in KeyShot Pro and if there are animations in the scene. [View output options.](#)

Learn more about Animation.

**KeyShotXR**
An interactive KeyShotXR with all code and images. [View output options.](#)

Note: This option is only available if you have the KeyShotWeb add-on. Learn more about KeyShotXR.

**Configurator**
Based on the configuration set up with the Configurator Wizard you can choose to output a series of still images (+ metadata) or a webpage/iBook widget where users can customize their product. [View output options.](#)

Note: This option is only available in KeyShot Pro (and KeyShotWeb for webConfigurations)
Still Image Output

The *Still Image* output option provides output of a single static image as well as options for render layers, render passes and region rendering.

**Output Options**

**Name**
Set the file name of the render in the text field. If one is not entered, the default name will be the scene name with an incremental suffix.

**Folder**
Choose where the render will be saved. Unless a specific folder is chosen, it will be saved in your KeyShot Renderings folder.

**Format**
Choose from PNG, JPEG, EXR, TIFF, TIFF 32-bit, PSD, PSD 16-bit and PSD 32-bit. All formats other than JPEG can include an alpha channel.
When PSD, PSD 16-bit or PSD 32-bit is selected you will see a checkbox appear in the Layers and Passes section to Add to PSD.

Note
The KeyShot output formats have various bit depths.

Integer output formats:
- PNG
- JPEG
- TIFF
- PSD
- PSD 16-bit

Floating point formats:
- EXR (16-bit half-precision)
- TIFF 32-bit
- PSD 32-bit

Include Alpha (transparency)
If the selected format supports transparency you can choose to include it in your image.

Metadata
When this option is enabled a file will be output with your still image. Metadata provides useful reference information including: scene name, Camera name and properties, Environment name and properties, active Model Sets, active Studio, Lighting settings, material names and Render Quality settings.

Click 📜 to select the format of the metadata:
- .xmp - This file can be read by any text editor and can also be imported to Adobe applications.
- Simple (.meta) - This file is formatted for easier reading.

Resolution
Set the resolution of the render. Type it in or select from the presets.

Print Size
If final output is for print quality, enter in the dimensions of the print size as well as the desired DPI. After size has been set, the resolution will update with the correct dimensions.

Layers and Passes
See the Layers and Passes page.

Region
See the Render Region page.
Animation Output

Output Options

Resolution
Set the resolution for the animation being rendered. Choose from the Preset drop-down, or enter in your own custom dimensions.

Time Range
Specify the range of the animation to be rendered. Default is “Entire Duration.” You can also set the designated work area to be rendered, as well a specific frame range. The “duration” and “frames” auto updates when time range is changed.

Video Output
Enable to output a video of the animation. Set the name and Folder location where the animation will be saved. Choose a file format in the drop-down.

Frame Output
Enable to output every frame used to create the animation. Set the file name and folder where the frames will be saved. The “%d” in the name-input adds a sequenced postfix to the frame name. In order to modify the postfix change the “%d” to i.e. “%04d” if you want the frames to have the format frame.0001.png.
Layers and Passes
See Layers and Passes section.

Region
See the Region Rendering page.
KeyShotXR Output

The KeyShotXR output option is available if the KeyShotWeb Add-on is installed. It provides setup and output of a KeyShotXR as well as options for render layers and render passes.

Learn more about KeyShot XR.

Most of the parameters set in the KeyShotXR Wizard can be edited in the KeyShotXR Render Output options. Additionally, there are other options for file format, file size, and iBooks output for viewing on iOS devices. There are also Advanced options for KeyShotXR control, customization and direct upload to a website via FTP.

Output Options

Name
Give the KeyShotXR a name. The frames will be located in a folder with the same name.

Folder
Set a destination folder the XR files will be added along side with a new folder containing all image files etc.

Viewing Resolution
Set the resolution

Format
Choose JPEG or PNG for the frames. Check Alpha if you want transparency on .png images.

File Size
Selecting the “Preview” button will render one frame from the KeyShotXR and has a compression slider that allows adjustments to the quality of the image, and updates in real-time. Be aware that a larger file size could increase the time to load the KeyShotXR in the browser.

Create iBooks Widget
If this is enabled, a HTML5 widget will be output in the same folder as your KeyShotXR which can be embedded in an iBook using iBooks Author.

KeyShotXR Control

Rotation Control

Environment
This option will set the center of rotation at the center of the scene.

Object
Select an object in the scene as a center of rotation.
Camera
Use the current camera settings to use as your rotation center.

Look At
Use your current “Look At” as your rotation center.

Custom
This option allows you to select the center of rotation from your scene tree items.

Horizontal Environment Rotation
Enable this option to have the environment rotate with the KeyShotXR.

Smoothness Control

Animation Frames
If animation is applied to the scene, you will be able to create a KeyShotXR from this animation. Additional parameters will be shown if enabled. See previous page for animation frames settings.

Horizontal Frames
This controls the number of frames in the “X” direction. The higher the number of frames, the more smoothly your model will rotate.

Vertical Frames
This controls the number of frames in the “Y” direction. The higher the number of frames the more smoothly your model will rotate.

Number of Images to be Rendered
This shows the number of images to render based on the number of horizontal and vertical frames.

Horizontal/Vertical Angle Increments
This shows the degrees between each frame. This value will change depending on the number of vertical and horizontal frames and the starting and ending angles.

Angle Control
This is equal to the custom setting of the KeyShotXR Mode in the wizard and controls possible viewing angles of KeyShotXR. If you want to use presets such as Turntable, Spherical, Hemispherical or Tumble use the wizard.

Horizontal
This controls the beginning and end of the rotation on the “X” plane.

Vertical
This controls the beginning and end of the rotation on the “Y” plane.

Advanced
Advanced settings for KeyShotXR are located in a drop-down menu on the same window as the custom settings. This menu controls how your KeyShotXR interacts in the web browser.
Rotation Damping
Increasing this value will reduce the time it takes a model to come to a rest after rotating it.

Mouse Sensitivity
This controls the overall mouse sensitivity in the KeyShot XR. Increasing this value will increase the model movement with less mouse movement.

Zoom-In
Enabling zoom-in will allow you to zoom into the KeyShot XR when inside the browser. Use the "Maximum Allowed Zoom-In Percent" slider to control the amount the user can zoom in your KeyShot XR.
Note: To ensure the browser page will scroll when the mouse scroll wheel is used while over the KeyShot XR, this option will need to be disabled.

Preserve Image Quality
Enable this option to render the frames at larger resolution for optimal image quality when zooming in. The image quality will be preserved when zooming in by enlarging the rendered frame resolution accordingly. This is separate from the viewport resolution setting for each frame. This will also increase the KeyShot XR file size.

Download on interaction
Enabling this option will set the KeyShot XR to only load the images into the browser after the user interacts with the KeyShot XR.

Allow Fullscreen Mode By Double-Click
Double-clicking the left mouse button will enter full-screen mode.

Show Loading Icon
Enabling this will allow the loading icon to be shown when the KeyShot XR is loading in the browser. This image can be changed by selecting "Browse" and browsing to the image file you prefer.

Name of Div
This defines the KeyShot XR section in the HTML code.

FTP Deployment
Enable this option to allow KeyShot to load the rendered KeyShot XR directly into your FTP address.

Confirm Before Deployment
When the KeyShot XR is finished rendering, you will be prompted to accept the deployment to the FTP site.

Generate Embeddable HTML Code
This will give you the code necessary for implementing your KeyShot XR in a website using the iframe tag.

Embed FTP Settings in BIP File
This will save all the FTP credentials inside your KeyShot BIP file for easy deployment by another user.

Layers and Passes
See Layers and Passes section.
Configurator Output

The Configurator option in the Render dialog offers following output options, based on the configuration set up with the Configurator Wizard:

- **Images**: Render a series of still images and their accompanying metadata of optional Model, Material, and Studio Variations that were setup via the Configurator Wizard.
- **Web Configurator**: If you have the KeyShotWeb add-on you will also be able to output for the web. Either in the form of a webpage or an iBook widget. The webpage/iBook widget will have the same UI as Presentation mode/KeyShot Viewer in terms of selecting model, material and studio - but it will not offer camera movement, as it is based on still images.

**Images**

**Include**
This option allows you to specify which variations are included in the Configurator output.

**Images**
This value will display the total number of images to be output determined by the included variations. The value will update dynamically as the Include check-boxes are marked and unmarked.

**Name**
Set the file name of the render in the text field. If one is not entered, the default name will be the scene name. It is important to keep the "%d" as this will add incremental post-fixes to each variation.

**Folder**
Choose where the render will be saved. Unless a specific folder is chosen, it will be saved in your default rendering-folder.

**Format**
Choose from JPG, TIF, EXR, TIF 32 Bit, PNG, PSD, and PSD 32 bit. All formats other than JPG can include an alpha channel.

**Resolution**
Set the resolution of the render. Type it in or select from the presets.

**Print Size**
If final output is for print quality, enter in the dimensions of the print size as well as the desired DPI. After size has been set, the resolution will update with the correct dimensions.

**Web Configurations**

**Create iBooks Widget**
When enabled KeyShot will output both the webpage and a create an iBook widget that you can use for iPhone/iPad in an iBook.

**Update layout and thumbnails of existing Web Configurator**
If you have already rendered a configuration once, and only made a few tweaks to the layout itself or the thumbnails, there is no need to re-render everything. Simply enable Update layout and thumbnails of existing Web Configurator, point to the folder containing the web configuration and press Update Web Configurator. KeyShot will update .css/.js files or the iBook widget, depending on which configuration you have chosen to update.

**Note**
The Update option will not detect changes to Materials, Model Sets or the choices within the configurator. If you have made changes to any of
Images
This value will display the total number of images the configurator needs to work.

Name
Set the file name of the Configurator in the text field. This will be used for both images (incl. a suffix), and the folder containing all the files. If you have selected to also output the iBooks Widget this will be created in its own folder, which will have .wdgt added to the name.

Folder
Choose where a folder containing all images and files for either the webpage or the iBook will be saved. Unless a specific folder is chosen, it will be created in your default rendering-folder.

Format
Choose from JPEG, TIF, EXR, TIF 32 Bit, PNG, PSD, and PSD 32 bit. All formats other than JPEG can include an alpha channel.

Resolution
Set the resolution of the render. Type it in or select from the presets.

Layers and Passes
See the Layers and Passes page.

Region
See the Region Rendering page.
Layers and Passes

KeyShot supports output of render layers and render passes. Render layers output specific parts and models assigned to layers, while a render pass outputs a specific attribute of the scene on its own layer. For example, a Lighting pass will output all the lighting on a single layer while a Shadow pass will output all the shadows on a single layer.

Output of layers and passes is used to separate out all the various aspects of the scene to provide more control in post processing operations. For example, you may want to adjust the intensity of light, shadows or a materials color. Having any of these on a separate layer gives you this control.

An image like the example below can be decomposed in individual render layers and render passes.

The model in this scene was created by dk and sourced from GrabCAD

Render Layer Output

This option is only available if you have assigned parts and models to a render layer. Select All Render Layers checkbox to enable layer ouput. Select the gear icon to show the Render Layer Settings dialog and select the Alpha (Transparency) Mode for the layers.
Alpha Modes

The Render Layer alpha modes include:

- **Straight Alpha - Unmatted** - (Default) This alpha mode extends the color at the edges of Render Layers to the semitransparent pixels of anti-aliased edges. This avoids any black fringing when compositing the Render Layers in post-processing. This alpha type is the default, as it provides the best results in most situations.

- **Premultiplied Alpha - Matted with Black** - This alpha mode premultiplies the Render Layer image by blending or matting any semi-transparent pixels, due to anti-aliasing, with black. This can cause black fringing when compositing the Render Layers, if the image editing application does not support specifying the black matting color and adjusting for it. In Photoshop, the issue can be remedied by trying one of the matting options, found under Image > Matting.

- **Aliased - Opaque Fringe** - This alpha mode extends the color at the edges of Render Layers and creates fully opaque (aliased) edges. This avoids any transparent gaps between adjoining Render Layers when compositing the Render Layers in post-processing. Due to the negative visual consequences of aliased edges, this mode should only be used if gaps between Render Layers are a dealbreaker. Rendering at higher resolutions will make the aliasing less noticeable though.

The example below shows the Still Image rendering of two interlocking rings.

The outer (blue) and inner (white) rings were put on two separate Render Layers.

The examples below show the result for the different Alpha Modes when compositing the Render Layers on a solid green background color. Click the images to enlarge.
With "Straight Alpha - Unmatted" enabled, the Render Layer edges don't show fringing (black matting), and the green background color bleeds through the anti-aliased gap between the two Render Layers.

With "Premultiplied Alpha - Matted with Black" enabled, the Render Layer edges show black fringing, and the green background color bleeds through the anti-aliased gap between the two Render Layers.

With "Aliased - Opaque Fringe" enabled, the Render Layer edges show opaque and aliased fringing, and there is no gap between adjoining Render Layers, so that the green background color does not bleed through.

**Note**
Enabling the render layers option will render all render layers created. To create a render layer go to the Project window, Scene tab. Go Properties, Render Layer to create a render layer. Select a part or group of parts and select the render layer you would like it to be on.

**Render Layer example**

The examples below show the different render layers of above scene.
Render Pass Output

Select All Render Passes checkbox or the checkbox next to the individual pass type to enable pass output. Doing so will render the selected pass(es), along with the original image format specified on the output tab. Select the PSD or PSD 32-bit option from the Format drop-down menu to enable the Add to PSD checkbox. This will compile all your passes into a single PSD file.

Note

Render Passes are always saved as separate EXR files. This is done to allow maximum flexibility and quality in post-processing. Most modern image editing and compositing applications can work with EXR files.

Please note that when rendering to PSD (not 32-bit) with "Add to PSD" enabled, all Render Passes are embedded in a 8-bit PSD file. As a consequence, some information will be lost. If maximum flexibility is desired, PSD 32-bit should be used instead.

KeyShot supports 12 types of render pass output, including:

Diffuse Pass

The Diffuse pass creates an image containing the diffuse color of all materials in the scene, including Labels.
**Lighting Pass**

The Lighting pass creates an image containing only the direct component of the lighting in the scene. Furthermore, this pass is multiplied by the materials’ diffuse color.

**Global Illumination Pass**
The Global Illumination pass creates an image containing only the indirect component of the lighting in the scene. Furthermore, this pass is multiplied by the materials’ diffuse color.

**Note:**
When Global Illumination is disabled in the Lighting tab, the Global Illumination pass will result in a completely black image.

---

**Caustics Pass**

The Caustics pass creates an image containing the lighting from caustics in the scene.

**Note**
When Caustics is disabled in the Lighting tab, the Caustics pass will result in a completely black image.

---

**Raw Pass**
The Raw pass creates an image without any Image Styles applied. It is output in the .exr format.

**Reflection Pass**

The Reflection pass creates an image containing the reflections of all reflective materials in the scene.

**Note**
The Reflection pass does not include the specular reflections of Light Source materials.

**Refraction Pass**

The Refraction pass creates an image containing the refractions of all refractive materials in the scene.
**Shadow Pass**

The Shadow pass creates an image containing shadows from all light sources in the scene, both HDRI lighting and physical lights (light source materials).

**Ambient Occlusion Pass**

The Ambient Occlusion pass creates an image where unoccluded surfaces are colored white, and occluded surfaces black. This pass can be used in compositing to accentuate crevices and internal model edges.
Clown Pass

The Clown Pass creates an image where each material is displayed as a flat color for easy selection and masking in an image editor or compositor. When the Clown Pass is enabled you have the option to "Separate Labels in Clown Pass" which can be accessed from the icon.

Color differentiation follows these rules:

- Pure primary rgb colors are assigned first, then secondary colors, then tertiary.
- The colors are only distributed among objects that are set to show in the currently active Model Set(s).
- This means that the less materials that are active the better the clown results will be.

Clown Pass with "Separate Labels in Clown Pass" disabled (default)

Clown Pass with "Separate Labels in Clown Pass" enabled
**Depth Pass**

The Depth pass creates a depth map, which is an image that contains information relating to the distance of surfaces to the camera. Depth maps are used in other applications like Adobe Photoshop and Adobe After effects to simulate effects like depth of field.

**Tip**

Since each pixel in the Depth pass represents an actual distance from the camera to the model surface, this pass might display with unexpected results in an image editor. Typically, the Depth pass will show as completely white. To reveal a greyscale image in Photoshop you can perform the following steps: Image > Adjustments > HDR Toning > Method: Equalize Histogram.

*Depth Pass as displayed in an image editor (preview completely white)*
**Normals Pass**

The Normals pass creates an image where each pixel represents the geometry's orientation, using the surface normals in the scene. By default, the normals are generated in world space (relative to the scene). When the Normals Pass is enabled you have the option to enable "Camera Space Normals" which can be accessed from the icon.

A Normals pass can be helpful for quick relighting in post without having to rerender the scene.

**Tip**
A Normals pass with "Camera Space Normals" can directly be used as a normal map for bump on materials.
Labels Pass

When this is enabled all Labels will be output on a single image with alpha.

Tip
A Clown pass with "Separate Labels in Clown Pass" enabled can be used to select or mask the individual Labels.
Compositing examples with Render Passes

Render Passes can be used in various ways during post-processing. Below are two basic examples of compositing workflows with Render Passes, using Photoshop to explain the concepts.

**Note**

Some discrepancies may exist between the rendered still image and a composite using Render Passes. Furthermore, Render Passes do not capture some of the more complex material effects like translucency (Translucent material).

Reconstruct Beauty image from Passes

Passes can be used to reconstruct the rendered still image, commonly called the "beauty pass" in compositing workflows. Adding together the Lighting, Global Illumination, Caustics, Reflection and Refractive Passes allow to achieve the beauty image.

In Photoshop, adding is done by setting each pass layer's blending mode to "Linear Dodge (Add)".

Adjust Beauty image with Passes

The same passes from the workflow above can also be used to strengthen or weaken their effect on the beauty image.

In Photoshop, strengthening the effect of a pass is done by setting the pass layer's blending mode to "Linear Dodge (Add)"). Weakening the effect is done by setting the blending mode to "Subtract". In both cases, the beauty image should be the base layer, positioned below the passes.

The example below shows the effect of adding the Reflection pass to the beauty image.
The example below shows the effect of subtracting the Global Illumination pass from the beauty image.
### Formats for Render Layers and Passes

Below is an overview of the image formats of Render Layers and Passes for the different output formats.

<table>
<thead>
<tr>
<th>Output Format</th>
<th>Render Layer Format</th>
<th>Render Pass Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>PNG</td>
<td>PNG</td>
<td>EXR</td>
</tr>
<tr>
<td>JPEG</td>
<td>PNG</td>
<td>EXR</td>
</tr>
<tr>
<td>EXR</td>
<td>EXR</td>
<td>EXR</td>
</tr>
<tr>
<td>TIFF</td>
<td>TIFF 32-bit</td>
<td>EXR</td>
</tr>
<tr>
<td>TIFF 32-bit</td>
<td>TIFF 32-bit</td>
<td>EXR</td>
</tr>
<tr>
<td>PSD</td>
<td>Last used format</td>
<td>Last used format</td>
</tr>
<tr>
<td>PSD 32-bit</td>
<td>Last used format</td>
<td>Last used format</td>
</tr>
</tbody>
</table>

#### Notes
1. The Clown Pass is always saved as a separate PNG file (except for PSD and PSD 32-bit with "Add to PSD" enabled).
2. The Depth Pass is always saved as a separate EXR file (except for PSD 32-bit with "Add to PSD" enabled).
3. When rendering to PSD with "Add to PSD" checked, all Render Layers and Passes will be embedded in the PSD file.
4. When Denoise is active the Normal and Diffuse passes are always created.
Region Rendering

When working on scenes in KeyShot with complex lighting or materials and you want to render specific areas faster, region rendering can help maintain an efficient workflow. There are two types of region rendering in KeyShot:

1. Real-time Render Region
2. Output Render Region

Both control the same region to be rendered. That is, the Real-time region will match the Output region and vice versa. You will see this best if the Real-time Resolution (set in the Project window, Image tab) is the same as the Output render Resolution (set in the Render window). If one is smaller or larger than the other, the region will adjust accordingly.

Set and adjust the region you want to render in the Real-time View. Once it's to your liking, open the Render window. The Region option will automatically be selected. Select Render to generate a full render of the region.

Real-time Render Region

To activate real-time region rendering click the Render Region icon on the Ribbon.

Select the Render Region icon on the Ribbon again to disable real-time region rendering.

Output Render Region

Region rendering is an output option on both the Still Image and Animation tabs.

To activate output region rendering check the Region checkbox in the Render window Output options.

Uncheck the Region checkbox in the Render window Output options again if you want to disable region rendering.

Render Region Setup

The smaller the region (and less complicated the materials and lighting), the faster the render will resolve. Both types of region rendering are set up in the same way. When region rendering is enabled you can control the region area size and position in two ways:

- **Real-time View**
  - Adjust region size: click and drag the corners or edge handles of the region area.
  - Move the region: click and drag inside the region to move the entire area.
- **Position Panel**
  - Adjust region size: Enter the Height and/or Width or the render region.
  - Move the region: Enter Left and/or Top (distance from the top-left corner).
  - Move the panel: click and drag the left side of the panel to re-locate it anywhere in the Real-time View.

Both can be used together as well and the camera can continue to be adjusted by clicking and dragging in the black area surrounding the render region.
Render Options

The Render Options window contains all settings for Render Mode, CPU Usage, and Render Quality. These options are specific for the Still Image, Animation and KeyShotXR output.

**Mode**

**Default**

The Default render mode simply allows you to render immediately after adjusting your render output settings or, if using KeyShot Pro, to send your render to the render queue.

**Background (PRO)**

The Background render mode option allows you to run the render in the background and continue working. Note: the Real-time View will be paused by default when the render is started. Select Render and un-check Pause Real-time Render to un-pause the Real-time View and continue working.

**Send to Network**

If you use KeyShot Network Rendering, the Send to Network render mode allows you to send your render to the KeyShot Network Rendering Monitor. Make sure the Monitor is installed and running to send a job to be rendered on the network. Visit the KeyShot Network Rendering Overview for more information.

**CPU/GPU Usage**

For Default and Background render modes, the CPU/GPU Usage setting allows you to specify how many CPU cores you want to utilize for rendering your project. Selecting Use Real-time CPU/GPU will use the CPU/GPU Usage settings defined on the KeyShot Ribbon.

**Quality**

KeyShot has three output options for quality based on your needs.

**Maximum Samples**

The Maximum Samples option controls how many times the image or animation frame will be calculated and refined. Each additional sample will further smooth out noise/grain in the image. This option uses the same rendering technique as you see when working in the Real-time View. (This technique is also used in Maximum Time option, but differs from the method used in Custom Control option.)

**Samples**

This controls how many times each pixel in the rendered image is calculated for increased accuracy. Too low of a value will result in an image that has excessive noise. Increasing samples will reduce the noise, however, increasing this setting too high will increase render times without a noticeable difference in quality.
Samples Per Frame
The Maximum Samples option will read Samples Per Frame when the Animation tab is selected under the Output section. This option is ideal for animation output as it guarantees that each frame will be rendered at the same quality. Therefore, as the animation plays through the frames you will not see changes/flickering in shadows or noise patterns on materials.

This method is typically preferred over the time-based output for animations, as some frames may require substantially more time to reach the same quality level as levels of detail and complexity change through the course of your animation. Using the time-based output will lead to more noise in the more complicated frames.

Samples and Resolution
A sample calculates the color of a pixel. There is a point of diminishing returns where you increase samples past the point of added quality, and just increase the render time.

Something important to be aware of is that as you increase the resolution of your image or animation, each pixel covers relatively less area of the image. This means you can use a lower samples setting when rendering at higher resolutions. Note that this does not apply to rendering with area lights, caustics or interior mode as increasing samples while using those features will still increase the quality.

Maximum Time
The Maximum Time option for render quality will progressively refine the render for the amount of time set. This option uses the same rendering technique as what you see in the Real-time View. This technique is also used in Maximum Samples option, but differs from the method used in Custom Control option.

When rendering an animation, you may set the maximum time for each frame to render, or set a total duration for the entire animation.

How many samples should I use?
Generally speaking, a simple scene will require fewer samples and a scene with more complex lighting and materials will require more samples. Start low and increase the samples if you still see noise or the render looks grainy. Before rendering out an animation using Maximum Samples, test your samples with a still image render first.

You can also set a Render Region on the Real-time View, focusing on the area, you think will require the most samples to look satisfactory. Turn on the Heads-Up Display (H hotkey) and let the Real-time View sit until the region looks that way you like it. Make a note of the number of samples from the HUD and use that info when setting the Max Samples.
**Custom Control**

The *Custom Control* option allows control over all quality settings available in KeyShot. This mode typically produces smoother results in areas of high noise or shadow.

The example below shows a Custom Control rendering with a blue plastic material. Custom Control can be a good option for efficiently rendering noise-free images of scenes with diffuse materials like plastics.

---

The model in this scene was created by *dk* and downloaded from GrabCAD

**Samples**

This will control the amount of rays per pixel that will be sent into the environment to gather information to determine that pixel’s final shade. It is best to control this setting per material and set a value between 8 and 16 in the render settings.
For information on samples and setting samples per material, please see the section on roughness and glossy samples.

**Ray Bounces**
Ray bounces are the number of times rays of light are calculated as they bounce around a scene. Ray bounces are initially set in the Lighting tab and any values entered there will be inherited by the Render Dialog. The value set in the Render Dialog is not however inherited by the lighting tab. this way you can adjust the amount of ray bounces for the specific rendering without affecting the general setting.

Learn more about Ray Bounces on the Custom Lighting Presets page.

**Anti Aliasing**
Anti aliasing is a method for smoothing out jagged edges that are created by pixels. Since pixels are made up of squares, they can produce a jagged look where edges meet. Anti aliasing smooths out these edges. In most cases, the default value of 1 is sufficient.

Increasing the anti aliasing quality can help to avoid artifacts that may occur when rendering with alpha (transparency) with objects having a very similar color to the background. For illustration, a synthetic example will be used.

The example below shows the Still Image rendering of a Flat material sphere with a Color Gradient texture whose color matches the background on one side.

The examples below show composites of the transparent rendering on a solid black background color for an Anti Aliasing quality of 1 and 5. Click the images to enlarge.
When the Anti Aliasing value is 1 the blue side of the sphere shows artifacts. These artifacts are absent when an Anti Aliasing quality of 5 is used.

### Shadow Quality
Shadow quality will control the shadow quality for ground and object shadows. Note that increasing Shadow Quality dramatically increases render time. This setting will have most effect for bright diffuse materials, like for example white plastics.
Global Illumination Quality
This will control the quality of all indirect light. Increasing this value can dramatically increase render time. It is rarely necessary to set a value above the default value of 1. If Global Illumination is turned off, this parameter will be grayed out. Global Illumination is enabled/disabled in the Lighting tap of the Project panel.

Pixel Blur
This will apply a slight blur to the image to reduce the overly sharp look that computer-generated images can have. Higher values will have more blur. This does not increase render time. It is advised to leave this setting at the default value of 1.5. Higher values will cause low resolution images to look overly blurry, but can be used for high resolution renderings. A value of 1 disables pixel blurring.
DOF (Depth of Field)
This will control the quality of depth of field if it is enabled in the camera tab. Increasing this value will have an effect on render time. For production quality a value between 3 – 5 is recommended. If Depth of Field is not activated, this parameter will be grayed out. Please see the section on cameras for more information on depth of field.

Caustics
Increasing this value will improve the samples and quality of the caustics. If caustics are not enabled, this parameter will be grayed out. You can enable caustics in the Lighting tab of the Project Panel. The maximum value that can be entered is 50. Increasing the value will increase memory consumption, and high values will require a lot of system memory.
Please see the Refractive Index page for more information about caustics.

The examples below show the effect of increasing the Caustics quality for a scene with a Solid Glass material, lit by a Spotlight.
Sharp Shadows
This will allow sharp shadows to be cast across 3D geometry when the lighting scenario would create a sharp shadow. It is more accurate to have this checked and it is enabled by default. It is generally recommended to leave this on.
**Sharper Texture Filtering**
This will attempt to preserve detail in textures when viewed at grazing angles. For example, imagine being eye level with a wood table and seeing the wood grain compress together. Detail can get lost in the compressed areas. This setting reduces the loss of detail. This feature can increase render time so enable only when using textures with glancing angles.

**Global Illumination Cache**
Disabling Global Illumination Cache replaces the potential dirty shadows and black spots with noise. These artifacts can appear when the scene has transparent materials with diffuse surfaces behind them. Increasing Global Illumination Quality will reduce the noise. Increasing the Samples will also help in reducing the noise.

The examples below show the effect of toggling Global Illumination Cache for a scene with a *Cloudy Plastic* material.

**Note**
Because the Custom Control uses a different noise pattern, denoising will not have the same impact on your image as you experience in the Real-time view.

**Limitation**
Disabling Sharp Shadows for Custom Control also disables Global Illumination for rendering.
Render Queue

The Render Queue is used for batch processing your still image, animation, KeyShotXR, and Configurator rendering jobs.

The Queue displays the job type, name, format, resolution, and frame count. You can hover over a job to see a larger thumbnail preview, when the job was added, the render mode and number of samples.

Add/Delete Job

Use these buttons to add and remove jobs from the queue list. Jobs are added with the current settings specified in Output and Options. Each job can have unique settings.

Send to Network
If you have KeyShot Network Rendering installed, the option to Send to Network will become available. Select/highlight one or more jobs in the Queue and click the Send to Network button.

**Add ... to Queue**

**Add Cameras**
Send saved Cameras to the Render Queue. This button is active if more than one Camera exists. Click the Add Cameras button to open the Camera Queue window and check the Cameras you want to add to the queue.

**Add Model Sets**
Send saved Model Sets to the Render Queue. This button is active if more than one Model Set exists. Click the Add Model Sets button to open the Model Sets Queue window and check the Model Sets you want to add to the queue.

**Add Studios**
Send saved Studios to the Render Queue. This button is active if more than one Studio exists. Click the Add Studios button to open the Studios Queue window and check the Studios you want to add to the queue.

**Add Multi-Material**
Send all sub-materials of a selected Multi-Material to the Render Queue. This button is active if one or more Multi-materials exist in a scene. Click the Add Multi-Material button to open the Multi-Material Queue window and select which variant of each Multi-Material you want to add to the Queue.
**Move Up/Down**

You can select a job in the list and click **Move Up** or **Move Down** to change the order of the job in the list. Jobs at the top render first. You can use the check box next to the job to turn off that job. The job will then be skipped during processing of the queue.

**Process Queue**

When you are ready to start the queue, click the **Process Queue** button. All jobs with a blue check-mark will be processed. You can enable/disable a multi-selection of jobs via the right-click menu.
Render Output Window (image editor)

The Render Output window shows the progress of the rendering based on the Render settings selected. This window also provides options for applying image adjustments while the image is being rendered that can be saved out when the render is complete.

Close
While the rendering is still in progress you can abort by clicking the red x this will give you the option to save the rendering at the current state or discard the image. When the rendering is finished the image is automatically saved in the selected location. Click the green check-mark to close the render output window.

Pause/resume Rendering
Click to temporarily stop the rendering. Resume by clicking .

Save image to file
Select the Save icon to save the current render as it appears in the Render Output window.

Hide/Show Image Styles Panel
Toggles the Image Styles panel. Here existing Image Style may be applied or new Image Styles created. Refer to Image Styles for more on how to create and apply image adjustments.

Note:
CAUTION: all unsaved adjustments made in the adjustments panel will be lost. Be sure to save your render after making adjustments before closing the render output window.

Zoom to fit
Fits the Image to the size of the view-port.

Zoom to 100%
Zooms the image to its full size regardless of the size of the view-port.

Zoom slider
When the view-port is smaller than the full size of the image, the slider allows incremental zooming the image between fitting the view-port and full size.
KeyShot 9 introduces the ability to harness the full GPU-accelerated ray tracing power of NVIDIA RTX with OptiX. Available for both real-time rendering and local render output, KeyShot’s GPU Mode allows GPU resources to be accessed with one-click to take advantage of multi-GPU performance scaling and the dedicated ray tracing acceleration hardware in NVIDIA RTX-capable GPUs. You may toggle between GPU and CPU as needed. GPU raytracing in KeyShot 9 supports the NVIDIA Maxwell microarchitecture found in GTX 980 and above.

**Requirements**

GPU raytracing in KeyShot 9 supports NVIDIA GPUs built on Maxwell microarchitecture and supports CUDA Compute Capability 5.0 or later, found in NVIDIA GTX 980 and above.

We recommend:

- Graphics cards on the NVIDIA RTX platform with a minimum of 8 GB memory.
- Driver version 436.xx. We do not recommend driver Version 440.xx and 441.xx as there are known issues in KeyShot with those drivers.
Driver version
If the driver version for your graphic card is not up to date the GPU icon in the Ribbon will be disabled. You may find the latest NVIDIA drivers [here].

Known issue
Some drivers of older Nvidia GPUs can be upgraded so the GPU toggle is enabled, without KeyShot actually being able to run in GPU mode on the graphics card. In these cases, KeyShot will stay in CPU mode. The GPUs affected are in the Nvidia 600, 700 and 800 series.

Using GPU Mode

Real-time View
To use GPU mode in the KeyShot Real-time View, select GPU mode on the Ribbon or Render, GPU mode from the Main Menu.

When GPU mode is active the CPU Usage drop-down in the Ribbon will be replaced with a GPU usage drop-down, listing the available GPUs. Here you can limit which GPUs are allocated for KeyShot. You can also limit the GPU usage under Render, GPU Usage from the Main Menu. Here the option is available even when GPU mode is not active, enabling you to set a limit before you enter GPU Mode.

In the Heads Up Display you can observe the GPU rendering speed with Samples per second, as well as the Memory Usage. If the GPU runs out of memory, KeyShot will revert to CPU rendering.

Render Output
Rendering in GPU mode is available for Default and Background render modes. If KeyShot is in GPU mode, the CPU usage drop-down in Render Dialog, Options will be replaced with a GPU Usage drop-down.

Network rendering is currently only available for CPU rendering.

Note
When Denoise is enabled, what you see in the Real-time View and the result of the rendering, may have slight variations. What causes the difference? When rendering images, the normal and diffuse maps are evaluated to produce the best possible result. These are not included in the real-time denoiser, which uses the fastest version of the denoiser under the given circumstances.

Limitations
The output of GPU mode matches what you get with traditional CPU rendering in KeyShot, with only a few limitations.

- Cutaway material: The cutaway material is not supported in GPU mode and objects with this material will be ignored.
- NURBS: NURBS-only objects will be ignored in GPU mode. Objects that have both triangles and NURBS data, will be shown as triangles.
- Legacy textures: All Legacy textures (from KeyShot 6 or earlier), except Texture maps, are not supported. They will be ignored in GPU mode.
- Curve geometry: GPU mode has limited support for Curve geometry, e.g. curves imported from Alembic, Max, C4D or Maya. Curve geometry that is not fully supported will either be ignored or appear wrong.
- **ZSpheres**: GPU Mode does not support ZSphere geometry (from ZBrush).

  If you run into one of these limitations, a warning icon 🚧 will appear in the top right corner of the *Real-time View*. Click the icon for more information about what parts of the scene are impacted and by what.
Scripting

Scripting allows you to unleash the power of KeyShot for automation, batch processing and more.

Scripting is available via the Ribbon or from the Main Menu, Window, Scripting Console.

The Scripting Console enables you to load scripts or input one-line commands inside the python interpreter, located at the bottom of the Console tab. You can also use KeyShot's predefined scripts or create your own custom scripts inside the Scripts tab.

Scripting Console

KeyShot scripting uses Python 3.7.4.

Scripting functionality includes:

- Opening, saving and importing files
- Camera control - Add, get, list, manipulate and save camera...
- Lighting presets - Get, Set...
- Materials - Get, set, delete...
  - Load/import from .mtl
- Multi-materials - Get, set, create and manipulate...
- Environment - List, set and manipulate...
- Geometry - Move, scale, duplicate, show/hide, lock/unlock...
- Model Set - Create, get, set, remove...
- Studios - List, get, set...
- Image styles - List, get, set and manipulate (high level only)
- Rendering - Manipulate render settings, add render passes and add jobs
  - Animation
  - Configurations
  - Frames
  - Image
  - Multi-Material
  - XR

View the full list of commands here, or visit the quick start guide.

Scripts

The Scripts tab offer a number of scripting examples that you can run on your scene.

On this page

- Scripting Console
- Scripts
  - Script location
  - Creating a Script
  - Import/Edit a script

Also see:

- Scripting Examples
Script location

Scripts are located in the KeyShot Resource folder, e.g. `\KeyShot 9\Scripts`. To change this location or add another location, select Edit, Preferences, Folders and change the path for the Scripts folder. Scripts in the folder will be visible in the Scripts tab of the Scripting window.

Creating a Script

To create a script, select Create from the Scripts tab. Provide a name for the script and the author.

If Python 3.7 (64 bit) is installed locally on the machine, KeyShot will detect Python and all installed modules (e.g. NumPy, SciPy, PIL, etc.) which then can be freely used for scripting in KeyShot (this can be disabled in the General Preferences).

Vector and matrix classes are made available in the luxmath module to help with doing calculations. They are named luxmath.Vector and luxmath.Matrix respectively.

Import/Edit a script

You may also import a script or edit an existing script using the corresponding buttons on the Scripts tab.
Scripting Examples

In this page you will find KeyShot's predefined scripts and instructions on how to use them. These scripts are listed under the Scripts tab inside the Scripting window.

Create Standard Views

Creates seven standard view cameras: front, back, top, bottom, left, right, and isometric.

How to use:

- Select script and press Run. You will receive confirmation message: Successful!
- Click OK.
- You will find the seven standard views under Project > Camera.

Learn more on KeyShot Support FAQ

Encode Video

Encodes video using an image sequence over a specific range of frames.

How to use:

- Select script and press Run. The user prompt appears.
Click the browse button and select a folder with the image frames.
For frame format, copy the name of the file, replacing the frame number with %d, e.g. my_new_animation.%d.jpg.
Enter the start frame – the number in the name of the first image, e.g. 1 on my_new_animation.0001.jpg.
Enter the end frame – the number in the name of the last image, e.g. 60 on my_new_animation.0060.jpg.
Enter FPS for the video.
Enter the video name.
Click OK to begin the process.

Learn More on KeyShot Support FAQ

Random Scattering
Duplicates and random scatters the selected model.

How to use:
- Select script and press Run. The user prompt appears.
- Select which model to duplicate & scatter
- Select number of duplicates
- Check axes to scatter along
- Check if the object is to be rotated as well
- Click OK to begin the process.

Render Ambient Occlusion
Renders an ambient occlusion pass of your scene.

How to use:
- Select script and press Run. The user prompt appears.
- Click the browse button and if you wish to change your output folder.
- Set the output image name.
- Set the output width and height.
- Set the render time. The default value is 20 seconds. Increase the render time better quality.
- Add to queue should be enabled if you wish to add your job to the local render queue. Otherwise your job will be rendered according to your render mode options: default, background, or network.
- Decide if you wish to process your local queue after adding the job. If you disabled the “Add to queue” checkbox, then this box should also be disabled.
- Click OK to begin the process.

Learn more on KeyShot Support FAQ

Render Animation Passes
Renders your animation frames with the option to output “ambient occlusion” and/or “toon outline shading” passes. Please note that in order to run this script, you must first apply animations1 to your scene.

How to use:
Render Images

Imports all CAD files within a folder and renders them one at a time. This script can be used to render an animation from an obj file sequence. Once your images are rendered, you may stitch them up and compile the video with the Encode Video script above.

How to use:

- Select script and press Run. The user prompt appears.
- Click the browse button and select the folder with the geometry (.obj) sequence.
- For input, type the extension of the geometry without the dot (obj).
- For output, type the extension of the image format without the dot (png).
- Input the width and height of the output images in pixels.
- If you created a material template for automatic material assignment, then select your template. Otherwise, use "None".
- Click OK to begin the process.

Learn more on KeyShot Support FAQ

Render Panoramic Frames

Renders a series of frames that can be used to create a panoramic view of the product (that is, 360 degrees along the vertical axis Y). Once your images are rendered, you may stitch them up and compile the video with the Encode Video script above.

How to use:

- Select script and press Run. The user prompt appears.
- Select which camera you’d like to use. The center of the camera will be the pivot of rotation.
- Set the number of frames to render. The default number of frames is 50. Since the camera rotates a full 360 degrees, this comes out to about 7 degrees per frame (360 / 50).
- Set the output file format. KeyShot uses %d to keep track of the frame number and you should leave this symbol in the name (e.g. my_new_animation.%d.jpg).
- Click the browse button and if you wish to change your output folder.
- Set the output width and height.
- Add to queue should be enabled if you wish to add your job to the local render queue. Otherwise your job will be rendered according to your render mode options: default, background, or network.
- Click OK to begin the process.

Learn more on KeyShot Support FAQ
• Decide if you wish to process your local queue after adding the job. If you disabled the "Add to queue" checkbox, then this box should also be disabled.
• Choose the direction of rotation: clockwise (checkbox ON) or counterclockwise (checkbox OFF).
• Click OK to begin the process.

Learn more on KeyShot Support FAQ

* Animation is only available in KeyShot Pro edition.
Animation

KeyShot Animation allows you to animate your Models, Materials and/or Cameras in no time.

To translate a part across the scene, simply right-click the part in the Scene Tree, select Animation > Translation, and tweak the animation settings. Similarly, to animate a camera: right click a camera in the Scene Tree or the Camera List, select your animation type, and make the desired changes. You may also launch the Animation Wizard (Animation > Animation Wizard) and follow the prompts.

Animation of materials can be added via the Material Graph's Animation Nodes.

Timeline

Animations in KeyShot are represented by rectangular nodes in the animation timeline. Each node has a start time (left side), an end time (right side) and a duration (the rectangle's length). You may move them around, scale them, stack them, or line them up in sequence to achieve different effects. You can also sort the animation nodes by right-clicking in the list and selecting Sort by and select to sort by: time, type or name.
Animation Types

Types

- **Part Animations**: Part animations affect your model’s position, orientation, and visibility in the scene. See Part animation types here.
- **Material Animations**: Material Animations enables you to create animations of a material’s value based or color properties. See Material animation types here.
- **Camera Animations**: With camera animations you can animate as well as switch between cameras. See the Camera animation types here.

Timeline appearance

Each animation type will appear with a color in the Animation timeline.

- Part animation are green.
- Material animations are red.
- Camera animations and switch events are blue.

You can add folders to structure your animations, these are yellow in the timeline.

Furthermore you can import models that contain animations such as Keyframe animations and Deformable meshes. These will appear as purple and orange nodes.

Time Settings

Common for the animation types (except Curve Fade animations*) are the Time Settings, where you can control the timing and duration of your animation.
Motion Ease
Select if you want the add motion ease to the animation - see the Motion Ease types.

Start
Set the start time for the animation

End
Set the end time for the animation

Duration
The duration will automatically be calculated from the Start and End time. Alternatively you can enter the Duration and Start time - This will automatically fill the End time.

*Curve Fade animations have the easing "built in" to the type itself. Learn more on the Animation Node Types page.
Part Animations

Part animations affect your model's position, orientation, and visibility in the scene. They allow you to translate, rotate, and fade all while maintaining your model's hierarchy. Thus, animations applied to your model's top assembly will also affect all parts under that assembly.

Adding a Part animation

To add a part animation right-click the part or group you want to animate, select Animation and the desired animation type. Or use the Animation Wizard to help you set up the animation.

The part animation is represented as an green node in the timeline.

Adjust the properties for your animation and you good to go. See the Animation Timeline page for more information about the options in the timeline.

Part Animation Types

Translation

A Translation is an animation in which a model or any one of its parts moves along the X, Y, and Z axis and changes position.

Translate X, Y, Z
Controls movement along the X / Y / Z axis.

Axis Orientation
When you apply a rotation to your model, you must choose the rotation axis: X, Y, or Z axis. However, these axes have two states: Original Local and Global.

- Original Local - The Original Local state uses the rotating part's local axis. If Y pointed up originally, rotating the part over 45 degrees
means that the Y axis is now also tilted 45 degrees. Use this axis state your model's axis orientation is not square (slightly tilted) with KeyShot's global axis. To reveal the global axis, press the "Z" key on your keyboard.

- **Global** - This is KeyShot's global axis. To reveal the global axis, press the "Z" key on your keyboard. Y axis always points up. Even if you have rotated a part using your modeling software.

### Rotation

A Rotation is an animation in which a model or any one of its parts rotates around its own or some other part's pivot point.

### Rotation Degrees

Controls the angle of rotation in degrees.

### Axis

Determines the reference axis of rotation. There are three mutually-exclusive options: X, Y, or Z.

### Axis Orientation

When you apply a rotation to your model, you must choose the rotation axis: X, Y, or Z axis. However, these axes have two states: Original Local and Global.

- **Original Local** - The Original Local state uses the rotating part's local axis. If Y pointed up originally, rotating the part over 45 degrees means that the Y axis is now also tilted 45 degrees. Use this axis state your model's axis orientation is not square (slightly tilted) with KeyShot's global axis. To reveal the global axis, press the "Z" key on your keyboard.

- **Global** - This is KeyShot's global axis. To reveal the global axis, press the "Z" key on your keyboard. Y axis always points up. Even if you have rotated a part using your modeling software.

### Pivot Point

A pivot point is the point around which a part/model will rotate. When you apply a rotation animation, the pivot point is set to "Self" by default. To select a different pivot point from the scene tree or in your scene, click the `Pick` button.

### Center and Origin

By default, the pivot point is always at the center of the model. Change this to `Origin` if your wish to use the model's origin instead. For example, it is possible that a cube's origin lies at one of its eight vertices.
Dynamic Pivot Points
This setting will allow the rotating part or model to follow a moving helper object. Dynamic pivot points should also be enabled when there are two or more rotations (each with different helper objects) applied to the same part or model.

Note that not all moving helper objects are dynamic pivot points. For example, let's say that you wish to animate a part orbiting around a helper object while the second is moving. In this case, enabling dynamic pivot point will not provide you with the desired result. Instead, make sure that the orbiting object is a child under the helper object in your scene tree hierarchy.

Tip
When dealing with complex animations consisting of multiple pivot points, we recommend a top-down hierarchy structure in your scene tree. Click here for a full article on how to animate hinges and multiple pivot points.

Fade
The Fade animation provides a smooth transition between two opacity values.

Fade From
This is your model's starting opacity level. Accepted values are between 0% and 100%, where 0% means that the model is invisible and 100% means that the model is entirely visible.

Fade To
This is your model's opacity level by the end of the animation. Accepted values are between 0% and 100%, where 0% means that the model is invisible and 100% means that the model is entirely visible.

Note
Fade animations are not supported with the Cutaway material.

Turntable (only model/group)
When you are adding an animation to a model/group you can also select a Turntable animation. This is similar to the Rotation animation but is limited to rotations around the up-axis.

Center of Rotation
Choose if you want your model/group to rotate around the center of the model/group or the center of the environment.

Direction
Set the rotation to go either Clockwise or Counter Clockwise.
Material Animations

Material Animations enables you to create animations of a material's value based or color properties.

Adding a Material Animation

The Material animations can currently only be added through the Material Graph.

1. Right click the material you want to animate either in the Real-time View or in the In-Project Library and select Edit Material Graph.
2. Inside the Material Graph go to Nodes > Animation and select the type of animation you want to add.

This will add a folder (yellow node) in the timeline which contains all animations of the material. The Material animation nodes are represented as red nodes in the timeline.

Material Animation Types

Color Fade

Provides a smooth transitions between two or more color values. You can apply a Color Fade to your material's diffuse, specular, and opacity map. You may also apply a Color Fade to any material value like roughness, refraction index, power, contour width, etc.

Learn about the Color Fade Node.

Curve Fade

The Curve Fade animation provides custom transitions between numerical values. You can apply a Curve Fade to your material's diffuse, specular, and opacity map. You may also apply a Curve Fade to any material value like roughness, refraction index, power, contour width, etc.

Learn about the Curve Fade Node.
**Note**
The material animation is tied to the material and thus will apply to all parts with the affected material. If you only want to affect the material of a specific part, you have to un-link it.

Unlike the other animation types the material animations will not be listed in the scene tree under any group or part. Rather, the material animation "lives" inside the Material Graph.
Camera Animations

With camera animations you can animate camera movement, rotation, focal length etc. as well as switch from one camera to another.

The instructions below assume that you’ve already created the cameras in your scene and set their targets.

Add Camera Animation

You can add Camera animations as follows:

- **Scene Tree:** Right-click your camera in the scene tree (Project > Scene) and select the desired animation type.
- **Camera List:** Right-click your camera in the list and select the desired animation type.
- **Animation Wizard:** Learn more about the Animation Wizard.

The camera animations will be represented blue node on the timeline and switch events with a blue dot.

Adjust the properties for your animation and you good to go. See the Animation Timeline page for more information about the options in the timeline.

Camera Animation Types

**Orbit**

A camera Orbit rotates the camera around its target.

**Properties**

**Degrees**

Control your orbit span in degrees.
Panorama
The camera Panorama rotates the camera around its own axis to simulate a full panoramic view. You may use this type of animation for showing a car interior or an architectural interior.

Properties
Degrees
Control your Panorama span in degrees.

Inclination
The camera Inclination rotates the camera up and down around its target.

Properties
Degrees
Control your inclination span in degrees.
Dolly

While the Zoom animation changes the focal length of the camera to achieve its effect, the Dolly animation physically moves the camera closer to the subject. Use this camera animation when you want to dynamically change your camera location. The instructions below assume that you've already created a camera in your scene and set its target.

Properties

Dolly
Control your Dolly distance. The Distance slider is calibrated to your scene units.

Translation
Camera Translation allows the camera to move on the X, Y and Z axes.

**Properties**

**Translate X, Y, Z**
Controls movement along the X / Y / Z axis.

**Axis Orientation**
When you apply a rotation to your model, you must choose the rotation axis: X, Y, or Z axis. However, these axes have two states: *Original Local* and *Global*.

- **Original Local** - The Original Local state uses the rotating part's local axis. If Y pointed up originally, rotating the part over 45 degrees means that the Y axis is now also tilted 45 degrees. Use this axis state your model's axis orientation is not square (slightly tilted) with KeyShot's global axis. To reveal the global axis, press the "Z" key on your keyboard.

- **Global** - This is KeyShot's global axis. To reveal the global axis, press the "Z" key on your keyboard. Y axis always points up. Even if you have rotated a part using your modeling software.

**Path**

Camera path animation creates a path through which the camera can travel. This is useful for walkthroughs, or for more dynamic camera movements.

**Camera Path**

Here you compose the path you want the camera to follow, by adding control points. The first control point is the current camera position.

**Walkthrough**
In walkthrough mode the control point will dictate both position and target of the camera.

**Target**
In target mode the camera will always point to the selected target and the control points will only dictate the position of the camera. Target mode is especially powerful with an animated target.

**Add new Control Point**
Adjust your camera and click *Add new Control point* - Repeat till you have all the points of the path.

**Closed Path**
When enabled the first and last control points will be connected and create closed loop.
Properties

Control Point list
Lists all the Control Points in the path, the order they are listed is also the order of the path. Right click to rename.

- Add a new control point
- Change order of the selected control point.
- Move control point - this will launch the geometry view, where the selected control point can be adjusted with the move tool.
- Remove Control Point

Tension
This enables you to adjust the sharpness of the path. Increasing the value will sharpen the change in direction at the control points while negative values will produce a smoother path.

Depth of Field

The camera Depth of Field animation animates your camera’s focus point. Before you can add this type of animation to a camera, you need to enable Depth of Field under the camera’s settings.

Properties

Start/End Focus distance
Set the distance from the camera to where the image is the sharpest.

Start/End F-stop
Adjusts the virtual aperture of the camera. This determines the extent of the area that is "in focus".
**Zoom**

The camera Zoom changes the camera's focal length. If your camera is set to Perspective the focal length will also control the amount of distortion (convergence) seen in the Real-time View. Read about Focal Length in the Camera, Perspective section.

**Properties**

**Start/End Focal Length**
Adjust the Zoom by setting the start and end focal lengths.

---

**Switch**

The camera Switch animation is an instant change between the current camera view and another camera in the scene.

**Properties**

**From Camera**
This will be fixed to the camera to which you added the switch event.

**To Camera**
Select which camera you want to switch to.
Animation Wizard

The Animation Wizard is the easiest way to create animations step-by-step. You start out by choosing an animation type and the wizard walks you through very step in the animation setup. The instructions below assume that your KeyShot version includes animation.

For more information about each animation type, see the Animation Types section.

How to launch the Animation Wizard

1. Click the Animation button in the Toolbar.
2. Click the Animation Wizard button in the animation timeline.

Setting up the animation

The Animation wizard has 3 steps regardless of what type of animation you want to add.

1. Select the type of animation
2. select what you want to animate
3. adjust the settings of the animation. See the Animation Types section for detailed descriptions of each type.
Once you have set up the animation it will appear in the timeline. If you want to adjust any of the settings you chose in the wizard, simply click the animation node in the timeline and the properties will be available for editing.

See the Animation Timeline page for more information about the options in the timeline.

Currently, the Animation Wizard does not include Material Animations.

1
Working with Animations

Animations are represented with nodes in the timeline and labeled according to the name set in the animation properties. When an animation node is clicked in the timeline, the properties will be displayed.

Animations can be shifted in time and scaled interactively to control timing and duration.

Groups of animations can be consolidated in a single folder for organization. These folders can also be scaled and shifted to control timing and duration.

Timeline

You can grab and drag the Current time indicator back/forward to the place in the animation you wish to see.

With the 2 left/right facing triangle handles you can limit the Work Area (the time span you want to animate), the Start/End time of the Work Area can also be set by right-clicking in the timeline ruler.

Managing Animations

Animation management utilities can be found by right-clicking on animations in the animation list. To change the animation order or to move an animation into an existing folder, click and drag the animation. To multi-select animations, hold CTRL (PC) or Command (Mac) while selecting multiple nodes.

Add Folder
Right-click on a blank area in the animation list to display this option.

Duplicate
To duplicate an animation or animations, right-click on the animation(s) you would like to copy and select Duplicate.

Mirror
Right-click on the animation(s) you would like to have a reverse duplicate animation of. This is useful for exploded view animations and for situations where you need to have the animation end where it began, such as for a looping video.
Lock/unlock
This will lock/unlock the current animation node, this means that the animation is still visible but can not be edited. Locked nodes appear with a color a shade lighter that the unlocked nodes.

Hide/show
Deactivates/activates the current node. This is the same as toggling the checkbox in front of the node name.

Hide and lock
Deactivates and locks the current node

Show only
Deactivates all other camera or part animations.

Rename
This will let you rename the current node, without going through the properties.

Sort By
This will let you sort your animation list by; Name, Type or Start Time. If you change the order by drag and drop, the sorting will revert to None.

Delete
Select this option to delete one or more animations from the timeline.

Animation Properties
Selecting an animation will display its properties on the right side of the Animation window. These settings are the same used when creating an animation via the Animation Wizard. You may change all existing animation settings as well as the name of the animation in the animation properties. See the Animation Types for detailed descriptions.

If the Animation window is docked, or if you are using the window with a short window, you can collapse sections of the properties to see the parameters that are most useful to you at that time.
Deformation Animations

A model deformation is any change in the model's shape: twists, expansions, contractions, and character rigging.

These types of animations required advanced techniques available in CAD packages such as Maya and 3DS Max. While KeyShot does not offer a "deformation" animation, it does still support deformations set up in CAD and exported to an Alembic (.ABC) file.

**How to import your deformation animations from an Alembic file:**

1. Click the Import button (or File > Import) in KeyShot.
2. Browse to your Alembic (.ABC) file and click Open.
3. From the KeyShot Import dialogue > Animation enable Deformable Meshes and confirm your Import.
4. Click Play in the animation timeline to play a preview in real-time. You may also click and drag the time scrubber in the timeline.

The file will import and appear as an animation node on the Animation Timeline where it may be positioned and re-sized.
Animation Effects

Animation Effects add realism to your animations. These effects include:

- Motion Blur
- Motion Ease
Motion Blur

KeyShot “Motion Blur” provides a real-time preview of motion applied to the scene where movement is blurred. Capture the motion of objects or cameras as they rotate or move across the screen before you even play an animation or render an image.

To apply “Motion Blur” to objects in motion, check “Motion Blur” button on the Animation window tool bar. Click the arrow to toggle the motion blur to Model/Part or Camera animation. If you already have objects or cameras with animations applied to them, the real time view will update to show the objects in motion.

“Motion Blur” can be seen quickly after turning the option on by adding a “Translation” animation to an object or an “Orbit” animation to a camera. The amount of motion blur is controlled through the “Animation” settings by adjusting how fast and how far an object or camera is moving. When “Motion Blur” is enabled, the real time preview of the motion is dependent on the FPS setting.
Motion Ease

Motion easing will create a more natural look when applied to rotations, translations and camera animations. This will add acceleration and deceleration to motion.

For example, if a car goes from one stop sign to another and reaches a maximum speed of the 35 miles per hour, it is not traveling that speed for the entire time. The car has to start moving, accelerate to its top speed and then slow down as it approaches the next stop sign. Without motion easing, the car would start and stop abruptly and travel 35 miles per hour the entire time it is in motion.

Presets

Linear

Ease In

Ease Out

Ease in/Ease Out
Custom Easing Curves

With custom easing you have full control of the easing curve. When you select the Custom easing curve the default will be a linear progression from start to end. Select one of the square handles and drag to change the easing.

Each keyframe determines the interval from the keyframe till the following keyframe. By default all keyframes will be curve points when you add them, but you can easily change the type:

Types of keyframes

- **Stepped:**
  - This will keep a fixed value until the next keyframe in the timeline is reached.
  - The stepped keyframe will by default not have a tangent handle opposite the stepped section, but you can add it via the Tangent handle icon. This way you can ease into/out from a stepped value.
  - Use the value at the start of the interval.
  - Use the value at the end of the interval.

- **Curve:**
  - Curve keyframes have tangent handles that can be manipulated to make the transition ease in/out.
  - Lets you enable/disable the left/right tangent handles
  - Keep tangent handles locked opposite to each other.
  - Unlock tangent handles.

- **Straight:**
  - This is a variant of the curve point, where both tangent handles have been disabled by default. Simply click the tangent handle icons to make it a regular curve point.

Customizing the easing curve.
Adding a keyframe: Double click in the grid or right click and select Add Key to add a keyframe.

Setting the value: Select a keyframe on the curve and add the time and the value of it below the grid or simply drag it in the curve editor. Hold Shift to restrict to horizontal movement (adjusting time only).

Adjusting the curve: Drag the tangent handles to adjust the ease-in/out of a key. Hold Shift to restrict to horizontal movement.

Deleting a keyframe: Select a keyframe and press the Delete key or right click the keyframe and select Delete.

Time indicator and work area: The curve editor has the same Time and Work Area indicators as the regular Animation timeline, enabling you to scrub through the timeline and limit the animation from the curve editor.

Move the Grid: Click and drag inside the grid to move the timeline.

Zoom in the grid: Click in the grid and use the scroll wheel or Ctrl +/- (Win) Cmd +/- (Mac) to zoom in/out.

Zoom to fit: You can fit the current curve in the curve editor simply by clicking the Zoom to Fit button above the grid.

Copy curves

You can copy custom curves from one animation to another. Simply right click anywhere in the curve editor, and select Copy Curve. Then right click the Curve editor of the “destination” animation and select Paste Curve. Note that this may impact the length of the second animation.
KeyShotWeb

KeyShotWeb is an add-on that allows you to create interactive, web-based content for use online, or in PowerPoint, Keynote and iBooks. The add-on may be purchased here.

KeyShotWeb is comprised of KeyShotXR and KeyShot Web Configurator. All content created using KeyShotWeb can be viewed on any touch-enabled devices or display, interacted with using your mouse or finger and does not require a browser plugin to work.

KeyShotXR

KeyShotXR gives you the ability to turn a KeyShot scene into an interactive 360° visual. With KeyShotXR, you can create and present high-quality, touch-enabled, 3D content for any web browser or presentation software.

KeyShot Web Configurator

KeyShot Web Configurator allows you to turn a Configurator created with KeyShot Pro into an interactive product configurator. Like KeyShotXR, a Web Configurator produces high-quality, touch-enabled, 3D content for use in any web browser or presentation software. KeyShot Pro is required to create the initial Configurator of your product. In KeyShot Pro, the Configurator is created based on a selection of Pro-level features, like Studios, Model Sets, and Multi-Materials. The Configurator can also be viewed in Presentation Mode and using the free KeyShot Viewer.

Embedding

When you render your KeyshotXR or Web Configurator it will create a folder containing all the necessary files and images needed. The output can be stored and shared on a local intranet, zipped and shared securely, or hosted online to embed on a website or in presentation software. A webserver to host the files will be needed to view and/or embed the files. Other options include the ability to create an iBook widget (.wdgt) which you can use in iBooks for iOS.
KeyShotXR

KeyShotXR gives you the ability to turn your 3D renderings into interactive visuals. With KeyShotXR, you can create and present high-quality, touch-enabled, 3D content in any web browser. The content can be viewed using touch-enabled devices (or mouse) and does not require a browser plugin to work.

KeyShotXR is part of the KeyShotWeb add-on, which can be purchased here

How is KeyShotXR different from other 360° viewers?

KeyShotXR goes beyond the standard 360° turntable viewing capability of other viewers. With KeyShotXR you can:

- Create turntable, spherical, hemispherical, tumble and animated interactive visuals.
- Use the camera as a pivot point to create a first person point-of-view or panoramic shot
- Ensure your visuals provide high-quality, scientifically accurate material and lighting representation
- Have full control over your visual with advanced features and customization
- Export direct to Apple iBooks for use on both iPad Retina and iPad Mini

Learn more and see examples here.
KeyShotXR Wizard

Create a KeyShotXR using the KeyShotXR Wizard. The KeyShotXR Wizard is accessed by pressing the KeyShotXR button on the KeyShot Toolbar, through the main menu by selecting Window, KeyShotXR..., or by hitting the X-key.

Pick KeyShotXR Mode

There are six KeyShotXR modes to choose from. When you select one of the six modes, you will see an animated preview of the KeyShotXR view rotation. After choosing a mode, click Next.

Turntable
Creates a standard turntable view to rotate a model up to 360 degrees.

Spherical
Creates a fully-spherical view to see all sides of the model.

Hemispherical
Create a half spherical view to rotate around only a portion of the model.

Tumble
Create a view that rotates around the model center.

Custom
This will enable you to set up a custom viewing angle, you will find the settings in one of the following steps.

Animation
If an animation is present, you will be able to create a KeyShotXR based on the animation. This is different from the other options where the camera that is rotated around the model. See KeyShotXR Animation.

Pick KeyShotXR Rotation Center

Next, you will be able to select the center of rotation for your KeyShotXR. After selecting a center of rotation, click Next.

Environment
This option will set the center of rotation at the center of the scene.

Object
Select an object in the scene as a center of rotation.

**Panoramic Camera**
Use the current camera position as your rotation center. This works well with scenes showing interior.

**Camera target**
Use your current camera target as your rotation center.

**Custom**
This option allows you to select the center of rotation from your scene tree items.

**Horizontal Environment Rotation**
Enable this option to have the environment rotate with the KeyShotXR.

---

**Pick Initial KeyShotXR View**

Next, you can fine tune the initial camera view of your KeyShotXR. Set the *Distance*, *Azimuth*, *Inclination*, and *Perspective* as you would on the *Camera* tab. Use the *Grid* option to help locate or center the model for optimal rotation. You can adjust the camera using mouse, pen or touch in the Real-time View or by using the sliders.

Once finished choosing your initial camera view, click *Next*.

**Distance**
Distance between the Camera Target and Camera in scene units. Setting this value too low can lead to the camera being “inside” the 3D model. This can be controlled with the mouse scroll wheel. The direction can be inverted in Preferences.

**Azimuth**
Rotation around KeyShot up (Y) axis, measured in degrees.

**Inclination**
Defines camera tilt, or vertical rotation from horizontal plane.

**Perspective**
Controls the amount of distortion (convergence) seen in the Real-time view; real world values can be used here to replicate camera lens focal lengths.

**Grid**
This provides the option to overlay the Real-Time View with a Halves, Thirds, or Quarters grid - useful to help locate objects in the view to optimize the interaction or rotation.

**Tip**
If you have edited the camera position it is a good idea to save the camera. Otherwise, when rendering, KeyShot may ask if you want to reset to the latest saved state of the camera, which will override any fine tuning you have made in this step of the wizard.

**Set KeyShotXR Smoothness**
This step allows you to control the smoothness of your KeyShotXR. The options you see below will depend on the KeyShotXR Mode selected. You will see a preview of the KeyShotXR in the Real-time View which will give you an idea about the smoothness of the KeyShotXR with the options entered. Once the number of frames has been set, click Next.

**Smoothness Control**
These settings allow you to control the smoothness of the KeyShotXR rotation. Here, you will also find details on the number of frames that will be rendered and what the horizontal and vertical angle increments will be.

**Horizontal Frames**
Sets the number of horizontal rotation frames rendered, e.g. a value of 18 will render out 18 frames to capture the rotation.

**Vertical Frames**
Sets the number of vertical rotation frames rendered and multiplies the amount of horizontal frames rendered by the value entered, e.g. a value of 18 horizontal frames and 3 vertical frames will render out 54 frames total to capture the rotation.

This option will not be seen for Turntable KeyShotXR Mode.

**Tip**
A higher value for horizontal and/or vertical frames will increase the smoothness of the rotation on the model inside a web browser, but it will also increase the total number of frames to be rendered and may affect load times of the KeyShotXR in the browser.

**Angle Control**
If *Custom* KeyShotXR Mode is chosen, you will also see options for Angle Control. Angle Control allows you to enter beginning and end angles for both the horizontal and vertical rotation.

**Horizontal Angle Begin**
Start angle for the horizontal movement. Default is -180 degrees.

**Horizontal Angle End**
Finish angle for the horizontal movement. Default is 180 degrees.

**Vertical Angle Begin**
Start angle for the vertical movement. Default is -90 degrees.

**Vertical Angle End**
Finish angle for the vertical movement. Default is 90 degrees.

**Set KeyShotXR Output**
In the final step, you configure the KeyShotXR output as well as the viewing resolution for the KeyShotXR.

**KeyShotXR Output**

**Name**
Choose a name for your KeyShotXR.

**Folder**
Choose the location of where it will be saved on your computer.

**Viewing resolution**

**Width/Height**
Set the resolution of your KeyShotXR or choose a preset from the pull down.
Presets
Provides a set of present resolutions based on the resolution of the Real-time View (set in the Project, Image tab).

Tip
Keep in mind that, when creating content for online use, size does matter. Make sure that your viewing resolution is only as big as needed. Larger images will impact performance without adding to the experience.

Loading icon
Each KeyShotXR has a default image for the loading icon. To change the icon, click Browse and select an image file to replace the default image. Maximum image size is 80px x 80px.

Time to Render!
After you've gone through each step, you have three options to continue:

1. Select Back to change any of the settings in the previous steps.
2. Select Render Now to start rendering the KeyShotXR.
3. Select Render Options to open the Render window to adjust additional KeyShotXR Output options.

How do I access other KeyShotXR options?
Selecting Render Options when you are done in the KeyShotXR Wizard will open the KeyShot Render window, KeyShotXR Output with more options for the KeyShotXR. Additional options include the ability to create an iBooks widget, adjust damping control and mouse sensitivity, along with deploying directly to FTP and/or generating Layer or Render Passes.
KeyShotXR Animation

If an animation is applied in the scene, the Animation option will be shown as an available KeyShotXR mode. Any animation type can be included as a KeyShotXR. Select Animation in the KeyShotXR Wizard.

Frames
Use the slider or input field to set the number of frames to render in the KeyShotXR.

Time Range
Select if you want to use the entire animation for your KeyShotXR or if you want to limit it to the current Work area selected in the Animation timeline.

Resulting FPS
This determines the overall smoothness of the KeyShotXR when it is used in a browser. Increasing the Frames slider increases the frame rate. A higher value will give a smoother transition, but be aware that internet speeds can also affect frame rate.

Loop Animation
This option will provide an infinite looping for the KeyShotXR Animation. Additional options can be accessed by selecting Render Options on the final step of the KeyShotXR Wizard.
KeyShotXR Variables

Below is a list of KeyShotXR variables. These variables are set in the .html file created by KeyShot when the KeyShotXR is rendered. These variables can be edited after the KeyShotXR is created if minor edits are needed, rather than recreating the KeyShotXR over again. The .html file can be edited using a standard text editor.

Variable Location

All KeyShot variables are located in the KeyShotXR .html file <head> section, within a <script> tag, and are called by the initKeyShotXR() function.

<table>
<thead>
<tr>
<th>Variable Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;head&gt;</td>
</tr>
<tr>
<td>&lt;script type=&quot;text/javascript&quot;&gt;</td>
</tr>
<tr>
<td>var keyshotXR;</td>
</tr>
<tr>
<td>function initKeyShotXR() {</td>
</tr>
<tr>
<td>var nameOfDiv = &quot;KeyShotXR&quot;;</td>
</tr>
<tr>
<td>// Other variables follow here..</td>
</tr>
<tr>
<td>keyshotXR = new keyshotXR(nameOfDiv, /* The other variables ... */);</td>
</tr>
<tr>
<td>}</td>
</tr>
<tr>
<td>window.onload = initKeyShotXR;</td>
</tr>
<tr>
<td>&lt;/script&gt;</td>
</tr>
<tr>
<td>&lt;/head&gt;</td>
</tr>
</tbody>
</table>

nameOfDiv

The div id of the KeyShotXR. This is where the KeyShotXR content is located. 

On this page

- Variable Location
- nameOfDiv
- Variables
- General Settings
  - Folder Name - folderName
  - Download only on click - downloadOnInteraction
  - Image type - imageExtension
  - Background color - backgroundColor
- Frame number
  - Horizontal - uCount
  - Vertical - vCount
- Start Frame
  - Horizontal - uStartIndex
  - Vertical - vStartIndex
- ViewPort Size
  - Width - viewPortWidth
  - Height - viewPortHeight
- Rotation settings
  - Continuous horizontal rotation - uWrap
  - Continuous vertical rotation - vWrap
  - Rotation damping - rotationDamping
- Mouse Sensitivity
  - Horizontal - uMouseSensitivity
  - Vertical - vMouseSensitivity
- Zoom levels
  - Minimum - minZoom
  - Maximum - maxZoom
- Loading icon
  - Show loading icon - showLoading
  - Set loading icon - loadingIcon
- Screen size
  - Automatic resizing (responsive size) - downScaleToBrowser
  - Allow full screen - allowFullScreen
- Move Direction
  - Reverse horizontal direction - uReverse
  - Reverse vertical direction - vReverse
- Deprecated variables
  - addDownScaleGUIButton
Variables

General Settings

Folder Name - `folderName`

The name of the folder that contains all the files for the KeyShotXR. This is set under `Render, Output` options in the `KeyShotXR` tab, `Name` entry.

```
var folderName = "material_ball_XR.10";
```

Download only on click - `downloadOnInteraction`

This variable allows a KeyShotXR only to be loaded after it has been clicked. This option is set in the KeyShotXR settings, under `Render, Output` options in the `KeyShotXR` tab, under `Advanced`.

```
var downloadOnInteraction = false;
```

Image type - `imageExtension`

This variable is the image extension for the frames generated for the KeyShotXR. Only one extension type may be used. This is set in the KeyShotXR settings, under `Render, Output` options in the `KeyShotXR` tab, under `KeyShotXR Control, Format`.
Background color - backgroundColor

The background color of the .html page in hexadecimal notation. This will be the color behind/surrounding the KeyShotXR. The default is white (#FFFFFF). This option can only be set from in the .html file.

Usage Example:

```javascript
var backgroundColor = "#FFFFFF";
```

Frame number

Horizontal - uCount

This is the number of horizontal frames in the KeyShotXR. This is set under Render, Output options in the KeyShotXR tab, under KeyShotXR Control, Smoothness Control.

Usage Example:

```javascript
var uCount = 18;
```

Vertical - vCount

This is the number of vertical frames in the KeyShotXR. This is set under Render, Output options in the KeyShotXR tab, under KeyShotXR Control, Smoothness Control.

Usage Example:

```javascript
var vCount = 18;
```
Start Frame

Horizontal - uStartIndex

This controls the horizontal start frame for the KeyShotXR. This is set by viewing angle in the KeyShotXR settings, under Render, Output options in the KeyShotXR tab, under KeyShotXR Control, Angle Control.

Usage Example:

```javascript
var uStartIndex = 1;
```

Vertical - vStartIndex

This controls the vertical start frame for the KeyShotXR. This is set by viewing angle in the KeyShotXR settings, under Render, Output options in the KeyShotXR tab, under KeyShotXR Control, Angle Control.

Usage Example:

```javascript
var vStartIndex = 0;
```

ViewPort Size

Width - viewPortWidth

The width of the KeyShotXR in pixels. This is set under Render, Output options in the KeyShotXR tab, Viewing Resolution, first text field entry.

Usage Example:

```javascript
var viewPortWidth = 640;
```

Height - viewPortHeight

The height of the KeyShotXR in pixels. This is set under Render, Output options in the KeyShotXR tab, Viewing Resolution, second text field entry.
Rotation settings

Continuous horizontal rotation - \textit{uWrap}
This allows the KeyShotXR to continue rotation after last frame in the horizontal direction when set to \textit{true}.

\begin{verbatim}
Usage Example:

var uWrap = true;
\end{verbatim}

Continuous vertical rotation - \textit{vWrap}
This allows the KeyShotXR to continue rotation after last frame in the vertical direction when set to \textit{true}.

\begin{verbatim}
Usage Example:

var vWrap = true;
\end{verbatim}

Rotation damping - \textit{rotationDamping}
This controls the speed at which the rotation slows down when a KeyShotXR is rotated. Increasing this value will increase the duration of rotation before coming to a stop. This is set in the KeyShotXR settings, under \textit{Render, Output} options in the \textit{KeyShotXR tab, under Advanced}.

\begin{verbatim}
Usage Example:

var rotationDamping = 0.96;
\end{verbatim}

Mouse Sensitivity
Horizontal - \textit{uMouseSensitivity}

This controls the horizontal mouse/touch sensitivity for the KeyShotXR. Changing the value to/from a negative value will change the direction of the KeyShotXR rotation. This is set under \textit{Render, Output} options in the \textit{KeyShotXR} tab, under \textit{Advanced}.

\begin{verbatim}
Usage Example:

var uMouseSensitivity = -0.0055;
\end{verbatim}

Vertical - \textit{vMouseSensitivity}

This controls the vertical mouse/touch sensitivity for the KeyShotXR. Changing the value to/from a negative value will change the direction of the KeyShotXR rotation. This is set under \textit{Render, Output} options in the \textit{KeyShotXR} tab, under \textit{Advanced}.

\begin{verbatim}
Usage Example:

var vMouseSensitivity = 1;
\end{verbatim}

Zoom levels

Minimum - \textit{minZoom}

This controls the minimum zoom level for the KeyShotXR. Setting to a negative value will allow Zoom out capability. Increasing the value above 1 will change the zoom level of the KeyShotXR when loaded. This is set in the KeyShotXR settings, under \textit{Render, Output} options in the \textit{KeyShotXR} tab, under \textit{Advanced} by checking the Zoom-In checkbox.

\begin{verbatim}
Usage Example:

var minZoom = 1;
\end{verbatim}

Note

KeyShot automatically calculates the resolution when rendering the KeyShotXR based on this setting when 'Preserve image quality' option is enabled. If changed afterward, grainy images may be experienced.

Maximum - \textit{maxZoom}
This controls the maximum zoom level for the KeyShotXR. Increasing this number, increases the amount a KeyShotXR can be zoomed in. This is set in the KeyShotXR settings, under Render, Output options in the KeyShotXR tab, under Advanced by checking the Zoom-In checkbox.

```
var maxZoom = 1;
```

**Note**
KeyShot automatically calculates the resolution when rendering the KeyShotXR based on this setting when 'Preserve image quality' option is enabled. If changed afterward, grainy images may be experienced.

### Loading icon

**Show loading icon - showLoading**

If this variable is set to `true`, the loading icon will be shown. If set to `false`, it will not be shown. This option is set in the KeyShotXR settings, under Render, Output options in the KeyShotXR tab, under Advanced by selecting the Show Loading Screen option.

```
var showLoading = true;
```

**Set loading icon - loadingIcon**

This allows a different loading icon to be used. The variable is the filename of the icon located in the KeyShotXR files folder. This option is set in the KeyShotXR settings, under Render, Output options in the KeyShotXR tab, under Advanced by selecting the Default loading icon.

```
var loadingIcon = "ks_logo.png";
```

### Screen size

**Automatic resizing (responsive size) - downScaleToBrowser**
This variable controls the automatic resizing of a KeyShotXR when a browser is resized; it allows a KeyShotXR to be responsive. This is set to true by default and can only be changed in the `.html` file.

```javascript
var downScaleToBrowser = true;
```

**Allow full screen - allowFullscreen**

This variable allows a KeyShotXR to be viewed fullscreen when it is double-clicked in desktop browsers. This option is set in the KeyShotXR settings, under *Render, Output* options in the *KeyShotXR* tab, under *Advanced*, by selecting *Allow Fullscreen Mode by Double-Click*.

```javascript
var allowFullscreen = true;
```

**Move Direction**

**Reverse horizontal direction - uReverse**

This variable will reverse the horizontal direction of rotation when set to `true`.

```javascript
var uReverse = false;
```

**Reverse vertical direction - vReverse**

This variable will reverse the vertical direction of rotation when set to `true`.

```javascript
var vReverse = false;
```
Deprecated variables

addDownScaleGUIButton

With KeyShot 6 this option has been deprecated. The option is still available for legacy KeyShotXRs that require this from in the .html file.

Usage Example:

```javascript
var addDownScaleGUIButton = false;
```
Web Configurator

If you are a KeyShot Pro user, you have the option to set up a configurator of your product. Here you can enable your users to configure the product, based on a selection of Model Sets and Multi-Materials, and make it available via KeyShot Viewer.

With KeyShotWeb you can also make your configuration available in a web browser.

The Web Configurator consists of still images of each configuration. It will have the same UI as Presentation mode/KeyShot Viewer in terms of selecting the model variations etc. but it will not offer camera movement.

Rendering a Configurator for the web

1. Set up the Configurator options as described in the Configurator Wizard page
2. Launch the Render Dialog. You can find the Render dialog in the Toolbar, via the hotkey CTRL+P (Windows) or CMD+P (MacOS) or via the Main Menu > Render > Render…
3. Select the Configurator tab.
4. Select the Web Configuration in Output Type.
5. Give your Configurator a name, select destination folder and choose format and size.
6. Render…

When the rendering is finished you will find a folder containing all the images and files needed to publish the configurator in a browser. Just open the .html file in the folder and you can start configuring the scene.

iBooks widget

You can also select to create an iBooks widget along with the web files. Just enable Create iBooks widget before rendering. The iBooks widget file (.wdgt) will be placed next to the folder containing all the files for the Web Configurator. See how you can embed the widget in an iBook here.

Updating an existing Web Configurator

If you have already rendered a Web Configuration once, and only made a few tweaks to the layout, the way the Model Sets/Materials are combined or to the thumbnails, there is no need to re-render everything. Simply enable Update layout and thumbnails of existing Web Configurator, point to the folder containing the web configuration and press Update Web Configurator. KeyShot will update .css/.js files or the iBook widget, depending on which configuration you have chosen to update.

Note

Updating a web configuration will not detect changes to material parameters, geometry. If you have altered anything related to materials or geometry, you need to re-render the Web Configuration.
Embedding KeyShotWeb output

There are several places you can embed your KeyShotXR or Web configurator. This section will provide the instructions for embedding within following media.

- Embed in an iBook
- Embed in a Presentation
- Embed in Wordpress
Embed in an iBook

The following instructions describe the process for creating and embedding a KeyShotXR or Web Configurator in an iBook using iBooks Author.

Prerequisites

You will need the following to embed in an iBook:

- iBooks Author
- An iBooks widget made from your KeyShotXR or Web Configurator.

Creating an iBooks Widget

KeyShotXR

To create an iBooks Widget of your KeyShotXR, follow the process below:

1. Open the Render dialogue by selecting Render from the Toolbar or use Ctrl-P (Windows)/Cmd-P (Mac).
2. Select the KeyShotXR tab in the Output section.
3. Enable Create iBooks Widget.
4. Render
5. A .wdgt file will be created next to the folder location of the XR files

Web Configurator

To create an iBooks Widget of your Web Configurator, follow the process below:

1. Open the Render dialogue by selecting Render from the Toolbar or use Ctrl-P (Windows)/Cmd-P (Mac).
2. Select the Configurator tab in the Output section.
3. Enable Create iBooks Widget.
4. Render
5. A .wdgt file will be created next to the folder location of the Web Configurator files
Embedding an iBook Widget (.wdgt) into iBooks

To use the iBooks Widget, follow the process below:

1. Open iBooks Author and create a new book or open an existing book.
2. Locate the iBook Widget you created and drag it to the book, or select Insert, Widget, HTML from the iBooks Author menu.

Your widget will be added to the page. You can verify with the widget inspector by selecting View, Show Inspector, selecting Widget Inspector and choosing the widget.

Viewing an iBook

Viewing the iBook can be done by selecting Preview while an iOS device is connected to the computer. The iBook can also be published to Apple Books.
Embed in a Presentation

If you want to add your KeyShotXR or Web Configuration in a presentation (Powerpoint/KeyNote) you have to install a plugin to achieve it. There are a number of plugins out there - The one we have tried is LiveSlide, which is a free plugin that works with both PowerPoint and Keynote.

**Windows (Powerpoint)**

Works with
- Windows XP or later
- PowerPoint on Office 2007 Service Pack 3 or later

Add slide
1. Download and install the Live Slides Plugin
2. Launch PowerPoint - in the ribbon you will now find a Live Slides tab
3. Click Live Slide in the insert section
4. LiveSlide will add a placeholder slide where the KeyShotXR/Configuration will be displayed when the presentation is launched.

**Mac (PowerPoint/KeyNote)**

Works with
- OS X Yosemite or later
- PowerPoint on Office 2011 for Mac or later
- Keynote 5.3 or later

Add Slide
1. Download and install the Live Slides Plugin
2. Launch PowerPoint/KeyNote
3. Launch LiveSlide.app and enter the link to the webpage
4. LiveSlide will add a placeholder slide where the KeyShotXR/Configurator will be displayed when the presentation is launched.

**Test KeyShotXR**

You can find a Test KeyShotXR here [https://www.keyshot.com/vr/keyshot6/motox/motox.html](https://www.keyshot.com/vr/keyshot6/motox/motox.html).
Embed in Wordpress

After you have created the KeyShotXR, you will find the files in your KeyShot Resources folder under Animations or in the location you selected in the KeyShotXR Wizard.

Displaying the KeyShotXR on a Wordpress website, is much like displaying a KeyShotXR on any website with static pages. If you want to include the KeyShotXR or Web Configurator in your Wordpress site you can embed it using a Wordpress plugin or you can simply add it via an iframe.

Prerequisites:

Location: Before you can embed your KeyShotXR or Web Configurator into your Wordpress site, you need to make it available online. Upload the entire KeyShotXR or Web Configurator folder to your web server. (E.g. uploading my_keyshotxr folder to /srv/www/wordpress/xr/ would display the KeyShotXR at yourwebsite.com/xr/my_keyshotxr/)

Note

You will need FTP/SFTP access to your webserver or request your site admin to upload for you.

Embed a KeyShotXR

When you render your KeyShotXR the folder will also include instructions.html. Here you can find a section of code which almost can be copied directly into the Wordpress editor on the page/post you want to embed it into. All you need to edit is the src url so it points to the location on the web server

- Upload the KeyShot XR folder to your webserver
- Copy the KeyShotXR code found in the instructions.html file
- Log into the admin panel of your Wordpress site and select/create the page/post where you want the KeyShotXR to appear.
- Ensure that you select the Text tab (not the Visual tab) on the Wordpress post/page edit screen.
- Paste the code from the instructions file into the editor.

```
<iframe src="my_keyshotxr.html"
allowfullscreen
style="position: absolute; top: 0px; left: 0px; height: 100%; width: 1px; min-width: 100%; width: 100%;"
frameborder="0"
scrolling="no">
</iframe>
```

- Make sure the src url location of the html file in the code matches the location of the upload.
- If you are uploading to a secure website with SSL, make sure to use https instead of http in the src url.

Details

The styling and div's around the iframe ensures that element works in a responsive layout. It will adapt to the width of the container, without loosing the aspect ratio.
Replace following values

- max-height/max-width: enter the size you rendered the KeyShotXR in.
- padding-bottom: the ratio between height and width in %. In this example it is 100% as the ratio is 1:1, a ratio of 16:9 would be 56.25%.
- src: enter the location of your KeyShotXR on the web server.

Examples

```html
<div style="max-width: 1000px; max-height:1000px;">
  <iframe style="position: absolute; top: 0px; left: 0px; height: 100%; width: 1px; min-width: 100%;" src="https://mywebserver.com/my_keyshotxrxr.html" frameborder="0" scrolling="no" allowfullscreen="allowfullscreen"></iframe>
</div>
```

```html
<div style="left: 0px; width: 100%; height: 0px; position: relative; padding-bottom: 100%; overflow: hidden;">    <iframe style="position: absolute; top: 0px; left: 0px; height: 100%; width: 1px; min-width: 100%; *width: 100%;" src="https://www.keyshot.com/vr/keyshot6/motox/motox.html" frameborder="0" scrolling="no" allowfullscreen="allowfullscreen"></iframe>
</div>
```

```html
<div style="position: relative; padding-bottom: 56.25%; height: 0px; overflow: hidden;">    <iframe style="position: absolute; top: 0px; left: 0px; height: 100%; width: 1px; min-width: 100%; *width: 100%;" src="https://www.keyshot.com/vr/keyshot6/ferrari/ferrari.html" frameborder="0" scrolling="no" allowfullscreen="allowfullscreen"></iframe>
</div>
```

Embed a Web Configurator

- Upload the Web Configuration folder to your web server.
- Log into the admin panel of your Wordpress site and select/create the page/post where you want the KeyhotXR to appear.
- Ensure that you select the **Text** tab (not the **Visual** tab) on the Wordpress post/page edit screen.
- Paste the code below into this area.
  - Make sure you replace the highlighted values to match your Web Configurator.
Replace following values:

max-height/max-width: enter the size you rendered the Web configurator in

src: enter the location of your Web Configurator on the web server.
Configurator

The KeyShot Configurator is a tool available in KeyShot Pro for presenting model and material variations in real-time for design reviews and interactive point-of-sale displays.

KeyShot Configurator Wizard

The Configurator Wizard can be accessed from the Ribbon. If it is not immediately visible there, right click on the ribbon and enable it. The Wizard guides you through the setup of Parent Models, Components, and their relationships. You can also define Material Variations and Material Ways to set up relationships between materials within Multi-Materials. The wizard also lets you add Studios to have preset camera angles and environments, and finally it gives you an option to customize the layout.

Configurator Output

When you have set up your configuration, you can
- View it in **Presentation mode**, inside KeyShot - Press the Presentation mode button in the Toolbar or press Shift+F to enter Presentation mode.
- Share it for viewing in **KeyShot Viewer** - Save a .ksp, either via the regular Save package in the Main Menu. Or via the Save for KeyShot Viewer, if you want to protect the file with a password or add logo/watermark. [Learn more about KeyShot Viewer.](#)
- Create a [webpage](#), which you can include on your site.¹ - Select Configurator > Web Configurations in the Render dialog
- Create an [iBook Widget](#), which can be used on iPhone/iPad.¹ - Select Configurator > Web Configurations, iBook in the Render dialog
- Render images of all possible configurations. - Select Configurator > Images in the Render dialog

¹ The webpage/iBook widget will have the same UI as Presentation mode/KeyShot Viewer in terms of selecting the model variations etc. but it will not offer camera movement.
Configurator Wizard

The Configurator Wizard enables you to set up a string of model and material choices for your product. Furthermore you can select a number of studios on which your model can be viewed.

The building blocks for the configuration is Model Sets and Multi-Materials. The Model Sets will constitute base model (Parent models) and possible product variations (Components) and the Multi-Materials will make up the Material Variations - these can be grouped in Material Sets/Material Ways which facilitates switching multiple materials in one click.

When you have finished the Configuration wizard, the configuration can be shared for KeyShot Viewer, rendered as a series of still images or set up as a web configuration.

The Configurator Wizard enables you to style the presentation for KeyShot Viewer/Web Configurations.

Overview
The first step of the Configurator Wizard is to select what you want to present - Model Variations, Material Variations, or both.

**Model Variations**
Use to set up a Configurator to display different models or combinations of models.

**Material Variations**
Use to set up a Configurator to display different materials for a single model.

**Model and Material Variations**
Use to set up a Configurator to display different model configurations and materials for any model configuration.

---

**Parent Models**

The second step is to define the *Parent Model*, which is the top-level product variation you wish to present. This is required even if you are only presenting Material Variations. If this is the case you can simply select the Default Model Set as your Parent Model.

The Configurator requires each model / model component to be in their own Model Set, in order to be able to switch between them. Parent models are the options of first choice the user will have to make in the Configurator.
Select existing Model Sets
If you already have separated Parent Models and components into Model Sets, choose the Model Sets that you want to be parent models.

Select geometry from Scene
If you have not got each of your Parent Models and Components in separate Model Sets, you can create them here by using the option to Select geometry from the scene. To do so, check the box next to the model or parts you want to define as the Parent and click the Add Model Set button above the Parent Models list. This will automatically create a Model Set in the Project window. Once one or more Parent Models have been added in the Configurator Wizard you can select in the list and click the Preview button to view and confirm in real-time.
Components

If you wish to present part or accessory variations you will need to add Component Model Sets. These will be the options in subsequent choices once the user has selected a parent model in the Configurator.

Once again you can select existing Model Sets if you have already separated them in the Scene tab or select geometry from the scene manually.

Select the Model Sets you want to use for components and proceed to the next step.

Notice that the names of the Model Sets will be exposed in the Configurator UI
Component Groups

After selecting which Model Sets are going to be components in your Configurator, you need to set up the relationships between Parents and components in Component Groups and Sub-component Groups. A Component Group or Sub Component group is a group of components that the user can choose between. Component groups are tied to the choice of a specific Parent and Sub Component Groups are tied to the choice of a specific Component.

A component can be reused in multiple component/sub-component groups, if the parent or parent component is different.
Add Component Groups
Simply click the inline link Add Component Group or Add Sub Component Group and check the respective Components in the list on the right. Repeat this until all relationships are defined. You can also select None as an option if you wish to display the Parent Model with no Component. In this example of a car with wheels it would not make sense to do so.

Remove Component Groups
To remove a component from the component group uncheck in the Components list. To remove a Component group, right-click the group and select delete. This will not affect the Model Sets, only the relationships you have set up.

Default choice
The radio buttons in front of each component determine the default option within that choice.

Order
If you want to list the options in a specific order, you can move them up/down with the buttons to the left of the tree-view.

Material Variations
In this step you can add additional materials to existing Multi-Materials or convert "simple" materials to
Multi-Materials

The list displays all the Multi-Materials in the current scene. When you select one of the Multi-Materials, the lower list (pictured in the example at the right) will display all materials it consists of.

Add to existing Multi-Materials
To add to an existing Multi-Material simply click the material in the list and drag new materials from the Library and drop them into the lower list.

Add New Multi-Materials
New Multi-Materials are added by selecting the desired material/part in the Real-time View, then dragging and dropping materials into the lower list. You will then see the material spheres populate the list to select and preview.

Once materials are in the list you can give the Material Variation a name i.e. Wheel Accent. This material will become a Multi-Material in your scene that can also be accessed and further edited from the Material tab.

Remove Material Variations
To remove variations from a Multi-Material select the Multi-material either in the list or by selecting a part (with the material) in the Real-time View. Now the bottom list shows the variations of the Multi-Material. Select the variation you want to remove and click . You can repeat this until there is only one variation left, reverting the Multi-Material to a single material.

Material Sets

With Material Sets you can group Multi-Materials that you want to be able to change concurrently with Material Ways.

Create Material Set
Click Create New Material Set and check the Multi-Materials you want to group.

Once a Material Set is in the list you can rename it. The name will be used in the Configurator UI.

You can have multiple Material Sets but a Multi-Material can only be a part of a single Material Set. Any Multi-Materials that are already a part of a Material Set will be disabled in the list.

Delete
To delete a Material Set, select it in the list and click , this will make the Multi-Materials available for re-selection.
**Material Ways**

Material Ways are the options within a Material Set. Select a Material Set in the drop-down and click *Add Material Way*. Then select the material combination you want in the current Material Way, by marking them with the blue bullet.

Make sure to give each Material Way a useful name, as they will be used in presentation mode/KeyShot Viewer.
**Studios**

Studios can be enabled in order to change preset Cameras, Environments Image Styles and prop/scene geometry created as Model Sets.

Select which Studios you want included in the presentation by checking/unchecking them or add a new studio if necessary.

If no studios are selected, the Studios tab in presentation mode will not be displayed and the presentation will use the current environment and camera position.

**Camera**

You can lock/unlock the Camera by clicking the lock icon next to the camera drop-down. If a Studio contains a locked camera, it will also be locked in presentation mode and the user will not be able to tumble/pan/dolly. In Presentation mode this is shown by a small lock icon in the top right corner.

**Model Sets and Multi-materials**
Any Model Sets/Multi-Materials that can be set as a part of the configuration will be ignored when you switch Studio in the presentation, even if they are set up to belong to a Studio. This means that only "prop" Model Sets/Multi-Materials can be displayed/hidden/changed with Studio switch.

**Thumbnails**
If the default thumbnail that is generated does not contain the elements you want displayed, you can select which Model Sets to include in the drop-down at the bottom of the page and re-render the thumbnail.

---

**Layout**
The Layout section is where you define the style of Presentation Mode for each given Configurator scene. You can choose between a Compact toolbar or Touch Friendly thumbnail interface.

When using the Touch Friendly mode you can choose between horizontal or vertical layout. Furthermore, you can set the size of the panels, and adjust thumbnail sizes.

**Preview**
This lets you view your layout choices immediately.

**Layout Style**
- Touch friendly - layout with thumbnails etc. This is the layout mode used for Web Configurations as well.
  - Horizontal - the options are displayed horizontally in the bottom of the screen
  - Vertical - the options are displayed in a vertical panel in the right side of the screen
• Compact mode - uses standard drop-downs for selecting choices/options. When this is active only a few of the following options will be visible.

**Interface and thumbnail size**

• User interface size: Select the height/width of the Configurator UI. This is set as a percentage of the window size.
• Thumbnail sizes: the thumbnail size is determined by the number of columns/rows that will fit into the UI height/width.

**Toolbar**

In this section you can select which buttons will be visible in the configurator toolbar along with the regular navigation buttons. When the Auto-hide button is enabled, the UI will be hidden if the user does not interact with it. Tab the screen/move the mouse to the UI area to bring it back.

**Panels**

Here you give a name to the choice of parent model, which is the first choice in the sequence of choices that make up the configuration. As well as to the section where the user can select between studios.

**Styling**

• Panels - Sets the colors of the UI itself
• Titles - Controls the appearance of the titles of the choices. note that the text colors will also apply to arrows etc. in the web version of the configurator.
• Thumbnails - Controls the appearance of the thumbnails.
• Window - sets the background color of the window - this is primarily relevant for web configurations or cases where the image size is locked.
• Scrollbar - controls the appearance of the scrollbars in Presentation Mode/KeyShot Viewer. This will have no effect on web configurations.

**Advanced**

• Call script on... - Offers the option of using scripting with your configurator.
• Render All Materials - The first time a material is present in the configuration a thumbnail is automatically rendered, but if you have made changes to your materials you may need to re-render. If you use large thumbnails in the configurator layout, it will also be a good idea to re-render materials in high resolution. Model Set and Studio thumbnails can be set to high resolution in the respective panels.

---

**Styling**

In KeyShot 8.2 we have introduced a styling section that enables you to easily customize the colors of your Configurator menu. In previous versions this could be achieved via the style sheet.

When opening older scenes in KeyShot 8.2 or KeyShot 9, the color values from the style sheet will automatically be mapped to the relevant colors in the style section. You may however still need to update some values.

> View mapping rules

**Style sheet**

**Style section Color**
| QFrame#PresentationMode (background); | Panel Background |
| QFrame#PresentationModeDivider (background); | Panel Border |
| QTabWidget#PresentationMode QTabBar::tab {color}; | Title Text |
| Alternative:QTabWidget#PresentationMode QTabBar::tab:selected {color}; | Title Text |
| QTabWidget#PresentationMode QTabBar::tab {background}; | Title Background |
| QTabWidget#PresentationMode QTabBar::tab:selected {color}; | Title Text, Selected |
| QTabWidget#PresentationMode QTabBar::tab:selected (background); | Title Background, Selected |
| QTabWidget#PresentationMode QTabBar::tab:hover {color}; | Title Text, Hover |
| QTabWidget#PresentationMode QTabBar::tab:hover {background}; | Title Background, Hover |
| QListWidget#PresentationMode:item:selected {background}; | Thumbnail Background, Selected |
| QListWidget#PresentationMode:item:selected {color}; | Thumbnail Text, Selected |
| QListWidget#PresentationMode:item:selected {border-color}; | Thumbnail Border, Selected |
| QListWidget#PresentationMode {background}; | Thumbnail Background |
| QListWidget#PresentationMode {color}; | Thumbnail Text |
| QListWidget#PresentationMode:item:hover:!selected {background}; | Thumbnail Background, Hover |
| QListWidget#PresentationMode:item:hover:!selected {border-color}; | Thumbnail Border, Hover |
| QScrollBar#PresentationMode:vertical {background}; | Scrollbar Background |
| QScrollBar#PresentationMode::handle:vertical {background}; | Scrollbar Handle |
Summary

The Summary section allows you to see an overview of the number of variations in your Configurator and to preview each of the variations in the Real-time View before entering Presentation Mode.

Naming

The names of Model Sets, Component and Sub-Component Groups, Multi-Materials and Materials, Material Sets and Ways may all be exposed in the Configurator UI. Select and click again to rename, or choose Rename in the context menu.

Ordering

The order if items in the summary matches what you will see in the Configurator UI. You can reorder by selecting the item you want to move and use the arrows to the left of the list.

Default options

You can select which options the configurator starts with, as well as what options are the default option within a Choice (Component Group / Sup-component Group / Material Set / Multi-Material), by turning on the blue button in front of the option. The branch with the active model and material configuration, will be enabled in the overview, while the rest will be greyed out.

Thumbnails

The summary step of the Configurator Wizard also gives you the option of re-rendering or adding custom thumbnails for Model Sets, Materials and Material Ways. The overview shows a mini thumbnail for all items, hover this or select to preview the thumbnail. If you want to replace it with an image of your own or render a new thumbnail, select the item and click the Replace Thumbnail. A dialog will appear, with following options

- **Model Sets**
  - Inherit from Model Set: this will use the thumbnail created in the Model Set panel
  - Custom Image: this option lets you select an image on the disk. This will be scaled down to fit the size of the rest of the thumbnails, but you may need to consider what aspect ratio it has to make it fit with the rest of thumbnails in the current group/set
  - Render: this option will let you select which studio to use. If you want to show the model isolated or in context, i.e. with all the default options related to the item. And enables you to set the aspect ratio of the thumbnail, adjust the position if the item and the size and quality of the thumbnail image.

- **Materials**
  The default thumbnail will show the KeyShot material ball with the current material. This can
be replaced with a custom image.

- **Material Ways**
  The default thumbnail will show 3 KeyShot Material balls with the first 3 materials in the material way. This can be replaced with a custom image.

**Using the KeyShot Configurator**

In this video, we show how to use the KeyShot Configurator to present model and material variations in real-time for design reviews or touch-enabled customer experiences.

This video was made for KeyShot 7. In KeyShot 9 a few things have changed, but the video gives a good overall idea about the Configurator and how to use it.
**What is it?**

KeyShot Viewer is a free, stand-alone, touch-enabled, desktop application for Mac and Windows that enables KeyShot scenes to be securely shared with anyone for interactive viewing, presentation and configuration. KeyShot Viewer uses the same CPU-powered ray-tracing render engine as KeyShot to produce amazing photo-realistic visuals in real-time.

**How it works**

**Saving for KeyShot Viewer**

KeyShot Viewer enables you to share a scene with someone who don't have KeyShot. You can share regular scenes as well as Configurator scenes. The viewer can open regular KSP files, but you can also Save For KeyShot Viewer, which will allow you to password protect the scene and/or add logo and watermark overlays to the scene.

**Downloading, installing, and opening files**

KeyShot Viewer can be downloaded at keyshot.com/viewer by entering your name and email address. Once KeyShot Viewer is installed you will be able to open any KeyShot Package file (.ksp) to interact with the scene.

When KeyShot Viewer is launched you will be prompted with a splash screen where you can browse to open a file or select from those recently opened.

You can also open .ksp files by dragging and dropping onto the splash screen, into the KeyShot Viewer application window or by the file menu if a scene is currently open.

The file menu is accessible when the application is in a windowed state, which can be reached from full-screen presentation mode by pressing the Esc key or clicking the exit icon. To enter full-screen presentation mode again, maximize the window or click the presentation mode icon.

KeyShot viewer comes with 2 demo scenes. Additional configurator scenes can be found [here](#).
Depending on how the scene was saved from KeyShot Pro you may be prompted to enter a password.

Moving the camera view

When you move the camera view or make changes the scene will update instantly - with the image quality improving as you let it sit until 256 samples has been reached.

To move the view, simply use your mouse or finger on a touch-enabled device. The toolbar has three icons indicating if tumble, pan, or dolly is active for the left mouse button or single-finger input.
If you're using a mouse you can also pan using the middle mouse button and dolly using the middle mouse wheel or by scrolling on a touch-pad. To reset the view click the camera reset icon on the toolbar.

You can open both regular scenes and Configurator scenes in KeyShot Viewer. The option to add watermark and powered by KeyShot is included when exporting a KeyShot Scene for KeyShot Viewer.

**Studio, Model, and Material variations**

Users of KeyShot Pro can use the Configurator to include Studio, Model, and Material variations, which will be available when KeyShot Viewer is in full-screen presentation mode. Simply click or tap on any of these variations to update the real-time view. Use the tabs to navigate the various options that have been setup in the scene.

For information about using the Configurator in KeyShot Pro, to setup Studio, Model, and Material variations for output to KeyShot Viewer click here.

The auto-hide icon allows you to hide the Studio, Model and Material variation panels after 10 seconds of inactivity. To show again simply mouse over or tap in the area the panels occupy.
KeyShot Pro allows you to present a configurator for unlimited Studio, Model and Material variation.

Taking a Screenshot

If included in your scene, click or tap the screenshot icon on the toolbar to save an image. If your scene includes watermarking it will also be included in screenshot output; however, the UI panels will not.

By default screenshots will be saved in your documents folder. In Preferences you can select another destination folder or choose or choose to be asked for destination every time you take a screenshot. To find Preferences on Windows click Edit, Preferences… and on Mac Keyshot, Preferences…

The Viewer can also output a metadata file in XMP or .meta format. The metadata file indicates which variations are active along with camera information that can be referenced to make changes to the original scene back in KeyShot. You enable/disable metadata output in preferences, where you can also choose the format by clicking the gear icon.

FAQs

1. How do I remove the watermark logo pattern?
   The inclusion of the KeyShot watermark logo pattern is defined when saving for KeyShot Viewer from KeyShot Pro. You will need to ask the provider of the file to remove this.

2. How do I remove the "Powered by KeyShot" logo in the upper right corner?
   The inclusion of the "powered by KeyShot" logo is defined when saving for KeyShot Viewer from KeyShot Pro. You will need to ask the provider of the file to remove this.

3. I see a message "Camera is locked". How do I unlock it?
   The camera state is defined in KeyShot Pro. You will need to contact the scene provider to get a version of the scene that is saved with the camera in an unlocked state.

4. What if I don’t know the password to open a scene?
   You will need to contact the provider of the scene.

5. Why is my Real-time view not using the entire screen space?
   In order to be efficient about CPU usage the real-time view in KeyShot Viewer is limited to 1920x1080 resolution. If you wish to take advantage of the entire screen space on high-resolution displays you will need to use Presentation Mode in KeyShot Pro.

6. How do I know if I'm using the latest version of KeyShot Viewer?
   If there is an update to KeyShot Viewer available a notification will appear on the splash screen.
7. **Where are the demo scenes located on my computer?**
   - Windows: C:\Users\Username\AppData\Local\Luxion\KeyShot Viewer 9
   - Mac: Library/Application Support/KeyShot Viewer 9

8. **Why does it say "Rendering Complete" at the top of the screen?**
   - The real-time view will not render more than 256 samples so the CPU isn't continuously used when KeyShot Viewer is left sitting.

9. **Does KeyShot Viewer support Animation?**
   - No, a file loaded with Animation included will show the scene at 0s and cannot playback any Animations.
Virtual Reality

KeyShot allows you to experience both real-time rendering mode and rendered visuals in virtual reality (VR) using a VR headset. This section describes how to setup and use VR hardware with KeyShot.
Note
Note that this is not the same as KeyVR - Click here if you are interested in the one-click KeyVR experience
VR Overview

The VR capabilities in KeyShot allow you to use VR devices, such as the Oculus Rift and the HTC Vive, to view KeyShot scenes. There are two applications for using VR with KeyShot:

1. **Render VR Images**
   View rendered panoramic images rendered in KeyShot. This mode is compatible with any type of VR device capable of viewing VR images. Please check with the manufacturer of the device to know what type of image is necessary. Learn more

2. **Work in Real-time VR**
   View and render the Real-time View through the VR headset. This mode is compatible with the *Oculus Rift* and the *HTC Vive* only. Learn more

Accessing KeyShot VR Settings

VR capabilities are a KeyShot Pro feature. (Compare KeyShot versions.) All VR settings are accessed from the *Project* window, *Camera* tab, under the *Lens Settings* and *Stereo* sections.

Terminology

**Cube Map**

- In this mode, six views will be rendered side by side.
- The views are: Front, Back, Right, Left, Top, Bottom.
- If your device supports stereo cub maps it will automatically orient the images for you to view them correctly.

**Spherical**

- As described by the name, this image will look like a flattened out sphere.
- This mode will be compatible with most devices out there.
Side-by-side

- In order to see the image in 3D via the headset, you need to have the same image played in both eyes. In this mode both images are stitched next to each other.

Over-under

- In order for you to see the image in 3D in the headset, you need to have the same image played in both eyes. In this mode both images are stitched one on top of the other.

Eye Distance

- This is to set the distance between your eyes. This is a setting that you configured when setting up your Oculus Rift or HTC Vive. Use the same distance set when setting up your device.
Pole Merging Angle

- This is a parameter for stereo rendering. It is the angle at which pole merging begins. It helps avoid artifacts when looking upward and downward. The eye distance value is kept the same until the viewing angle reaches the specified angle after which the eye distance is gradually decreased until it reaches a value of 0 when looking directly downwards or upwards.
Render VR Images
This section will guide you through the steps necessary to render out an image to view on a VR head-mounted display:

1. Open and setup the scene of your choice in KeyShot.
2. Go to the Project window's Camera tab and open the Lens Settings accordion.
3. Select Panoramic mode.
4. Depending on the type of VR device you have, you may need to select Cube Map or Spherical, i.e. Oculus Rift and HTC Vive can use both, but Google Daydream needs a Spherical image.
5. Enable the Stereo radio button.
6. Go to the Render menu by using the Render button in the toolbar or by going to the top menu under Render, Render...
7. Render the image as you would any other image. Keep in mind that you will be "immersed" in the scene, so the bigger the image resolution the more realistic it will look.
8. Upload your rendered image to your headset to view the VR image. This step can be different for each VR headset device. Please consult the headset manufacturer for specific instructions for loading a VR image.
Work In Real-Time VR

This section will guide you through the steps necessary to view the real-time window through a VR head-mounted display:

- This will only work with the Oculus Rift and the HTC Vive.
- These instructions assume that you have the Oculus Rift or the HTC Vive already installed and ready to go.
- These instructions assume that you are wearing the Oculus Rift or the HTC Vive HMD.

Perspective Realtime View

1. Open and setup the scene of your choice in KeyShot.
2. Go to the Project window’s Camera tab and open the Lens Settings accordion.
3. Select Perspective mode.
4. Enable the Stereo radio button.
5. You can change the stereo settings if you know specifically what you need or you can just leave the default settings the way they are.
6. Click on the Head-Mounted Display drop-down and choose which VR device you have. For the Oculus choose Oculus Rift and for the HTC Vive, choose OpenVR.
7. It might take a few seconds for the VR device’s software to load but you can now put your headset on to view your scene.

Panoramic Real-time View

Workflow 1:

1. Open and setup the scene of your choice in KeyShot.
2. In the top menu, go to Camera Enable VR.
3. Choose between Cube map mode or Spherical mode.
4. Choose your desired resolution. Keep in mind that the higher you go the more powerful your machine will need to be. For example, if you are working on a laptop, you should stay at lower resolution.
5. Choose which VR device you have. For the Oculus choose Oculus Rift and for the HTC Vive, choose OpenVR.
6. Click Start. (It might take a few seconds for the VR software to start)

Workflow 2:

1. Open and setup the scene of your choice in KeyShot.
2. Go to the Project window’s Camera tab and open the Lens Settings accordion.
3. Select Panoramic mode.
4. Choose between Cube map mode or Spherical mode.

5. Enable the Stereo radio button.

6. You can change the stereo settings if you know specifically what you need or you can just leave the default settings the way they are.

7. Click on the Head-Mounted Display drop-down and choose which VR device you have. For the Oculus choose Oculus Rift and for the HTC Vive, choose OpenVR.

8. It might take a few seconds for the VR device's software to load but you can now put your headset on to view your scene.
KeyShot Cloud

KeyShot Cloud is an online library where you can share your own custom materials and resources, as well as having access to resources uploaded by other KeyShot users.

You can access Keyshot Cloud here: https://cloud.keyshot.com - or launch it inside KeyShot via the KeyShot Cloud icon in the bottom left corner of the Toolbar.
KeyShot Cloud User Interface

1. Search Field
2. Display Style
3. User account/settings
4. Category Tabs - the number next to the icon shows how many results the active search has within the category.
5. Total number of resources within a category
6. Search Results, the number shows how many search results there are withing the category.
7. "Download" Button
8. "Like" Button
9. Details
KeyShot Cloud Account

You only need an account if you want to upload or like resources.

Login/Create Account

Create an account by clicking the user icon in the top right corner of KeyShot Cloud and click login - On this page you will find an option to register.

If you are not logged in when trying to upload or like you will be asked to login/register before you can proceed.

Log Out

To log out, click the settings icon in the upper right of KeyShot Cloud window and click Log out.

Delete Account

If you for some reason want to delete your account, just login, click on Account Settings in the dialog click Delete My Account.

When your account is deleted Luxion will delete any information that can be associated with you and resources uploaded by you will be redelegated to a Luxion account.
KeyShot Cloud Search

KeyShot Cloud has robust search capability. You can use the filters or do a more advanced search using our search syntax.

Sorting and Filters

The search results may be organized using the Order By and the Results Since drop-down menus.

Search Syntax

If you want to perform a more specific search you can use search syntax.

- Normal Search: `term`
- User Search: `@username`
- Include: `+term`
- Exclude: `-term`
- User Likes: `L@email/username`
You can find examples of the search syntax by clicking the little question mark in the search field.

**Resource Details**

Click on a resource entry to bring up the details of that specific resource such as the size, description, tags, creator, and more. The details section will also contain the Download button to download the resource to your KeyShot Library, as well as a Report button to flag any resource as offensive or copyright-infringing material.

**Compatible Version**

When you access KeyShot Cloud from KeyShot, the resources will only be shown if they are compatible with the current version of KeyShot. If you are browsing directly on the site, see the resource details for information about compatible version.
Uploading/Downloading Resources

Uploading Resources

To upload your custom resources to the Cloud Library,

- Select the resource(s) you want to upload and click the Upload button on the bottom right of the KeyShot library panel. Alternatively you can right-click the resources and select Upload To Cloud Library.
- If you are not yet logged in you will be asked to do so.
- Describe the resource, edit the name if necessary and add tags to help other users search for your resource. If you don’t know what tags to use, you can click Suggestions and KeyShot will auto-generate tags for you. The check mark icon next to the input fields will let you know if your input is OK.
- Click next to input information about the next resource, if any.
- The final step displays a confirmation of resources to be uploaded - Click Upload to send your resource to the cloud.

Upload Guidelines

To ensure the quality of resources in the KeyShot Cloud remains high, all resources will have to be approved by Luxion staff before they will be available on the Cloud. This will be done within 48 hours.

The approval procedure considers both the quality of the resource and the name and description. If you want to know the guidelines you can always find them in the bottom left corner of the upload dialog.

It is not possible to upload KeyShot stock resources, Procedural Environments, and Multi-Materials to KeyShot Cloud.

Downloading Resources

To download a resource, click the blue Download button on the resource in the overview or in the resource details. You can also drag-and-drop the resource on the Real-Time View.

If you are accessing KeyShot Cloud outside KeyShot, KeyShot will be launched and the downloaded resource can be found in the Download folder.
The resource will be automatically downloaded to your downloads folder in the appropriate tab, and you will then be able to move it to an existing or custom folder.
# KeyShot Cloud Release Notes

## 1.2.0

- Support of the new Model resource type (KeyShot 9 onwards)
- Support rendering Models with thumbnail generator
- Fixed background card color for selected resources
- Fixed a few SQL query errors
- Preserve query-string when logging out so language selection isn’t lost
- Deny info endpoint on Models for KS 8 and earlier
- Expose KS major version in API endpoints
- Improvements to the thumbnail generator
- Resource name links to the specific resource
- Proper escaping of characters when using the site search
- Eliminate white space between asset cards with varying aspect ratios
- Force cache invalidation of JS/CSS for every new site version
- Various tool and code speedups
- Compressed our PNGs further 11% with PNG Crush
- Migrated to PHP 7.3

## 1.1.2

This is a rejuvenated version of KeyShot Cloud which has a lot of updates, fixes, and improvements since version 1.0.25.

- KeyShot Cloud launches directly in the KeyShot user interface as a dockable window (KeyShot 8 only).
- When viewing in KeyShot, it only shows materials that are compatible with the version of KeyShot.
- Login is no longer needed to browse the site and download resources! (It is, however, needed for uploading new resources and for user actions such as liking assets or browsing likes and downloads.)
- Login prompt shown instead of redirecting to login page (when not shown inside KeyShot).
- Correctly identify if site is running inside KeyShot or not.
- "My Downloads" and "My Likes" browse options show only when logged in.
- Download link exposed on download button.
- Support searching for resources via ID: #ID. Example: #123
- Removed upload modal dialog - now located in KeyShot.
- Use active type for initial resource count instead of always materials.
- Simplified registration process to avoid confusion.
- Simplified password reset (account recovery) process to avoid confusion.
- Dragging the thumbnail, in details view, to KeyShot will drag the link instead.
- Toggle password visibility for login.
- CSS fallbacks to support KeyShot v5 (older web engine).
- Show compatible KeyShot version for materials in details view (though it's hidden for version <= 5).
- Commenting has been disabled.
- Squashed various bugs.
- General improvements.

## 1.0.25

<table>
<thead>
<tr>
<th>Release note version</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.2.0</td>
</tr>
<tr>
<td>1.1.2</td>
</tr>
<tr>
<td>1.0.25</td>
</tr>
</tbody>
</table>
• Implemented account deletion under account settings in relation to GDPR.
• Updated thumbnail generation.
• Various other fixes.
• Approval process for newly upload resources.
Network Rendering

KeyShot Network Rendering allows you to connect multiple computer systems in your office network and utilize the available hardware to reduce rendering times significantly. In fact, the correlation between render time and number of cores in your network is approximately linear and inversely proportional. In other words, by doubling the number of cores you potentially cut your render time in half.* In addition, rendering over the network is convenient. You may continue working in KeyShot or any other application without slowing down your system while the designated rendering stations process your render “jobs”.

The KeyShot Network Rendering software is compatible with Mac and PC systems.

* Please note that this is an approximation under optimal conditions. Render times are subject to hardware specs, core count differences between workers, scene complexity, unit of time, multi-tasking, and network traffic.

** Please note that Luxion does not sell or rent cores. All computer hardware (i.e. processor cores) is provided by the customer.

More on KeyShot Network Rendering and Network Rendering Installation can be found in the KeyShot 8 Network Rendering Manual.

View KeyShot 9 Network Rendering Manual
End-User License Agreement

Luxion KeyShot® 9


Protected by US patents 8,913,065; 9,043,007; 9,183,654.

Copyright law and international treaties protect this computer software program. Unauthorized reproduction or distribution of this software program, or any portion of it, will be prosecuted to the maximum extent possible under law and may result in civil and criminal penalties.

KeyShot®, KeyShotXR™, KeyVR™, and LiveLinking™ are a Trademark or Registered Trademark of Luxion ApS.

PLEASE READ THE FOLLOWING CAREFULLY AS IT AFFECTS YOUR LEGAL RIGHTS:

THE LICENSE GRANT MADE TO YOU PURSUANT TO THIS END-USER LICENSE AGREEMENT (THIS “AGREEMENT”) IS CONDITIONED UPON YOUR ACCEPTANCE OF ITS TERMS. IF YOU DO NOT AGREE WITH THIS AGREEMENT’S TERMS, YOU SHOULD RETURN THE SOFTWARE AND ANY DOCUMENTATION, AND YOU WILL RECEIVE A FULL REFUND FOR ANY MONIES PAID FOR THE SOFTWARE.

1. License. The software (the "Software"), no matter how delivered (e.g. as a download online, in CD form), as well as any and all related documentation ("Documents") are licensed to you by Luxion ApS, a Denmark corporation. This License is non-exclusive, with Luxion retaining the right to license the Software and/or Documents to any other party at Luxion’s sole discretion. This license is not a sale and except for the license granted below, Luxion retains all right, title and interest in and to the Software and Documents and any copies thereof. The node-locked License allows you to use the Software and Documents on a single fixed personal computer system or on a single mobile computer system (the "Host System"). The floating License allows you to use the Software and Documents within your organization by checking out no more than the number of purchased licenses from a license host. You are also allowed to make one copy of the Software in machine-readable form and one copy of the Documents in hard-copy form for backup purposes only. You must reproduce on any such copy (in whatever form such copy may be) the Luxion copyright notice and any other proprietary legends that are on the original copy of the Software and Documents. Annual maintenance includes all updates and releases for the prepaid year as well as phone-in support.

2. Restrictions. The Software contains copyrighted material, trade secrets, and other proprietary information, and in order to protect them, you may not reverse engineer, disassemble, or otherwise reduce the Software to a human-perceivable form except to the extent that it is unallowable to prohibit such acts under applicable law. You may not modify, network, rent, lease, loan, sell, distribute, or create derivative works based upon the Software or Documents in whole or in part. You may not electronically transfer the Software from one computer to another over a network. In addition, you may not remove, obscure, or alter any proprietary rights or notices affixed or contained in the Software or Documents. All rights not expressly granted are reserved by Luxion.

3. Termination. This License is effective until terminated. You may terminate this License at any time by destroying the Software and Documents and all copies thereof. If you fail to comply with any provision of this License, this License will terminate immediately without notice from Luxion and other legal remedies will become available to Luxion. Upon termination, you must destroy the Software, Documents and all copies thereof.

4. Export Law Assurances. You agree and certify that the Software will not be exported from the jurisdiction in which you acquired it except as permitted by the applicable laws of such jurisdiction.

5. U.S. Government Restricted Rights. The Software and Documents are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19 and successors thereof, as applicable. Contractor/manufacturer is Luxion ApS.

6. Disclaimer of Warranty on Software. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE SOFTWARE IS AT YOUR SOLE RISK. THE SOFTWARE AND DOCUMENTS ARE PROVIDED "AS IS" AND WITHOUT WARRANTY OR CONDITION OF ANY KIND AND LUXION EXPRESSLY DISCLAIMS ALL WARRANTIES AND CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. LUXION DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT ANY DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, LUXION DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE OR DOCUMENTS IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY LUXION OR AN
AUTHORIZED REPRESENTATIVE THEREOF SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT LUXION OR ANY AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. SOME STATES AND JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

7. Limitation of Liability. UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL LUXION OR ITS SUPPLIERS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, CONSEQUENTIAL DAMAGES OR RELIANCE THAT RESULT FROM THE USE OF OR INABILITY TO USE THE SOFTWARE OR RELATED DOCUMENTATION, EVEN IF LUXION OR A LUXION AUTHORIZED REPRESENTATIVE HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF ANY LIMITED REMEDY. SOME STATES AND JURISDICTIONS MAY NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

In no event shall Luxion’s total liability to you for all damages, losses, and causes of action (whether in contract, tort (including negligence), or otherwise) exceed the amount paid by you for the Software.

8. Controlling Law and Severability. This license shall be governed by and construed in accordance with the laws of Denmark. If for any reason a court of competent jurisdiction finds any provision of this license, or portion thereof, to be unenforceable, that provision of the license shall be enforced to the maximum extent permissible so as to effect the intent of the parties, and the remainder of this license shall continue in full force and effect.

9. Injunctive Relief. You acknowledge and agree that your obligations and promises of under this Agreement are of a unique, intellectual character that gives them particular value. You acknowledge and agree that a breach of any of the promises or agreements contained in this Agreement will result in irreparable and continuing damage to Luxion for which there will be no adequate remedy at law and, in the event of a breach, Luxion will be entitled to injunctive relief and/or a decree for specific performance, and any other additional relief as may be proper (including monetary damages if appropriate).

10. Assignment. You may not assign any rights or obligations arising under this Agreement without Luxion’s prior written consent. Luxion may assign any rights or obligations under this Agreement without your prior written consent. Subject to this restriction on assignment, this Agreement will inure to the benefit of and bind the successors and assigns of each of Luxion and you.

11. Waiver. A waiver of a breach or default under this Agreement will not be a waiver of any other default. Failure by either party to enforce compliance with any term of this Agreement will not be a waiver of that term.

12. Arbitration. The Parties agree that any and all disputes arising out of the terms of this Agreement, their interpretation, and any of the matters herein released shall be subject to binding arbitration, to the extent permitted by law, in Denmark. The Parties agree that the prevailing party in any arbitration shall be entitled to injunctive relief in any court of competent jurisdiction to enforce the arbitration award. The Parties further agree that the prevailing party in any arbitration shall be entitled to reimbursement of their reasonable attorneys’ fees and costs incurred in the arbitration. THE UN CONFERENCE ON CONTRACTS FOR THE INTERNATIONAL SALE OF GOODS IS HEREBY EXPRESSLY DISCLAIMED.

13. Entire Agreement; Amendments. This Agreement states the final, complete, and exclusive agreement between the parties with respect to the subject matter and supersedes any previous oral or written communications, representations, understandings, or agreements with respect to that subject matter. Any representations, warranties, or statements made by either party that differ from the terms of this Agreement will be given no force or effect. No course of dealing or usage of trade or course of performance will be relevant to explain or supplement any term expressed in this contract. The terms of this Agreement may be modified only in writing signed by you and an authorized representative of Luxion.